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Introduction

JavaScript is a platform-independent scripting language that you can use to control many features and
automate many tasks in Adobe® applications. Scripting is easier to learn and use than many other kinds of
programming, and provides a convenient way of automating repetitive tasks or extending applications to
provide additional tools for other users.

e If you are new to scripting, see Adobe Creative Suite: Introduction to Scripting, which introduces basic
scripting concepts and describes different scripting languages that are available, including JavaScript.
JavaScript and other scripting languages are object-oriented, and this book also describes the basic
concepts of object-oriented programming and document object models.

e Each application that supports JavaScript also provides an application-specific Scripting Guide that
introduces the object model for that application, and reference material for the objects. This document
provides information about the JavaScript features, tools, and objects that are common to all Adobe
applications that support JavaScript.

e This document does not teach JavaScript. If you are familiar with scripting or programming in general,
but unfamiliar with JavaScript, see publicly available Web resources and documents, such as:

e The public JavaScript standards organization web site: www.ecma-international.org

e “JavaScript: The Definitive Guide,” David Flanagan, O'Reily Media Inc, 2002. ISBN 0-596-00048-0
e “JavaScript Bible,” Danny Goodman, Hungry Minds Inc, 2001. ISBN 0-7645-4718-6

e “Adobe Scripting,” Chandler McWilliams, Wiley Publishing, Inc., 2003. ISBN 0-7645-2455-0

Note: Check for updated versions of this document at Adobe Developer Center,
http://www.adobe.com/devnet/.

Adobe provides an extended implementation of JavaScript, called ExtendScript, that is used by all Adobe
applications that provide a scripting interface. In addition to implementing the JavaScript language
according to the ECMA JavaScript specification, ExtendScript provides certain additional features and
utilities.

This document describes JavaScript modules, tools, utilities, and features that are available to all
JavaScript-enabled Adobe applications.

Note: Some modules, and features of some modules, are optional. Check the product documentation for
each application for details of which modules and features are implemented.

Example code

The Adobe Bridge SDK, which contains this document, also contains a set of code samples (“Snippets”),
that demonstrate how to use the features of ScriptUl and interapplication communication. This book
refers to these samples by name for illustration of concepts and techniques. You can download the SDK
from Adobe Developer Center, http://www.adobe.com/devnet/.
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For help in developing, debugging, and testing scripts, Adobe provides the ExtendScript Toolkit, an
interactive development and testing environment for ExtendScript, which is installed with all
JavaScript-enabled applications. For complete details, see Chapter 2, “The ExtendScript Toolkit.”

ExtendScript also provides global objects that support development and debugging:
e A global debugging object, the Dollar ($) Object.

e Areporting utility for ExtendScript elements, the ExtendScript Reflection Interface.

For complete details, see Chapter 8, “ExtendScript Tools and Features.”

Adobe ExtendScript defines File and Folder classes that simplify cross-platform file-system access.
These classes are available to all applications that support a JavaScript interface.

For complete details, see Chapter 3, “File System Access.”

Adobe provides the ScriptUl module, which works with the ExtendScript JavaScript interpreter to provide
JavaScript scripts with the ability to create and interact with user interface elements. It provides an object

model for windows and Ul control elements within an Adobe application. For complete details, see
Chapter 4, “User Interface Tools.”

In addition, ExtendScript provides:

e Global functions for localization of display strings; see “Localizing ExtendScript Strings” on page 206

e Global functions for displaying short messages in dialog boxes; see “User Notification Dialogs” on
page 209.

e An object type for specifying measurement values together with their units; see “Specifying
Measurement Values” on page 212.

ExtendScript provides a common scripting environment for all Adobe JavaScript-enabled applications,
and allows interapplication communication through scripts.

Different levels of communication are provided through the cross-DOM and the messaging framework.

e Cross-DOM Functions are a limited set of basic functions common across all message-enabled

applications, which allow your script to, for example, open or print files in other applications, simply by

calling the open or print function for that application.

In addition to the basic set of common functions, some applications provide more extensive sets of
exported JavaScript functions to other applications.

e The interapplication messaging framework is an application programming interface (API) that allows
extensive control over communication between applications. The APl allows you to send messages to
other applications and receive results, and to receive messages sent by other applications and return
results. Typically the data passed between applications are JavaScript scripts. However, the messaging
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framework is extensible. It allows you to define different types of data to send between applications,
and to specify how they are handled.

For complete details, see Chapter 5, “Interapplication Communication with Scripts.”

ExtendScript offers tools for communicating with other computers or the internet using standard
protocols. These objects support external communication:

e The Web Access library defines the FtpConnection Object, which supports FTP and SFTP
communication protocols, and the HttpConnection Object, which supports HTTP and HTTPS
communication protocols.

e The Socket Object supports low-level TCP connections.

For complete details, see Chapter 6, “External Communication Tools.”

You can extend the JavaScript DOM for an application by writing a C or C++ shared library, compiling it for
the platform you are using, and loading it into JavaScript as an ExternalObject instance. A shared
library is implemented by a DLL in Windows, a bundle or framework in Mac OS, or a SharedObject in UNIX.

For complete details, see Chapter 7, “Integrating External Libraries.”

ExtendScript provides these utilities and features:
e JavaScript language enhancements:

e Tools for combining scripts, such as a #include directive, and import and export statements.
See “Modular Programming Support” on page 216.

e Support for extending or overriding math and logical operator behavior on a class-by-class basis.
See “Operator Overloading” on page 219.

For complete details, see Chapter 8, “ExtendScript Tools and Features.”

e JavaScript compilation, through the ExtendScript Toolkit. See “The ExtendScript Toolkit” on page 13.

e XML integration: ExtendScript defines the XML object, which allows you to process XML with your
JavaScript scripts. For complete details, see Chapter 9, “Integrating XML into JavaScript.”

e Scripting support for XMP metadata manipulation: XMPScript provides a JavaScript API for the Adobe
XMP Toolkit. For complete details, see Chapter 10, “Scripting Access to XMP Metadata.”

On startup, all Adobe JavaScript-enabled applications execute JSX files that they find in their startup
directories; some of these are installed by applications, and some can be installed by scripters. The policies
of different applications vary as to the locations, write access, and loading order.

In addition, individual applications may look for application-specific scripts in particular directories, which
may be configurable. Some applications allow access to scripts from menus; all of them allow you to load
and run scripts using the ExtendScript Toolkit.
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For details of how to load and run scripts for any individual application, see the JavaScript Scripting Guide
for that application.

Individual applications in Adobe® Creative Suite 3 vary in the extent to which they support features and
modules of ExtendScript. For details of which features are supported in which applications, see “Feature
Support in Applications” on page 270.

A scriptin a startup directory might be executed on startup by multiple applications. If you place a script in
such a directory, it must contain code to check whether it is being run by the intended application. You
can do this using the appName static property of the BridgeTalk class. For example:

if ( BridgeTalk.appName == "bridge" ) {
//continue executing script
}

If a script that is run by one application will communicate with another application, or add functionality
that depends on another application, it must first check whether that application and version is installed.
You can do this using the BridgeTalk . getSpecifier() static function. For example:

if ( BridgeTalk.appName == "bridge-2.0" ) {
// Check to see that Photoshop is installed.
if ( BridgeTalk.getSpecifier ("photoshop",10)) {
// Add the Photoshop automate menu to the Adobe Bridge UI.
}

}

For details of interapplication communication, see Chapter 5, “Interapplication Communication with
Scripts.”

Scripting shares a global environment, so any script executed at startup can define variables and functions
that are available to all scripts. In all cases, variables and functions, once defined by running a script that
contains them, persist in subsequent scripts during a given application session. Once the application is
quit, all such globally defined variables and functions are cleared. Scripters should be careful about giving
variables in scripts unique names, so that a script does not inadvertently reassign global variables
intended to persist throughout a session.
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The ExtendScript Toolkit

The ExtendScript Toolkit provides an interactive development and testing environment for ExtendScript
in all JavaScript-enabled Adobe applications. It includes a full-featured, syntax-highlighting text editor
with Unicode capabilities and multiple undo/redo support. The Toolkit is the default editor for
ExtendScript files, which use the extension . jsx.

The Toolkit includes a JavaScript debugger that allows you to:

e Single-step through JavaScript scripts (JS or JSX files) inside an application.

e Inspect all data for a running script.

e Set and execute breakpoints.

When you double click a JSX file in the platform’s windowing environment, the script runs in the Toolkit,

unless it specifies a particular target application using the #target directive. For more information, see
“Selecting a debugging target” on page 25 and “Preprocessor directives” on page 216.

Tip: When you have completed editing and debugging your JavaScript script, you can choose to save it as
a binary file (with the extension JSXBIN), using File > Export as Binary.

The ExtendScript Toolkit initially appears with a default workspace arrangement, containing a default
configuration of tabbed panels and Script Editor document windows. The arrangement is highly
configurable, through the Window menu, the context menus of individual panels and panel groups, or
directly using drag and drop.

B ExtendScript Toolkit 2 =(ol x|
Ele Edit View Debug Profle Window Help
B Saphivenutemjsn (/0] e ]
)
|Extendscriot Todlkit 2 = [main = e la| ®m] || A | tavaseript consale > L
Document ] >|val =
) R = Panels
W|ndOW 2 @fileoverview Shows how to add a custom menu element to Bridge
3 @class
4 .
e JavaScript
&
7 Run the snippet in the ExtendScript Toolkit (see readme tut) COhSOIe
8 <li= In Bridge, select SnpaddMenu > SnpaddMenultem
e 5
10 Description: J
11 5 Ar——— wrET— =%
12 Shows how to add a custom menu element to Bridge. | scripts s | Breakpaints | Call Stack | _—
13 IFavorltes ;l IDeFau\t ;‘
14 The script adds a new menu to the menu bar after the Help menu, d
15 When selected, the command displays a message dialog.
16
17 The script can only be run once within a Bridge session; you must n
18 This avoids the creation of duplicate menu elements with slightly dit
19
20 @constructor Constructor
- _lj
22 function SnpaddMenultem() <] )
G - | — —
o4 e e | Data Browser x |
25 The contest in which this snippet can run; Bridge must be running
26 @type String :Iﬂl
27 il
28 this.requiredContext = "tadobe Bridge CS2 must be running.y gfuncuo{' Eﬂnt() I ' -
o0 app = [object Application
a0 - e @ function setDefaulkXMLNamespace()
31 The unique identifier for the menu g:ﬂ:z:zg ;SSE::T(()) 1
32 w@?type String et @ function Object)
1 14 @ Function alert() _'LI
1 ¥
| Line 1 Column 1 Y

13
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You can, for example, adjust the relative sizes of the panels by dragging the separators up or down, or
right or left, and can rearrange the groupings. To move a tabbed panel, drag the tab into another pane.

If you drag a tab so that the entire destination group is highlighted, it becomes another stacked panel in
that group. If you drag a tab to the top or bottom of a group (so that only the top or bottom bar of the
destination group is highlighted), that group splits to show the panels in a tiled format.

e You can dock the entire panel group to different edges of the Toolkit window.
e You can collapse the entire panel group, then expose individual panels.
e You can open and close, or collapse and expand individual panels, regardless of the dock state.

e You can undock individual tabs, making them floating panels.

Right click in tab for panel menu Right click in top bar for panel-group menu
‘ = Close Group
Minimize Group

alllEs

| Scripts x | JavaScript Cansale |

Close Panel

4

rripks

| v

Shiowe Inkerface Preferences...

Minimize Panel

Shiows Inkerface Preferences...

----- ¥ SnpAuuScrithTNavBar.jsx

- #] snpCreateCheckBoxRadioButtons, jsx

¥ SnpCreatelialog. jsx _ ifi

B e x Panel-specific flyout menu

¥ SnpCreatelconInspectorPanel. jsx

4] SnpCreateProgressBar,jsx —

¥ SnpCreateslider . jsx REFFESI‘I

¥ SnpCreateTabbedPaletteScriptUl jsx

¥ SnpCreateTextInspectorPanel jsx .

----- #] snpCreateThumbInspectorPanel jsx 'ﬁ'dd Favarite. ..
#] snpCreatelladdMethod, jsx

4] SnpCreatelIResourceSpec, jsx

5 SnpCreateWebTabbedPalette, jsx

----- %] snpDefineAppClosingHandler . jsx LI

Modify Fawvarite
Remowve Favarite

Both individual panels and panel groups have context menus, which you invoke with a right click in the
tab or on the background of the title bar. These menus have panel-control commands, including Close
Panel and Close Group to hide the individual panel or entire group.

e You can also show or hide specific panels by toggling them on or off in the Window menu. Use the
Window menu to show a hidden panel, or to bring a floating panel to the front.

e Use Window > Hide panels to close all of the panels.

Some panels also have a flyout menu, specific to that panel, which you access through the menu icon in
the upper right corner.

The individual panels are discussed in detail in the following sections.
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2: The ExtendScript Toolkit

Document windows

When you open scripts or text files, each file appears in its own Script Editor document window. You can
use the Window menu to arrange multiple document windows in the default cascade display style
(overlapping windows) or tiled display style (non-overlapping windows). In the cascade style, a window
that you move into the panel area goes behind any visible panels.

E™ ExtendScript Toolkit 2

File Edt Yew Debug Profle Window Help

E® snpScheduleTask.jsu [R/0]

[Extendscrint Taolkit 2 =1 [main =1 | u| ®m]| » | |l savascript consd seripts * Breskpoints EallStack |~
e app.document.setPresentationMode("HTML", "bridge: html: file: /" + this.htmlFil [Favories =1 Joeta =]
76 =
77 E= snpaddMenultem.jsx [R/0]

78 | i
Extendscript Toolkit 2 ;I main d | 2NN |
i J El
20 63 M Create the menu element
81 64 var newhenu = new MenuElement{ "menu’, "SnpaddMend”, "afte
== (=18
83 66 M Create the menu item =
84 67 war alertCommand = new MenuElement( "command”, "Snpaddme q Lrl
25 {at=S
86 69 M Define the behavior (what happens when the item is selected) — T
a7 70 alertCommand.onSelect = function {m) | Data Browser |
28 2 - ||l
4 72 var txt = m.text; —I
‘— Jf Display result as UL, as this is Ul sample © Function pri) ;l
£ alert("" + txt + " was chosen menu item"); © app = [obiect Applcation]
Function setDefaultXMLNamespace()
Function confirm(}
@ Function prompt)
Line 1 Column 1| | € Function Object()
Function alsrk()
@ function isXMLName() _'LI
»

Docked panels

Document windows, cascade style

If you choose a tiled display style, the open document windows are automatically arranged into
non-overlapping tiles, either vertical or horizontal, that fill the space between the edge of the window and
the edge of the current panel configuration.

E™ ExtendScript Toolkit 2 I

File Edt Yew Debug FProfle Window Help
ES snphddMenuttemjsk [8/0] ]

|Extendseriot Toolk: 2 =1 |main | Javascript Consd Scripts  Breakpoints Call Stack |

Il
|l

= S

T = || [Favorites =1 [pefaul
2 @fileoverview Shows how to add 3 custom menu element to Brldgej
B} @class
4
5 Usage:
6
7 Run the snippet in the ExtendScript Toolkit (see readme txt)
B8 <liz In Bridge, select SnpaddMenu > SnpaddMenultem
9
10 Description:
11
12 Shows how to add 3 custom menu element to Bridge.
i -
4 v
-
| | Al e
E® snpscheduleTask.jsx [R/0] 1 _Exf ———— =2
| Data Brawser x |

T84 [mein

[ExtendSeript Toalkit 2

3 ol alalplvlall o5

JLine 1 Column 1

Z

T &
2 @fileoverview Shows how ta schedule a task in Bridge, and how to j © function print() =]
B make a remote call from Bridge to a JavaScript function @ app = [object Application]
4 defined in an HTML page that is displayed by the Bridge Content ¢ @ Function setDefault¥MLMamespace()
I @class @ Function confirm(}
6 @ function prompt{}
7¢ Usage: @ function Object()
8 @ function alert{)
[} Rur the snippet in the ExtendScript Toolkit (see readme.txt) D Function iskMLNamed)
10
11 Description:
12
13 Schedules 3 task using app . scheduleTask(), which is repeated at fi:l
4 3 b
L] _'l_I

Document windows, horizontal tile style

Docked panels
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J1=TE
File Edit View Dshug Profle Window Help
BRITES] |~ sl roskise /0 -l
|ExtendScriDt Toolkit 2 ;“ma\n ;I Lli_illlilﬂ:l |ExtendScriDt Toolkit 2 ;”main ;I Llllllilﬂil |@ Javaseript Con
63 #f Create the menu element =] 75 app.document.setPresentationMadel HTML | |@‘ Seript
64 var newhenu = new MenuElement{ "menL 76 ) =i
65 7T Jf Define some components for complex string |@ Ereakpaints
66 Jf Create the menu item 78 wvar quote = "'; o
67 var alertCommand = new MenuElement{ " 79 var someText = "Example html embedded . @ Call stack
68 80 var someMoreText = "With a scheduled ta
69 /f Define the behavior {what happens when t g1 =
70 alertCommand.onSelect = function {m) gz $.writeln("Scheduling tasks...");
T - { g3 Jf Schedule a single call to the remote functio
72 var txt = m.text; 84 app.scheduleTask{"app.document. exec]S('
73 Jf Display result as UI, as this is UI sample 85
74 alert("" + txut + " was chosen menu ite 26 Jf Schedule repeated calls to the remote func
75 ¥ a7 someMoreText = "We can even repeat the
76 =1} var taskID = app.scheduleTask("app. docu
77 return retval; g9
78 ¥ an Jf Schedule the task that cancels the repeatit
79 ik app.scheduleTask{"stopTask(" + taskID +
. - 92 $.writeln("Script complete...tasks schedule
81 Determines whether snippet can be run given ¢ 93
a2 failz if these preconditions are not met: 94 return retval;
83 95 ¥
84 <li= Must be running in Bridge = 96 =
- IESCRHe iSO | - ¥
| JLine 1t Column 1 A | | 7
Document windows, vertical tile style Minimized docked panels

You can edit or run scripts in multiple document windows simultaneously. The current document window
is highlighted and has the input focus. You can select another document window by clicking in it, or you
can switch between them with the commands Window > Next document and Window > Previous
document. The default keyboard shortcuts for these commands are F6 and SHIFT-F6; you can change
these using the Keyboard Shortcuts page in the Preferences dialog (Edit > Preferences).

Note: Because you can run scripts in the same application simultaneously, you should be careful not to
interrupt the processing of one script with another. For example, if one script opens a modal dialog
in Photoshop, and you run another script that targets Photoshop while the dialog is still open, the
second script is likely to generate an error.

For more information about the document windows and the Script Editor, see “The Script Editor” on
page 18.

The Toolkit saves the current layout when you exit, and restores it at the next startup. It also saves and
restores the open documents, the current positions within the documents, any breakpoints that have
been set, and other preferences that have been set in the Preferences dialog.

e To restore the default panel layout, choose Window > Reset Panel Locations.

e The Startup page in the Preferences dialog (Edit > Preferences) offers a choice of whether to open a
blank document window, no document window, or display a previously opened document on startup.

e The Keyboard Shortcuts page in the Preferences dialog (Edit > Preferences) allows you to set or
modify keyboard shortcuts for all menu commands. There is a warning if you assign a key combination
that is already in use. If you assign the combination to a new command, it is removed from the previous
command.

e You can restore all preferences to their default values by holding the SHIFT key down while the Toolkit
loads.
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You can open multiple scripts (or text files, including programs in other languages). You can find and open
scripts in a number of ways:

e Use File > Open to bring up the platform-specific file browser.

e Choose from recently opened files using File > Recent files.

e Create a new script using File > New JavaScript.

e Drop files from the Explorer or the Finder onto the Toolkit to open them in a document window.

e For JavaScript scripts in trusted locations (the user-script folders of installed Adobe applications), a
double-click on the file runs it in the target application or in the Toolkit. For script files in other
locations, you must confirm that you want to run the script.

e Search for scripts containing particular text using Edit > Find and Replace. You can search in a
particular document window, among all scripts open in document windows, or among scripts
associated with an application, or kept in favorite locations. See “Searching in text” on page 22.

e Use the Scripts panel to display and open scripts made available by loaded Adobe applications, or
those kept in favorite locations.

The Scripts panel offers a list of debuggable scripts, which can be JS or JSX files or (for some applications)
HTML files that contain embedded scripts.

You can display a list of scripts made available by a particular target application. Select the target
application in the leftmost drop-down list; the available JavaScript engines for that application become
available in the right-hand list.

| Seripts x | Breakpaints | Call Stack | S
|.ﬁ.d|:|I:ue InDesign C53 ;I |main LI

E- [ User

553 Application

- Export &s 2html

- Scripts Panel

[ ®HTML Far Digital Editions
-0 ¥ml Rules

When you select a target application, the Toolkit offers to open that application if it is not running, then
displays the scripts which that application makes public. Select a script in this panel to load it and display
its contents in a new document window, where you can modify it, save it, or run it within the target
application.

When you choose the target Favorites, the right-hand list shows the default favorite script location, and
any other favorite locations that have been defined. You can create your own list of favorite script
locations using the flyout menu.
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| Scripts 3 | Refresh

Favaorites ~ Current Sc
I J I add Favorite, .

o AlertBoxBuilder ! jsx Maodify Favorite
: AlertBoxBuilder 2, jsx

: BasicExtensionHandler . jsx

b SnpaddContesxtMenulten, jsx
e SnpAddHTMLMavEar jsx

b SnpAddMenultem, jsx

Remove Favarite

You can also examine and set favorite locations using the Favorites page of the Preferences dialog (Edit >
Preferences). Use the Add, Modify, and Remove buttons to edit the list of folders.

Extendscript Toolkit 2 Pr x|

~ /My E20D0cument s -

D :OWorkFilesyAdobeC534Perfol

Startup ;I Default
Dacuments Current Scripts

Font and Colors

Debugging
Help

Keyboard Shortcuts

Create New Favorite ﬂ
Mame Filker
* jsx
| =]

[~ Recursive Folders

OF | Cancel I

B Add... Modify | Remove |
Kl _>l_I

Default | oF I Cancel |

The favorite script locations that you define are also available to the Find and Replace dialog; see
“Searching in text” on page 22.

The Script Editor is a full-featured source code editor for JavaScript. You can open any number of Script
Editor document windows; each displays one Unicode source code document.

The Script Editor offers many useful and powerful text editing and navigation features. Some are intended
specifically for use with JavaScript, while others are useful for all kinds of text editing. Features include:

e Navigation aids and options applicable to any kind of text, and specific code navigation for JavaScript;
see “Navigation aids” on page 19.

e General editing and coding support such as undo-redo, and specific JavaScript coding support such as
syntax checking; see “Coding aids” on page 21.

o Afull-featured text search tool that can search in multiple files; see “Searching in text” on page 22.

e Syntax marking (color and font styles for specific syntactic structures) for JavaScript and for many other
computer languages. The marking styles are configurable; see “Syntax marking” on page 24.
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You can configure the Script Editor to display text with various features that help you track the structure of
your code, or that help you move around in the file. It also offers mouse and keyboard shortcuts for
specific types of cursor movement and text selection.

The Script Editor offers a number of viewing options that aid in code navigation, including the following:
e Automatic line numbering. View > Line Numbers toggles numbering on and off.

e A collapsible tree view of code, where you can open or close logical units of the structure, such as
comments or function definitions. View > Code Collapse toggles the tree view on and off.

e Aline-wrapping mode, where there is no horizontal scroll bar, and lines are wrapped at word breaks.
View > Word Wrap toggles line-wrapping on and off.

e Syntax marking, which uses color and font styles to highlight specific syntactic structures. View >
Syntax Highlighting allows you to turn syntax marking off, or set it to mark a particular language,

JavaScript or many other computer languages. The marking styles are configurable; see “Syntax
marking” on page 24.

You can set the default values for any of these states using the Documents page of the Preferences dialog
(Edit > Preferences).

The Edit > Bookmarks menu allows you to set and clear navigation points in your text. The F2 function
key is the default shortcut key for the bookmark commands:

e Toggle the bookmark for the current line using CTRL-F2.

e Move the cursor to the next bookmark with F2, or to the previous one with SHIFT-F2. The bookmarks
wrap, so that the first follows the last.

o Use SHIFT-CTRL-F2 to clear all bookmarks in the current text.
When you navigate to a bookmark in a collapsed section of code, that section automatically opens.

Bookmarks are marked with a blue, right-pointing arrow at the left of the line (to the right of the line
number if it is shown). This is the same place where a breakpoint is marked with a dot (see “Setting
breakpoints” on page 28). If you have both a breakpoint and a bookmark set in the same line, the blue
arrow is superimposed on the breakpoint dot.
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t: SnpCreateDialog.jsx [R/0] * _I- _ID li
@= | Extendscript Tookt 2 x| » fmain Zl » uE >V A
line numbers —1 B
12 Creates and shows a zimple ScriptUI modeless dialog (alzo called a palette]
13 with OK/Cancel buttons and event listeners that implement the button behavior,
14
15 Beonstructor Constructor,
16 L
bookmark —t7 [> function SnpCreateDialog() {3}
18

. 18 At
C0||apSIb|e Functional part of this snippet.

H L
on
code sections 22 Create a window of type "palette" (o modeles= dialag) and dizplay it.
23
4 @return True if the snippet ran oz expected, false otherwise,
Etype Boolean
2 0
27 SnpCreateDialog.prototype.run = function{)
28 H{
bOOkmarkand 29 /f Create a window of type palette.
breakpomt —r var win = new Window("palette", "SnpCreateDialog”,[100,100,380,2451);
i /¢ Add a frame for the contents,
32 win.btnPanel = win.add("panel", [25,15,255,130], "SnpCreatebialog");
33 /¢ Add the components, twa buttons i
" i e i o e o _'l_l

| JLine 19 Column 3

| RS

You can use the mouse or special keyboard shortcuts to move the insertion point or to select text in the
document window. Click the left mouse button in the document window to move the position caret.

To select text with the mouse, click in unselected text, then drag over the text to be selected. If you drag
above or below the currently displayed text, the text scrolls, continuing to select while scrolling. You can
also double-click to select a word, or triple-click to select a line.

To initiate a drag-and-drop of selected text, click in the block of selected text, then drag to the destination.
You can drag text from one document window to another. You can also drag text out of the Toolkit into
another application that accepts dragged text, and drag text from another application into a Toolkit
document window.

You can drop files from the Explorer or the Finder onto the Toolkit to open them in a document window.

The Keyboard Shortcuts page in the Preferences dialog (Edit > Preferences) allows you to set or modify
keyboard shortcuts for all menu commands.

In addition to the keyboard shortcuts specified for menu commands, and the usual keyboard input, the
document window accepts these special movement keys. You can also select text by using a movement
key while pressing SHIFT.

Enter Insert a Line Feed character
Backspace Delete character to the left
Delete Delete character to the right

Left arrow Move insertion point left one character
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Right arrow

Up arrow

Down arrow

Page up

Page down

CTRL 4+ Up arrow
CTRL + Down arrow
CTRL + Page up
CTRL + page down
CTRL + Left arrow

CTRL + right arrow

Move insertion point right one character

Move insertion point up one line; stay in column if possible
Move insertion point down one line; stay in column if possible
Move insertion point one page up

Move insertion point one page down

Scroll up one line without moving the insertion point

Scroll down one line without moving the insertion point
Scroll one page up without moving the insertion point

Scroll one page down without moving the insertion point
Move insertion point one word to the left

Move insertion point one word to the right

Home Move insertion point to start of line
End Move insertion point to end of line
CTRL + Home Move insertion point to start of text
CTRL + End Move insertion point to end of text

The Script Editor supports extended keyboard input via IME (Windows) or TMS (Mac OS). This is especially
important for Far Eastern characters.

The Script Editor offers a number of visual and editing features that help you navigate in and maintain the
syntactic structure of your JavaScript code, including:

» Brace matching

The Edit menu offers two kinds of brace-matching selection, that operate when the cursor is placed

immediate after an opening brace character, orimmediately before a closing brace:

e Edit > Select to Brace: Moves the cursor to the matching bracing, but does not select any text. The
default keyboard shortcut is CTRL O (zero).

e Edit > Select Including Brace: Selects all text between the braces. The default keyboard shortcut is

SHIFT CTRL O (zero).

Brace characters include parentheses, curly braces, and square brackets.

» Block indentation

When Word Wrap is off, you can automatically indent or outdent entire blocks of text. To indent a block
of text, select some or all of the text on the line or lines, and press TAB. (Be careful; if Word Wrap is on,
this deletes the selected text.) To outdent, press SHIFT TAB.
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» Comment and uncomment commands

Use Edit > Comment or Uncomment Selection to temporarily remove parts of a JavaScript program
from the path of execution. This command is a toggle. When you first issue the command, it places the
special comment sequence //~ at the front of any line that is wholly or partially selected. When you
next issue the command with such a line selected, it removes that comment marker.

The command affects only the comment markers it places in the text; it ignores any comment markers
that were already in the selected lines. This allows you to temporarily remove and replace blocks of text
that include both code and comments.

» Version comments

A special comment format is reserved for a code versioning statement, which is used internally by
Adobe scripts, but is available to all scripters. Use Edit > Insert Version Tag to insert a comment
containing the file name and current date-time, in this format:
/**
* @aBU LD NFO@al SnpOr eat eDi al og. j sx ! Version! Tue Dec 05 2006 08: 03: 38 QVI- 0800
*/
You are responsible for manually updating the ! version! portion with your own version
information.

» Undo and redo

Choose Undo or Redo from the Edit menu or from the document window’s right-click context menu
to revoke and reinstate multiple editing changes sequentially. The change history is kept from when a
file is created or loaded, and maintained through file-save operations.

» Syntax checking

Before running the new script or saving the text as a script file, use Edit > Check Syntax to check
whether the text contains JavaScript syntax errors. The default keyboard shortcut is F7.

e If the script is syntactically correct, the status line shows “No syntax errors.”

e If the Toolkit finds a syntax error, such as a missing quote, it highlights the affected text, plays a
sound, and shows the error message in the status line so you can fix the error.

The Toolkit offers a search utility through the Edit > Find and Replace command. This command brings
up the Find and Replace panel. If the panel is not docked, you can hide it by pressing the EsC key.

The Find and Replace panel allows you to search through multiple documents for text that matches a
specific search string or regular expression. You can choose to search in:

The current document, or the current selection in the current document
All open documents
All scripts made public by the current target application

Folders that you have defined as favorite locations; see “The Scripts panel and favorite script locations”
on page 17.
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_J. Find and Replace = .|- Find resulks .[

Find: I

Find |
Replace |

Replace with: I

[T Match Case Search where:

Replace & Find |
Replace All |

[T Match Whole Waord Current document

[T Match Regular Expression CLrrent selechion
&l open documents
Current target/engine
Favorite : Default

-

Doane |

The results of a search are listed in the Find Results panel; by default, this is stacked with the Find and
Replace panel, but you can drag it to another stack, or display it as an independent floating panel.

Double-click a result line in the Find Results panel to jump directly to the document and line where the

text was found.

| File Edit Yiew Debug Profile Window Help

|
B snpaddMenultem.jsy [R/0O]

| IExtendScriDt Toolkit 2 | Imain

r Extendscript Toolkit 2 1

= _lil_lll il _| @] Javascript Con...

=Nt

=1olx]|

i 48 using an event handler far the onSelect event., | @ Breakpoints
49
&0 Can only run once in a session. You must restart Bridge to test any change you m:
5l
£z @return True if the snippet ran as expected, false otherwise.
E3 @type boolean
54 i
L] SnpaddMenultem.prototype.run = function{)
=15} -4
&7 var retval = true;
g8 - if(!this.canRun{)) {
{=t=] retval = false;
60 return retval;
61 ¥
a2
63 ff Create the menu element
G var newhMenu = new MenuElement{ '

"menu", "SnpaddMenu", "after Help", i]lll
»

4

E_', SnpScheduleTask.jsx [R/0]

=10l x|

&

Display an HTML page in the Content pane, which ca
rment. e

run = Functi
D,l’,l’ Cancel a scheduled task, This Function is schedub

0O/f Define some components For complex strings to [

O/f Schedule a single call to the remote function u_l_l

IExtendScriDt Toolkit 2 ;”main = bl i | ] | )l "l Al
88 - SnpScheduleTask.prototype.run = function() { |
53
a0 var retval = true;

61 - if(!this.canRun{)) {
62 retval = false; || Find and Replace. | Find results > |
63 return retval; Document "snpScheduleTask.jsx”  Line:25  function SnpScheduleTask() {
64 ¥ Document * SnpScheduIeTask jsx Line:48  Functional part of this snippet,
605 ;
ot} Jf Cancel a scheduled ta: te Function in the HTML page using D
67 stopTask = function(ic I
(o1= { Document "SnpScheduleTask, jsx"  Line:6e
= app.cancelTask(id); |Document "SnpScheduleTask.jsx”  Line:6?  OstopTask = function(id)
70 app.document.exec] Document "SnpScheduleTask.jsx"  Line:77
71 £.writeln("Task canc: Document "SnpScheduleTask.jsx"  Line:a3
72 ke
i
T4 /i Display the HTML page Find "function” , 20 matches in 2 files.
1 | i
| Line 55 Colurnn 33 5
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Debugging in the Toolkit

Syntax marking

The Script Editor offers language-based syntax highlighting to aid in editing code. Although the
debugging features (including syntax checking) are only available for JavaScript, you can choose to edit

other kinds of code, and the syntax is highlighted according to the language. The style of syntax marking
is automatically set to match the file extension, or you can choose the language from the View > Syntax

Highlighting menu.

File Edit | iew Debug Profile ‘Window Help
Word Wrap ShiftHCEr-

' Line Mumbers
v Code Collapse

Shift-+Chr+L
Select language for syntax

highlighting in Script Editor

wtendScript Toolkit 2

Mone
Bash
navbar.html [R/0] c#
Fustomlze hlghlilg hting styles == IExtendScript i clct
in Preferences dialog FlashjactionScript 3
| 4 St o |
ExtendScript Toolkit 2 Preferences x| ccyils it HTML Style Sheet |
= L =
Startup d Show Settings For: :l_dliITI\iH‘_'NaVBaI:' lava B
Documents =ed /_]a\.rasc:rlp JavaScript
| HTML j ction(x) LISP
Debugging Fartt: Sige: Lua
Help Microsoft Batch File
Favorites |'v'erdana j I 10 j form thumbfame.va oy
Keyboard Shortouts Display Trems: Ttem Foreground: Perl
ASP <% L. Yl - |- RoyalElue j PostScript
ASP <% . % " Pythan
ASP Python Itemn Background: 0 Ruby
Attributes S0L
-
CDF\TF\ II:I HoneyDew J I('hfmlLoa.dzd', [
‘lass name definition [ Bad [ Italics Td
Class name definition il
Comment :
Bl torr Visual BASIC/VBSCript
Comment IGroup L j Windows Resources
bd="loaded(}"> r—
Cornment a abbr acrorym address 3 HTMLHNavEar B Assembler
Comment applet area b base basefont ayDar: RML 2
Comment bdo big blockquote bady br ="ntfnem
Contral characters button caption center cite
Default code col colgroup dd del dfn
B ud dir div dl dt em fieldset Font
_I _ILI 4 ¥ form frame frameset h1 h2 h3 j
i b
Default | QK I Cancel |

The style of highlighting is configurable, using the Fonts and Colors page of the Preferences dialog.

Debugging in the Toolkit

You can debug the code in the currently active document window. Select one of the debugging
commands to either run or to single-step through the program.

When you run code from the document window, it runs in the current target application’s selected
JavaScript engine. The Toolkit itself runs an independent JavaScript engine, so you can quickly edit and
run a script without connecting to a target application.
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The Toolkit can debug multiple applications at one time. If you have more than one Adobe application
installed, use the drop-down list at the upper left of a document window to select the target application
for that window. All installed applications that support JavaScript are shown in this list. If you try to run a
script in an application that is not running, the Toolkit prompts for permission to run it.

Some applications use multiple JavaScript engines; all available engines in the selected target application
are shown in a drop-down list to the right of the application list, with an icon that shows the current
debugging status of that engine. A target application can have more than one JavaScript engine, and
more than one engine can be active, although only one is current. An active engine is one that is currently
executing code, is halted at a breakpoint, or, having executed all scripts, is waiting to receive events. An
icon by each engine name indicates whether it is running, halted, or waiting for input:

> running
®  halted

waiting

The current engine is the one whose data and state is displayed in the Toolkit’s panes. If an application has
only one engine, its engine becomes current when you select the application as the target. If there is more
than one engine available in the target application, you can select an engine in the list to make it current.

When you open the Toolkit, the Toolkit itself is the default target application. When you select another
target, if the target application that you select is not running, the Toolkit prompts for permission and
launches the application. Similarly, if you run a script that specifies a target application that is not running
(using the #target directive), the Toolkit prompts for permission to launch it. If the application is running
but not selected as the current target, the Toolkit prompts you to switch to it.

If you select an application that cannot be debugged in the Toolkit, an error dialog reports that the Toolkit
cannot connect to the selected application.

The ExtendScript Toolkit is the default editor for JSX files. If you double-click a JSX file in a file browser, the
Toolkit looks for a #target directive in the file and launches that application to run the script; however, it
first checks for syntax errors in the script. If any are found, the Toolkit displays the error in a message box
and quits silently, rather than launching the target application. For example:

$cript Error

Error in C:iphotoshop.jsx
Line 14: #include "Incudefile, js"

File or folder does not exisk
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The JavaScript console is a command shell and output window for the currently selected JavaScript

engine. It connects you to the global namespace of that engine.

| Javascript Consale | V.

myobj = { name ; "caks", number : 2, color : "black” }; ﬂ
Result: [object Object]

rybg;

Result: [object Object]

i Cibj.name;

Result: cats

Qb number

Resule: 2

rybg. color;

Result: black,

The console is a JavaScript listener, that expects input text to be JavaScript code.

You can use the console to evaluate expressions or call functions. Enter any JavaScript statement and

execute it by pressing ENTER. The statement executes within the stack scope of the line highlighted in the

Call Stack panel, and the result appears in the next line.

e You can use the up- and down-arrow keys to scroll through previous entries, or place the cursor with

the mouse. Pressing ENTER executes the line that contains the cursor, or all selected lines.

e The right-click context menu provides the same editing commands as that of the document window.

You can copy, cut, and paste text, and undo and redo previous actions.
e You can select text with the mouse, and use the normal copy and paste shortcuts.

e The flyout menu allows you to clear the current content.

Commands entered in the console execute with a timeout of one second. If a command takes longer than

one second to execute, the Toolkit generates a timeout error and terminates the attempt.

The console is the standard output location for JavaScript execution. If any script generates a syntax error,

the error is displayed here along with the file name and the line number. The Toolkit displays errors here

during its own startup phase.

The debugging commands are available from the Debug menu, from the document window'’s right-click

context menu, through keyboard shortcuts, and from the toolbar buttons. Use these menu commands

and buttons to control the execution of code when the JavaScript Debugger is active.

Run F5 (Windows) Starts or resumes execution of a script.

P Continue  CtrlR (Mac09) Disabled when script is executing.

Break Ctrl F5 (Windows)  Halts the currently executing script temporarily and
il Cmd . (Mac OS) reactivates the JavaScript Debugger.
Enabled when a script is executing.
Stop Shift F5 (Windows) Stops execution of the script and generates a runtime error.
[ Ctrl K (Mac OS)

Enabled when a script is executing.
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Step Over F10 (Windows) Halts after executing a single JavaScript line in the script. If
|3 Ctrl S (Mac OS) the statement calls a JavaScript function, executes the
function in its entirety before stopping (do not step into the
function).
Stepinto  F11 (Windows) Halts after executing a single JavaScript line statement in the
v Ctrl T (Mac OS) script or after executing a single statement in any JavaScript
function that the script calls.
StepOut  Shift F11 (Windows) When paused within the body of a JavaScript function,
FY Ctrl U (Mac OS) resumes script execution until the function returns.

When paused outside the body of a function, resumes script
execution until the script terminates.

While the engine is running, a spinning icon in the lower right corner of the Toolkit window indicates that
the scriptis active.

When the execution of a script halts because the script reached a breakpoint, or when the script reaches
the next line when stepping line by line, the document window displays the current script with the current
line highlighted in yellow.

B ' Program Files',Qualcomm'Eudora’,attach’ Alert BoxBuilder1.jss =10l x|
== IEridge 53 j "] IMainEngine j - 1 E > VY A
e W ﬂ current
36 AlertBoxBuilder Lprototypesrun = function() line
o
38
39 var retval = true;
40
41 function createBuilderDialog() {
42 If Create an emphe dialog window near the upper left of the soreen
43 var dig = new Window ('dialog', 'Alert Box Builder'); =
activity
| Line 36 Column 1 ® ——— indicator

If the script encounters a runtime error, the Toolkit halts the execution of the script, displays the current
script with the current line highlighted in orange, displays the error message in the status line, and plays a

sound.
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(L C:'Program Files' Qualcomm’,Eudora’ attach' BoxBuilde & I Dl_ﬁ]
&= |Bridge €53 #| m [wairErgne ¥ P Ul H > ¥V A
219 } =
220

error line oo return rinval; |

222 |
223 T -

R 5

error message ftreval is undefined I_ine 221 Column 1 v,

Scripts often use a t ry/catch clause to execute code that may cause a runtime error, in order to catch the
error programmatically rather than have the script terminate. You can choose to allow regular processing
of such errors using the catch clause, rather than breaking into the debugger. To set this behavior,
choose Debug > Don’t Break On Guarded Exceptions. Some runtime errors, such as Out Of Memory,
always cause the termination of the script, regardless of this setting.

When debugging a script, it is often helpful to make it stop at certain lines so that you can inspect the state
of the environment, whether function calls are nested properly, or whether all variables contain the
expected data.

e To stop execution of a script at a given ling, click to the left of the line number to set a breakpoint. A red
dot indicates the breakpoint.

e Click a second time to temporarily disable the breakpoint; the icon changes color.

e Click a third time to delete the breakpoint. The icon is removed.

Some breakpoints need to be conditional. For example, if you set a breakpoint in a loop that is executed
several thousand times, you would not want to have the program stop each time through the loop, but
only on each 1000th iteration.

You can attach a condition to a breakpoint, in the form of a JavaScript expression. Every time execution
reaches the breakpoint, it runs the JavaScript expression. If the expression evaluates to a nonzero number
or true, execution stops.

To set a conditional breakpoint in a loop, for example, the conditional expression could be "i >= 1000",
which means that the program execution halts if the value of the iteration variable 1 is equal to or greater
than 1000.

Tip: Itis often useful to check the boundary conditions for loops; to do this, you can set the condition for a
breakpoint within a loop to trigger on the first and last iterations.

You can set breakpoints on lines that do not contain any code, such as comment lines. When the Toolkit
runs the program, it automatically moves such a breakpoint down to the next line that actually contains
code.

The Breakpoints panel displays all breakpoints set in the current document window. You can use the
panel’s flyout menu to add, change, or remove a breakpoint.
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C:\Program Files',Qualcomm’ Fudoratattach’ AlertBoxBuilderl.jsx =10l x|

&= |Bridge €53 x| |manEngine =] P i B >V A

160 var textHeight = Mumber (builder .rmsgPnl.msgHeight.et.bext); -]

161 res += " msg: StaticText { " + stringProperty("text", builder.msgPnl.msg.et.te

162 "preferredSize: [ + textWidth + ", " + texiHeight + "]\n" +

163 " alignment:['center',top'], properties: {multiline true} 1";

o

165 /i Define buttons if dezired (T
166 @ var hasButions = builder hasBinsCh.valus; BEiihiond —
167 @  if (hasbuttons) { ® Line 166 =
168 O var groupalign = "center"; € pesol : G i

= ! T & Line 1658 when groupalign = "center

169 I Align buttons as specified € Line 171 when groupalign = "left"

170 if {builder.alert®msPrl.alignlefiRb.value) {

171@® groupalign = "left"; '
172 } ’
173 else if (builder.alertBmsPnlalignRightRbyalus) £ | SiFrogram Files|Qualeomm|EudoralattachialertBoxl

174 aroupslion = "riaht":
< i _|:l
| Line 36 Colurnn 1

You can edit a breakpoint by double-clicking it, or by selecting it and choosing Add or Modify from the
panel menu. A dialog allows you to change the line number, the breakpoint’s enabled state, and the
condition statement. You can also specify a hit count, which allows you to skip the breakpoint some
number of times before entering the debugger. The default is 1, which breaks at the first execution.

| Breakpoints |
@ Line 166
D Line 167

Line 168 when groupalign = "center”
<> Line 171 when groupalign = "left"

Z:\Program FilesiQualcommiEudoral attachh AlertBoxBuilder]  jsx

— Breakpoint | i
Line: |168 IV active

groupalign = "center”

Condition:

Hit count: I 1

Remove | Cancel |

When execution reaches this breakpoint after the specified number of hits, the debugger evaluates this
condition. If it does not evaluate to true, the breakpoint is ignored and execution continues. This allows
you to break only when certain conditions are met, such as a variable having a particular value.
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Each breakpoint is indicated by an icon to the left of the line number in the document window, and an
icon and line number in the Breakpoints panel. Different icons are used in the document window and in
the Breakpoints panel.

)
t g
£ s
= ] ',Ed.l
8L ¢§
Qs oo

Unconditional breakpoint. Execution stops here.

Unconditional breakpoint, disabled. Execution does not stop.

o ® @
O

L Conditional breakpoint. Execution stops if the attached JavaScript expression evaluates
to true.

@
o

Conditional breakpoint, disabled. Execution does not stop.

If you let your mouse pointer rest over a variable or function in a document window, the result of
evaluating that variable or function is displayed as a help tip. When you are not debugging the program,
this is helpful only if the variables and functions are already known to the JavaScript engine. During

debugging, however, this is an extremely useful way to display the current value of a variable, along with
its current data type.

The Data Browser panel is your window into the JavaScript engine. It displays all live data defined in the
current context, as a list of variables with their current values. If execution has stopped at a breakpoint, it
shows variables that have been defined using var in the current function, and the function arguments. To
show variables defined in the global or calling scope, use the Call Stack to change the context (see “The.
call stack” on page 32).

You can use the Data Browser to examine and set variable values.
e Click a variable name to show its current value in the edit field at the top of the panel.

e To change the value, enter a new value and press ENTER. If a variable is Read only, the edit field is
disabled.
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S T ——— -_—
| Data Browser x | @ flyout menu
I False)\
=) Window = [nbjEWindeud\ -
(D active = false Examine or modify selected variable’s value

-4 add()
1-1f 3 addEventListerier()
|- 44 alert)
“-lggd alignChildren = center
E’uij; center()
-6 children = [object Window], [object Window]
L@ length = 2 Object opened to show properties

i closen =]

Bridge C53

Eral

E

S

The flyout menu for this panel lets you control the amount of data displayed:
o Undefined Variables toggles the display of variables whose value is undefined (as opposed to null).

e Functions toggles the display of all functions that are attached to objects. Most often, the interesting
data in an object are its callable methods.

e Core JavaScript Elements toggles the display of all data that is part of the JavaScript language
standard, such as the Array constructor or the Math object.

e Prototype Elements toggles the display of the JavaScript object prototype chain.

Each variable has a small icon that indicates the data type. An invalid object (that is, a reference to an
object that has been deleted) shows the object icon crossed out in red. An undefined value has no icon.

() Boolean
'EE Number

= String

Ej Object
{.j-i Method
e null

You can inspect the contents of an object by clicking its icon. The list expands to show the object’s
properties (and methods, if Functions display is enabled), and the triangle points down to indicate that
the object is open.
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The Call Stack panel is active while debugging a program. When an executing program stops because of a
breakpoint or runtime error, the panel displays the sequence of function calls that led to the current

execution point. The Call Stack panel shows the names of the active functions, along with the actual
arguments passed in to that function.

For example, this panel shows a break occurring at a breakpoint in a function createResource ():

| Call Stack x |

[Top Lewvel] ;I
runi )

runBuilder (['Windaw])

anClick()

createResource ([window])

4 . of

Bridge C53

The function containing the breakpoint is highlighted in the Call Stack panel. The line containing the
breakpoint is highlighted in the Document Window and Breakpoints panel.

You can click any function in the call hierarchy to inspect it. In the document window, the line containing
the function call that led to that point of execution is marked with a green background. In the example,

when you select the line [Top Levell] in the call stack, the Document Window highlights the line where
the first function was called.

runi)

runBuilder {{'Window])
onilick)

createResource {[Window])

4. —

Bridge 53
M c.pProgram Files"-.,uualcumn1"-.,Euduraf'-.,al:t-ac:f'f-ﬁ'{._ tBoxBui -0 x|
&3 | Bridge €53 | m [MainEngine ¥] > 1 H > ¥V A
228 v N
229 if{typeof{ilertBoxBuilder1_unitTest) == "undefined") {
230 new AlertBoxBuilder 1 }.run();
231
232 =
1] | »
| Line 230 Column 1 1
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Switching between the functions in the call hierarchy allows you to trace how the current function was
called. The Console and Data Browser panels coordinate with the Call Stack panel. When you select a
function in the Call Stack:

e The Console panel switches its scope to the execution context of that function, so you can inspect and
modify its local variables. These would otherwise be inaccessible to the running JavaScript program
from within a called function.

e The Data Browser panel displays all data defined in the selected context.

The Profiling tool helps you to optimize program execution. When you turn profiling on, the JavaScript
engine collects information about a program while it is running. It counts how often the program
executed a line or function, or how long it took to execute a line or function. You can choose exactly which

profiling data to display.

Because profiling significantly slows execution time, the Profile menu offers these profiling options.

Ooff

Functions

Lines

Add Timing Info

No Profiler Data
Show Hit Count
Show Timing
Erase Profiler Data

Save Data As

Profiling turned off. This is the default.

The profiler counts each function call. At the end of execution, displays the total
to the left of the line number where the function header is defined.

The profiler counts each time each line is executed. At the end of execution,
displays the total to the left of the line number.

Consumes more execution time, but delivers more detailed information.

Instead of counting the functions or lines, records the time taken to execute
each function or line. At the end of execution, displays the total number of
microseconds spent in the function or line, to the left of the line number.

This is the most time-consuming form of profiling.
When selected, do not display profiler data.

When selected, display hit counts.

When selected, display timing data.

Clear all profiling data.

Save profiling data as comma-separated values in a CSV file that can be loaded
into a spreadsheet program such as Excel.

When execution halts (at termination, at a breakpoint, or due to a runtime error), the Toolkit displays this
information in the Document Window, line by line. The profiling data is color coded:

e Green indicates the lowest number of hits, or the fastest execution time.

e Orange or yellow indicates a trouble spot, such as a line that has been executed many times, or which
line took the most time to execute.
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This example shows number-of-hits information:

1‘38 =z function sitringProperty(pname, pval) {

189 return pname + " + pval + ", "

190 ¥

191

1‘3'.—-_’ I Dizplavthe generated alert dialog

193 | function createTestDialog(resource) { -
144, : var taroet = new Windmw fresmierade 2l

This example displays timing information for the program, in microseconds. The timing might not be
accurate down to the microsecond; it depends on the resolution and accuracy of the hardware timers built

into your computer.
.1'29 _ testBin.onClick = function ()
130 ' {
131 t.owritein{"Displaying customized alert dialog");
132 createTestDialog{createResource (this.parent.parent));
135 ¥
134
135 if The Build and Cancel buttons close this dialog
135 buildetn.onClick = function () { this.parent.parent.close(1); };
137 cancelBm.onClick = function () { this.parent.parent.cloze(2); ¥;

Inspecting Object Models

The ExtendScript Toolkit offers the ability to inspect the object model of any loaded dictionary. All loaded
dictionaries are listed in the Help menu.

M ExtendScript Toolkit 2

File Edit Wiew Debug Profile ‘Window | Help

Core Javascript Classes
ScripkUI Classes

Adobe Bridge C53 Objeck Madel
Adobe Illustrator C53 Twpe Library

Adobe Photoshop £53 Ohject Library

Extendscript Toolkit ReadMe
S0k

Updates...
fhout ExtendScript Taalkit, .

e The Core JavaScript Classes dictionary includes Adobe tools and utilities such as File and Folder.

e The ScriptUI Classes dictionary shows the interface elements defined in the ScriptUl JavaScript
module.

e Each Adobe application defines a dictionary for that application’s Document Object Model (DOM). The
dictionary for a particular application may not be available until you launch that application, or until
you select it as a target in the Toolkit.
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To inspect an object model, select the appropriate dictionary from the Help menu. The Object Model
Viewer appears, allowing you to browse through the object hierarchy and inspect the type and
description of each property, and the description and parameters for each method.

E_:'E:-:tendScript Toolkit 2 - [Core JavaScript Classes] =101l
& Fl= Edit Wiew Debug Profile Window Help P =l et
Classes Properties And Methods

U4 ;I |Cnnstructors - |
L) Array
L] Lo Boolean Instance Elements &
i |1 Date 4| | v
)

A Errar
=i Fs: string [~
1| Folder ij decode {uri): string
1| Funckion ij encode {name); string
1! lobal Elements [l isEncodingévailable (name: bool
L Math §! cpenDialog (prompt, fi
L Mumber 14l saveDialog (prampt, filter): File
1 Object
H || RegExp
; 1 3tring

i | _’lLI 4] | _’|LI
&= A e |

File.openDialog {prompt:string, filter:any, multiSelect:bool):File
Qpens a dialog so the user can select one or more files to open.
Qpens the built-in platform-specific file-browsing dialog in which a user can select an existing file or multiple files, and
creates new File objects to represent the selected files,
+ If the user clicks OK, returns a File object for the selected file, or an array of objects if multiple files are selected,
+ If the user cancels, returns null,

prompt: Data Type: string

The prompt text, displaved if the dialog allows a prompt,

filter: Data Type: any, Default Walue: null

A filter that limits the types of files displayed in the dialog,
+ In Windows, a filter expression such as "* jsx",

+ In Mac OF, a filter function that takes a File instance and returns true if the file should be included in the display,
false if it should not,

multiSelect: Data Type: boaol, Default Yalue: false
When true, the user can select multiple files and the return value is an array,
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File System Access

Adobe ExtendScript defines classes that simplify cross-platform file-system access. These classes are
available to all applications that support a JavaScript interface.

e The first part of this chapter, Using File and Folder Objects, describes how to use these classes and
provides details of pathname syntax.

e “File and Folder Object Reference” on page 44 provides reference details of the objects, properties,
methods, and creation parameters. You can also choose the Core JavaScript Classes dictionary from the
Help menu in the ExtendScript Toolkit to inspect the objects in the Object Model Viewer.

Because path name syntax is very different on Windows, Mac OS, and UNIX’, Adobe ExendScript defines
the File and Folder objects to provide platform-independent access to the underlying file system. A
File object represents a disk file, a Folder object represents a directory or folder.

e The Folder object supports file system functionality such as traversing the hierarchy; creating,
renaming or removing files; or resolving file aliases.

e The File object supports input/output functions to read or write files.

There are several ways to distinguish between a File and a Folder object. For example:

if (f instanceof File)
if (typeof f.open == "undefined") ...// Folders do not open

File and Folder objects can be used anywhere that a path name is required, such as in properties and
arguments for files and folders.

Note: When you create two File objects that refer to the same disk file, they are treated as distinct
objects. If you open one of them for I/0, the operating system may inhibit access from the other
object, because the disk file already is open.

When creating a File or Folder object, you can specify a platform-specific path name, or an absolute or
relative path in a platform-independent format known as universal resource identifier (URI) notation. The
path stored in the object is always an absolute, full path name that points to a fixed location on the disk.

e Use the toString method to obtain the name of the file or folder as string containing an absolute
path name in URI notation.

e Use the £sName property to obtain the platform-specific file name.

An absolute path name in URI notation describes the full path from a root directory down to a specific file
or folder. It starts with one or two slashes (/), and a slash separates path elements. For example, the
following describes an absolute location for the file myFile.jsx:

/dirl/dir2/mydir/myFile.jsx

36
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A relative path name in URI notation is appended to the path of the current directory, as stored in the
globally available current property of the Folder class. It starts with a folder or file name, or with one of
the special names dot (.) for the current directory, or dot dot (. .) for the parent of the current directory. A
slash (/) separates path elements. For example, the following paths describe various relative locations for
the filemyFile.jsx:

nyFil e. j sx In the current directory.

.InyFile.jsx

..InyFile.jsx In the parent of the current directory.
../..InyFile.jsx In the grandparent of the current directory.

.. /dirl/nyFile.jsx Indirl, whichis parallel to the current directory.

Relative path names are independent of different volume names on different machines and operating
systems, and therefore make your code considerably more portable. You can, for example, use an absolute
path for a single operation, to set the current directory in the Folder. current property, and use relative
paths for all other operations. You would then need only a single code change to update to a new
platform or file location.

There are some platform differences in how pathnames are interpreted:
e On Windows and Mac OS, path names are not case sensitive. In UNIX, paths are case sensitive.

e On Windows, both the slash (/) and the backslash (\) are valid path element separators. Backslash is
the escape character, so you must use a double backslash (\\) to indicate the character.

e On Mac OS, both the slash (/) and the colon (:) are valid path element separators.

If a path name starts with two slashes (or backslashes on Windows), the first element refers to a remote
server. For example, / /myhost /mydir/myfile refers to the path /mydir/myfile on the server
myhost.

URI notation allows special characters in pathnames, but they must specified with an escape character (%)
followed by a hexadecimal character code. Special characters are those which are not alphanumeric and
not one of the characters:

/==t ()

A space, for example, is encoded as %20, so the file name "my file" is specified as "my%20file™.
Similarly, the character & is encoded as $E4, so the file name "Braun" is specified as "Br%E4un".

This encoding scheme is compatible with the global JavaScript functions encodeURI and decodeURI.

A path name can start with a tilde (~) to indicate the user’s home directory. It corresponds to the platform’s
HOME environment variable.

UNIX and Mac OS assign the HOME environment variable according to the user login. On Mac OS, the
default home directory is /Users/username. In UNIX, it is typically /home /username or
/users/username. ExtendScript assigns the home directory value directly from the platform value.
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On Windows, the HOME environment variable is optional. If it is assigned, its value must be a Windows path
name or a path name referring to a remote server (such as \ \myhost \mydir). If the HOME environment
variable is undefined, the ExtendScript default is the user’s home directory, usually the C: \Documents
and Settings\username folder.

Note: A script can access many of the folders that are specified with platform-specific variables through
static, globally available Folder class properties; for instance, appData contains the folder that
stores application data for all users.

A volume or drive name can be the first part of an absolute path in URI notation. The values are interpreted
according to the platform.

Mac OS volumes

When Mac OS X starts, the startup volume is the root directory of the file system. All other volumes,
including remote volumes, are part of the /Volumes directory. The File and Folder objects use these
rules to interpret the first element of a path name:

e Ifthe name is the name of the startup volume, discard it.

e Ifthe name is a volume name, prepend /Volumes.

e Otherwise, leave the path as is.

Mac OS 9 is not supported as an operating system, but the use of the colon as a path separator is still

supported and corresponds to URI and to Mac OS X paths as shown in the following table. These examples
assume that the startup volume is Mac0SX, and that there is a mounted volume Remote.

URI path name Mac OS 9 path name Mac OS X path name

I MacoeX/dir/file MacCex: dir:file /dir/file
/Rermote/dir/file Remote:dir:file / Vol unes/ Rerot e/ dir/file
lroot/dir/file Root:dir:file /root/dir/file
~/dir/file /Users/jdoel/dir/file

Windows drives

On Windows, volume names correspond to drive letters. The URI path /c/temp/£1ile normally translates
to the Windows path C:\temp\file.

If a drive exists with a name matching the first part of the path, that part is always interpreted as that drive.
It is possible for there to be a folder in the root that has the same name as the drive; imagine, for example,
afolder ¢: \C on Windows. A path starting with /c always addresses the drive C:, so in this case, to access
the folder by name, you must use both the drive name and the folder name, for example /c/c for C:\C.

If the current drive contains a root folder with the same name as another drive letter, that name is
considered to be a folder. That is, if there is a folder D: \ ¢, and if the current drive is D :, the URI path
/c/temp/file translates to the Windows path D: \c\temp\£file. In this case, to access drive C, you
would have to use the Windows path name conventions.

To access a remote volume, use a uniform naming convention (UNC) path name of the form
// servername/sharename. These path names are portable, because both Max OS X and UNIX ignore
multiple slash characters. Note that on Windows, UNC names do not work for local volumes.
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These examples assume that the current driveis D:

URI path name Windows path name

lcidir/file c:\dir\file

Iremote/dir/file D\renote\dir\file

Iroot/dir/file D\root\dir\file

~/dir/file C \Docurrents and Settings\jdoe\dir\file

When you access an alias, the operation is transparently forwarded to the real file. The only operations that
affect the alias are calls to rename and remove, and setting properties readonly and hidden. When a
File object represents an alias, the alias property of the object returns true, and the resolve method
returns the File or Folder object for the target of the alias.

On Windows, all file system aliases (called shortcuts) are actual files whose names end with the extension
. 1nk. Never use this extension directly; the File and Folder objects work without it.

For example, suppose there is a shortcut to the file /folder1/some. txt in the folder /folder2.The
full Windows file name of the shortcut file is \folder2\some. txt . 1nk.

To access the shortcut from a File object, specify the path /folder2/some. txt.Calling that File
object’s open method opens the linked file (in /£folder1). Calling the File object’s rename method
renames the shortcut file itself (leaving the . 1nk extension intact).

However, Windows permits a file and its shortcut to reside in the same folder. In this case, the File object
always accesses the original file. You cannot create a File object to access the shortcut when it is in the
same folder as its linked file.

A script can create a file alias by creating a File object for a file that does not yet exist on disk, and using
its createAlias method to specify the target of the alias.

If your application will run on multiple platforms, use relative path names, or try to originate path names
from the home directory. If that is not possible, work with Mac OS X and UNIX aliases, and store your files
on a machine that is remote to your Windows machine so that you can use UNC names.

As an example, suppose you use the UNIX machine myServer for data storage. If you set up an alias share
in the root directory of myServer, and if you set up a Windows-accessible share at share pointing to the
same data location, the path name //myServer/share/file would work for all three platforms.

When doing file I/0, Adobe applications convert 8-bit character encoding to Unicode. By default, this
conversion process assumes that the system encoding is used (code page 1252 on Windows or Mac
Roman on Mac OS). The encoding property of a File object returns the current encoding. You can set
the encoding property to the name of the desired encoding. The File object looks for the
corresponding encoder in the operating system to use for subsequent I/0. The name is one of the
standard Internet names that are used to describe the encoding of HTML files, such as ASCII, X-SJIS, or
IS0-8859-1.Fora complete list, see File and Folder Supported Encoding Names.
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A special encoder, BINARY, is provided for binary I/0. This encoder simply extends every 8-bit character it
finds to a Unicode character between 0 and 255. When using this encoder to write binary files, the encoder
writes the lower 8 bits of the Unicode character. For example, to write the Unicode character 1000, which
is Ox3E8, the encoder actually writes the character 232 (OxE8).

The data of some of the common file formats (UCS-2, UCS-4, UTF-8, UTF-16) starts with a special byte order
mark (BOM) character (\uFEFF). The File.open method reads a few bytes of a file looking for this
character. If it is found, the corresponding encoding is set automatically and the character is skipped. If
there is no BOM character at the beginning of the file, open () reads the first 2 KB of the file and checks
whether the data might be valid UTF-8 encoded data, and if so, sets the encoding to UTF-8.

To write 16-bit Unicode files in UTF-16 format, use the encoding UCS-2. This encoding uses whatever
byte-order format the host platform supports.

When using UTF-8 encoding or 16-bit Unicode, always write the BOM character "\uFEFF" as the first
character of the file.

Each object has an error property. If accessing a property or calling a method causes an error, this
property contains a message describing the type of the error. On success, the property contains the empty
string. You can set the property, but setting it only causes the error message to be cleared. If a file is open,
assigning an arbitrary value to the property also resets its error flag.

For a complete list of supported error messages, see “File and Folder Error Messages” on page 41.
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The following messages can be returned in the error property.

File or fol der does not exist
File or folder already exists
I/ O device is not open

Read past ECF

Conver si on error

Partial multibyte character found
Per m ssi on deni ed

Cannot change directory
Cannot create

Cannot renane

Cannot del ete

I/Oerror

Cannot set size

Cannot open

Cannot cl ose

Read error

Wite error

Cannot seek

Cannot execut e

The file or folder does not exist, but the parent folder exists.
The file or folder already exists.

An 1/O operation was attempted on a file that was closed.
Attempt to read beyond the end of a file.

The content of the file cannot be converted to Unicode.
The character encoding of the file data has errors.

The OS did not allow the attempted operation.

Cannot change the current folder.

Cannot create a folder.

Cannot rename a file or folder.

Cannot delete a file or folder.

Unspecified 1/0O error.

Setting the file size failed.

Opening of a file failed.

Closing a file failed.

Reading from a file failed.

Writing to a file failed.

Seek failure.

Unable to execute the specified file.
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The following list of names is a basic set of encoding names supported by the File object. Some of the
character encoders are built in, while the operating system is queried for most of the other encoders.
Depending on the language packs installed, some of the encodings may not be available. Names that refer
to the same encoding are listed in one line. Underlines are replaced with dashes before matching an
encoding name.

The File object processes an extended Unicode character with a value greater that 65535 as a Unicode
surrogate pair (two characters in the range between 0xD700-0xDFFF).

Built-in encodings are:

US-ASC 1, ASOI,|S3B46-US, 1 SO 646.1RV: 1991, |SOIR6,
ANSI - X3. 4- 1968, CP367, | BMB67, US, | S(646. 1991- | RV

UCS- 2, UCS2, | SO 10646- UCS- 2

UCS2LE, UCS- 2LE, | SO 10646- UCS- 2LE

UCS2BE, UCS- 2BE, | SO 10646- UCS- 2BE

UCS- 4, UCH4, | SO 10646- UCS- 4

UCHALE, UCS- 4LE, | SO 10646- UCS- 4LE

UCHABE, UCS- 4BE, | SO 10646- UCS- 4BE

UTF- 8, UTF8, UN CCDE- 1- 1- UTF- 8, UNl OCDE- 2- 0- UTF- 8, X- UN OCDE- 2- 0- UTF- 8
UTF16, UTF- 16, | SO 10646- UTF- 16

UTF16LE, UTF- 16LE, | SO 10646- UTF- 16LE

UTF16BE, UTF- 16BE, | SO 10646- UTF- 16BE

CP1252, WNDONB- 1252, M5- ANSI

1 SO 8859-1, | SO 8859- 1, | SO 8859- 1: 1987, | SO | R-100, LATI NL
MAC NTCBH, X- MAG- ROVAN

Bl NARY

The ASCll encoder raises errors for characters greater than 127, and the BINARY encoder simply converts
between bytes and Unicode characters by using the lower 8 bits. The latter encoder is convenient for
reading and writing binary data.

In Windows, all encodings use code pages, which are assigned numeric values. The usual Western
character set that Windows uses, for example, is the code page 1252. You can select Windows code pages
by prepending the number of the code page with “CP” or “WINDOWS": for example, “CP1252" for the code
page 1252. The File object has many other built-in encoding names that match predefined code page
numbers. If a code page is not present, the encoding cannot be selected.

In Mac OS, you can select encoders by name rather than by code page number. The File object queries
Mac OS directly for an encoder. As far as Mac OS character sets are identical with Windows code pages,
Mac OS also knows the Windows code page numbers.

In UNIX, the number of available encoders depends on the installation of the iconv library.

Common encoding names
The following encoding names are implemented both in Windows and in Mac OS:

UTF- 7, UTF7, UN CCDE- 1- 1- UTF- 7, X- UN OCDE- 2- 0- UTF- 7

|1 SO 8859- 2, | SO 8859- 2, | SO 8859- 2: 1987, | SO | R- 101, LATI N2

|1 SO 8859- 3, | SO 8859- 3, | SO 8859- 3: 1988, | SO | R- 109, LATI N3

| SO 8859- 4, | SO 8859- 4, | SO 8859- 4: 1988, | SO | R- 110, LATI N4, BALTI C

|1 SO 8859- 5, | SO 8859- 5, | SO 8859- 5: 1988, | SO | R- 144, CYR LLI C

| SO 8859- 6, | SO 8859- 6, | SO 8859- 6: 1987, | SO | R- 127, EQVA- 114, ASMD- 708, ARABI C

|1 SO 8859- 7, | SO 8859- 7, | SO 8859- 7: 1987, | SO | R- 126, EQVA- 118, ELOT- 928, GREEKS, GREEK
| SO 8859- 8, | SO 8859- 8, | SO 8859- 8: 1988, | SO | R- 138, HEBREW
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I SO 8859- 9, | SO 8859- 9, | SO 8859- 9: 1989, | SO | R- 148, LATI N5, TURKI SH

| SO 8859- 10, | SO 8859- 10, | SO 8859- 10: 1992, | SO | R- 157, LATI N6

|1 SO 8859-13, 1 SO 8859- 13,1 SO | R- 179, LATI N7

| SO 8859- 14, | SO 8859- 14, | SO 8859- 14, | SO 8859- 14: 1998, | SO | R- 199, LATI N8
|1 SO 8859- 15, | SO 8859- 15, | SO 8859- 15: 1998, | SO | R- 203

|1 SO 8859- 16, | SO 885, | SO 885, M5- EE

CP850, W NDOWS- 850, | BMVB50

CP866, W NDO/S- 866, | BVB66

CP932, WNDOWNS- 932, SJI S, SH FT-JI S, X-SJ1 S, X- M5 SJ1 S, M5 SJ1 S, M5 KANDI
CP936, W NDOAS- 936, GBK, W NDONS- 936, (B2312, (B-2312- 80, | SO | R-58, CH NESE
CP949, W NDONS- 949, UHC, KSG- 5601, KS- G 5601- 1987, KS- G- 5601- 1989, | SO | R- 149, KCREAN
CP950, W NDONS- 950, Bl Gb, BI G 5, Bl G FI VE, Bl GFl VE, ON- Bl (b, X- X-Bl &

CP1251, WNDONB- 1251, M5- CYRL

CP1252, WNDONB- 1252, M5- ANSI

CP1253, WNDONG- 1253, M5- CGREEK

CP1254, W NDONB- 1254, M5- TURK

CP1255, WNDOAS- 1255, M5- HEBR

CP1256, W NDOAB- 1256, M5- ARAB

CP1257, W NDOAB- 1257, WNBALTR M

CP1258, W NDONG- 1258

CP1361, WNDOAG- 1361, JCHAB

EUG- JP, EUCIP, X- EUG- JP

EUG KR, EUCKR, X- EUCG- KR

HZ, HZ- (B- 2312

X- MAG JAPANESE

X- MNAG GREEK

X-MAGCYR LLIC

X- MAG LATIN

X-MAG | CELANDI C

X- MAG TURKI SH

Additional Windows encoding names
CP437, | BMB50, W NDONS- 437

CP709, WNDONS- 709, ASMD- 449, BOONV4
EBCDI C

KA -8R

KA - 8U

1 SO 2022- JP

1 SO 2022- KR

Additional Mac OS encoding names
These names are alias names for encodings that Mac OS might know.

TI' S 620, Tl S620, Tl S620- 0, Tl S620. 2529- 1, Tl S620. 2533- 0, Tl S620. 2533-1, 1 SO | R 166
CP874, WNDONS- 874

JP, JI S (5220- 1969- RO, | SG646- JP, | SO | R- 14

JI' S X0201, JI SX0201- 1976, X0201

JI S X0208, JI S X0208- 1983, JI S- X0208- 1990, JI S0208, X0208, | SO | R- 87
JI S X0212, JI S X0212. 1990- 0, JI S X0212- 1990, X0212, | SO | R 159

ON GB- 1988- 80, | S(646-CN, 1 SO | R 57

1 SO I R 16, ON-GB- 1 SA R165

KSG 5601, KS- G- 5601- 1987, KS- G- 5601- 1989, | SO | R 149

EUG- O\, EUCCN, (B2312, ON- (B

EUG TW EUCTW X- EUG TW

UNIX encodings

In UNIX, the File object looks for the presence of the iconv library, and uses whatever encoding it finds
there. If you need a special encoding in UNIX, make sure that there is an iconv encoding module installed
that converts between UTF-16 (the internal format that the File object uses) and the desired encoding.
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Represents a file in the local file system in a platform-independent manner. All properties and methods
resolve file system aliases automatically and act on the original file unless otherwise noted.

To create a File object, use the File function or the new operator. The constructor accepts full or partial
path names, and returns the new object. The CRLF sequence for the file is preset to the system default, and
the encoding is preset to the default system encoding.

File ([pathl); //can return a Folder object
new File ([path]); //always returns a File object

pat h Optional. The absolute or relative path to the file associated with this object, specified in
platform-specific or URI format; see “Specifying paths” on page 36. The value stored in the
object is the absolute path.

The path need not refer to an existing file. If not supplied, a temporary name is generated.
If the path refers to an existing folder:
e TheFil e function returns a Fol der object instead of a Fi | e object.

e The newoperator returns a Fi | e object for a nonexisting file with the same name.

This property is available as a static property of the File class. It is not necessary to create an instance to
access it.

fs  String  The name of the file system. Read only. One of W ndows, Maci nt osh, or Uni x.
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These functions are available as static methods of the File class. It is not necessary to create an instance
to call them.

decode()
Fil e. decode (uri)

uri String. The encoded string to decode. All special characters must be encoded in
UTF-8 and stored as escaped characters starting with the percent sign followed by
two hexadecimal digits. For example, the string "ny%20f i | e" is decoded as "ny
file"
Special characters are those with a numeric value greater than 127, except the
following:

[ - _ .1 ~%"' ()
Decodes the specified string as required by RFC 2396.

Returns the decoded string.

encode()
Fi | e. encode ( nhane)

naie String. The string to encode.

Encodes the specified string as required by RFC 2396. All special characters are encoded in UTF-8
and stored as escaped characters starting with the percent sign followed by two hexadecimal digits.
For example, the string "ny file"is encoded as "ny%20fi | e"

Special characters are those with a numeric value greater than 127, except the following:

I = 1~ ()

Returns the encoded string.

i sEncodi ngAvai | abl e()
Fi | e. i sEncodi ngAvai | abl e ( nane)

nane String. The encoding name. Typical values are “ASCII," “binary,” or “UTF-8." See “File
and Folder Supported Encoding Names” on page 42.

Checks whether a given encoding is available.

Returns true if your system supports the specified encoding, false otherwise.
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openDi al og()
File.openD alog ([pronpt, filter, nultiSelect])

pronpt Optional. A string containing the prompt text, if the dialog allows a prompt.

filter Optional. A filter that limits the types of files displayed in the dialog.
e In Windows, a filter expression, such as "*. j sx"

e In Mac 0§, afilter function that takes a File instance and returns true if the file
should be included in the display, false if it should not.

mul ti Sel ect Optional. Boolean. When true, the user can select multiple files and the return value
is an array. Default is false.

Opens the built-in platform-specific file-browsing dialog in which a user can select an existing file or
multiple files, and creates new Fi | e objects to represent the selected files.

If the user clicks OK, returns a Fi | e object for the selected file, or an array of objects if multiple files
are selected. If the user cancels, returns nul | .

saveD al og()
Fil e.saveD al og (pronpt[, preset])

pronpt A string containing the prompt text, if the dialog allows a prompt.

filter Optional. A filter that limits the types of files displayed in the dialog.
e In Windows, a filter expression, such as "*. j sx"

e In Mac 0§, afilter function that takes a File instance and returns true if the file
should be included in the display, false if it should not.

Opens the built-in platform-specific file-browsing dialog in which a user can select an existing file
location to which to save information, and creates a new Fi | e object to represent the selected file
location.

If the user clicks OK, returns a Fi | e object for the selected file location. If the user cancels, returns
nul | .

These properties are available for File objects.

absol ut elR String The full path name for the referenced file in URI notation. Read only.

alias Boolean When true, the object refers to a file system alias or shortcut. Read
only.

creat ed Date The creation date of the referenced file, or nul | if the object does not

refer to a file on disk. Read only.

creat or String In Mac OS, the file creator as a four-character string. In Windows or
UNIX, value is " ????". Read only.

di spl ayNane String The localized name of the referenced file, without the path. Read
only.
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encodi ng

eof

error

exists

f sNane

ful | Narre

hi dden

I engt h

| i neFeed

| ocal i zedNane

nodi fi ed

nane

par ent

pat h

readonl y

String

Boolean

String

Boolean

String

String

Boolean

Number

String

String

Date

String

Folder

String

Boolean

Gets or sets the encoding for subsequent read/write operations. One
of the encoding constants listed in “File and Folder Supported
Encoding Names” on page 42. If the value is not recognized, uses the
system default encoding.

A special encoder, Bl NARY, is used to read binary files. It stores each
byte of the file as one Unicode character regardless of any encoding.
When writing, the lower byte of each Unicode character is treated as
a single byte to write.

When true, a read attempt caused the current position to be at the
end of the file, or the file is not open. Read only.

A message describing the last file system error; see “File and Folder
Error Messages” on page 41. Typically set by the file system, but a
script can set it. Setting this value clears any error message and
resets the error bit for opened files. Contains the empty string if
there is no error.

When true, this object refers to a file or file-system alias that actually
exists in the file system. Read only.

The platform-specific full path name for the referenced file. Read
only.

The full path name for the referenced file in URI notation. Read only.

When true, the file is not shown in the platform-specific file browser.
Read/write. If the object references a file-system alias or shortcut,
the flag is altered on the alias, not on the original file.

The size of the file in bytes. Can be set only for a file that is not open,
in which case it truncates or pads the file with 0-bytes to the new
length.

How line feed characters are written in the file system. One of:

W ndows: Windows style
Maci nt osh: Mac OS style
Uni x: UNIX style

A localized version of the file name portion of the absolute URI for
the referenced file, without the path specification. Read only.

The date of the referenced file’s last modification, or nul | if the
object does not refer to a file on disk. Read only.

The file name portion of the absolute URI for the referenced file,
without the path specification. Read only.

The Fol der object for the folder that contains this file. Read only.

The path portion of the absolute URI for the referenced file, without
the file name. Read only.

When true, prevents the file from being altered or deleted. If the
referenced file is a file-system alias or shortcut, the flag is altered on
the alias, not on the original file.
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relativeUr String The path name for the referenced file in URI notation, relative to the
current folder. Read only.

type String The file type as a four-character string.
e In Mac OS, the Mac OS file type.

e In Windows, "appl " for . EXEfiles, " shl b" for. DLL files and " TEXT"
for any other file.

If the file does not exist, the value is " 22??". Read only.

These functions are available for File objects.

changePat h()
fileQj.changePath ( path)

pat h A string containing the new path, absolute or relative to the current folder.

Changes the path specification of the referenced file.

Returns true on success.

cl ose()
fileQyj.close ()

Closes this open file.

Returns true on success, false if there are 1/0 errors.

copy()
fileQyj.copy (target)

t ar get A string with the URI path to the target location, or a Fi | e object that references
the target location.

Copies this object’s referenced file to the specified target location. Resolves any aliases to find the
source file. If a file exists at the target location, it is overwritten.

Returns true if the copy was successful, false otherwise.

createAlias()
fileQyj.createAlias (path])

pat h A string containing the path of the target file.

Makes this file a file-system alias or shortcut to the specified file. The referenced file for this object
must not yet exist on disk.

Returns true if the operation was successful, false otherwise.

execut e()
fileQ.execute ()

Opens this file using the appropriate application, as if it had been double-clicked in a file browser.
You can use this method to run scripts, launch applications, and so on.

Returns true immediately if the application launch was successful.
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get Rel ati veUR! ()
fileQ.getRel ati veUR ([ basePath])

basePat h Optional. A string containing the base path for the relative URI. Default is the
current folder.

Retrieves the URI for this file, relative to the specified base path, in URI notation. If no base path is
supplied, the URl is relative to the path of the current folder.

Returns a string containing the relative URI.

open()
fileQyj.open (nodel, typel[, creator])

node A string indicating the read/write mode. One of:

r: (read) Opens for reading. If the file does not exist or cannot be found, the
call fails.

w: (write) Opens a file for writing. If the file exists, its contents are destroyed.
If the file does not exist, creates a new, empty file.

e: (edit) Opens an existing file for reading and writing.

t ype Optional. In Mac OS, the type of a newly created file, a 4-character string.
Ignored in Windows and UNIX.

creat or Optional. In Mac OS, the creator of a newly created file, a 4-character string.
Ignored in Windows and UNIX.

Opens the referenced file for subsequent read/write operations. The method resolves any aliases to
find the file.

Returns true if the file has been opened successfully, false otherwise.

The method attempts to detect the encoding of the open file. It reads a few bytes at the current
location and tries to detect the Byte Order Mark character OxFFFE. If found, the current position is
advanced behind the detected character and the encoding property is set to one of the strings
UCS- 2BE, UCS- 2LE, UCS4- BE, UCS- 4LE, or UTF- 8. If the marker character is not found, it checks for zero
bytes at the current location and makes an assumption about one of the above formats (except
UTF-8). If everything fails, the encodi ng property is set to the system encoding.

Note: Be careful about opening a file more than once. The operating system usually permits you to
do so, but if you start writing to the file using two different Fi | e objects, you can destroy your
data.
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openD g()

filej.enD g ([pronpt][,filter][, nultiSel ect])
pr onpt Optional. A string containing the prompt text, if the dialog allows a prompt.
filter Optional. A filter that limits the types of files displayed in the dialog.

e In Windows, a filter expression, such as "*. j sx"

o In Mac OS, afilter function that takes a File instance and returns true if the
file should be included in the display, false if it should not.

nmul ti Sel ect Optional. Boolean. When true, the user can select multiple files and the return
value is an array. Default is false.

Opens the built-in platform-specific file-browsing dialog, in which the user can select an existing file
or files, and creates new Fi | e objects to represent the selected files. Differs from the class method
openDi al og() in that it presets the current folder to this Fi | e object’s parent folder and the current
file to this object’s associated file.

If the user clicks OK, returns a Fi | e or Fol der object for the selected file or folder, or an array of
objects. If the user cancels, returns nul | .

read()
fileQj.read ([ chars])

chars Optional. An integer specifying the number of characters to read. By default,
reads from the current position to the end of the file. If the file is encoded,
multiple bytes might be read to create single Unicode characters.

Reads the contents of the file starting at the current position.

Returns a string that contains up to the specified number of characters.

readch()
fileQj.readch ()

Reads a single text character from the file at the current position. Line feeds are recognized as CR LF,
CRLF, or LFCRpairs. If the file is encoded, multiple bytes might be read to create single Unicode
characters.

Returns a string that contains the character.

readl n()
fileQyj.readln ()

Reads a single line of text from the file at the current position, and returns it in a string. Line feeds are
recognized as CR, LF, CRLF, or LFCRpairs. If the file is encoded, multiple bytes might be read to create
single Unicode characters.

Returns a string that contains the text.
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renove()
fileQ.renove ()

Deletes the file associated with this object from disk, immediately, without moving it to the system
trash. Does not resolve aliases; instead, deletes the referenced alias or shortcut file itself.

Note: Cannot be undone. It is recommended that you prompt the user for permission before
deleting.

Returns true if the file is deleted successfully.

r enane()
fileQyj.renane (newhane)

newhane The new file name, with no path.

Renames the associated file. Does not resolve aliases, but renames the referenced alias or shortcut
file itself.

Returns true on success.

resol ve()
fileQj.resolve ()

If this object references an alias or shortcut, this method resolves that alias and returnsanew Fi | e
object that references the file-system element to which the alias resolves.

Returns the new Fi | e object, or nul | if this object does not reference an alias, or if the alias cannot be
resolved.

saveD g()

fileQyj.saveD g ([ pronpt][, preset])
pronpt Optional. A string containing the prompt text, if the dialog allows a prompt.
preset Optional. A filter that limits the types of files displayed in the dialog.

e In Windows, a filter expression, such as "*. j sx"

o In Mac OS, afilter function that takes a File instance and returns true if the
file should be included in the display, false if it should not.

Opens the built-in platform-specific file-browsing dialog, in which the user can select an existing file
location to which to save information, and creates a new Fi | e object to represent the selected file.

Differs from the class method saveDi al og() in that it presets the current folder to this Fi | e object’s
parent folder and the file to this object’s associated file.

If the user clicks OK, returns a Fi | e object for the selected file. If the user cancels, returns nul | .
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seek()
fileQj.seek (pos[, node])

pos The new current position in the file as an offset in bytes from the start, current
position, or end, depending on the node.

node Optional. The seek mode, one of:

0: Seek to absolute position, where pos=0 is the first byte of the file. This is
the default.

1: Seek relative to the current position.

2. Seek backward from the end of the file.

Seeks to the specified position in the file. The new position cannot be less than 0 or greater than the
current file size.

Returns true if the position was changed.

tell()
fileaj.tell ()

Retrieves the current position as a byte offset from the start of the file.

Returns a number, the position index.

Wi te()
filej.wite (text[, text...]...)

text One or more strings to write, which are concatenated to form a single string.

Writes the specified text to the file at the current position. For encoded files, writing a single Unicode
character may write multiple bytes.

Note: Be careful not to write to a file that is open in another application or object, as this can
overwrite existing data.

Returns true on success.

writel n()
filej.witeln (text[, text...]...)

text One or more strings to write, which are concatenated to form a single string.

Writes the specified text to the file at the current position, and appends a Line Feed sequence in the

style specified by the | i nef eed property.For encoded files, writing a single Unicode character may
write multiple bytes.

Note: Be careful not to write to a file that is open in another application or object, as this can
overwrite existing data.

Returns true on success.



3: File System Access Folder Object 53

Represents a file-system folder or directory in a platform-independent manner. All properties and
methods resolve file system aliases automatically and act on the original file unless otherwise noted.

To create a Folder object, use the Folder function or the new operator. The constructor accepts full or
partial path names, and returns the new object.

Folder ([path]); //can return a File object
new Folder ([pathl); //always returns a Folder object

path Optional. The absolute or relative path to the folder associated with this object, specified in
URI format; see “Specifying paths” on page 36. The value stored in the object is the absolute
path.

The path need not refer to an existing folder. If not supplied, a temporary name is generated.
If the path refers to an existing file:
e The Fol der function returns a Fi | e object instead of a Fol der object.

e The newoperator returns a Fol der object for a nonexisting folder with the same name.

These properties are available as static properties of the Folder class. It is not necessary to create an
instance to access them.

appDat a Folder A Fol der object for the folder that contains application data for all users.
Read only.

e In Windows, the value of %APPDATA%(by default, C:\ Docunent s and
Settings\Al| Users\Application Data)

e InMacOS,/Library/ Application Support

appPackage String In Mac OS, the Fol der object for the folder that contains the bundle of
the running application. Read only.

comonki | es Folder A Fol der object for the folder that contains files common to all
programs. Read only.

e In Windows, the value of %ConmonPr ogr anfi | es%(by default,
C \Program Fi | es\ Common Fi | es)

e InMacOS,/ Library/ Application Support

current Folder A Fol der object for the current folder. Assign either a Fol der object or a
string containing the new path name to set the current folder.

deskt op Folder A Fol der object for the folder that contains the user’s desktop. Read
only.

e InWindows, C\ Docunents and Setti ngs\ user name\ Deskt op
e In Mac OS, ~/ Deskt op
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fs String The name of the file system. Read only. One of W ndows, Maci nt osh, or
Uni x.
nyDocunent s Folder A Fol der object for the user’s default document folder. Read only.
e InWindows, C \ Docurent s and Setti ngs\ user nanme\ My Docurent s
e InMacOS, ~/ Docunent s
startup Folder A Fol der object for the folder containing the executable image of the
running application. Read only.
system Folder A Fol der object for the folder containing the operating system files.
Read only.
e In Windows, the value of %i ndi r %(by default, C \ Wndows)
e InMacOS,/System
tenp Folder A Fol der object for the default folder for temporary files. Read only.
trash Folder A Fol der object for the folder containing deleted items. Read only.
user Dat a Folder A Fol der object for the folder that contains application data for the

current user. Read only.

e In Windows, the value of %JSERDATA%(by default, C:\ Docunent s and
Setti ngs\ user nane\ Appl i cation Dat a)

e InMacOS,~/Library/ Application Support

These functions are available as a static methods of the Folder class. It is not necessary to create an
instance in order to call them.

decode()

Fol der . decode (uri)

uri

String. The encoded string to decode. All special characters must be encoded in
UTF-8 and stored as escaped characters starting with the percent sign followed by
two hexadecimal digits. For example, the string "ny%20f i | e" is decoded as "ny
file"

Special characters are those with a numeric value greater than 127, except the
following:

[ - _ =% ()

Decodes the specified string as required by RFC 2396.

Returns the decoded string.
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encode()
Fol der . encode ( nane)

naie String. The string to encode.

Encodes the specified string as required by RFC 2396. All special characters are encoded in UTF-8
and stored as escaped characters starting with the percent sign followed by two hexadecimal digits.
For example, the string "ny file"is encoded as "ny%20fi | "

Special characters are those with a numeric value greater than 127, except the following:

I = L~ ()

Returns the encoded string.

i sEncodi ngAvai | abl e()
Fol der . i sEncodi ngAvai | abl e ( nane)

nane String. The encoding name. Typical values are “ASCII," “binary,” or “UTF-8." See “File
and Folder Supported Encoding Names” on page 42.

Checks whether a given encoding is available.

Returns true if your system supports the specified encoding, false otherwise.

sel ect D al og()
Fol der. sel ectD al og ([ pronpt])

pronpt Optional. A string containing the prompt text, if the dialog allows a prompt.

Opens the built-in platform-specific file-browsing dialog, and creates a new Fi | e or Fol der object
for the selected file or folder. Differs from the object method sel ect D g() in that it does not
preselect a folder.

If the user clicks OK, returns a Fi | e or Fol der object for the selected file or folder. If the user cancels,
returns nul | .

These properties are available for Folder objects.

absol ut elR String The full path name for the referenced folder in URI notation. Read
only.

alias Boolean When true, the object refers to a file system alias or shortcut. Read
only.

creat ed Date The creation date of the referenced folder, or nul | if the object
does not refer to a folder on disk. Read only.

di spl ayNane String The localized name of the referenced folder, without the path.
Read only.

error String A message describing the most recent file system error; see “File

and Folder Error Messages” on page 41. Typically set by the file
system, but a script can set it. Setting this value clears any error
message and resets the error bit for opened files. Contains the
empty string if there is no error.
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exi sts

f sNane

ful | Nane

| ocal i zedNane

nodi fi ed

nane

par ent

pat h

relati veURl

Boolean

String

String

String

Date

String

Folder

String

String

When true, this object refers to a folder that currently exists in the
file system. Read only.

The platform-specific name of the referenced folder as a full path
name. Read only.

The full path name for the referenced folder in URI notation. Read
only.

A localized version of the folder name portion of the absolute URI
for the referenced file, without the path specification. Read only.

The date of the referenced folder’s last modification, or nul | if the
object does not refer to a folder on disk. Read only.

The folder name portion of the absolute URI for the referenced
file, without the path specification. Read only.

The Fol der object for the folder that contains this folder, or nul | if
this object refers to the root folder of a volume. Read only.

The path portion of the absolute URI for the referenced folder,
without the folder name. Read only.

The path name for the referenced folder in URI notation, relative
to the current folder. Read only.

These functions are available for Folder objects.

changePat h()

fol der @yj . changePat h ( pat h)

path

A string containing the new path, absolute or relative to the current parent

folder.

Changes the path specification of the referenced folder.

Returns true on success.

create()

folderQj.create ()

Creates a folder at the location given by this object’s path property.

Returns true if the folder was created successfully.

execut e()

fol der Qj . execute ()

Opens this folder in the platform-specific file browser (as if it had been double-clicked in the file

browser).

Returns true immediately if the folder was opened successfully.
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get Fi | es()
folderj.getFiles ([nask])

mask Optional. A search mask for file names. A string that can contain question mark
(?) and asterisk (*) wild cards. Default is " *", which matches all file names.

Can also be the name of a function that takes a Fi | e or Fol der object as its
argument. It is called for each file or folder found in the search; if it returns true,
the object is added to the return array.

Note: In Windows, all aliases end with the extension . | nk; ExtendScript strips
this from the file name when found, in order to preserve compatibility
with other operating systems. You can search for all aliases by supplying
the search mask " *. | nk", but note that such code is not portable.

Retrieves the contents of this folder, filtered by the supplied nask.

Returns an array of Fi | e and Fol der objects, or nul | if this object’s referenced folder does not exist.

get Rel ati veUR! ()
fol der j . get Rel ati veUR ([ basePat h])

basePat h Optional. A string containing the base path for the relative URI. Default is the
current folder.

Retrieves the path for this folder relative to the specified base path or the current folder, in URI
notation.

Returns a string containing the relative URI.

remove()
fol der Qyj . renove ()

Deletes the empty folder associated with this object from disk, immediately, without moving it to
the system trash.

e Folders must be empty before they can be deleted.
e Does not resolve aliases; instead, deletes the referenced alias or shortcut file itself.

Note: Cannot be undone. It is recommended that you prompt the user for permission before
deleting.

Returns true if the folder is deleted successfully.

renane()
fol der @j . renamre ( new\ane)

newhane The new folder name, with no path.

Renames the associated folder. Does not resolve aliases; instead, renames the referenced alias or
shortcut file itself.

Returns true on success.

resol ve()
fol der Qvj . resol ve ()

If this object references an alias or shortcut, this method resolves that alias

Returns a new Fol der object that references the file-system element to which the alias resolves, or
nul I if this object does not reference an alias, or if the alias cannot be resolved.
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sel ect D g()
fol deryj . sel ectD g (pronpt)

pronpt A string containing the prompt text, if the dialog allows a prompt.

Opens the built-in platform-specific file-browsing dialog, and creates a new Fi | e or Fol der object
for the selected file or folder. Differs from the class method sel ect D al og() in that it preselects this
folder.

If the user clicks OK, returns a Fi | e or Fol der object for the selected file or folder. If the user cancels,
returns nul | .
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Adobe provides the ScriptUl component, which works with the ExtendScript JavaScript interpreter to
provide JavaScript scripts with the ability to create and interact with user interface elements. It provides an
object model for windows and Ul control elements within an Adobe application.

e The first part of this chapter describes the features and programming model, with details of how you
can use JavaScript to build a user interface with ScriptUl objects.

e “ScriptUl Object Reference” on page 94 provides reference details of the objects, properties, methods,
and creation parameters. You can also choose the ScriptUI Classes dictionary from the Help menu in
the ExtendScript Toolkit to inspect the objects in the Object Model Viewer.

» Code examples for ScriptUI

The sample code distributed with the Adobe Bridge SDK includes code examples that specifically
demonstrate different ways of building and populating a ScriptUl dialog.

Building ScriptUI dialogs

SnpCreat eDi al og. j sx

SnpQr eat eUl AddMet hod. j sx

SnpCr eat eU Resour ceSpec. j sx

SnpCr eat eCheckBoxRadi oBut t ons. j sx

SnpCr eat eTr eeMi ew. j sx
SnpQr eat eProgr essBar . j sx
SnpCreateSl i der. j sx

SnpQr eat eFl ashControl . j sx

Fl ashDeno. j sx

Col or Sel ector. j sx

ol or Pi cker . j sx

SnpAl i gnH enent s. j sx

Creates a very simple, modeless dialog (a palette) with OK and
Cancel button behavior.

Shows how to add controls to a dialog using the add method.

Shows how to define a resource string that creates the control
hierarchy in a dialog.

Shows how to create and initialize check box and radio button
controls and define their behavior.

Shows how to create a hierarchical list with subitems.
Shows how to create, initialize, and update a progress bar.
Shows how to create and handle input from a slider control.

Shows how to create a Flash® Player, and use it to load a play
back a movie defined in an SWF file.

Shows how to communicate between the Adobe application
scripting environment and the ActionScript™ scripting
environment of the Flash Player.

Shows how to use the graphics objects to change colorsin a
window.

A more complex version of the color-selection dialog shows
how to use additional graphics objects, including fonts and
paths.

Shows how to align elements along two dimensions in order to
control the relative positions of controls within rows and
columns.

59
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SnpQCr eat eDynam cScri pt U . j sx Shows how to use automatic layout, switching component
layout between “row” and “stack” orientation.

Al ert BoxBui | der 1. j sx Shows a way to use resource specifications. Uses the add()
method to build a dialog that collects values from the user, and
creates a resource string from those values. Saves the string to
a file, then uses it to build a new dialog. See “Using resource
strings” on page 74.

Al ert BoxBui | der 2. j sx Shows another way to use a resource specification, building
the same user-input dialog itself from a resource string. See
“Using resource strings” on page 74.

ScriptUl defines Wwindow objects that represent platform-specific windows, and various control elements
such as Button and StaticText, that represent user-interface controls. These objects share a common
set of properties and methods that allow you to query the type, move the element around, set the title,

caption or content, and so on. Many element types also have properties unique to that class of elements.

ScriptUl defines the following types of windows:

e Modal dialog box: Holds focus when shown, does not allow activity in other application windows until
dismissed.

e Floating palette: Also called modeless dialog, allows activity in other application windows. (Adobe
Photoshop’ does not support script creation of palette windows.)

e Main window: Suitable for use as an application’s main window. (Main windows are not normally
created by script developers for Adobe applications. Photoshop does not support script creation of
main windows.)

To create a new window, use the Window constructor function. The constructor takes the desired type of
the window. The type is "dialog" for a modal dialog, or "palette" for a modeless dialog or floating
palette. You can supply optional arguments to specify an initial window title and bounds; or you can set
the location and size separately.

The following example creates an empty dialog with the variable name d1g, which is used in subsequent

examples:
// Create an empty dialog window near the upper left of the screen
var dlg = new Window('dialog', 'Alert Box Builder');
dlg.framelLocation = [100,100];

Newly created windows are initially hidden; the show method makes them visible and responsive to user
interaction. For example:

dlg.show () ;

Allwindows are containers—that is, they contain other elements within their bounds. Within a window,
you can create other types of container elements: Panels and Groups. These can contain control
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elements, and can also contain other Panel and Group containers. However, a Window cannot be added
to any container.

e AGroup is the simplest container used to visually organize related controls. You would typically define
a group and populate it with related elements, for instance an edittext box and its descriptive
statictext label.

e APanel isaframe object, also typically used to visually organize related controls. It has a text property
to specify a title, and can have a border to visually separate the collection of elements from other
elements of a dialog.

You might create a Panel and populate it with several Groups, each with their own elements. You can
create nested containers, with different layout properties for different containers, in order to define a
relatively complex layout without any explicit placement.

You can add elements to any container using the add method (see “Adding elements to containers” on
page 62). An element added to a container is considered a child of that container. Certain operationson a
container apply to its children; for example, when you hide a container, its children are also hidden.

When a script creates a Window and adds various Ul elements to it, the locations and sizes of elements and
spacing between elements is known as the layout of the window. Each Ul element has properties which
define its location and dimensions: 1ocation, size, and bounds. These properties are initially
undefined, and a script that employs Automatic Layout should leave them undefined for the main window
as well as its contained elements, allowing the automatic layout mechanism to set their values.

Your script can access these values, and (if not using auto-layout) set them as follows:

e The location of awindow is defined by a Point object containing a pair of coordinates (x and y) for
the top left corner (the origin), specified in the screen coordinate system. The 1ocat ion of an element
within a window or other container is defined as the origin point specified in the container’s coordinate
system. That is, the x and y values are relative to the origin of the container.

The following examples show equivalent ways of placing the content region of an existing window at
screen coordinates [10, 50]:

win.location = [10, 50];
win.location {x:10, y:50};
win.location = "x:10, y:50";

e The size of an element’s region is defined by a Dimension object containing a width and height
in pixels.

The following examples show equivalent ways of changing an existing window’s width and height to
200 and 100:

win.size = [200, 100];
win.size = {width:200, height:100};
win.size = "width:200, height:100";

This example shows how to change a window’s height to 100, leaving its location and width
unchanged:

win.size.height = 100;
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e The bounds of an element are defined by a Bounds object containing both the origin point (x, y) and
size (width, height) To define the size and location of windows and controls in one step, use the
bounds property.

The value of the bounds property can be a string with appropriate contents, an inline JavaScript
Bounds object, or a four-element array. The following examples show equivalent ways of placing a 380
by 390 pixel window near the upper left corner of the screen:

var dlg = new Window('dialog', 'Alert Box Builder', [100,100,480,490]);
dlg.bounds = [100,100,480,490];

dlg.bounds = {x:100, y:100, width:380, height:390};

dlg.bounds {left:100, top:100, right:480, bottom:490};

dlg.bounds = "left:100, top:100, right:480, bottom:490";

The window dimensions define the size of the content region of the window, or that portion of the window
that a script can directly control. The actual window size is typically larger, because the host platform’s
window system typically adds title bars and borders. The bounds property for a Window refers only to its
content region. To determine the bounds of the frame surrounding the content region of a window, use
the Window. frameBounds property.

To add elements to a window, panel, or group, use the container’s add method. This method accepts
the type of the element to be created and some optional parameters, depending on the element type. It
creates and returns an object of the specified type.

In additions to windows, ScriptUl defines the following user-interface elements and controls:
e Panels (frames) and groups, to collect and organize other control types

e Push buttons with text or icons, radio buttons, checkbox buttons

e Static text or images, edit text

e Progress bars, scrollbars, sliders

e Lists, which include list boxes and drop-down (also called popup) lists. Each item in a list is a control of
type item, and the parent list's items property contains an array of child items. You can add list items
with the parent list's add method.

You can specify the initial size and position of any new element relative to the working area of the parent
container, in an optional bounds parameter. Different types of elements have different additional
parameters. For elements which display text, for example, you can specify the initial text. See the ScriptUI
Classes dictionary in the ExtendScript Toolkit's Object Model Viewer for details.

The order of optional parameters must be maintained. Use the value undefined for a parameter you do
not wish to set. For example, if you want to use automatic layout to determine the bounds, but still set the
title and text in a panel and button, the following creates Panel and Button elements with an initial
text value, but no bounds value:

dlg.btnPnl = dlg.add('panel', undefined, 'Build it');
dlg.btnPnl.testBtn = dlg.btnPnl.add('button', undefined, 'Test');

Tip: This example creates a dynamic property, btnPnl, on the parent window object, which contains the
returned reference to the child control object. This is not required, but provides a useful way to access
your controls.

A new element is initially set to be visible, but is not shown unless its parent object is shown.
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Some element types have attributes that can only be specified when the element is created. These are not
normal properties of the element, in that they cannot be changed during the element’s lifetime, and they
are only needed once. For these element types, you can supply an optional creation-properties argument
to the add method. This argument is an object with one or more properties that control aspects of the
element’s appearance, or special functions such as whether an edit text element is editable or Read only.
See “Control object constructors” on page 108 for details.

You can also specify the creation properties for new objects using the resource specification format; for
details, see “Resource Specifications” on page 73.

All Ul elements have an optional creation property called name, which assigns a name for identifying that
element. For example, the following creates a new But ton element with the name 'ok":

dlg.btnPnl.buildBtn =
dlg.btnPnl.add('button', undefined, 'Build', {name:'ok'});

Note: In Photoshop CS, panel coordinates were measured from outside the frame (including the title bar),
butin Photoshop CS2, panel coordinates are measured from the inside the frame (the content area).
This means that if you use the same values to set the vertical positions of child controls in a panel,
the positions are slightly different in the two versions. When you add a panel to a window, you can
choose to set a creation property (sulPanelCoordinates), which causes that panel to
automatically adjust the positions of its children; see the add method for panel. When automatic
adjustment is enabled, you provide position values that were correct for Photoshop CS, and the
result is the same in Photoshop CS2 or CS3. You can also set automatic adjustment for a window; in
this case, it applies to all child panels of that window unless it is explicitly disabled in the child panel.
See Window object constructor.

A reference to each element added to a container is appended to the container’s children property. You
can access the child elements through this array, using a 0-based index. For controls that are not
containers, the children collection is empty.

In this example, the msgPn1 panel was the first element created in d1g, so the script can access the panel
object at index 0 of the parent’s children property to set the text for the title:

var dlg = new Window('dialog', 'Alert Box Builder');
dlg.msgPnl = dlg.add('panel') ;
dlg.children[0] .text = 'Messages';

If you use a creation property to assign a name to a newly created element, you can access that child by its
name, either in the children array of its parent, or directly as a property of its parent. For example, the
Button in a previous example was named "ok", so it can be referenced as follows:

dlg.btnPnl.children['ok'] .text = "Build";
dlg.btnPnl.ok.text = "Build";

For list controls (type 1ist and dropdown), you can access the child list-item objects through the items
array.
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To remove elements from a Window, Panel, or Group, use the container’s remove method. This method
accepts an object representing the element to be removed, or the name of the element, or the index of the
element in the container’s children collection (see “Accessing child elements” on page 63).

The specified element is removed from view if it was currently visible, and it is no longer accessible from
the container or window. The results of any further references by a script to the object representing the
element are undefined.

To remove list items from a list, use the parent list control’s remove method in the same way. It removes
the item from the parent’s i tems list, hides it from view, and deletes the item object.

The following sections introduce the types of controls you can add to a Window or other container
element (panel or group). For details of the properties and functions, and of how to create each type of
element, see “Control object constructors” on page 108.

These are types of Control objects which are contained in windows, and which contain and group other

controls.
Panel Typically used to visually organize related controls.
e Setthetext property to define a title which appears at the top of the Panel .
e An optional bor der Styl e creation property controls the appearance of the border
drawn around the panel.
You can use Panel s as separators: those with wi dt h of 0 appear as vertical lines and
those with hei ght of 0 appear as horizontal lines.
var dlg = new Wndow('dialog', 'Aert Box Builder");
dl g. msgPnl = dl g. add(' panel ', [25, 15, 355,130], ' Messages');
G oup Used to visually organize related controls. Unlike Panel s, @ oups have no title or

visible border. You can use them to create hierarchies of controls, and for fine control
over layout attributes of certain groups of controls within a larger panel. For
examples, see “Creating more complex arrangements” on page 86.

These are types of Control objects that are contained in windows, panels, and groups, and that provide
specific kinds of display and user interaction. Control instances are created by passing the corresponding
type keyword to the add () method of a Window or container; see “Control types and creation
parameters” on page 109.

These examples do not set bounds explicitly on creation, because it is often more useful to set a preferred
size, then allow the layout manager to set the bounds; see “Automatic Layout” on page 80.




4: User Interface Tools Types of Controls 65

StaticText Typically used to display text strings that are not intended for direct manipulation by
a user, such as informative messages or labels.

This example creates a Panel and adds several St ati cText elements:

var dlg = new Wndow('dialog', 'Alert Box Builder");

dl g. nsgPnl = dl g. add(' panel ', undefined, 'Messages');

dlg.nsgPnl .titleSt = dl g. nsgPnl . add(' statictext', undefined,
"Alert box title:");

dl g. megPnl . rsgSt = dl g. msgPnl . add(' statictext', undefined,
"Alert message:');

dl g. show() ;

Edi t Text Allows users to enter text, which is returned to the script when the dialog is
dismissed. Text in Edi t Text elements can be selected, copied, and pasted.

e Setthetext property to assign the initial displayed text in the element, and read it
to obtain the current text value, as entered or modified by the user.

e Setthetextsel ection property to replace the current selection with new text, or
to insert text at the cursor (insertion point). Read this property to obtain the
current selection, if any.

This example adds some Edi t Text elements, with initial values that a user can accept
or replace:

var dlg = new Wndow('dialog', 'Aert Box Builder');
dl g. nsgPnl = dl g. add(' panel ', undefined, 'Messages');
dlg.nsgPnl .titleSt = dl g. nsgPnl . add(' statictext', undefined,
"Alert box title:");
dlg.nmsgPnl .titleEt = dl g. nsgPnl . add(' edittext', undefi ned,
"Sample Alert');
dl g. nsgPnl . nsgSt = dl g. nsgPnl . add(' statictext', undefi ned,
"Alert message:');
dl g. megPnl . nsgEt = dI g. msgPnl . add(' edi ttext', undefi ned,
' <your message here>', {nultiline:true});
dl g. show();
Note the creation property on the second Edi t Text field, where mul tiline:true
indicates a field in which a long text string can be entered. The text wraps to appear
as multiple lines.

Button Typically used to initiate some action from a window when a user clicks the button;
for example, accepting a dialog’s current settings, canceling a dialog, bringing up a
new dialog, and so on.

e Setthetext property to assign a label to identify a But t on’s function.
e Theond i ck callback method provides behavior.

var dlg = new Wndow('dialog', 'Aert Box Builder");

dlg.btnPnl = dl g. add(' panel ', undefined, 'Build it');

dig.btnPnl.testBtn = dl g. bt nPnl . add(' button', undefined, 'Test');

dl g. bt nPnl . bui | dBtn = dl g. bt nPnl . add(' button', undefined, 'Build",
{nane:' ok'});

dl g. bt nPnl . cancel Btn = dl g. bt nPnl . add(' button', undefined, ' Cancel",
{nare: ' cancel '});

dl g. show();

| conBut t on A button that displays an icon instead of text. Like a text button, typically initiates an
action in response to a click.

e Thei mage property identifies the icon image; see”Displaying icons” on page 68.

e Theond i ck callback method provides behavior.
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| mrage Displays an iconic image.

e Thei mage property identifies the icon image; see “Displaying icons” on page 68.

Checkbox Allows the user to set a boolean state.

e Setthetext property to assign an identifying text string that appears next to the
clickable box.

e The user can click to select or deselect the box, which shows a checkmark when
selected. The val ue is true when it is selected (checked) and false when it is not.

When you create a Checkbox, you can set its val ue property to specify its initial state
and appearance.

// Add a checkbox to control the buttons that dismss an alert box
dl g. hasBt nsCbh = dl g. add("' checkbox', undefi ned,

"Should there be alert buttons?);
dl g. hasBt nsCh. val ue = true;

Radi oBut t on Allows the user to select one choice among several.

e Setthetext property to assign an identifying text string that appears next to the
clickable button.

e Theval ueis true when the button is selected. The button shows the state in a
platform-specific manner, with a filled or empty dot, for example.

You group a related set of radio buttons by creating all the related elements one after
another. When any button’s value becomes true, the value of all other buttons in the
group becomes false. When you create a group of radio buttons, you should set the
state of one of them true:

var dlg = new Wndow('dialog', 'Aert Box Builder');

dlg.alertBtnsPnl = dl g. add(' panel ', undefined, 'Button alignnent');

dig.alertBtnsPnl .alignLeft R = dl g.al ert BtnsPnl . add(' r adi obut t on' ,
undefined, 'Left');

dig.alertBtnsPnl.alignCenterRb = dl g.al ert BtnsPnl . add(' radi obutton',
undefined, 'GCenter');

dig.alertBinsPnl.alignR ght Ro = dl g.al ert BtnsPnl . add(' radi obutton',

undefined, 'R ght');
dl g. al ert BtnsPnl . al i gnCent er Rb. val ue = true;
dl g. show() ;

Pr ogr essbar Typically used to display the progress of a time-consuming operation. A colored bar
covers a percentage of the area of the control, representing the percentage
completion of the operation. The val ue property reflects and controls how much of
the visible area is colored, relative to the maximum value (maxval ue). By default the
range is 0 to 100, so the val ue=50 when the operation is half done.

Slider Typically used to select within a range of values. The slider is a horizontal bar with a
draggable indicator, and you can click a point on the slider bar to jump the indicator
to that location. The val ue property reflects and controls the position of the indicator,
within the range determined by ni nval ue and naxval ue. By default the range is 0 to
100, so setting val ue=50 moves the indicator to the middle of the bar.
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Scrol | bar Like a slider, the scrollbar is a bar with a draggable indicator. It also has “stepper”
buttons at each end, that you can click to jump the indicator by the amount in the
st epdel t a property. If you click a point on the bar outside the indicator, the indicator
jumps by the amount in the j unpdel t a property.

You can create scrollbars with horizontal or vertical orientation; if wi dt h is greater
than hei ght, it is horizontal, otherwise it is vertical.

Scrollbars are often created with an associated Edi t Text field to display the current
value of the scrollbar, and to allow setting the scrollbar’s position to a specific value.
This example creates a scrollbar with associated St at i cText and Edi t Text elements
within a panel:

dl g.sizePnl = dl g.add("' panel ', undefined, 'D nensions');

dl g.sizePnl .widthSt = dl g.sizePnl.add(' statictext', undefined, 'Wdth:"');

dl g.sizePnl .widthScrl = dl g.sizePnl.add(' scrollbar', undefi ned,

300, 300, 800);

dl g.sizePnl.wi dthE = dlg.sizePnl.add('edittext');
The last three arguments to the add method that creates the scrollbar define the
values for the val ue, m nval ue and naxval ue properties.

Li st Box These controls display lists of items, which are represented by Li st | t emobjects in the
DropDownLi st itens property. You can access the items in this array using a 0-based index.
TreeVi ew

e A Li st Box control displays a list of choices. When you create the object, you
specify whether it allows the user to select only one or multiple items. If a list
contains more items than can be displayed in the available area, a scrollbar may
appear that allows the user to scroll through all the list items.

e A DropDownLi st control displays a single visible item. When you click the control, a
list drops down and allows you to select one of the other items in the list.
Drop-down lists can have nonselectable separator items for visually separating
groups of related items, as in a menu.

e A TreeVi ewcontrol is similar to a Li st Box, except that the items can have child
items. ltems with children can be expanded or collapsed to show or hide the child
items. Child items can in turn contain children.

You can specify the choice items on creation of the list object, or afterward using the
list object’s add() method. You can remove items programmatically with the list
object’s remove() and renoveA | () methods.

Listltem Items added to or inserted into any type of list control are Li st I t emobjects, with
properties that can be manipulated from a script. Li st | t emelements can be of the
following types:

e itemthe typical item in any type of list. It displays text or an icon, and can be
selected. To display an icon, set the item object’s i mage property; see “Displaying
icons” on page 68.

e separat or: a separator is a nonselectable visual element in a drop-down list.
Although it has a t ext property, the value is ignored, and the item is displayed as
a horizontal line.

e node: a displayable and selectable item in a Tr eeVi ewcontrol which can contain
other Li st I t emobjects, including other items of type node.
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Fl ashPl ayer Runs a Flash movie within a ScriptUl window. Its control’s methods allow you to load
a movie from an SWF file and control the playback. See “FlashPlayer control
functions” on page 124.

You can also use the control object to communicate with the Flash application,
calling ActionScript methods, and making JavaScript methods defined in your Adobe
application script available to the Flash ActionScript code. See “Calling ActionScript
functions from a ScriptUl script” on page 79.

You can display icon images in Image or IconButton controls, or display images in place of strings or in
addition to strings as the selectable items in a Listbox or DropdownList control. In each case, the
image is defined by setting the element’s image property, either to an ScriptUlimage object, a named icon
resource, a File Object, or the pathname of a file containing the iconic image (see “Specifying paths” on

page 36).

The image data for an icon can be in Portable Network Graphics (PNG) format, or in Joint Photographic
Experts Group (JPEG) format. See http://www.libpng.org and http://www.jpeg.org/ for detailed
information on these formats.

You can set or reset the image property at any time to change the image displayed in the element.

The scripting environment can define icon resources, which are available to scripts by name. To specify an
icon resource, set a control’s image property to the resource’s JavaScript name, or refer to the resource by
name when creating the control. For example, to create a button with an application-defined icon
resource:

myWin.upBtn = myWin.add ("iconbutton", undefined, "SourceFolderIcon") ;

Photoshop CS3, for example, defines these icon resources:

SteplIcon

Step2Icon

Step3Icon

Step4Icon
SourceFolderIcon
DestinationFolderIcon

If a script does not explicitly set the preferredSize or size property of an element that displays a icon
image, the value of preferredSize is determined by the dimensions of the iconic image. If the size
values are explicitly set to dimensions smaller than those of the actual image graphic, the displayed image
is clipped. If they are set to dimensions larger than those of the image graphic, the displayed image is
centered in the larger space. An image is never scaled to fit the available space.

Static functions on the Window class are globally available to display short messages in standard dialogs.
The host application controls the appearance of these simple dialogs, so they are consistent with other
alert and message boxes displayed by the application. You can often use these standard dialogs for simple
interactions with your users, rather than designing special-purpose dialogs of your own.

Use the static functions alert, confirm, and prompt on the Window class to invoke these dialogs with
your own messages. You do not need to create a Window object to call these functions.


http://www.libpng.org
http://www.jpeg.org/
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A modal dialog is initially invisible. Your script invokes it using the show method, which does not return
until the dialog has been dismissed. The user can dismiss it by using a platform-specific window gesture,
or by using one of the dialog controls that you supply, typically an OK or Cancel button. The onClick
method of such a button must call the close or hide method to close the dialog. The close method
allows you to pass a value to be returned by the show method.

For an example of how to define such buttons and their behavior, see “Defining Behavior with Event
Callbacks and Listeners” on page 75.

A dialog typically contains some controls that the user must interact with, to make selections or enter
values that your script will use. In some cases, the result of the user action is stored in the object, and you
can retrieve it after the dialog has been dismissed. For example, if the user changes the state of a
Checkbox or RadioButton, the new state is found in the control’s value property.

However, if you need to respond to a user action while the dialog is still active, you must assign the control
a callback function for the interaction event, either onC1ick or onChange. The callback function is the
value of the onClick or onChange property of the control.

For example, if you need to validate a value that the user enters in a edittext control, you can do soin
an onChange callback handler function for that control. The callback can perform the validation, and
perhaps display an alert to inform the user of errors.

Sometimes, a modal dialog presents choices to the user that must be correct before your script allows the
dialog to be dismissed. If your script needs to validate the state of a dialog after the user clicks OK, you can
define an onClose event handler for the dialog. This callback function is invoked whenever a window is
closed. If the function returns true, the window is closed, but if it returns false, the close operation is
cancelled and the window remains open.

Your onClose handler can examine the states of any controls in the dialog to determine their correctness,
and can show alert messages or use other modal dialogs to alert the user to any errors that must be
corrected. It can then return true to allow the dialog to be dismissed, or false to allow the user to correct
any errors.

Every modal dialog should have at least one button that the user can click to dismiss the dialog. Typically
modal dialogs have an OK and a Cancel button to close the dialog with or without accepting changes that
were made in it.

You can define onC1ick callbacks for the buttons that close the parent dialog by calling its close
method. You have the option of sending a value to the c1lose method, which is in turn passed on to and
returned from the show method that invoked the dialog. This return value allows your script to distinguish
different closing events; for example, clicking OK can return 1, clicking Cancel can return 2. However, for
this typical behavior, you do not need to define these callbacks explicitly; see “Default and cancel
elements” on page 70.

For some dialogs, such as a simple alert with only an OK button, you do not need to return any value. For
more complex dialogs with several possible user actions, you might need to distinguish more outcomes. If
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you need to distinguish more than two closing states, you must define your own closing callbacks rather
than relying on the default behavior.

If, by mistake, you create a modal dialog with no buttons to dismiss it, or if your dialog does have buttons,
but their onC1ick handlers do not function properly, a user can still dismiss the dialog by typing Esc. In
this case, the system will execute a call to the dialog’s close method, passing a value of 2. This is not, of
course, a recommended way to design your dialogs, but is provided as an escape hatch to prevent the
application from hanging in case of an error in the operations of your dialog.

The user can typically dismiss a modal dialog by clicking an OK or Cancel button, or by typing certain
keyboard shortcuts. By convention, typing ENTER is the same as clicking OK or the default button, and
typing Esc is the same as clicking Cancel. The keyboard shortcut has the same effect as calling not i £y for
the associated but ton control.

To determine which control is notified by which keyboard shortcut, set the Dialog object’s
defaultElement and cancelElement properties. The value is the control object that should be
notified when the user types the associated keyboard shortcut.

e For buttons assigned as the defaultElement, if there is no onC1ick handler associated with the
button, clicking the button or typing ENTER calls the parent dialog’s c1ose method, passing a value of 1
to be returned by the show call that opened the dialog.

e For buttons assigned as the cancelElement, if there is no onC1lick handler associated with the
button, clicking the button or typing Esc calls the parent dialog's c1ose method, passing a value of 2
to be returned by the show call that opened the dialog.

If you do not set the defaultElement and cancelElement properties explicitly, ScriptUl tries to
choose reasonable defaults when the dialog is about to be shown for the first time. For the default
element, it looks for a button whose name or text value is "ok" (disregarding case). For the cancel
element, it looks for a button whose name or text value is "cancel" (disregarding case). Because it looks
at the name value first, this works even if the text value is localized. If there is no suitable button in the
dialog, the property value remains null, which means that the keyboard shortcut has no effect in that
dialog.

To make this feature most useful, it is recommended that you always provide the name creation property
for buttons meant to be used in this way.

ScriptUl defines objects to represent the complex values of properties that place and size windows and Ul
elements. These objects cannot be created directly, but are created when you set the corresponding
property. That property then returns that object. For example, the bounds property returns a Bounds
object.

You can set these properties as objects, strings, or arrays.

e e.prop = Object:The object must contain the set of properties defined for this type, as shown in the
table below. The properties have integer values.

e e.prop = String: The string must be an executable JavaScript inline object declaration, conforming
to the same object description.
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e e.prop = Array:The array must have integer coordinate values in the order defined for this type, as
shown in the table below. For example:

The following examples show equivalent ways of placing a 380 by 390 pixel window near the upper left

corner of the screen:

var

dlg.
dlg.
dlg.
dlg.
dlg.

dlg = new Window('dialog', 'Alert Box Builder') ;

bounds
bounds
bounds

bounds =

bounds

= {x:100, y:100, width:380, height:390}; //object

= {left:100, top:100, right:480, bottom:490}; //object
= "x:100, y:100, width:380, height:390"; //string
"left:100, top:100, right:480, bottom:490"; //string
= [100,100,480,490]; //array

You can access the resulting object as an array with values in the order defined for the type, or as an object
with the properties supported for the type.

The following table shows the property-value object types, the element properties that create and contain
them, and their array and object-property formats.

Bounds

D nensi on

Mar gi ns

Defines the boundaries of a window within the screen’s coordinate space, or of a
Ul element within the container’s coordinate space. Contains an array, [ | ef t,
top, right, bottonj,thatdefinesthe coordinates of the upper left and lower
right corners of the element.

A Bounds object is created when you set an element’s bounds property, and this
property returns a Bounds object.

e An object must contain properties named | eft, t op, ri ght, bottomor x, y,
wi dt h, hei ght .

e An array must have values in the order [l eft, top, right, bottoni.

Defines the size of a W ndowor Ul element. Contains an array, [ wi dth, hei ght], that
defines the element’s size in pixels.

A D nensi on object is created when you set an element’s si ze or pref erredS ze
property.
e An object must contain properties named wi dt h and hei ght .

e Anarray must have values in the order [wi dth, height].

Defines the number of pixels between the edges of a container and its outermost
child elements. Contains an array [l eft, top, right, botton] whose elements
define the margins between the left edge of a container and its leftmost child
element, and so on.

A Mar gi ns object is created when you set an element’s mar gi ns property.
e An object must contain properties named | eft, t op, ri ght, and bot t om
e An array must have values in the order [l eft, top, right, bottoni.

You can also set the mar gi ns property to a number; all of the array values are then
set to this number.
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Poi nt Defines the location of a Wndowor Ul element. Contains an array, [ X, y], whose
values represent the origin point of the element as horizontal and vertical pixel
offsets from the origin of the element’s coordinate space.

A Poi nt object is created when you set an element’s | ocat i on property.
e An object must contain properties named x and y.

e Anarray must have values in the order [x, y].

ScriptUl allows you to draw directly on controls to customize their appearance. You do this by calling
methods of the ScriptUIGraphics object in response to the onDraw event (see “Defining Behavior with
Event Callbacks and Listeners” on page 75). These methods take as parameters a number of helper objects
that encapsulate drawing information, including the following:

ScriptU G aphics  Encapsulates the drawing methods. The graphics object is associated with each
control is found in the control object’s gr aphi cs property.

Scri pt U Brush Describes the brush used to paint textures in a control.

Scri pt U Font Describes the font used to write text into a control.

Script U | nage Describes an image to be drawn in a control.

ScriptU Path Describes a drawing path for a figure to be drawn into a control.
Script U Pen Describes the pen used to draw lines in a control.

For details of these objects, see “Graphic Customization Objects” on page 130.

The scriptUIGraphics object contains methods that create the other graphics objects; for example,
ScriptUIGraphics.newBrush () createsa ScriptUIBrush instance with a specific color. These
graphic objects are then used as property values in the ScriptUIGraphics object, which controls how
a Ul element is drawn on the screen. For example, if you put the new Brush object in the
backgroundColor property, the element is drawn using that color for the background.

To make the background of a window light gray, you could use this code:

g = myWindow.graphics;
myBrush = g.newBrush (g.BrushType.SOLID COLOR, [0.75, 0.75, 0.75, 11);
g.backgroundColor = myBrush;

These examples in the Adobe Bridge and JavaScript SDK demonstrates how to use graphic customization
objects:

Col or Sel ector. j sx  Uses graphic objects to change the background color of a window as the user
selects the color value with a slider.

Gol or Pi cker.jsx A more complex version of the color-selection dialog shows how to use
additional graphics objects, including fonts and paths.
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You can create one or more Ul elements at a time using a resource specification. This specially formatted
string provides a simple and compact means of creating an element, including any container element and
its component elements. The resource-specification string is passed as the type parameter to the
Window () oradd () constructor function.

The general structure of a resource specification is an element type specification (such as dialog),
followed by a set of braces enclosing one or more property definitions.

var myResource = "dialog{ control specs }";
var myDialog = new Window ( myResource ) ;

Controls are defined as properties within windows and other containers. For each control, give the class
name of the control, followed by the properties of the control enclosed in braces. For example, the
following specifies a Button:

testBtn: Button { text: 'Test' }

The following resource string specifies a panel that contains grouped StaticText and EditText
controls:

"msgPnl: Panel { orientation:'column', alignChildren: ['right', 'top'],\
text: 'Messages', \
title: Group { \
st: StaticText { text:'Alert box title:' }, \
et: EditText { text:'Sample Alert', characters:35 } \
}

msg: Group { \
st: StaticText { text:'Alert message:' }, \
et: EditText { properties:{multiline:true}, \
text:'<your message here>' \
FA

}n

The property with name properties specifies creation properties; see “Creation properties” on page 63.

A property value can be specified as null, true, false, a string, a number, an inline array, or an object.
e Aninline array contains one or more values in the form:

[value, value,...]
e An object can be an inline object, or a named object, in the form:

{classname inlineObject}

In this case, the classname must be one of the control class names list in “Types of Controls” on page 64.

e Aninline object contains one or more properties, in the form:

{propertyName:propertyvalue,propertyName:propertyvalue,... }
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These examples in the Adobe Bridge and JavaScript SDK demonstrate how to use resource specification
strings:

Al ertBoxBuilderl.jsx  Demonstrates one way to use resource strings, creating a dialog that allows
the user to enter some values, and then using those values to construct the
resource string for a customizable alert dialog.

Al ertBoxBuilder2.jsx  Constructs the same dialog, using a resource string (rather than the add()
method) to specify all of the dialog contents for the user-input dialog.

The two Alert Box Builder examples create the same dialog to collect values from the user.

Alert Box Builder

— Messages
Alert box title: Sample Alert

<your message here>
Alert message:

150

Message width:

L=

Message height: 20

E Has alert buttons?

Button alignment
’7 S Left @ Center S Right

, o

Build it
|7|_, Test jl ( Build } 'i Cancel )

The Build button event handler builds a resource string from the collected values, and returns it from the
dialog invocation function; the script then saves the resource string to a file. That resource string can later
be used to create and display the user-configured alert box.

The resource specification format can also be used to create a single element or container and its child
elements. For instance, if the alertBuilderResource in the example did not contain the panel
btnPnlResource, you could define that resource separately, then add it to the dialog as follows:

var btnPnlResource =
"btnPnl: Panel { orientation:'row', \
text: 'Build it', \
testBtn: Button { text:'Test' }, \
buildBtn: Button { text:'Build', properties:{name:'ok'} }, \
cancelBtn: Button { text:'Cancel',6 properties:{name:'cancel'} } \
|RF

dlg = new Window (alertBuilderResource) ;
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dlg.btnPnl = dlg.add (btnPnlResource) ;
dlg.show() ;

You must define the behavior of your controls in order for them to respond to user interaction. You can do
this by defining event-handling callback functions as part of the definition of the control or window. To
respond to a specific event, define a handler function for it, and assign a reference to that function in the
corresponding property of the window or control object. Different types of windows and controls respond
to different actions, or events:

Windows generate events when the user moves or resizes the window. To handle these events, define
callback functions for onMove, onMoving, onResize, and onResizing. To respond to the user opening or
closing the window, define callback functions for onShow and onClose.

Button, RadioButton, and Checkbox controls generate events when the user clicks within the control
bounds. To handle the event, define a callback function for onClick.

EditText, Scrollbar, and Slider controls generate events when the content or value changes—that is,
when the user types into an edit field, or moves the scroll or slider indicator. To handle these events,
define callback functions for onChange and onChanging.

ListBox, DropDownlList, and TreeView controls generate events whenever the selection in the list
changes. To handle the event, define a callback function for onChange.

The ListBox also generates an event when the user double-clicks an item. To handle it, define a callback
function for the onDoubleClick event.

Both containers and controls generate events just before they are drawn, that allow you to customize
their appearance. To handle these events, define callback functions for onDraw. Your handler can
modify or control how the container or control is drawn using the methods defined in the control’s
associated ScriptUIGraphics object.

In Windows only, you can register a key sequence as a shortcutKey for a window or for most types of
controls. To handle the key sequence, define a callback function for onShortcutKey in that control.

Your script can define an event handler as a named function referenced by the callback property, or as an
unnamed function defined inline in the callback property.

If you define a named function, assign its name as the value of the corresponding callback property.
For example:

function hasBtnsCbOnClick () { /* do something interesting */ }
hasBtnsCb.onClick = hasBtnsCbOnClick;

For a simple, unnamed function, set the property value directly to the function definition:

UI element.callback name = function () { handler definition};

Event-handler functions take no arguments.

For example, the following sets the onC11ick property of the checkbox hasBtnsCb, to a function that
enables another control in the same dialog:

hasBtnsCb.onClick = function ()
{ this.parent.alertBtnsPnl.enabled = this.value; };
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The following statements set the onC1ick event handlers for buttons that close the containing dialog,
returning different values to the show method that invoked the dialog, so that the calling script can tell
which button was clicked:

buildBtn.onClick = function () { this.parent.parent.close(1l); };
cancelBtn.onClick = function () { this.parent.parent.close(2); };

You can simulate user actions by sending an event notification directly to a window or control with the
notify method. A script can use this method to generate events in the controls of a window, as if a user
was clicking buttons, entering text, or moving the window. If you have defined an event-handler callback
for the element, the not i fy method invokes it.

The not i fy method takes an optional argument that specifies which event it should simulate. If a control
can generate only one kind of event, notification generates that event by default.

The following controls generate the onC1lick event:

Button
Checkbox
TconButton
RadioButton

The following controls generate the onChange event:

DropDownList
EditText
ListBox
Scrollbar
Slider
TreeView

The following controls generate the onChanging event:

EditText
Scrollbar
Slider

In the ListBox, double-clicking an item generates the onDoubleClick event.

In RadioButton and Checkbox controls, the boolean value property automatically changes when the
user clicks the control. If you use notify () to simulate a click, the value changes just as if the user had
clicked. For example, if the value of a checkbox hasBtnsCb is true, this code changes the value to false:

if (dlg.hasBtnsCb.value == true) dlg.hasBtnsCb.notify () ;
// dlg.hasBtnsCb.value is now false

Another way to define the behavior of your windows and controls is register a handler function that
responds to a specific type of event in that window or control. This technique allows you to respond to the
cascading of an event through a hierarchy of containers and controls.

Use windowOb7 .addEventListener() or controlobj .addEventListener() to register a handler. The
function you register receives a UlEvent Object that encapsulates the event information. As an event
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cascades down through a hierarchy and back up through the hierarchy, your handler can respond at any
level, or use the UTEvent object’s stopPropagation() method to stop the event propagation at some level.

You can register:

e The name of a handler function defined in the extension that takes one argument, the UlEvent Object.
For example:

myButton.addEventListener( 'click', myFunction ) ;
e Alocally defined handler function that takes one argument, the UlEvent Object. For example:
myButton.addEventListener( 'click', 'function(e){/*handler code*/}"');

The handler or registered code statement is executed when the specified event occurs in the target. A
script can programmatically simulate an event by calling an event target’s dispatchEvent() function.

You can remove a handler that has been previously registered by calling the event target’s
removeEventListener() function. The parameters you pass to this function must be identical to those
passed to the addEventListener() call that registered the handler. Typically, a script would register all event
handlers during initialization, and unregister them during termination; however, unregistering handlers
on termination is not required.

You can register for an event in a parent or ancestor object of the actual target; see the following section.

The predefined types of UIEvent correspond to the event callbacks, as follows:

Callback UlEvent type
onChange change
onChangi ng changi ng
ond i ck click (detail = 1)
onDoubl ed i ck click (detail = 2)
onEnt er Key ent er Key
onhMbve nove
onMvi ng novi ng
onResi ze resize
onResi zi ng resizing
onShow show
onActivate focus
onDeacti vat e bl ur

When an event occurs in a target, all handlers that have been registered for that event and target are
called. Multiple event handlers can be registered for the same event in different targets, even in targets of
the same type. For example, if there is a dialog with two checkboxes, you might want to registera click
handler for each checkbox object. You would do this, for example, if each checkbox reacts differently to
the click.
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You can also register events for child objects with a parent object. If both checkboxes should react the
same way to a mouse click, they require the same handler. In this case, you can register the handler with
the parent window or container instead. When the c1ick event occurs in either child control, the handler
registered for the parent window is called.

You can combine these two techniques, so that more than one action occurs in response to the event.
That is, you can register a general event handler with the parent, and register a different, more specific
handler for the same event with the child object that is the actual target.

The rules for how multiple event handlers are called depend on three phases of event propagation, as
follows:

e Capture phase

When an event occurs in an object hierarchy, it is captured by the topmost ancestor object at which a
handler is registered (the window, for example). If no handler is registered for the topmost ancestor,
ScriptUl looks for a handler for the next ancestor (the dialog, for example), on down through the
hierarchy to the direct parent of actual target. When ScriptUl finds a handler registered for any ancestor
of the target, it executes that handler then proceeds to the next phase.

e At-target phase
ScriptUI calls any handlers that are registered with the actual target object.
e Bubble phase

The event bubbles back out through the hierarchy; ScriptUl again looks for handlers registered for the
event with ancestor objects, starting with the immediate parent, and working back up the hierarchy to
the topmost ancestor. When ScriptUI finds a handler, it executes it and the event propagation is
complete.

For example, suppose a dialog window contains a group which contains a button. A script registers an
event handler function for the c1ick event at the Window object, another handler at the group object,
and a third handler at the button object (the actual target).

When the user clicks the button, the Window object’s handler is called first (during the capture phase),
then the but ton object’s handler (during the at-target phase). Finally, ScriptUI calls the handler registered
with the group object (during the bubble phase).

If you register a handler at an ancestor object of the actual event target, you can specify the third
argument to addEventListener(), so that the ancestor’s handler responds only in the capture phase, not in
the bubbling phase. For example, the following click handler, registered with the parent dialog object,
responds only in the capture phase:

myDialog.addEventListener ("click", handleAllItems, true);

This value is false by default, so if it is not supplied, the handler can respond only in the bubbling phase
when the object’s descendent is the target, or when the object is itself the target of the event (the
at-target phase).

To distinguish which of multiple registered handlers is being executed at any given time, the event object
provides the eventPhase property, and the currentTarget property, which In the capture and bubbling
phases contains the ancestor of the target object at which the currently executing handler was
registered.
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ScriptUl supports a Flash Player, which runs the Flash application within a window in an Adobe
application. The Flash application runs ActionScript, a different implementation of JavaScript from the
ExtendScript version of JavaScript that Adobe applications run.

To open a Flash Player, add a control of type flashplayer to your ScriptUl window. A control object of this
type contains functions that allow your script to load SWF files and control movie playback. It also contains
functions that allow your Adobe application script to communicate with the ActionScript environment of
the Flash application. See “FlashPlayer control functions” on page 124.

A limited set of data types can be passed between the two scripting environments:

Number
String
Boolean
Null
undefined
Object
Array

The ActionScript class and date objects are not supported as parameter values.

In the ActionScript script for your Flash application, you must prepare for two-way communication by
providing access to the External API. Do this by importing the ExternalInterface classinto your Flash
application:

import flash.external.ExternalInterface;

The ActionScript ExternalInterface class allows you to call an ExtendScript function that has been
defined in the FlashPlayer element in the Adobe application script, and run it in the ActionScript
environment. You must define the method in your FlashPlayer element with a matching function name.

For example, in order for the SWF code to call an ExtendScript function named
myExtendScriptFunction, define a function with the name myExtendScriptFunctionasa
method of your FlashPlayer control object. There are no special requirements for function names, but
the function must take and return only data of the supported types.

You do not need to register the ExtendScript function in the ActionScript environment. Your ActionScript
script can simply call the external function using the ExternalInterface.call () method:

var res = ExternalInterface.call ("myJavaScriptFunction") ;
When the Flash Player executes the ExternalInterface call, ScriptUl looks for a function with the

same name as a method of the FlashPlayer element, and invokes it with the specified arguments. In
the context of the function, the JavaScript this object refers to the FlashPlayer object.

From the ExtendScript side, use the FlashPlayer method invokePlayerFunction() to call ActionScript
methods that have been defined within the Flash application:

result = flashElement.invokePlayerFunction ("ActionScript function name",
largl, ..., argN] );



4: User Interface Tools Automatic Layout 80

You can use the optional arguments to pass data (of supported types) to the ActionScript method.

Before you can call any ActionScript function from your Adobe application script, your Flash application
must register that function with the ExternalInterface object, as a callback from the Flash container.
To register a function, use the ExtenalInterface.addCallback () method:

public static addCallback (methodName:String, instance:0bject,
method: Function)
For example, this registers a function defined in your Adobe application script named
getActionScriptArray():

ExternalInterface.addCallback ("getActionScriptArray", this,
getActionScriptArray) ;

These examples in the Adobe Bridge and JavaScript SDK demonstrate how to use the Flash Player:

SnpQOr eat eFl ashControl . j sx  Shows how to create a Flash Player, and use it to load a play back a movie
defined in an SWF file.

H ashDeno. j sx Shows how to communicate between the Adobe application scripting
environment and the ActionScript scripting environment of the Flash
Player.

When a script creates a window and its associated Ul elements, it can explicitly control the size and
location of each element and of the container elements, or it can take advantage of the automatic layout
capability provided by ScriptUl. The automatic layout mechanism uses certain available information about
Ul elements, along with a set of layout rules, to establish a visually pleasing layout of the controlsin a
dialog, automatically determining the proper sizes for elements and containers.

Automatic layout is easier to program than explicit layout. It makes a script easier to modify and maintain,
and easier to localize for different languages. It also makes the script automatically adapt to the default
font and font size used by the host application for ScriptUl windows.

The script programmer has considerable control over the automatic layout process. Each container has an
associated layout manager object, specified in the 1ayout property. The layout manager controls the
sizes and positions of the contained elements, and also sizes the container itself.

There is a default layout manager object, or you can create a new one:

myWin.layout = new AutoLayoutManager (myWin) ;

By default, the autoLayoutManager object implements the default layout behavior. A script can modify
the properties of the default layout manager object, or create a new, custom layout manager if it needs
more specialized layout behavior. See “Custom layout manager example” on page 89.
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Child elements of a container can be organized in a single row or column, or in a stack, where the elements
overlap one other in the same region of the container, and only the top element is fully visible. This is
controlled by the container’s orientation property, which can have the value row, column, or stack.

You can nest Panel and Group containers to create more complex organizations. For example, to display
two columns of controls, you can create a panel with a row orientation that in turn contains two groups,
each with a column orientation.

Containers have properties to control inter-element spacing and margins within their edges. The layout
manager provides defaults if these are not set.

The alignment of child elements within a container is controlled by the alignChildren property of the
container, and the alignment property of the individual controls. The alignChildren property
determines an overall strategy for the container, which can be overridden by a particular child element’s
alignment value.

A layout manager can determine the best size for a child element through the element’s preferredsSize
property. The value defaults to dimensions determined by ScriptUl based on characteristics of the control
type and variable characteristics such as a displayed text string, and the font and size used to display text.

For details of how you can set these property values to affect the automatic layout, see “Automatic layout
properties” on page 81.

Note: The default font and font size are chosen differently on different platforms, and by different
applications on the same platform, so ScriptUl windows that are created the same way can appear
different in different contexts.

Your script establishes rules for the layout manager by setting the values of certain properties, both in the
container object and in the child elements. The following examples show the effects of various
combinations of values for these properties. The examples are based on a simple window containing a
StaticText, Button and EditText element, created (using Resource Specifications) as follows:

var w = new Window (
"window { \
orientation: 'row', \
st: StaticText { }, \
pb: Button { text: 'OK' }, \
et: EditText { characters:4, justify:'right' } \
bmy;

w.show () ;

Each example shows the effects of setting particular layout properties in various ways. In each window, w .
text is set so that the window title shows which property is being varied, and w. st . text is set to display
the particular property value being demonstrated.

The orientation property of a container specifies the organization of child elements within it. It can
have these values:

e row: Child elements are arranged next to each other, in a single row from left to right across the
container. The height of the container is based on the height of the tallest child element in the row, and
the width of the container is based on the combined widths of all the child elements.
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e column: Child elements are arranged above and below each other, in a single column from top to
bottom across the container. The height of the container is based on the combined heights of all the
child elements, and the width of the container is based on the widest child element in the column.

e stack: Child elements are arranged overlapping one another, as in a stack of papers. The elements
overlie one another in the same region of the container. Only the top element is fully visible. The height
of the container is based on the height of the tallest child element in the stack, and the width of the
container is based on the widest child element in the stack.

The following figure shows the results of laying out the sample window with each of these orientations:

een orientation & O 7 orientation & O 7 orientation
orientation=row [ OK ) Siertation Soalimn orientation=stack
C ok )

The alignment of child elements within a container is controlled by two properties: alignChildrenin
the parent container, and alignment in each child. The alignChildren value in the parent container
controls the alignment of all children within that container, unless it is overridden by the alignment
value set on an individual child element.

These properties use the same values, which specify alignment along one axis, depending on the

orientation of the container. You can specify an array of two of these strings, to specify alignment along

both axes. The first string specifies the horizontal value, the second specifies the vertical value. The

property values are not case-sensitive; for example, the strings FILL, Fi11,and £i111 are all valid.

Elements in a row can be aligned along the vertical axis, in these ways:

e top:The element’s top edge is located at the top margin of its container.

e bottom: The element’s bottom edge is located at the bottom margin of its container.

e center: The element is centered within the top and bottom margins of its container.

e f£i11:The element’s height is adjusted to fill the height of the container between the top and bottom
margins.

Elements in a column can be aligned along the horizontal axis, in these ways:

e left:Theelement’s left edge is located at the left margin of its container.

e right:The element’s right edge is located at the right margin of its container.

e center: The element is centered within the right and left margins of its container.

e fil1l:The element’s width is adjusted to fill the width of the container between the right and left
margins.

Elements in a stack can be aligned along either the vertical or the horizontal axis, in these ways:

e top:The element’s top edge is located at the top margin of its container, and the element is centered
within the right and left margins of its container.

e bottom: The element’s bottom edge is located at the bottom margin of its container, and the element
is centered within the right and left margins of its container.
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e left:Theelement’s left edge is located at the left margin of its container, and the element is centered
within the top and bottom margins of its container.

e right:The element’s right edge is located at the right margin of its container, and the element is
centered within the top and bottom margins of its container.

e center: The element is centered within the top, bottom, right and left margins of its container.

e fil1:The element’s height is adjusted to fill the height of the container between the top and bottom
margins., and the element’s width is adjusted to fill the width of the container between the right and
left margins.

The following figure shows the results of creating the sample window with row orientation and the
bottomand top alignment settings in the parent’s alignChildren property:

een alignChildren 8en alignChildren

alignChildren=bottom E—0k—) ARIEIEHEITIOn ol

The following figure shows the results of creating the sample window with column orientation and the
right, left,and £i11 alignment settings in the parent’s alignChildren property. Notice how in the
£i11 case, each element is made as wide as the widest element in the container:

& O MalignChild... & @ M alignChild... & O 7 alignChil...
alignChildren=left alignChildren=right alignChildren=fill
¢ ok ) C ok ) C ok )

You can override the container’s child alignment, as specified by alignChildren, by setting the
alignment property of a particular child element. The following diagram shows the result of setting
alignment to right for the EditText element, when the parent’s alignChildren value is left:

& O ) alignment=right

override alignChildren=left

€ ax )

You can set the alignment property with a two-string array instead of a single string, where the first string
is the horizontal alignment and the second is the vertical alignment. This allows you to control the
horizontal placement of children in a container with row orientation, and the vertical placement of
children in a container with column orientation.

The following figures show the results of the sample script SnpAlignElements. jsx, that demonstrates
how to specify alignment in two dimensions.

e Inthefirst, each control is centered vertically within its row, and placed at a specific horizontal position,
using an alignment value suchas ['1left', 'center'] foreach element:
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B.0.8 Horizontal alignment in rows

Demonstrate horizontal placement of elements within
groups with row arientation

left center right
left | left right
left right | right
left| fill right

e The vertical alignment example creates four columns, and places the controls within each column
along the vertical axis. It uses alignment valuessuchas ['£il1l', 'top'] to distribute controls
within the column, while still controlling the relative vertical positions:

B.60.6 Vertical alignment in columns

Demonstrate top top top top
vertical placement e -
of elements within top fill
groups with

column orientation | center

bottom

bottom  bottom  bottom  bottom

The margins property of a container specifies the number of pixels between the edges of a container and
the outermost edges of the child elements. You can set this property to a simple number to specify equal
margins, or using a Margins object, which allows you to specify different margins for each edge of the
container.

The following figure shows the results of creating the sample window with row orientation and margins of
5 and 15 pixels:

® O O margins ® OO  margins
margins=5 (__OK ) margins=15 (I.

This figure shows the results of creating the sample window with column orientation, a top margin of 0
pixels, a bottom margin of 20 pixels, and left and right margins of 15 pixels:

& O () margins
margins=15,0,15,20

 ————

I OK ]




4: User Interface Tools Automatic Layout 85

The spacing property of a container specifies the number of pixels separating one child element from its
adjacent sibling element.

This figure shows the results of creating the sample window with row orientation, and spacing of 15 and 5
pixels, respectively:

8een spacing ® O O spacing
spacing=15 £ oK ) spacing=5 ¢ OK ‘,I

This figure shows the results of creating the sample window with column orientation, and spacing of 20
pixels:

86 Ospa..

spacing=20

Each element has a preferredSize property, which is initially defined with reasonable default
dimensions for the element. The default value is calculated by ScriptUl, and is based on constant
characteristics of each type of element, and variable characteristics such as the text string to be displayed
in a button or text element.

If an element’s size property is not defined, the layout manager uses the value of preferredSize to
determine the dimensions of each element during the layout process. Generally, you should avoid setting
the preferredsize property explicitly, and let ScriptUl determine the best value based on the state of
an element at layout time. This allows you to set the text properties of your Ul elements using localizable
strings (see “Localization in ScriptUl Objects” on page 92). The width and height of each element are
calculated at layout time based on the chosen language-specific text string, rather than relying on the
script to specify a fixed size for each element.

However, a script can explicitly set the preferredSize property to give hints to the layout manager
about the intended sizes of elements for which a reasonable default size is not easily determined, such as
an IconButton element that has no initial image to measure.

You can also set a maximum and/or minimum size value for a control, that limit how it can be resized.
There is a default maximum size that prevents automatic layout from creating elements larger than the
screen.

You can explicitly resize the controls in a window to fit the current text contents, or after the window is
resized by the user, using the resize() method of the layout object.
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You can easily create more complex arrangements by nesting Group containers within Panel containers
and other Group containers.

Many dialogs consist of rows of information to be filled in, where each row has columns of related types of
controls. For instance, an edit field is typically in a row next to a static text label that identifies it, and a
series of such rows are arranged in a column. This example (created using Resource Specifications) shows a
simple dialog in which a user can enter information into two Edit Text fields, each arranged in a row with
its StaticText label. To create the layout, a Panel with a column orientation contains two Group
elements with row orientation. These groups contain the control rows. A third Group, outside the panel,
contains the row of buttons.

res =
"dialog { \
info: Panel { orientation: 'column', \
text: 'Personal Info', \
name: Group { orientation: 'row', \
s: StaticText { text:'Name:' }, \
e: EditText { characters: 30 } \
oA
addr: Group { orientation: 'row', \
s: StaticText { text:'Street / City:' }, \
e: EditText { characters: 30 } \
P
oA
buttons: Group { orientation: 'row', \
okBtn: Button { text:'OK', properties:{name:'ok'} }, \
cancelBtn: Button { text:'Cancel',6 properties:{name:'cancel'} } \
A
}n,.
win = new Window (res) ;
win.center () ;
win.show () ;

Personal Info

MName:

Street [ City:

(— oK 3 (" Cancel )

In this simplest example, the columns are not vertically aligned. When you are using fixed-width controls
in your rows, a simple way to get an attractive alignment of the Stat icText labels for your EditText
fields is to align the child rows in the Panel to the right of the panel. In the example, add the following to
the Panel specification:

info: Panel { orientation: 'column', alignChildren:'right', \
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This creates the following result:

Personal Info

Name:

Street [ City:

(—Gl(—)( Cancel :1

Suppose now that you need two panels, and want each panel to have the same width in the dialog. You
can specify this at the level of the dialog window object, the parent of both panels. Specify
alignChildren="'£1i11"', which makes each child of the dialog match its width to the widest child.

res =
"dialog { alignChildren: 'fill', \
info: Panel { orientation: 'column', alignChildren:'right', \
text: 'Personal Info', \
name: Group { orientation: 'row', \
s: StaticText { text:'Name:' }, \
e: EditText { characters: 30 } \
FA
oA
workInfo: Panel { orientation: 'column', \
text: 'Work Info', \
name: Group { orientation: 'row', \
s: StaticText { text:'Company name:' }, \
e: EditText { characters: 30 } \
A
b
buttons: Group { orientation: 'row',6 alignment: 'right', \
okBtn: Button { text:'OK', properties:{name:'ok'} }, \
cancelBtn: Button { text:'Cancel',6 properties:{name:'cancel'} } \
A
1

win = new Window (res); win.center(); win.show() ;

— Personal Info

Name:

— Work Info

Company name:

' d Ny
€ oKk ( cancel )

To make the buttons to appear at the right of the dialog, the but tons group overrides the £111
alignment of its parent (the dialog), and specifies alignment="'right'.
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Many dialogs need to present different sets of information based on the user selecting some option within
the dialog. You can use the stack orientation to present different views in the same region of a dialog.

A stack orientation of a container places child elements so they are centered in a space which is wide
enough to hold the widest child element, and tall enough to contain the tallest child element. If you
arrange groups or panels in such a stack, you can show and hide them in different combinations to display
a different set of controls in the same space, depending on other choices in the dialog.

For example, this dialog changes dynamically according to the user’s choice in the DropDownList.

Personal Info i¢] Work Info i:]

Name: Company name:

€ ok ) ( cancel ) € ok ) ( cancel )

The following script creates this dialog. It compresses the “Personal Info” and “Work Info” panels from the
previous example into a single Panel that has two Groups arranged in a stack. A DropDownIList allows
the user to choose which set of information to view. When the user makes a choice in the list, its
onChange function shows one group, and hides the other.

res =
"dialog { \
whichInfo: DropDownList { alignment:'left' }, \
allGroups: Panel { orientation:'stack', \
info: Group { orientation: 'column', \
name: Group { orientation: 'row', \
s: StaticText { text:'Name:' }, \
e: EditText { characters: 30 } \
FA
oA
workInfo: Group { orientation: 'column', \
name: Group { orientation: 'row', \
s: StaticText { text:'Company name:' }, \
e: EditText { characters: 30 } \
FA
oA
oA

buttons: Group { orientation: 'row', alignment: 'right', \
okBtn: Button { text:'OK', properties:{name:'ok'} }, \
cancelBtn: Button { text:'Cancel',6 properties:{name:'cancel'} } \
P
IR
win = new Window (res) ;
win.whichInfo.onChange = function () {
if (this.selection != null) {
for (var g = 0; g < this.items.length; g++)
this.items[g] .group.visible = false; //hide all other groups
this.selection.group.visible = true;//show this group
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var item = win.whichInfo.add ('item', 'Personal Info');
item.group = win.allGroups.info;
item = win.whichInfo.add ('item', 'Work Info');

item.group = win.allGroups.workInfo;
win.whichInfo.selection = win.whichInfo.items[0] ;
win.center () ;

win.show () ;

This script creates a dialog almost identical to the one in the previous example, except that it defines a
layout-manager subclass, and assigns an instance of this class as the 1ayout property for the last Group
in the dialog. (The example also demonstrates the technique for defining a reusable class in JavaScript.)

This script-defined layout manager positions elements in its container in a stair-step fashion, so that the
buttons are staggered rather than in a straight line.

Personal Info | :]

Name:

ok )

[ Cancel )

/* Define a custom layout manager that arranges the children
*% of 'container' in a stair-step fashion.*/

function StairStepButtonLayout (container) { this.initSelf (container); }

// Define its 'method' functions
function SSBL_initSelf (container) { this.container = container; }

function SSBL_ layout () ({
var top = 0, left = 0;
var width;
var vspacing = 10, hspacing = 20;
for (i = 0; 1 < this.container.children.length; i++) {
var child = this.container.children([i];
if (typeof child.layout != "undefined")
// If child is a container, call its layout method
child.layout.layout () ;
child.size = child.preferredSize;
child.location = [left, topl;
width = left + child.size.width;
top += child.size.height + vspacing;
left += hspacing;

}

this.container.preferredSize = [width, top - vspacing];
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// Attach methods to Object's prototype
StairStepButtonLayout.prototype.initSelf = SSBL initSelf;
StairStepButtonLayout.prototype.layout = SSBL layout;

// Define a string containing the resource specification for the controls
res =
"dialog { \
whichInfo: DropDownList { alignment:'left' }, \
allGroups: Panel { orientation:'stack', \
info: Group { orientation: 'column', \
name: Group { orientation: 'row', \
s: StaticText { text:'Name:' }, \
e: EditText { characters: 30 } \
A
oA
workInfo: Group { orientation: 'column', \
name: Group { orientation: 'row', \
s: StaticText { text:'Company name:' }, \
e: EditText { characters: 30 } \
FA
oA
oA
buttons: Group { orientation: 'row', alignment: 'right', \
okBtn: Button { text:'OK', properties:{name:'ok'} }, \
cancelBtn: Button { text:'Cancel',6 properties:{name:'cancel'} } \
FA
P
// Create window using resource spec
win = new Window (res) ;
// Create list items, select first one
win.whichInfo.onChange = function () {
if (this.selection != null) {
for (var g = 0; g < this.items.length; g++)
this.items[g] .group.visible = false;
this.selection.group.visible = true;

}

var item = win.whichInfo.add ('item', 'Personal Info');
item.group = win.allGroups.info;
item = win.whichInfo.add ('item', 'Work Info');

item.group = win.allGroups.workInfo;
win.whichInfo.selection = win.whichInfo.items[0] ;

// Override the default layout manager for the 'buttons' group
// with custom layout manager
win.buttons.layout = new StairStepButtonLayout (win.buttons) ;

win.center () ;
win.show() ;

When a script creates a Window object and its elements and shows it the first time, the visible Ul-platform
window and controls are created. At this point, if no explicit placement of controls was specified by the
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script, all the controls are located at [0, 0] within their containers, and have default dimensions. Before the
window is made visible, the layout manager’s 1ayout method is called to assign locations and sizes for all
the elements and their containers.

The default AutoLayoutManager’s 1ayout method performs these steps when invoked during the
initial call to a window object’s show method:

1.

Read the bounds property for the managed container; if undefined, proceed with auto layout. If
defined, assume that the script has explicitly placed the elements in this container, and cancel the
layout operation (if both the location and size property have been set, this is equivalent to setting
the bounds property, and layout does not proceed).

Determine the container’s margins and inter-element spacing from its margins and spacing
properties, and the orientation and alignment of its child elements from the container’s orientation
and alignChildren properties. If any of these properties are undefined, use default settings
obtained from platform and Ul framework-specific default values.

Enumerate the child elements, and for each child:

e If the child is a container, call its layout manager (that is, execute this entire algorithm again for the
container).

e Readits alignment property; if defined, override the default alignment established by the parent
container with its alignChildren property.

e Readits size property: if defined, use it to determine the child’s dimensions. If undefined, read its
preferredSize property to get the child’s dimensions. Ignore the child’s location property.

All the per-child information is collected for later use.

Based on the orientation, calculate the trial location of each child in the row or column, using
inter-element spacing and the container’s margins.

Determine the column, row, or stack dimensions, based on the dimensions of the children.

Using the desired alignment for each child element, adjust its trial location relative to the edges of its
container.

Set the bounds property for each child element.

Set the container’s preferredSize property, based on the margins and dimensions of the row or
column of child elements.

The following restrictions apply to the automatic layout mechanism:

e The default layout manager does not attempt to lay out a container that has a defined bounds

property. The script programmer can override this behavior by defining a custom layout manager for
the container.

e The layout mechanism does not track changes to element sizes after the initial layout has occurred. The

script can initiate another layout by calling the layout manager’s 1ayout method, and can force the
manager to recalculate the sizes of all child containers by passing the optional argument as true.
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For portions of your user interface that are displayed on the screen, you may want to localize the displayed
text. You can localize the display strings in any ScriptUl object simply and efficiently, using the global
localize function. This function takes as its argument a localization object containing the localized
versions of a string.

For complete details of this ExtendScript feature, see “Localizing ExtendScript Strings” on page 206.

A localization object is a JavaScript object literal whose property names are locale names, and whose
property values are the localized text strings. The locale name is an identifier as specified in the ISO 3166
standard. In this example, a bt nText object contains localized text strings for several locales. This object
supplies the text for a But ton to be added to a window w:

btnText = { en: "Yes", de: "Ja", fr: "Oui" };
bl = w.add ("button", undefined, localize (btnText)) ;

The 1ocalize function extracts the proper string for the current locale. It matches the current locale and
platform to one of the object’s properties and returns the associated string. On a German system, for
example, the property de provides the string "Ja".

When your script uses localization to provide language-appropriate strings for Ul elements, it should also
take advantage of the Automatic Layout feature. The layout manager can determine the best size for each
Ul element based on its localized text value, automatically adjusting the layout of your script-defined
dialogs to allow for the varying widths of strings for different languages.

The 1localize function allows you to include variables in the string values. Each variable is replaced with
the result of evaluating an additional argument. For example:
today = {
en: "Today is %1/%2.",
de: "Heute ist der %2.%1."
Vi
d = new Date() ;
Window.alert (localize (today, d.getMonth()+1l, d.getDate()));

If you do not need variable replacement, you can use automatic localization. To turn on automatic
localization, set the global value:

$.localization=true
When it is enabled, you can specify a localization object directly as the value of any property that takes a
localizable string, without using the 1ocalize function. For example:

btnText = { en: "Yes", de: "Ja", fr: "Oui" };

bl = w.add ("button", undefined, btnText) ;
The localize function always performs its translation, regardless of the setting of the $.1ocalize
variable. For example:

//0nly works if the $.localize=true
bl = w.add ("button", undefined, btnText) ;
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//Always works, regardless of $.localize value
bl = w.add ("button", undefined, localize (btnText)) ;

If you need to include variables in the localized strings, use the 1ocalize function.
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ScriptUl is a component that works with the ExtendScript JavaScript interpreter to provide JavaScript
programs with the ability to create and interact with user interface elements. It provides an object model
for windows and Ul control elements within an application.

This section provides the details of the ScriptUIl classes and objects with their properties, methods, and

creation parameters.

e ScriptUI Class
e Window Class
e Window Object
e Control Objects
e UlEvent Object

e Graphic Customization Objects

e LayoutManager Object

The globally available scriptUI class provides central information about the ScriptUl module. This

object is not instantiable.

Al'i gnrent

appl i cati onFont s

conpatability

coreVer si on

Object

Object

Object

String

Collects the enumerated values that can be used in the
alignment and alignChildren properties of controls and
containers. For example:

nyQoup. al i gnment = [ScriptU. A ignment. LEFT,
ScriptU. Aignnent. TGP

Read only. Values are:

Collects the enumerated values that specify the default
application fonts. The available fonts vary according to the
application and system configuration.

An object whose properties are the names of compatability
modes supported by the host application. For example, the
presence of Scri pt U . conpat abi | i ty. sulPanel Coor di nat es
means that the application allows backward compatibility with
the coordinate system of Panel elements in ScriptUl version 1.

The internal core version number of the ScriptUl components.
Read only.
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FontStyl e String
f r amewor kNane String
version String

Collects the enumerated values that can be used as the style
argument to the Scri pt U . newFont() method. For example:

var font = ScriptU.newront ('Helvetica",
ScriptU. Font Styl e. BALD)

Read only. Values are:
REGULAR
BALD

I TALIC
BCLD TALI C

The name of the user-interface framework with which this
ScriptUl component is compatible. Read only.

The main version number of the ScriptUl component
framework. Read only.

get Resour ceText ()
ScriptU . get Resour ceText (text)

text The text to match.

Finds and returns the resource for a given text string from the host application’s resource data. If no
string resource matches the given text, the text itself is returned.

Returns a String.

newFont ()
ScriptU.newont ( nane, style, size);
nane The font or font family name string.
style The font style string or an enumerated value from Scri pt U . FontStyle.
si ze The font size in points, a number.

Creates a new font object for use in text controls and titles.

Returns a ScriptUIFont object.

new nmage()
ScriptU.new nage ( nornal, disabled, pressed, rollover );
nor nal The resource name or path to the image to use for the normal state.
di sabl ed The resource name or path to the image to use for the disabled state.
pressed The resource name or path to the image to use for the pressed state.
rol I over The resource name or path to the image to use for the rollover state.

Creates a new image object for use in controls that can display images, loading the associated
images from the specified resources or image files.

Returns a ScriptUllmage object.
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The window class defines these static properties and functions. Window instances created with new
Window () do not have these properties and functions defined.

f r amewor kNane String Deprecated. Use Scri pt U . frameworkName instead.

ver si on String Deprecated. Use Scri pt U . version instead.

Access these function through the class. For example:

Window.alert (“Notification to user”) ;

al ert ()
Wndow al ert (nessage[, title, erroricon]);

nmessage The string for the displayed message.

title Optional. A string to appear as the title of the dialog, if the platform supports a
title. Mac OS does not support titles for alert dialogs. The default title string is
“Script Alert.”

errorlcon Optional. When true, the platform-standard alert icon is replaced by the

platform-standard error icon in the dialog. Default is false.

Displays a platform-standard dialog containing a short message and an OK button.

Returns undef i ned

confirnm()
W ndow. confirm (nessage[, noAsO¥l t ,title]);
ressage The string for the displayed message.
noAsDY I t Optional. When true, the No button is the default choice, selected when the

user types ENTER. Default is false, meaning that Yes is the default choice.

title Optional. A string to appear as the title of the dialog, if the platform supports a
title. Mac OS does not support titles for confirmation dialogs. The default title
string is “Script Alert”

Displays a platform-standard dialog containing a short message and two buttons labeled Yes and
No.

Returns true if the user clicked Yes, false if the user clicked No.
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fi nd()

Wndow. fi nd (resour ceNane)
Wndow find (type, title)

r esour ceNane The name of a predefined resource available to JavaScript in the current
application.

type Optional. The window type (see "Window object constructor” on page 97) used
if there is more than one window with the same title. Can be nul | or the empty
string.

title The window title.

Use this method to find an existing window. This includes windows already created by a script, and
windows created by the application (if the application supports this case).

Note: Not supported in all ScriptUl implementations.

Returns a W ndowobject found or generated from the resource, or nul | if no such window or
resource exists.

pr onpt ()
W ndow. pronpt (nessage, preset[, title]);
nmessage The string for the displayed message.
preset The initial value to be displayed in the text edit field.
title Optional. A string to appear as the title of the dialog. In Windows, this appears

in the window's frame; in Mac OS it appears above the message. The default
title string is “Script Prompt.”

Displays a modal dialog that returns the user’s text input.

Returns the value of the text edit field if the user clicked OK, nul | if the user clicked Cancel.

The constructor creates and returns a new Window object, or nul1 if window creation failed.

new Window (type [, title, bounds, {creation properties}]);

type The window type. The value is:

di al og: Creates a modal dialog.

pal et t e: Creates a modeless dialog, also called a floating palette. (Not
supported by Photoshop CS3.)

wi ndow: Creates a simple window that can be used as a main window for
an application. (Not supported by Photoshop CS3.)

This argument can be a ScriptUIl resource specification; in this case, all other
arguments are ignored. See “Resource Specifications” on page 73.

title Optional. The window title. A localizable string.

bounds Optional. The window’s position and size.
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creation_properties

Optional. An object that can contain any of these properties:

resi zeabl e: When true, the window can be resized by the user. Default is

false.
sulPanel Coor di nat es: Photoshop only. When true, the child panels of

this window automatically adjust the positions of their children for
compatability with Photoshop CS (in which the vertical coordinate
was measured from outside the frame). Default is false. Individual
panels can override the parent window’s setting.

cl oseBut t on: When true, the title bar includes a button to close the
window, if the platform and window type allow it. When false, it does
not. Default is true. Not used for dialogs.

maxi m zeBut t on: When true, the title bar includes a button to expand the
window to its maximum size (typically, the entire screen), if the
platform and window type allow it. When false, it does not. Default is
false for type pal et t e, true for type wi ndow Not used for dialogs.

m ni ni zeBut t on: When true, the title bar includes a button to minimize or
iconify the window, if the platform and window type allow it. When
false, it does not. Default is false for type pal et t e, true for type wi ndow
Main windows cannot have a minimize button in Mac OS. Not used for
dialogs.

i ndependent : When true, a window of type wi ndowis independent of
other application windows, and can be hidden behind them in
Windows. In Mac OS, has no effect. Default is false.

All types of Ul elements, including windows, containers, and controls, share many of the same properties,
although some have slightly different meanings for different types of objects. The following table
summarizes which properties are used in which object types.
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= - - | - v | =
Property = o U @ U O uw o 8 E S5 5 & & w wn o
active X X X X X X X |X X X X |X X /X
al i gnChi l dren X X X
al i gnnent X X X X X |X X X X X X X X X X X |X
bounds X X X X X X X X X |x X X X |X |XxX X |X
cancel B enent X
characters X X
checked X
children X X /X X X |X X X X X X X X |X X X X
def aul t El enent X
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3 e
T:' a; c © <]
: 8 3sEf . e%335 %
2 3 § ¥ 32 :aa g8 &5z 5 e
€ € 0o ¥ 9 o E W £ m© ¥ ¥ o6 T 2 v ®B I
Property £ 8§ 62558 8c S ES 3 & & 857 8k
enabl ed X X X X X |X X X X X X X X X X X X
expanded X
f raneBounds X
franeLocat i on X
franeS ze X
gr aphi cs X X X X X |X X X X X X X X X X X |X
hel pTi p X X X X X X X X X |x X X X X X X /X
i con X X X
i mage X
i ndex X
itens X X X
itens ze X X X
junpdel ta X
justify X X X X X
| ayout X X X
| ocati on X X X X X |X X X X X X X X X X X /X
nar gi ns X X X
maxi nunsi ze X X X X X X /X X |X X /X X X X X X X
naxval ue X X | X
m ni nunsi ze X X |X X X X X X X X |x X X |X |[X X |X
m nval ue X X | X
orientation X X X
par ent X X X X X X X X /X |X X X X X X X |x X
preferredS ze X X /X X /X X |X X |x X /X X X /X X X X
properties X X X /X X X X X /X X X X X X |X X 'x x
resi zeabl e X
sel ect ed X

sel ection X X X
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short cut Key X X X X X X /X X X X |X X X
si ze X X X X X |X X X X X X X X |X X X X
spaci ng X X X
stepdel ta X
t ext X | X X | X X X X X
t ext sel ecti on X
type X X X X X |X X /X |XxX X X /X X X |x x x X
val ue X X X | X |X
visible X X X X X X X X X |x X X X |X |X X /X
Wi ndow X X /X X X X /X X |x x |x X X /X X X X
wi ndowBounds X X X X X X X X X |x X X X X X X /X
The following element properties apply specifically to Window elements:
active Boolean When true, the object is active, false otherwise. Set to true to

make a given control or dialog active.

e A modal dialog that is visible is by definition the active
dialog.
e An active palette is the front-most window.

e An active control is the one with focus—that is, the one
that accepts keystrokes, or in the case of a But t on, be
selected when the user types RETURN or ENTER.

cancel B erent Object For a window of type di al og, the control to notify when a
user types the Esc key. By default, looks for a but t on whose
name or text is "cancel " (case disregarded).

def aul t El enent Object For a window of type di al og, the control to notify when a
user types the ENTER key. By default, looks for a but t on whose

name or text is "ok" (case disregarded).

f raneBounds Bounds A Bounds object for the boundaries of the Window’s frame in
screen coordinates. The frame consists of the title bar and
borders that enclose the content region of a window,
depending on the windowing system. Read only.
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franeLocati on

franeS ze
maxi m zed
m ni m zed

short cut Key

Point

Dimension

Boolean
Boolean

String

A Point object for the location of the top left corner of the
Window's frame. The same as [ f r aneBounds. x,

frameBounds. y] . Set this value to move the window frame to
the specified location on the screen. The f r aneBounds value
changes accordingly.

A Dimension object for the size and location of the Window’s
frame in screen coordinates. Read only.

When true, the window is expanded.
When true, the window is minimized or iconified.

The key sequence that invokes this window’s onShortcutKey
callback (in Windows only).

The following table shows properties that apply to Window objects and container objects (controls of type

panel and group).

al i gnChi |l dren

String, or Array of 2

Strings

Tells the layout manager how unlike-sized children of a
container should be aligned within a column or row. Order
of creation determines which children are at the top of a
column or the left of a row; the earlier a child is created, the
closer it is to the top or left of its column or row.

If defined, al i gnnent for a child element overrides the
al i gnChi | dr en setting for the parent container.

For a single string value, allowed values depend on the
orientationvalue. Fororientation=row

top

bot t om

center (default)

fill
For ori ent ati on=col um:

| eft

ri ght

center (default)

fill
For ori ent at i on=st ack:

top

bot t om

left

ri ght

center (default)

fill
For an array value, the first string element defines the
horizontal alignment and the second element defines the
vertical alignment. The horizontal alignment value must be
oneofleft,right,center orfill.The vertical alignment
value must be one of t op, bot t om center, orfill.

Values are not case sensitive.
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al i gnrrent String, or Array of 2 Applies to child elements of a container. If defined, this
Strings value overrides the al i gnthi | dr en setting for the parent
container.

For a single string value, allowed values depend on the
orientationvalue. Fororientation=row

top

bot t om

center (default)

fill
For ori ent ati on=col um:

left

ri ght

center (default)

fill
For ori ent at i on=st ack:

top

bot t om

| eft

ri ght

center (default)

fill
For an array value, the first string element defines the
horizontal alignment and the second element defines the
vertical alignment. The horizontal alignment value must be
oneofleft,right,center orfill.The vertical alignment
value must be one of t op, bot t om cent er, orfill.

Values are not case sensitive.

bounds Bounds A Bounds object for the boundaries of the window's
drawable area in screen coordinates. Compare
frameBounds. Read only.

children Array of Object The collection of Ul elements that have been added to this
container (wi ndow panel , gr oup). An array indexed by
number or by a string containing an element’s nare. The
| engt h property of this array is the number of child elements
for container elements, and is zero for controls. Read only.

gr aphi cs Graphics A ScriptUIGraphics object that can be used to customize the
window’s appearance, in response to the onDraw event.

| ayout LayoutManager A LayoutManager Object for a container (wi ndow panel ,
gr oup). The first time a container object is made visible,
ScriptUl invokes this layout manager by calling its | ayout
function. Default is an instance of the Layout Manager class
that is automatically created when the container element is
created.

| ocation Point A Point object for the location of the top left corner of the
Window’s drawable area, or the top left corner of the frame
for a panel. The same as [ bounds. x, bounds. y] .
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nmar gi ns

maxi munsi ze

m ni munsi ze

orientation

par ent

preferredS ze

properties

si ze

spaci ng

t ext

Margins

Dimension

Dimension

String

Object

Dimension

Object

Dimension

Number

String

A Margins object describing the number of pixels between
the edges of this container and the outermost child
elements. You can specify different margins for each edge of
the container. The default value is based on the type of
container, and is chosen to match the standard Adobe Ul
guidelines.

A Dimension object for the largest rectangle to which the
window can be resized, used in automatic layout and
resizing.

A Dimension object for the smallest rectangle to which the
window can be resized, used in automatic layout and
resizing.

How elements are organized within this container.
Interpreted by the layout manager for the container. The
default LayoutManager Object accepts the (case-insensitive)
values:

row

col um

st ack
The default orientation depends on the type of container.
For W ndowand Panel , the default is col um, and for G oup
the default is r ow

The allowed values for the container’s al i gnthi | dren and its
children’s al i gnnent properties depend on the orientation.

The immediate parent object of this element, a wi ndow
panel or group. The value is nul | for Wndowobjects. Read
only.

A Dimension object for the preferred size of the window,
used in automatic layout and resizing.

An object that contains one or more creation properties of
the container (properties used only when the element is
created).

A Dimension object for the current size and location of a
group or panel element, or of the content area of a window.

The number of pixels separating one child element from its
adjacent sibling element. Because each container holds only
a single row or column of children, only a single spacing
value is needed for a container. The default value is based
on the type of container, and is chosen to match standard
Adobe Ul guidelines.

The title, label, or displayed text. Does not apply to
containers of type gr oup. This is a localizable string: see
“Localization in ScriptUl Objects” on page 92.
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visible Boolean When true, the element is shown, when false it is hidden.

When a container is hidden, its children are also hidden, but
they retain their own visibility values, and are shown or
hidden accordingly when the parent is next shown.

wi ndow Window The top-level parent window of this container, a Window
Object.
wi ndowBounds Bounds A Bounds object for the size and location of this container

relative to its top-level parent window.

These functions are defined for Window instances, and as indicated for container objects of type Panel

and Group.
add()
w ndowQ Cont ai ner @yj . add (type [, bounds, text, { creation props>} ]);
type The control type. See “Control types and creation parameters” on page 109.
bounds Optional. A bounds specification that describes the size and position of the new
control or container, relative to its parent. See Bounds object for specification
formats.
If supplied, this value creates a new Bounds object which is assigned to the new
object’s bounds property.
text Optional. String. Initial text to be displayed in the control as the title, label, or

creation_props

contents, depending on the control type. If supplied, this value is assigned to
the new object’s t ext property.

Optional. Object. The properties of this object specify creation parameters,
which are specific to each object type. See “Control types and creation
parameters” on page 109.

Creates and returns a new control or container object and adds it to the children of this window or

container.

Returns the new object, or nul | if unable to create the object.
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addEvent Li st ener ()
w ndow(yj . addEvent Li st ener (event Nane, handl er[, capturePhase]);

event Nane The event name string.

handl er The function to register for the specified event in this target. This can be the
name of a function defined in the extension, or a locally defined handler
function to be executed when the event occurs. A handler function takes one
argument, the UIEvent Object. See “Registering event listeners for windows or
controls” on page 76.

capt ur ePhase Optional. When true, the handler is called only in the capturing phase of the
event propagation. Default is false, meaning that the handler is called in the
bubbling phase if this object is an ancestor of the target, or in the at-target
phase if this object is itself the target.

Registers an event handler for a particular type of event occurring in this window.

Returns undef i ned.

center ()
wi ndowQj . center ([ w ndow)

wi ndow Optional. A Window Object.

Centers this window on the screen, or with respect to another specified window.

Returns undef i ned.

cl ose()
w ndowyj . cl ose ([result])

result Optional. A number to be returned from the showmethod that invoked this
window as a modal dialog.

Closes this window. If an onClose callback is defined for the window, calls that function before
closing the window.

Returns undef i ned.

di spat chEvent ()
w ndow(yj . di spat chEvent (event Q)

event Gbj A UlEvent Object.

Simulates the occurrence of an event in this target. A script can create a UIEvent Object for a specific
event and pass it to this method to start the event propagation for the event.

Returns false if any of the registered listeners that handled the event called the event object’s
preventDefault() method, true otherwise.

hi de()
Wi ndowa; . hi de()

Hides this window. When a window is hidden, its children are also hidden, but when it is shown
again, the children retain their own visibility states.

For a modal dialog, closes the dialog and sets its result to 0.

Returns undef i ned.
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not i fy()
w ndowyj . noti fy([event])

event Optional. The name of the window event handler to call. One of:

ond ose
onhMbve
onMvi ng
onResi ze
onResi zi ng
onShow

Sends a notification message, simulating the specified user interaction event. For example, to
simulate a dialog being moved by a user:

nyD g. noti fy("onMove")
Returns undef i ned.

renove()

wi ndowQ Cont ai ner Qoj . r enove( i ndex)
wi ndowQ Cont ai ner Cbj . r enove( t ext)
wi ndowQ Cont ai ner Qoj . r enove( chi | d)

i ndex The child control to remove, specified by 0-based index, t ext value, or as a
t ext i

control object.
child )

Removes the specified child control from this window’s or container’s chi I dr en array. No error
results if the child does not exist.

Returns undef i ned.

removeAl | ()
wi ndowQ Cont ai ner Gbj . renoveA | ()

Removes all items from the window’s or container’s chi | dr en array.

Returns undef i ned.

r enoveEvent Li st ener ()
w ndow(yj . addEvent Li st ener (event Nane, handl er[, capturePhase]);

event Nane The event name string.
handl er The function that was registered to handle the event.
capt ur ePhase Optional. Whether the handler was to respond only in the capture phase.

Unregisters an event handler for a particular type of event occurring in this window. All arguments
must be identical to those that were used to register the event handler.

Returns undef i ned.
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show()
wi ndowQj . show()

Shows this window, container, or control. If an onShow callback is defined for a window, calls that
function before showing the window.

When a window or container is hidden, its children are also hidden, but when it is shown again, the
children retain their own visibility states.

For a modal dialog, opens the dialog and does not return until the dialog is dismissed. If it is
dismissed via the close() method, this method returns any resul t value passed to that method.
Otherwise, returns 0.

The following callback functions can be defined to respond to events in windows. To respond to an event,
define a function with the corresponding name in the W ndowinstance. These callbacks are not available
for other container types (controls of type panel or group).

Callback Description

ond ose Called when a request is made to close the window, either by an explicit call to the
close() function or by a user action (clicking the OS-specific close icon in the title bar).

The function is called before the window actually closes; it can return false to cancel
the close operation.

onDr aw Called when a container or control is about to be drawn. Allows the script to modify
or control the appearance, using the control’s associated ScriptUIGraphics object.
Handler takes one argument, a DrawState object.

onhMbve Called when the window has been moved.

onMovi ng Called while a window in being moved, each time the position changes. A handler
can monitor the move operation.

onResi ze Called when the window has been resized.

onResi zi ng Called while a window is being resized, each time the height or width changes. A
handler can monitor the resize operation.

onshort cut Key | (In Windows only) Called when a shortcut-key sequence is typed that matches the
shortcutKey value for this window.

onShow Called when a request is made to open the window using the show() method, before
the window is made visible, but after automatic layout is complete. A handler can
modify the results of the automatic layout.
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Use the add method to create new containers and controls. The add method is available on window and
container (panel and group) objects. (See also add() for dropdownlist and listbox controls.)

add()
container@yj.(type [, bounds, text, { creation props>1} ]);
type The control type. See “Control types and creation parameters” on page 109.
bounds Optional. A bounds specification that describes the size and position of the new
control or container, relative to its parent. See Bounds object for specification
formats.

If supplied, this value creates a new Bounds object which is assigned to the new
object’s bounds property.

text Optional. String. Initial text to be displayed in the control as the title, label, or
contents, depending on the control type. If supplied, this value is assigned to
the new object’s t ext property.

creation_props Optional. Object. The properties of this object specify creation parameters,
which are specific to each object type. See “Control types and creation
parameters” on page 109.

Creates and returns a new control or container object and adds it to the children of this window or
container.

Returns the new object, or nul | if unable to create the object.
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The following keywords can be used in string literals as the type specifier for the add method, available
on Window and container (Panel and Group) objects. The class names can be used in resource
specifications to define controls within a container element (Window, Panel, or Group).

All types of controls, including containers, have an optional creation parameter name that allows you to
give the object a unique name.

Type keyword Class name Description

button But t on A pushbutton containing a mouse-sensitive text string. Calls the
onClick callback if the control is clicked or if its notify() method is
called.

To add to a window w:

w add (“button” [, bounds, text, {creation_properties}]);

bounds: Optional. The control’s position and size.

t ext: Optional. The text displayed in the control.

creat i on_pr operti es:Optional. An object that contains any of the
following properties:

narme: A unique name for the control. For a modal dialog, the

special name “ok” makes this defaultElement, and the special
name “cancel” makes this the cancelElement of the parent
dialog.

checkbox Checkbox A dual-state control showing a box with a checkmark when val ue is
true, empty when val ue is false. Calls the onClick callback if the
control is clicked or if its notify() method is called.

To add to a window w:

w add (“checkbox” [, bounds, text, {creation_properties}]);

bounds: Optional. The control’s position and size.
text: Optional. The text displayed in the control.
creat i on_properti es:Optional. An object that contains any of the
following properties:
name: A unique name for the control.

dropdownl i st | DropDownLi st | A drop-down list with zero or more items. Calls the onChange
callback if the item selection is changed by a script or the user, or if
the object’s notify() method is called.

To add to a window w:

w add ("dropdownlist", bounds [, itens,
{creation _properties}]);

bounds: The control’s position and size.

i t ens: Optional. Supply this argument or the
creat i on_properties argument, not both. An array of strings
for the text of each list item. A Li st | t emobject is created for
each item. An item with the text string "-" creates a separator
item.
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Type keyword Class name

Description

dr opdownl i st
(cont’d)

edi tt ext Edi t Text

f1 ashpl ayer Fl ashPl ayer

creation_properties: Optional. Supply this argument or the

i t ens argument, not both. This form is most useful for
elements defined using Resource Specifications. An object
that contains the following property:

name: A unique name for the control.

i tens: An array of strings for the text of each list item. ALi st1tem
object is created for each item. An item with the text string " -"
creates a separator item.

An editable text field that the user can change. Calls the onChange
callback if the text is changed and the user types ENTER or the control
loses focus, or if its notify() method is called. Calls the onChanging
callback when any change is made to the text. The t ext sel ecti on
property contains currently selected text.

To add to a window w:

w add (“edittext” [, bounds, text, {creation properties}]);

bounds: Optional. The control’s position and size.
text: Optional. The text displayed in the control.
creat i on_properti es:Optional. An object that contains any of the
following properties:
nane: A unigque name for the control.
mul ti | i ne: When false (the default), the control accepts a single
line of text. When true, the control accepts multiple lines, in
which case the text wraps within the width of the control.
readonl y: When false (the default), the control accepts text
input. When true, the control does not accept input but only
displays the contents of the t ext property.
noecho: When false (the default), the control displays input text.
When true, the control does not display input text (used for
password input fields).
ent er KeySi gnal snChange: When false (the default), the control
signals an onChange event when the editable text is changed
and the control loses the keyboard focus (that is, the user tabs
to another control, clicks outside the control, or types ENTER).
When true, the control only signals an onChange event when
the editable text is changed and the user types ENTER; other
changes to the keyboard focus do not signal the event.

A control that contains a Flash Player, which can load and play Flash
movies stored in SWF files.

The ScriptUl FlashPlayer element runs the Flash application within an
Adobe application. The Flash application runs ActionScript, a
different implementation of JavaScript from the ExtendScript version
of JavaScript that Adobe applications run.

A control object of this type contains functions that allow your script
to load SWF files, control movie playback, and communicate with the
ActionScript environment. See “FlashPlayer control functions” on

page 124.
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Type keyword Class name

Description

f1ashpl ayer

(cont’d)

group Q oup

i conbut t on | conBut t on
i mage | mage

To add to a window w:

w add (“flashplayer” [, bounds, {creation properties}]);

bounds: Optional. The control’s position and size.
creat i on_properti es:Optional. An object that contains any of the
following properties:
name: A unique name for the control.

A container for other controls. Containers have additional properties
that control the children; see “Container properties” on page 101.
Hiding a group hides all its children. Making it visible makes visible
those children that are not individually hidden.

To add to a window w:

w add (“group” [, bounds, {creation_properties}]);

bounds: Optional. The element’s position and size.
creat i on_properti es:Optional. An object that contains any of the
following properties:
name: A unique name for the control.

A mouse-sensitive pushbutton containing an icon. Calls the onClick
callback if the control is clicked or if its notify() method is called.

To add to a window w:

w add (“iconbutton” [, bounds, icon,
{creation_properties}]);

bounds: Optional. The control’s position and size.

i con: Optional. The named resource for the icon or family of icons
displayed in the button control, or a pathname or File Object
for an image file. Images must be in PNG format.

creati on_properties:Optional. An object that contains the
following property:

name: A unique name for the control.
styl e: A string for the visual style, one of:

but t on: Has a visible border with a raised or 3D appearance.
t ool but t on: Has a flat appearance, appropriate for inclusion in
a toolbar

Displays an icon or image.
To add to a window w:

w add (“inage” [, bounds, icon, {creation properties}]);

bounds: Optional. The control’s position and size.

i con: Optional. The named resource for the icon or family of icons
displayed in the image control, or a pathname or File Object
for an image file. Images must be in PNG format.

creati on_properties:Optional. An object that contains the
following property:

nane: A unique name for the control.
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Type keyword Class name

Description

item

| i stbox

panel

Array of
Listltem

Li st Box

Panel

The choice items in a list box or drop-down list. The objects are
created when items are specified on creation of the parent list object,
or afterward using the list control’s add() method.

e Itemsin a drop-down list can be of type separ at or, in which case
they cannot be selected, and are shown as a horizontal line.

Item objects have these properties which are not found in other
controls:

checked
expanded
image
index
selected

A list box with zero or more items. Calls the onChange callback if the
item selection is changed by a script or the user, or if the object’s
notify() method is called. A double click on an item selects that item
and calls the onDoubleClick callback.

To add to a window w:

w add ("listbox", bounds [, itens, {creation properties}]);

bounds: Optional. The control’s position and size.

i t ens: Optional. An array of strings for the text of each list item. A
Li st I t emobject is created for each item. Supply this
argument, or the i t ens property in creation_properties, not
both.

creat i on_pr operti es:Optional. An object that contains any of the
following properties:

nane: A unigque name for the control.

mul ti sel ect: When false (the default), only one item can be
selected. When true, multiple items can be selected.

i t ems: An array of strings for the text of each listitem. A Li st tem
object is created for each item. An item with the text string " -"
creates a separator item. Supply this property, or the i t ens
argument, not both. This form is most useful for elements
defined using Resource Specifications.

A container for other types of controls, with an optional frame.
Containers have additional properties that control the children; see
“Container properties” on page 101. Hiding a panel hides all its
children. Making it visible makes visible those children that are not
individually hidden.

To add to a window w:

w add (“panel” [, bounds, text, {creation properties}]);

bounds: Optional. The element’s position and size. A panel whose
width is 0 appears as a vertical line. A panel whose height is 0
appears as a horizontal line.

text: Optional. The text displayed in the border of the panel.
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Type keyword Class name

Description

panel (cont'd)

pr ogr essbar

r adi obut t on

Pr ogr essbar

Radi oBut t on

creation_properties:Optional. An object that contains the
following property:
nane: A unique name for the control.
bor der St yl e: A string that specifies the appearance of the border
drawn around the panel. One of bl ack, et ched, gr ay, r ai sed,
sunken. Default is et ched.
sulPanel Coor di nat es: When true, this panel automatically
adjusts the positions of its children for compatability with
Photoshop CS. Default is false, meaning that the panel does
not adjust the positions of its children, even if the parent
window has automatic adjustment enabled.

A horizontal rectangle that shows progress of an operation. All

pr ogr essbhar controls have a horizontal orientation. The val ue
property contains the current position of the progress indicator; the
default is 0. There is a m nval ue property, but it is always 0; attempts
to set it to a different value are silently ignored.

To add to a window w:

w add (“progressbar” [, bounds, value, ninvalue, naxval ue,
{creation_properties}]);

bounds: Optional. The control’s position and size.

val ue: Optional. The initial position of the progress indicator.
Default is 0.

m nval ue:Optional. The minimum value that the val ue property
can be set to. Default is 0. Together with naxval ue, defines the
scrolling range.

nmaxval ue:Optional. The maximum value that the val ue property
can be set to. Default is 100. Together with ni nval ue, defines
the scrolling range.

creati on_properties:Optional. An object that contains the
following property:

name: A unique name for the control.

A dual-state control, grouped with other radiobuttons, of which only
one can be in the selected state. Shows the selected state when

val ue is true, empty when val ue is false. Calls the onClick callback if
the control is clicked or if its notify() method is called.

All r adi obut t ons in a group must be created sequentially, with no
intervening creation of other element types. Only one r adi obut t onin
a group can be set at a time; setting a different r adi obut t on unsets
the original one.

To add to a window w:

w add (“radiobutton” [, bounds, text,
{creation_properties}]);

bounds: Optional. The control’s position and size.
t ext: Optional. The text displayed in the control.
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Type keyword Class name

Description

r adi obut t on

(cont'd)
scrol | bar Scrol | bar
sl i der S i der

creation_properties:Optional. An object that contains the
following property:
nane: A unique name for the control.

A scrollbar with a draggable scroll indicator and stepper buttons to
move the indicator. The scrol I bar control has a horizontal
orientation if the wi dt h is greater than the hei ght at creation time, or
vertical if its hei ght is greater than its wi dt h.

Calls the onChange callback after the position of the indicator is
changed or if its notify() method is called. Calls the onChanging
callback repeatedly while the user is moving the indicator.

The val ue property contains the current position of the scrollbar’s
indicator within the scrolling area, within the range of ni nval ue and
maxval ue.

The st epdel t a property determines the scrolling unit for the up or
down arrow; default is 1.

The j unpdel t a property determines the scrolling unit for a jump (as
when the bar is clicked outside the indicator or arrows); default is
20% of the range between mi nval ue and maxval ue.

To add to a window w:

w add (“scrollbar” [, bounds, value, mnvalue, naxval ue,
{creation_properties}]);

bounds: Optional. The control’s position and size.

val ue: Optional. The initial position of the scroll indicator. Default
is 0.

mi nval ue:Optional. The minimum value that the val ue property
can be set to. Default is 0. Together with naxval ue, defines the
scrolling range.

naxval ue:Optional. The maximum value that the val ue property
can be set to. Default is 100. Together with ni nval ue, defines
the scrolling range.

creation_properties:Optional. An object that contains the
following property:

nane: A unigque name for the control.

A slider with a moveable position indicator. All sl i der controls have
a horizontal orientation. Calls the onChange callback after the
position of the indicator is changed or if its notify() method is called.
Calls the onChanging callback repeatedly while the user is moving
the indicator.

The val ue property contains the current position of the indicator
within the range of ni nval ue and naxval ue.

To add to a window w:

w add (“slider” [, bounds, value, mnvalue, naxval ue,
{creation_properties}]);

bounds: Optional. The control’s position and size.
val ue: Optional. The initial position of the indicator. Default is 0.
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Type keyword  Class name Description

sli der (cont'd) mi nval ue:Optional. The minimum value that the val ue property
can be set to. Default is 0. Together with naxval ue, defines the
range.

naxval ue:Optional. The maximum value that the val ue property
can be set to. Default is 100. Together with ni nval ue, defines
the range
creati on_properties:Optional. An object that contains the
following property:
name: A unique name for the control.

stati ctext Stati cText A text field that the user cannot change.

To add to a window w:

w add (“statictext” [, bounds, text,
{creation_properties}]);

bounds: Optional. The control’s position and size.
t ext: Optional. The text displayed in the control.
creat i on_pr operti es:Optional. An object that contains any of the
following properties:
name: A unique name for the control.
mul ti I'i ne: When false (the default), the control displays a single
line of text. When true, the control displays multiple lines, in
which case the text wraps within the width of the control.
scrol Ii ng: When false (the default), the displayed text cannot be
scrolled. When true, the displayed text can be vertically
scrolled using scrollbars; this case implies mul ti | i ne is true.

treevi ew TreeVi ew A hierarchical list whose items can contain child items. Items at any
level of the tree can be individually selected. Calls the onChange
callback if the item selection is changed by a script or the user, or if
the object’s notify() method is called.

To add to a window w.

w add (“treeview [, bounds, itens,
{creation_properties}])

bounds: Optional. The control’s position and size.

i t ens: Optional. An array of strings for the text of each top-level
list item. A Li st I t emobject is created for each item. An item
with the type node can contain child items. Supply this
argument, or the i t ens property in creation_properties, not
both.

creat i on_pr operti es:Optional. An object that contains any of the
following properties:

nane: A unique name for the control.

i t ems: An array of strings for the text of each top-level list item.
A Li st | t emobject is created for each item. An item with the
type node can contain child items. Supply this property, or the
i t ens argument, not both. This form is most useful for
elements defined using Resource Specifications.
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The following table shows the properties of all ScriptUl elements. Some values apply only to controls of

particular types, as indicated.

active

al i gnnent

bounds

Boolean

String or Array of
2 Strings

Bounds

When true, the object is active, false otherwise. Set to true to
make a given control or dialog active.

e A modal dialog that is visible is by definition the active
dialog.

e An active palette is the front-most window.

e An active control is the one with focus—that is, the one that
accepts keystrokes, or in the case of a Button, be selected
when the user types ENTER in Windows, or presses the
spacebar in Mac OS.

Applies to child elements of a container. If defined, this value
overrides the al i gnChi | dr en setting for the parent container.

For a single string value, allowed values depend on the

ori entati on value in the parent container. For ori ent at i on=r ow.
top
bot t om

center (default)

fill
For ori ent ati on=col um:

left

right

center (default)

fill
For ori ent ati on=st ack:

top

bottom

left

right

center (default)

fill
For an array value, the first string element defines the horizontal
alignment and the second element defines the vertical
alignment. The horizontal alignment value must be one of | ef t,
right,center orfill.The vertical alignment value must be one
of t op, bott omcenter,orfill.

Values are not case sensitive.

A Bounds object describing the boundaries of the element, in
screen coordinates for Window elements, and parent-relative
coordinates for child elements (compare windowBounds). For
windows, the bounds refer only to the window’s content region.

Setting an element’s si ze or | ocat i on changes its bounds
property, and vice-versa.
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characters

checked

enabl ed

expanded

graphi cs

hel pTi p

i con

i rage

i ndent

i ndex

itens

Number

Boolean

Boolean

Boolean

Object

String

String or File
Object

Number

Number

Array of Object

Used by the LayoutManager Object to determine the default
preferredSize for a StaticText or EditText control. The control will

be made wide enough to display the given number of 'X'
characters in the font used by the control. Setting this property
is the best way to reserve space in a control for a maximum
number of characters to display.

For Listltem objects only. When true, the item is marked with the
platform-appropriate checkmark. When false, no checkmark is
drawn, but space is reserved for it in the left margin, so that the
item lines up with other checkable items. When undef i ned, no
space is reserved for a checkmark.

When true, the control is enabled, meaning that it accepts input.
When false, control elements do not accept input, and all types
of elements have a dimmed appearance.

For Listltem objects of type node in TreeView list controls. When
true, the item is in the expanded state and its children are
shown, when false, it is collapsed and children are hidden.

A ScriptUIGraphics object that can be used to customize the
control’s appearance, in response to the onDraw event.

A brief help message (also called a tool tip) that is displayed in a
small floating window when the mouse cursor hovers over a Ul
control element. Set to an empty string or nul | to remove help
text.

Deprecated. Use image instead.

A ScriptUllmage object, or the name of an icon resource, or the
pathname or File Object for a file that contains a
platform-specific image in PNG or JPEG format.

e Foran IconButton, the icon appears as the content of the
button.

e Fora Listltem, the image is displayed to the left of the text.

e ForanImage, the image is the entire content of the image
element.

A number of pixels by which to indent the element during
automatic layout. Applies for col umm orientation and | ef t
alignment, or r oworientation and t op alignment.

For Listltem objects only. The index of this item in the i t ens
collection of its parent list control. Read only.

For a list object ListBox, DropDownlList or TreeView list), a
collection of Listltem objects for the items in the list. Access by
0-based index. To obtain the number of items in the list, use

i tens. | engt h. Read only.
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itensi ze Dimension For a list object (ListBox, DropDownlList or TreeView list), a
Dimension object describing the width and height in pixels of
each item in the list. Used by auto-layout to determine the
pr ef err edSi ze of the list, if not otherwise specified.

If not set explicitly, the size of each item is set to match the
largest height and width among all items in the list

jurpdel ta Number The amount to increment or decrement a Scrollbar indicator’s
position when the user clicks ahead or behind the moveable
element. Default is 20% of the range between the naxval ue and
m nval ue property values.

justify String The justification of text in static text and edit text controls. One
of:
left (default)
cent er
ri ght
Note: Justification only works if the value is set on creation,
using a resource specification or creation parameters.

| ocation Point A Point object describing the location of the element as an
array, [ x, y], representing the coordinates of the upper left
corner of the element. These are screen coordinates for W ndow
elements, and parent-relative coordinates for other elements.

Thel ocati onis defined as [ bounds. x, bounds. y] . Setting an
element’s | ocat i on changes its bounds property, and vice-versa.
By default, | ocat i on is undef i ned until the parent container’s
layout manager is invoked.

nmaxi nunsi ze Dimension A Dimension object that specifies the maximum height and
width for an element.

The default is 50 pixels less than the screen size in each
dimension. In Windows, this can occupy the entire screen; you
must define a maxi munsi ze to be large enough for your intended
usage.

m ni nunsi ze Dimension A Dimension object that specifies the minimum height and
width for an element. Defaultis [0, 0] .

maxval ue Number The maximum value that the val ue property can have.

If maxval ue is reset less than val ue, val ue is reset to naxval ue. If
naxval ue is reset less than ni nval ue, m nval ue is reset to
naxval ue.

m nval ue Number The minimum value that the val ue property can have.

If m nval ue is reset greater than val ue, val ue is reset to m nval ue.
If m nval ue is reset greater than maxval ue, naxval ue is reset to
m nval ue.

par ent Object The immediate parent object of this element. Read only.
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preferredSi ze  Dimension A Dimension object used by layout managers to determine the
best size for each element. If not explicitly set by a script, value is
established by the Ul framework in which ScriptUl is employed,
and is based on such attributes of the element as its text, font,
font size, icon size, and other Ul framework-specific attributes.

A script can explicitly set pref err edSi ze before the layout
manager is invoked in order to establish an element size other
than the default.

properties Object An object that contains one or more creation properties of the
element (properties used only when the element is created).

sel ect ed Boolean For Listltem objects only. When true, the item is part of the
sel ect i on for its parent list. When false, the item is not selected.
Set to true to select this item in a single-selection list, or to add it
to the selection array for a multi-selection list.

sel ection Array of Listitem | For a ListBox, an array of Listltem objects for the current

(Li st Box) selection in a multi-selection list. Setting this value causes the
selected item to be highlighted and to be scrolled into view if
necessary. If no items are selected, the value is nul | . Set to nul |
to deselect all items.

The value can also change because the user clicked or
double-clicked an item, or because an item was removed with
remove() or removeAll(). Whenever the value changes, the
onChange callback is called. If the value is changed by a double
click, calls the onDoubleClick callback.

You can set the value using the index of an item or an array of
indices, rather than object references. If set to an index value
that is out of range, the operation is ignored. When set with
index values, the property still returns object references.

e If you set the value to an array for a single-selection list, only
the firstitem in the array is selected.

e Ifyou set the value to a single item for a multi-selection list,
that item is added to the current selection.

sel ection Listltem For a DropDownlList or TreeView list object, the currently
( Dr opDownli st selected Listltem object.
TreeVi ew)

Setting this value causes the selected item to be highlighted
and to be scrolled into view if necessary. If no item is selected,
the valueis nul I . Set to nul | to deselect all items.

The value can also change because the user clicked on an item,
or because an item was removed with remove() or removeAll().
Whenever the value changes, the onChange callback is called.

You can set the value using the index of an item or an array of
indices, rather than object references. If set to an index value
that is out of range, the operation is ignored. When set with an
index value, the property still returns an object reference.
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short cut Key String The key sequence that invokes the onShortcutKey callback for
this element (in Windows only).

si ze Dimension A Dimension object that defines the actual dimensions of an
element. Initially undef i ned, and unless explicitly set by a script,
it is defined by a Layout Manager.

Although a script can explicitly set size before the layout
manager is invoked to establish an element size other than the
pr ef erredSi ze or the default size, this is not recommended.

Defined as [ bounds. wi dt h, bounds. hei ght]. Setting an
element’s si ze changes its bounds property, and vice-versa.

stepdel ta Number The amount by which to increment or decrement a Scrol | bar
element’s position when the user clicks a stepper button.

t ext String The title, label, or displayed text. Ignored for containers of type
gr oup. For controls, the meaning depends on the control type.
Buttons use the t ext as a label, for example, while edit fields use
the t ext to access the content.

This is a localizable string: see “Localization in ScriptUl Objects”
on page 92.

textsel ection | String The currently selected text in a control that displays text, or the
empty string if there is no text selected.

Setting the value replaces the current text selection and
modifies the value of the t ext property. If there is no current
selection, inserts the new value into the t ext string at the
current insertion point. The t ext sel ect i on value is reset to an
empty string after it modifies the t ext value.

Note: Setting the t ext sel ect i on property before the edi t t ext
control’s parent W ndowexists is an undefined operation.

type String Contains the type name of the element, as specified on creation.

e For Wndowobjects, one of the type names wi ndow pal ette,
ordi al og.

e For controls, the type of the control, as specified in the add
method that created it.

Read only.

val ue Boolean For a Checkbox or RadioButton, true if the control is in the
selected or set state, false if it is not.

val ue Number For a Scrollbar or Slider, the current position of the indicator. If
set to a value outside the range specified by ni nval ue and
maxval ue, it is automatically reset to the closest boundary.

vi si bl e Boolean When true, the element is shown, when false it is hidden.

When a container is hidden, its children are also hidden, but
they retain their own visibility values, and are shown or hidden
accordingly when the parent is next shown.
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W ndow Window The Window Object that contains this control. Read only.
wi ndowBounds Bounds A Bounds object that contains the bounds of this control in the

containing window’s coordinates. Compare bounds, in which
coordinates are relative to the immediate parent container. Read
only.

function _nanme | Function For the FlashPlayer control, a function definition for a callback
from the Flash ActionScript environment.

There are no special naming requirements, but the function
must take and return only the supported data types:

Number
String
Boolean
Null
undefined
Object
Array

Note: The ActionScript cl ass and dat e objects are not
supported as parameter values.

The following table shows the methods defined for each element type, and for specific control types as
indicated.

addEvent Li st ener ()
cont rol Qoj . addEvent Li st ener (event Nane, handl er, capt urePhase);

event Nane The event name string.

handl er The function to register for the specified event in this target. This can be the
name of a function defined in the extension, or a locally defined handler
function to be executed when the event occurs.

A handler function takes one argument, the UIEvent Object. See “Registering
event listeners for windows or controls” on page 76.

capt ur ePhase Optional. When true, the handler is called only in the capturing phase of the
event propagation. Default is false, meaning that the handler is called in the
bubbling phase if this object is an ancestor of the target, or in the at-target
phase if this object is itself the target.

Registers an event handler for a particular type of event occurring in this control.

Returns undef i ned.
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di spat chEvent ()
control Qyj . di spat chEvent (event Qyj)

event Qvj A UlEvent Object.

Simulates the occurrence of an event in this target. A script can create a UIEvent Object for a specific
event and pass it to this method to start the event propagation for the event.

Returns false if any of the registered listeners that handled the event called the event object’s
preventDefault() method, true otherwise.

fi nd()
listahj.find(text)

text The text of the item to find.

For list objects (ListBox, DropDownlList or TreeView) only. Looks in this object’s i t ens array for an
i t emobject with the givent ext value.

Returns the i t emobject if found; otherwise, returns nul | .

hi de()
control Qyj . hi de()

Hides this container or control. When a window or container is hidden, its children are also hidden,
but when it is shown again, the children retain their own visibility states.

Returns undef i ned.

not i fy()
control Qyj . notify([event])
event Optional. The name of the control event handler to call. One of:
ond i ck
onChange
onChangi ng

By default, simulates the onChange event for an EditText control, an onClick
event for controls that support that event.

Sends a notification message, simulating the specified user interaction event.

Returns undef i ned.

r enoveEvent Li st ener ()
control bj . addEvent Li st ener (event Nane, handl er[, capturePhase]);

event Nane The event name string.
handl er The function that was registered to handle the event.
capt ur ePhase Optional. Whether the handler was to respond only in the capture phase.

Unregisters an event handler for a particular type of event occurring in this control. All arguments
must be identical to those that were used to register the event handler.

Returns undef i ned.
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show()
cont rol Qj . show()

Shows this container or control. When a window or container is hidden, its children are also hidden,
but when it is shown again, the children retain their own visibility states.

Returns undef i ned.

toString()
listltempj.toString()

For Listltem controls only. Retrieves the value of this item’s t ext property as a string.
Returns a String.

val ueCr ()
l'istltemp.val ueC ()

For Listltem controls only. Retrieves the index number of this item in the parent list’s i t ens array.
Returns a Number.

The following table shows the methods defined for list objects only.

add()
listQyj.add (type, text[, index])

type The type of item to add. One of:

i t em A basic, selectable item with a text label.
separ at or : A separator. For dr opdownl i st controls only. In this case, the t ext
value is ignored, and the method returns nul I .

t ext The localizable text label for the item.

i ndex Optional. The index into the current item list after which this item is inserted. If

not supplied, or greater than the current list length, the new item is added at
the end.

For list objects (ListBox, DropDownlList or TreeView) only. Adds an item to the i t ens array at the
given index.

Returns the i t emcontrol object for t ype=i t em or nul | fortype=separ at or.
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renove()

cont ai ner Qoj . r enove( i ndex)
cont ai ner Qj . renove( t ext)
cont ai ner Qoj . r enove( chi | d)

i ndex The item or child to remove, specified by 0-based index, t ext value, oras a

t ext R
trol .
child control object

For containers (Panel, Group), removes the specified child control from the container’s chi | dren
array.

For list objects (ListBox, DropDownlList or TreeView) only, removes the specified item from this
object’si t ens array. No error results if the item does not exist.

Returns undef i ned.

renoveA | ()
list@j.removeA l ()

For list objects (ListBox, DropDownlList or TreeView) only. Removes all items from the object’s i t ens
array.

Returns undef i ned.

These functions apply only to controls of type flashplayer.

Note: There are limitations on how these functions can be used to control playback of Flash movies:

e Do not use stopMovie() and playMovie() to suspend and subsequently resume or restart an SWF file
produced by Flex™.

e The stopMovie() and playMovie() sequence does not make sense for some SWF files produced by
Flash Authoring, depending on the exact details of how they were implemented. The sequence may
not correctly reset the file to the initial state (when the rewind argument to playMovie() is true) nor
suspend then resume the execution of the file (when rewind is false).

e Using stopMovie() from the player’s hosting environment has no effect on an SWF file playing in a
ScriptUI Flash Player element. It is, however, possible to produce an SWF using Flash Authoring that
can stop itself in response to user interaction.

e Do not call playMovie() when an SWF file is already playing.

i nvokePl ayer Functi on()
fl ashP ayer Qoj . i nvokeM ayer Function(fnhNane, [argl[,...argn]] )

fnName  String. The name of a Flash ActionScript function that has been registered with the
Ext er nal I nt er f ace object by the currently loaded SWF file; see “Calling ActionScript
functions from a ScriptUl script” on page 79.
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args Optional. One or more arguments to pass through to the function, of these types:

Number
String
Boolean
Null
undefined
Object
Array

Invokes an ActionScript function defined in the Flash application.

Returns the result of the invoked function, which must be one of the allowed types. The ActionScript
cl ass and dat e objects are not supported as return values.

| oadMovi e()
flashP ayer Qyj . | oadMovi e(fil e)

file The File Object for the SWF file.

Loads a movie into the Flash Player, and begins playing it.

Returns undef i ned.

pl ayMovi e()
fl ashP ayer Qj . pl ayMovi e( r ew nd)

rewind  When true, restarts the movie from the beginning; otherwise, starts playing from the point
where it was stopped.

Restarts a movie that has been stopped.
Note: Do not call when a movie is currently playing.

Returns undef i ned.

st opMovi e()
fl ashP ayer Qoj . st opMovi e()

Halts playback of the current movie.
Note: Does not work when called from the player’s hosting environment.

Returns undef i ned.
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The following events are signalled in certain types of controls. To handle the event, define a function with
the corresponding name in the control object. Handler functions take no arguments and have no
expected return values; see “Defining Behavior with Event Callbacks and Listeners” on page 75.

ond i ck

onChange

onChangi ng

onDoubl e i ck

onDr aw

onShor t cut Key

Called when the user clicks one of the following control types:

Button
Checkbox
IconButton
RadioButton

Called when the user finishes making a change in one of the following control
types:

DropDownlList
EditText

ListBox
Scrollbar
Slider
TreeView

e Foran EditText control, called only when the change is complete—that is,
when focus moves to another control, or the user types ENTER. The exact
behavior depends on the creation parameter ent er KeySi gnal snChange; see
the edittext description.

e ForaSlider or Scrollbar, called when the user has finished dragging the
position marker or has clicked the control.

e ForaListBox, DropDownlList or TreeView control, called whenever the
sel ecti on property changes. This can happen when a script sets the property
directly or removes a selected item from the list, or when the user changes the
selection.

Called for each incremental change in one of the following control types:

edittext
scrol | bar
slider

e Foranedittext control, called for each keypress while the control has focus.

e Foraslider orscrollbar, called for any motion of the position marker.

Called when the user double clicks an item in a ListBox control. The list’s sel ecti on
property is set to the clicked item.

Called when a container or control is about to be drawn. Allows the script to
modify or control the appearance, using the control’s associated ScriptUIGraphics
object. Handler takes one argument, a DrawState object.

(In Windows only) Called when a shortcut-key sequence is typed that matches the
shortcutKey value for an element in the active window.
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A helper object that describes an input state at the time of the triggering onDraw event. Contains
properties that report whether the current control has the input focus, and the particular mouse button
and key-press state. There is no object constructor.

The object contains the following read-only properties:

al t KeyPressed Boolean When true, the ALT key was pressed. (In Windows only.)

capsLockKeyPr essed Boolean When true, the CAPSLOCK key was pressed.

cndKeyPr essed Boolean When true, the CMD key was pressed. (In Mac OS only.)

ctrl KeyPressed Boolean When true, the CTRL key was pressed.

hasFocus Boolean When true, the control containing this object has the input
focus.

| ef t Butt onPr essed Boolean When true, the left mouse button was pressed.

m ddl eBut t onPr essed Boolean When true, the middle mouse button was pressed.

nouseOver Boolean When true, the cursor position was within the bounds of the

control containing this object.

nuniockKeyPr essed Boolean When true, the NUMLOCK key was pressed.
opt KeyPr essed Boolean When true, the OPT key was pressed. (In Mac OS only.)
ri ght Butt onPr essed Boolean When true, the right mouse button was pressed.

shi ft KeyPr essed Boolean When true, the SHIFT key was pressed.
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Encapsulates input event information for an event that propagates through a container and control

hierarchy.

This object is passed to a function that you register to respond to events of a certain type that occurin a
window or control. Use windowOb7j . addEventListener() or controlobj .addEventListener() to register a
handler function. See “Registering event listeners for windows or controls” on page 76.

The UIEvent object is normally created by ScriptUl and passed to your event handler. However, you can
simulate a user action by constructing an event object and sending it to a target object’s dispatchEvent()

function.
new UIEvent (type, canBubble, cancelable, view, detail) ;
type String The event type.
canBubbl e Boolean When true, the event should be triggered in ancestors of the target
object during the bubbling phase.
cancel abl e Boolean When true, the event can be cancelled.
vi ew Object The container or control object that dispatched the event.
detai | Number Details of the event, which vary according to the event type. The value is
1 or 2 for the cl i ck event, indicating a single or double click.
bubbl es Boolean When true, the event supports the bubbling phase.
cancel abl e Boolean When true, the handler can call this object’s preventDefault()
method to cancel the default action of the event.
current Tar get Object The element object where the currently executing handler was
registered. This could be an ancestor of the target object, if the
handler is invoked during the capture or bubbling phase.
det ai | Number Details of the event, which vary according to the event type. The
value is 1 or 2 for the cl i ck event, indicating a single or double click.
event Phase Number Current event propagation phase. One of these constants:
Event . NOT_Dl SPATCH NG
Event . CAPTUR NG_PHASE
Event . AT_TARGET
Event . BUBBLI NG_PHASE
t ar get Object The element object where the event occurred.
ti meSt anp Object Time the event was initiated. A JavaScript Dat e object.
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type String The name of the event that occurred. Predefined events types are:

change

changi ng
click (detail
click (detail
ent er Key
nove

novi ng
resize
resizing
show

f ocus

bl ur

Vi ew Object The container or control object that dispatched the event.

i ni t Event ()
event Qoj . i nit Event (event Name, bubbl e, isCancel able )

event Nane The event name string.

bubbl e When true, the event should be triggered in ancestors of the target object during
the bubbling phase.

i sCancel abl e When true, the event can be cancelled.

Reinitializes the object, allowing you to change the event properties after construction.

Returns undef i ned.

i ni t U Event ()
event Qyj . initU Event (event Nane, bubble, isCancel able )

event Nane The event name string.

bubbl e When true, the event should be triggered in ancestors of the target object during
the bubbling phase.

i sCancel abl e When true, the event can be cancelled.
vi ew The container or control object that dispatched the event.

detail Details of the event, which vary according to the event type. The valueis 1 or 2
for the cl i ck event, indicating a single or double click.

Modifies an event before it is dispatched to its targets. Takes effect only if U Event . eventPhase is
Event . NOT_Dl SPATCH NG Ignored at all other phases.

Returns undef i ned.

prevent Def aul t ()
event Qoj . prevent Default ( )

Cancels the default action of this event, if this event is cancelable (that is, cancelable is true). For
example, the default click action of an OK button is to close the containing dialog; this call prevents
that behavior.

Returns undef i ned.
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st opPr opagat i on()
event (yj . st opPropagation ( )

Stops event propagation (bubbling and capturing) after executing the handler or handlers at the
current target.

Returns undef i ned.

These objects provide the ability to customize the appearance of user-interface controls before they are
drawn.

Most types of Ul elements have a graphics property which contains an object of this type, which allows
you to customize aspects of the element’s appearance, such as the color and font. Use an onDraw callback
function to set these properties or call the functions.

All measurements are in pixels.

These static properties provide color type constants with which to create Pen and Brush objects.

BrushType Object Contains the enumerated constants for the type argument of newBrush().
Types are:

SOLI D OOLCR
THEME OOLCR
PenType Object Contains the enumerated constants for the type argument of newPen().
Types are:

SCLI D OCLCR
THEME_COLCR

The object contains the following properties:

backgr oundCol or Object The background color of a container, or the parent
background color for a control element. A ScriptUIBrush
object.

current Pat h Object The current drawing path for this object, a ScriptUIPath
object.

cur rent Poi nt Object The current position in the drawing path for this object,

a Point object.
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di sabl edBackgr oundCol or Object The background color for the disabled state of a
container, or the parent background color for the
disabled state of a control element. A ScriptUIBrush

object.

di sabl edFor egr oundCol or Object The foreground color for the disabled state of a
container, or the parent foreground color for the
disabled state of a control element. A ScriptUIPen

object.

font Object The default font to use in writing text, a ScriptUIFont
object.

f or egr oundCol or Object The foreground color for a container, or the parent
foreground color of a control element. A ScriptUIPen
object.

These functions directly customize the appearance of the associated element by drawing on the screen, or
create the Pen and Brush objects used to populate the graphics object or pass to the drawing methods:

cl osePat h()
cont rol Qoj . graphi cs. cl osePath ()

Defines a line from the current position to the start point of the current path (the value of
currentPath), which closes the path.

Returns undef i ned.

dr awFocusRi ng()
control Qoj . graphi cs. drawFocusRi ng (/eft, top[, wdth, height])

left, top Defines the top left corner of the region, in the coordinate system of the control
that contains this graphics object.

width, height The width and height of the region in pixels.

Draws a focus ring within the given rectangular region. This is a visual indicator showing that a given
control has the keyboard focus (accepts keyboard input). In Mac OS, this is typically a light blue ring
around the control. In Windows, it is typically a dashed-line rectangle around some part of the
control.

Returns undef i ned.
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dr awl mage()
control Quj . graphi cs. drawl nage (inage, left, top[, wdth, height])
i nage The ScriptUlimage object containing the images to be drawn.
left, top Defines the top left corner of the drawing region, in the coordinate system of the

control that contains this graphics object.

width, height Optional. The width and height of the drawing region in pixels. If specified, the
image is stretched or shrunk to fit into the given rectangular area. If omitted, the

image’s original width or height is used.

Draws an image within the given rectangular region, using the image file from the given image
object that is appropriate to the control’s current state.

Returns undef i ned.

dr anCsCont r ol ()
cont rol Qyj . graphi cs. dranCSControl ( )

Draws the platform-specific control associated with this element.

Returns undef i ned.

dr awsSt ri ng()
control Qyj . graphics.drawstring (text, pen, x, y, font)

text The text string.

pen The ScriptUIPen object for the drawing pen to use.

X,y The origin point of the drawn text, in the coordinate system of the control that
contains this graphics object.

font Optional. The ScriptUIFont object for the font to use. Default is the font value in
this object.

Draws a string of text starting at a given point, using the given pen and font.

Returns undef i ned.

el | i psePat h()
control Qyj . graphics.ellipsePath (/eft, top[, wdth, height])

left, top Defines the top left corner of the region, in the coordinate system of the control
that contains this graphics object.

width, height The width and height of the region in pixels.

Defines an elliptical path within a given rectangular area in the currentPath object, which can be
filled using fillPath() or stroked using strokePath().

Returns a Point object for the upper left corner of the area, which is the new currentPoint.
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fillPath()
control Qyj . graphics.fillPath (brush[, path])
brush The ScriptUIBrush object that defines the fill color.
path Optional, the ScriptUIPath object for the path. If not supplied, operates on the
currentPath.

Fills a path using a given painting brush.

Returns undef i ned.

| i neto()
control Qyj . graphics.lineto (x, y)

X,y The destination point of the ling, in the coordinate system of the control that
contains this graphics object.

Adds a path segment to the currentPath, from the currentPoint to the specified point.

Returns a Point object for the given destination point, which is the new current position.

measureString()
control Qyj . graphi cs. neasureString (text, font[, boundi ngWdth])

text The text string to measure.
font Optional. The ScriptUIFont object for the font to use. Default is the font value in
this object.

boundi ngWdt h  Optional. A number that specifies the maximum width in pixels of the area in
which the text might be placed. Use when wrapping a long string of text across

multiple lines.

Calculates the size needed to draw a text string in a given font.

Returns a Dimension object containing the height and width of the string in pixels.

novet o()
control Qoj . graphi cs. moveto (x, )
X,y The new coordinates, in the coordinate system of the control that contains this

graphics object.

Adds a given point to the currentPath, and makes it the currentPoint.

Returns a Point object for the given destination point, which is the new current position.

newBr ush()
cont rol Qoj . gr aphi cs. newBr ush( type, color );

type The brush type, one of these constants:

Scri pt U G aphi cs. BrushType. SOLI D COLCR
Scri pt U @ aphi cs. BrushType. THEME_ COLCR
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col or The brush color.

e If typeis SOLI D OOLCR the color expressed as an array of three or four values,
intheform[R B G A specifying the red, green, and blue values of the
color and, optionally, the opacity (alpha channel). All values are numbers in
the range [0.0..1.0]. An opacity of 0 is fully transparent, and an opacity of 1 is
fully opaque.

o If the type is THEME_OOLCR the name string of the theme. Theme colors are
defined by the host application.

Creates a new painting brush.

Returns a ScriptUIBrush object.

newPat h()
control Qyj . graphi cs. newPat h( );

Creates a new, empty drawing path in currentPath, replacing any existing path.

Returns a ScriptUIPath object.

newPen( )
cont rol Quj . gr aphi cs. newPen( type, color, |ineWdth);

type The pen type, one of these constants:

Scri pt U @ aphi cs. PenType. SCLI D CCLCR
Scri pt U G aphi cs. PenType. THEME_COLCR

col or The pen color.

e If typeis SOLI D OOLCR the color expressed as an array of three or four values,
intheform[R B G A specifying the red, green, and blue values of the
color and, optionally, the opacity (alpha channel). All values are numbers in
the range [0.0..1.0]. An opacity of 0 is fully transparent, and an opacity of 1 is
fully opaque.

o If the typeis THEME_OOLCR the name string of the theme. Theme colors are
defined by the host application.

l'i neWdt h The width in pixels of the line this pen will draw. The line is centered around the
current point. For example, if lineWidth is 2, drawing a line from (0, 10) to (5, 10)
paints the two rows of pixels directly above and below y-position 10.

Creates a new drawing pen.

Returns a ScriptUIPen object.

rect Pat h()
control Quj . graphics.rectPath (/eft, top[, wdth, height])

left, top Defines the top left corner of the region, in the coordinate system of the control
that contains this graphics object.

wi dth, height The width and height of the region in pixels.

Defines a rectangular path in the currentPath object, which can be filled using fillPath() or stroked
using strokePath().

Returns a Point object for the upper left corner of the rectangle, which is the new currentPoint.
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st r okePat h()
control Qyj . graphics.fillPath (pen[, path])

pen The ScriptUIPen object that defines the color and line width.
path Optional, the ScriptUIPath object for the path. If not supplied, operates on the
currentPath.

Strokes the path segments of a path with a given drawing pen.

Returns undef i ned.

A helper object that encapsulates the qualities of a brush used to paint fill into a path in a control. Create
with the newBrush() method of the ScriptUIGraphics object.

e Used as a value of backgroundColor and disabledBackgroundColor.

e Passed as an argument to fillPath().

The object contains the following properties:

col or Array of Number  The paint color to use when the t ype is SOLI D OOLCR An array in the
form[R B G A specifying the red, green, blue values of the color
and the opacity (alpha channel) value as numbers in the range [0.0..1.0].

An opacity of 0 is fully transparent, and an opacity of 1 is fully opaque.

t hene String The name of a color theme to use as a painting texture when the t ype is
THEME_OOLCR Theme colors are defined by the host application.
type Number The brush type, one of these constants:

Scri pt U G aphi cs. BrushType. SOLI D COLCR
Scri pt U @ aphi cs. BrushType. THEME_ COLCR

A helper object that encapsulates the qualities of a font used to draw text into a control. Create with the
newFont() method of the ScriptUl Class.

e Used as a value of font.

e Passed as an argument to drawString() and measureString().

The object contains the following properties:

famly String The font family name.
nane String The complete font name, consisting of the family and style, if specified.

si ze Number The font point size.
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style Object The font style. One of these constants:

ScriptU. Font Styl e. REGLAR
ScriptU. Font Styl e. BOLD
ScriptU. FontStyle. | TALIC
ScriptU. Font Styl e. BGLD TALI C

substitute | String The name of a substitution font, a fallback font to substitute for this font
if the requested font family or style is not available.

A helper object that encapsulates a set of images that can be drawn into a control. Alternate versions of an
image can reflect the state, such as a dimmed version for a disabled control.

An object of this type is created automatically when a script uses a pathname or File Object to set the
image property of an Image, IconButton, or Listltem object; the new object becomes the value of that

property.

You can create this object explicitly using the newlmage() method of the ScriptUl Class. When you do this,
you can specify alternate versions of the image to be used for different control states, such as enabled,
disabled, and rollover.

This object is passed as an argument to drawlmage().

The object contains the following properties:

f or mat String The image format, one of:
resour ce
JPEG
aF
TI FF
PNG
PICT (in Mac G5 only)
nane String The image name, either a file name or resource name.
pat hnarre String The full path to the file that contains the image.
si ze Dimension A Dimension object that defines the size of the image in pixels.

A helper object that encapsulates a drawing path for a figure to be drawn into a control. Create the object
the newPath() method and define path segments with the moveto(), lineto(), rectPath(), and ellipsePath()
methods of the ScriptUIGraphics object.

e Used as a value of currentPath, where it is acted upon by closePath() and other methods.

e (Can be passed as an optional argument to fillPath() and strokePath() (which otherwise act upon the
currentPath).

The class defines no properties or methods.
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A helper object that encapsulates the qualities of a pen used to stroke path segments in a control. Create
with the newPen() method of the ScriptUIGraphics object.

e Used as a value of foregroundColor and disabledForegroundColor.

e Passed as an argument to drawString() and strokePath().

The object contains the following properties:

col or Array of
Number

lineWdth Number

t hene String

type Number

The paint color to use when the type is SCLI D OOLCR An array in the form
[R B G A specifying the red, green, blue values of the color and the
opacity (alpha channel) value as numbers in the range [0.0..1.0].

An opacity of 0 is fully transparent, and an opacity of 1 is fully opaque.
The pixel width of the drawing line.

The name of a color theme to use for drawing when the t ype is
THEME_OOLCR Theme colors are defined by the host application.
The pen type, one of these constants:

Scri pt U @ aphi cs. PenType. SCLI D COLCR
Scri pt U G aphi cs. PenType. THEME_COLCR
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Controls the automatic layout behavior for a window or container. The subclass AutoLayoutManager
implements the default automatic layout behavior.

Create an instance of the AutoLayoutManager class with the new operator:
myWin.layout = new AutoLayoutManager (myWin) ;
An instance is automatically created when you create a Window or container (group or panel) object,

and referenced by the container’s layout property. This instance implements the default layout behavior
unless you override it.

The default object has no predefined properties, but a script can assign arbitrary properties to an object it
creates, to store data needed by the script-defined layout algorithm.

| ayout ()
wi ndowQj . | ayout . | ayout (recal cul at e)

recal cul ate Optional. When true, forces the layout manager to recalculate the container
size for this and any child containers. Default is false.

Invokes the automatic layout behavior for the managed container. Adjusts sizes and positions of the
child elements of this window or container according to the placement and alignment property
values in the parent and children.

Invoked automatically the first time the window is displayed. Thereafter, the script must invoke it
explicitly to change the layout in case of changes in the size or position of the parent or children.

Returns undef i ned

resi ze()
wi ndow(j . | ayout . resi ze ()

Resizes and moves the child elements of the managed container, according to the alignment values
for each child of the container, after the container has been resized by the user or by a script.

See “Automatic Layout” on page 80 for details of how alignment affects an element’s size and
location.

Returns undef i ned.
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Interapplication Communication with Scripts

The Adobe scripting environment provides an interapplication messaging framework, a way for to send
and receive information and scripts from one Adobe application to another. An application that supports
the messaging framework is said to be message enabled.

Code samples that demonstrate various techniques are provided with the Adobe Bridge SDK, and
referenced by name in the relevant sections.

Scripts written for any message-enabled application can communicate with other message-enabled
applications in two ways; through directly calling functions defined in a remote application, and by
sending messages and receiving responses from a remote application. A specific syntax is provided for
identifying applications unambiguously.

A limited set of basic functions (the cross-DOM) are common across all message-enabled applications, and
allow your script to, for example, open or print files in other applications, simply by calling the open or
print function for that application.

e “Cross-DOM Functions” on page 140 describes the usage of this feature.

e “Cross-DOM API reference” on page 141 provides reference details for the functions of the basic
cross-DOM.

Each message-enabled application can also export a set of functions to provide a selected set of
application-specific functionality; see “Application-specific exported functions” on page 140. For example,
an Adobe Bridge script can request a photo merge in Photoshop by calling

photoshop.photomerge (files). The set of functions available for each application varies widely.

The interapplication messaging framework is a JavaScript application programming interface (API) that
allows extensive control over communication between applications. The API allows you to send messages
to other applications and receive results, and to receive messages sent by other applications and return
results. Typically the data passed between applications are JavaScript scripts. However, the messaging
framework is extensible. It allows you to define different types of data to send between applications, and
to specify how they are handled.

e “Communicating Through Messages” on page 143 describes the usage of this feature.

e “Messaging Framework API Reference” on page 152 provides complete reference details.

When calling external functions or exchanging messages, you must identify particular applications using
namespace specifiers. A specifier consists of a specific name string (such as photoshop), and optional

139
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additions that identify a particular release or locale version. Application specifiers are used occasionally in
other contexts as well. For details of the syntax, see “"Application and Namespace Specifiers” on page 162.

Regardless of which method you use to perform interapplication communication, you must place your
script in a location where the application you want to run it can see it. There are different locations for the
startup scripts of the applications themselves, and for scripts provided by developers.

Because all JavaScript-enabled applications look in the same locations for scripts to run, the scripts
themselves must be explicit about which application they are meant for. A script should check that all
applications it needs to communicate with are installed with the correct version, and that any other
applications that might be installed do not run the script. For details, see “Scripting for Specific
Applications” on page 11.

The cross-DOM is a small application programming interface (API), which provides a set of functions that
are common across message-enabled applications. These include functions to open files, execute scripts,
and print files. For details of the function set, see the “Cross-DOM API| reference” on page 141.

You can access cross-DOM functions in any script by prefixing the function name with the namespace
specifier for the target application (see “Namespace specifiers” on page 163). For example, a Photoshop
CS3 script can call indesign.open (file) to open afile in Adobe InDesign® CS3.

The cross-DOM functions for each application are implemented in JavaScript. You can see the
implementation for each installed application by reading its associated startup script in the Adobe startup
folder. For example, Adobe Illustrator’ CS3 defines illustrator.open () inthe
illustrator-13.Jjsx startup script (13 is the version number of the installed application). See “Startup
folder locations” on page 141.

» Example code

The sample code distributed with the Adobe Bridge SDK includes these code examples that specifically
demonstrate the use of cross-DOM functions:

Cross-DOM calls

SnpQpenl nPhot oshop. j sx  Shows how to send a file selected in Adobe Bridge to be opened in
Photoshop.

In addition to the required base cross-DOM functions, each message-enabled application can provide
application-specific functionality to all scripts through a simple syntax. You can access exported functions
in any script by prefixing the function name with the namespace specifier for the target application (see
“Namespace specifiers” on page 163). For example, Photoshop CS3 exports the photomerge function, so
an lllustrator CS3 script can directly call photoshop . photomerge (files).

The only difference between cross-DOM functions and the application-specific exported functions is that
all applications expose the same set of cross-DOM functions, whereas each application exposes its own set
of application-specific functions. Each application determines the extent of its exported functionality.
Some applications provide extensive support for exported functions, others less.



5: Interapplication Communication with Scripts Cross-DOM Functions 141

For details of additional functions that are exported by individual applications, refer to the startup scripts
for those applications. The application startup scripts are named appname-n. jsx, where n is the version
number of the installed application. See “Startup folder locations” on page 141.

For each platform, there is a startup folder shared by all Adobe Creative Suite 3 applications that support
JavaScript, and an application-specific startup folder.

e InWindows’, the installation startup folders are:
$CommonProgramFiles%\Adobe\Startup Scripts CS3\Adobe AppName\
e InMac OS’, the installation startup folders are:
/Library/Application Support/Adobe/Startup Scripts CS3/Adobe AppName/

Note: This is not the location in which to store your own startup scripts; see “Scripting for Specific
Applications” on page 11.

All exported functions, including those of the cross-DOM API, are invoked through the exporting
application, identified by its namespace specifier (see “Namespace specifiers” on page 163). For example:

//execute an Illustrator script in version 12
illustratorl2.executeScript (myAIScript) ;

A specifier with no version information invokes the highest installed version of the application. For
example:
//execute a Photoshop script in the highest available version
photoshop.executeScript (myPSScript) ;

All message-enabled applications implement the following cross-DOM functions:

execut eScri pt ()
appspec. execut eScri pt (scri pt)

script A string containing the script to be evaluated.

Performs a JavaScript eval on the specified script. The entire document object model (DOM) of the
target application is available to the script. Returns undef i ned.

open()
appspec. open(files)

files A File Object or array of Fi | e objects. For applications that use compound
documents, this should be a project file.

Performs the equivalent of the target application’s File > Open command on the specified files.
Returns undef i ned.
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openAsNew( )
appspec. openAsNew( [ opt i ons])

options Optional. Application-specific creation options:

Adobe Bridge: none

Photoshop: none

InDesign: creation options are:
(Bool ean: showi ngWndow;, Cbj ect O Stri ng: docunent Preset s)
See the arguments for document s. add() in the InDesign CS3 Scripting
Reference.

[llustrator: creation options are:
([ Docunent Col or Space: col orspace] [, Nunber: wi dt h, Nunber: hei ght])

See the arguments for docunent s. add() in the lllustrator CS3 JavaScript
Reference.

Performs the equivalent of the target application’s File > New command. Returns true on success.

print()
appspec.print(files)

files A File Object or array of Fi | e objects. For applications that use compound
documents, this should be a project file.

Performs the equivalent of the target application’s File > Print command on the specified files.
Returns undef i ned.

qui t ()
appspec. qui t ()

Performs the equivalent of the target application’s File > Exit or File > Close command. Returns
undef i ned.

Note: This function is available for Adobe Acrobat’, but does nothing. Scripts cannot terminate the
application.

reveal ()
appspec.reveal (file)

file A File Object or string specifying a file that can be opened in the target application.

Gives the target application the operating-system focus, and, if the specified file is open in that
application, brings it to the foreground. Returns undef i ned.
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Adobe Bridge provides an application programming interface (API) that defines a communication
protocol between Adobe ExtendScript- and message-enabled applications. This provides the most
general mechanism for communication between applications. A messaging-enabled application can
launch another messaging-enabled application, and send or receive scripts to effect certain actions. For
example, from within Adobe Bridge, a script can launch Photoshop, and then send a script to Photoshop
that requests a photomerge operation.

While the exported functions allow specific access to certain capabilities of the application, the scriptin an
interapplication message allows full access to the target application’s document object model (DOM), in
addition to all cross-DOM and application exported functions.

The messaging API defines the BridgeTalk Class, whose globally available static properties and functions
provide access to environmental information relevant for communication between applications. You can
instantiate this class to create a BridgeTalk Message Object, which encapsulates a message and allows you
to send it to another application. For details of these objects, see “Messaging Framework API Reference”

on page 152.

To send a script or other data to another application, you must create and configure a BridgeTalk Message
Object. This object contains the data to be sent (generally a script to be executed in the target application),
and also specifies how to handle the response.

This simple example walks through the steps of sending a script from Adobe Bridge CS3 to Photoshop
CS3, and receiving a response.

Step 1: Check that the target application is installed

Before you can actually send a message, you must check that the required version of the target application
is installed. The function getSpecifier(), available in the global namespace through the BridgeTalk Class,
provides this information.

For example, this code, which will send a message to Adobe Bridge CS3 as part of a script being executed
by Photoshop CS3, checks that the required version of Adobe Bridge is installed:

var targetApp = BridgeTalk.getSpecifier( "bridge-2.0");
if ( targetBApp ) {

// construct and send message
}

When you send the message, the messaging framework automatically launches the target application, if it
is not already running.

Step 2: Construct a message object

The next step is to construct a message to send to the application. You do this by creating a BridgeTalk
Message Object, and assigning values to its properties. You must specify the target application and the
message body, which is usually a script packaged into a string.
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Scripts sent in messages can be very complex, and can use the full DOM of the target application. This
example defines a message script that accesses the Adobe Bridge DOM to request the number of files or
folders found in a specific folder:

// create a new BridgeTalk message object

var bt = new BridgeTalk;

// send this msg to the Adobe Bridge CS3 application

var targetApp = BridgeTalk.getSpecifier( "bridge-2.0");

bt.target = targetApp;

// the script to evaluate is contained in a string in the "body" property

bt.body = "new Document ('C:\\BridgeScripts') ;
app.document.target.children.length;"

Step 3: Specify how to handle a response

If you want to handle a response for this message, or use the data that is returned from the script’s
evaluation, you must set up the response-handling mechanism before you send the message. You do this
by defining the onResult callback in the message object.

Note: The message callbacks are optional, and are not implemented by all message-enabled applications.

The response to a message is, by default, the result of evaluation of the script contained in that message’s

"

body property. The target application might define some different kind of response; see “Receiving
messages” on page 145.

When the target has finished processing this message, it looks for an onrResult callback in the message
object it received. If it is found, the target automatically invokes it, passing it the response. The response is
packaged into a string, which is in turn packaged into the body property of a new message object. That
message object is the argument to your onResult callback function.

This handler, for example, processes the returned result using a script-defined processResult function.

bt.onResult = function (returnBtObj)
{ processResult (returnBtObj.body) ; }

If you want to handle errors that might arise during script processing, you can define an onError callback in
the message object. Similarly, you can define a timeout value and onTimeout callback to handle the case
where the target cannot process the message within a given time. For more information, see “Handling
responses from the message target” on page 146.

Note: If you define callbacks to handle a response, you must store the message in a variable that still exists
when the response is received. Otherwise, JavaScript might garbage-collect the message object,
and the response would be lost.

Step 4: Send the message

To send the message, call the message object’s send method. You do not need to specify where to send
the message to, since the target application is set in the message itself.

bt.send() ;

You can optionally specify a timeout value, which makes the call synchronous; when you do this, the
method waits for a response from the target application, or for the timeout value to expire, before
returning. When a timeout is not specified, as in this example, the call is asynchronous and the send ()
method returns immediately.

A second optional parameter allows you to specify launch parameters, in case the target application is not
currently running, and the messaging framework needs to launch it.
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The complete script looks like this:

// script to be executed in Photoshop CS3
#target "photoshop-10.0"
// check that the target app is installed
var targetApp = BridgeTalk.getSpecifier( "bridge-2.0");
if ( targethpp )
// construct a message object
var bt = new BridgeTalk;
// the message is intended for Adobe Bridge CS3
bt.target = targetApp;
// the script to evaluate is contained in a string in the "body" property
bt.body = "new Document ('C:\\BridgeScripts') ;
app.document .target.children.length;"
// define result handler callback
bt.onResult = function (returnBtObj) {
processResult (returnBtObj.body); } //fn defined elsewhere
// send the message asynchronously
bt.send() ;

An application can be the target of a message; that is, it receives an unsolicited message from another
application. An unsolicited message is handled by the static BridgeTalk . onReceive callback function in
the target application. See “Handling unsolicited messages” on page 145.

An application that sends a message can receive response messages; that is, messages that come as the
result of requesting a response when a message was sent. These can be:

e The result of an error in processing the message

e The result of a timeout when attempting to process the message

e A notification of receipt of the message

e Intermediate responses

e The final result of processing the message.

All of these response messages are sent automatically by the target application, and are handled by

callbacks defined in the sending message object. For details, see “Handling responses from the message
target” on page 146.

To specify how the application should handle unsolicited incoming messages, define a callback handler
function in the static onReceive property of the BridgeTalk class. This function takes a single argument,
a BridgeTalk Message Object.

The default behavior of the onReceive handler is to evaluate the body of the received message with
JavaScript, and return the result of that evaluation. (The result of evaluating a script is the result of the last
line of the script.) To return the result, it creates a new message object, encapsulates the result in a string
in the body property of that object, and passes that object to the onResult callback defined in the original
message.
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If an error occurs on evaluation, the default onReceive handler returns the error information using a
similar mechanism. It creates a new message object, encapsulates the error information in a string in the
body property of that object, and passes that object to the onError callback defined in the original
message.

To change the default behavior set the BridgeTalk.onReceive property to a function definition in the
following form:

BridgeTalk.onReceive = function( bridgeTalkObject ) ({
// callback definition here

Vi
e The body property of the received message object contains the received data.
e The function can return any type.

The function that you define does not need to explicitly create and return a BridgeTalk message object.
The messaging framework creates a new BridgeTalk message object, and packages the return value of
the onReceive handler as a string in the body property of that object.

Return values are flattened into a string using the Unicode Transformation Format-8 (UTF-8) encoding. If
the function does not specify a return value, the resulting string is the empty string.

The result object is transmitted back to the sender if the sender has implemented an onResult callback
for the original message.

» Message handling examples

This example shows the default mechanism for handling unsolicited messages received from other
applications. This simple handler executes the message’s data as a script and returns the results of that
execution.

BridgeTalk.onReceive = function (message) {
return eval ( message.body ) ;
}

This example shows how you might extend the receive handler to process a new type of message.

BridgeTalk.onReceive = function (message) {
switch (message.type) {
case "Data":
return processData( message ) ;
break;
default: //"ExtendScript"
return eval ( mesage.body ) ;

To handle responses to a message you have sent, you define callback handler functions in the message
object itself. The target application cannot send a response message back to the sender unless the
message object it received has the appropriate callback defined.

Note: The message callbacks are optional, and are not implemented by all message-enabled applications.

When your message is received by its target, the target application’s static BridgeTalk object’s
onReceive method processes that message, and can invoke one of the message object’s callbacks to
return a response. In each case, the messaging framework packages the response in a new message
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object, whose target application is the sender. Your callback functions receive this response message
object as an argument.

A response message can be:

e The result of an error in processing the message. This is handled by the onError callback.

If an error occurs in processing the message body (as the result of a JavaScript syntax error, for
instance), the target application invokes the onError callback, passing a response message that
contains the error code and error message. If you do not have an onError callback defined, the error is
completely transparent. It can appear that the message has not been processed, since no result is ever
returned to the onResult callback.

e A notification of receipt of the message. This is handled by the onReceived callback.

Message sending is asynchronous. Getting a true result from the send method does not guarantee that
your message was actually received by the target application. If you want to be notified of the receipt
of your message, define the onReceived callback in the message object. The target sends back the
original message object to this callback, first replacing the body value with an empty string.

e The result of a timeout. This is handled by the onTimeout callback.

You can specify a number of seconds in a message object’s timeout property. If the message is not
removed from the input queue for processing before the time elapses, it is discarded. If the sender has
defined an onTimeout callback for the message, the target application sends a timeout message back
to the sender.

e Intermediate responses. These are handled by the onResult callback.

The script that you send can send back intermediate responses by invoking the original message
object’s sendResult() method. It can send data of any type, but that data is packaged into a body string
in a new message object, which is passed to your callback. See “Passing values between applications”
on page 149.

e The final result of processing the message. This is handled by the onResult callback.

When it finishes processing your message, the target application can send back a result of any type. If
you have sent a script, and the target application is using the default BridgeTalk . onReceive callback
to process messages, the return value is the final result of evaluating that script. In any case, the return
value is packaged into a body string in a new message object, which is passed to your callback. See
“Passing values between applications” on page 149.

The following examples demonstrate how to handle simple responses and multiple responses, and how
to integrate error handling with response handling.

» Example: Receiving a simple response

In this example, an application script asks Adobe Bridge to find out how many files and folders are in a
certain folder, which the evaluation of the script returns. (The default BridgeTalk.onReceive method
processes this correctly.)

The onResult method saves that numberin fileCountResult, a script-defined property of the
message, for later use.

var bt = new BridgeTalk;
bt.target = "bridge-2.0";
bt.body = "new Document ('C:\\BridgeScripts') ;
app.document.target.children.length;"
bt.onResult = function( retObj ) ({
processFileCount (retObj.body) ;

}
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bt.send() ;

» Example: Handling any error
In this example, the onExrror handler re-throws the error message within the sending application.

var bt = new BridgeTalk;

bt.onError = function (btObj) {
var errorCode = parselnt (btObj.headers ["Error-Code"]) ;
throw new Error (errorCode, btObj.body) ;

}

» Example: Handling expected errors and responses

This example creates a message that asks Adobe Bridge to return XMP metadata for a specific file. The
onResult method processes the data using a script-defined processFileSize function. Any errors are
handled by the onError method. For example, if the file requested is not an existing file, the resulting
error is returned to the onError method.

var bt = new BridgeTalk;
bt.target = "bridge-2.0";
bt.body = "var tn = new Thumbnail ('C/MyPhotos/temp.gif') ;
tn.core.immediate.size;"
bt.onResult = function( resultMsg ) ({
processFileSize (resultMsg.body) ;
}

bt.onError = function( errorMsg ) ({
var errCode = parselnt (errorMsg.headers ["Error-Code"]) ;
throw new Error (errCode, errorMsg.body) ;

}

bt .send() ;

» Example: Setting up a target to send multiple responses

This example integrates the sending of multiple responses with the evaluation of a message body. It sets
up a handler for a message such as the one sent in the following example.

The target application (Adobe Bridge) defines a static onReceive method to allow for a new type of
message, which it calls an iterator. An iterator type of message expects the message . body to use the
iteration variable i within the script, so that different results are produced for each pass through the
while loop. Each result is sent back to the sending application with the sendResult() method. When the
message . body has finished processing its task, it sets a flag to end the while loop.

// Code for processing the message and sending intermediate responses
// in the target application (Adobe Bridge)
BridgeTalk.onReceive = function (message) {
switch (message.type) {
case "iterator":
done = false;
i=0;
while (!done) {
// the message.body uses "i" to produce different results
// for each execution of the message.
// when done, the message.body sets "done" to true
// so this onReceive method breaks out of the loop.
message.sendResult (eval (message.body) ) ;
iv+; )
break;
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default: //"ExtendScript"
return eval ( message.body ) ;

}

» Example: Setting up a sender to receive multiple responses

This example sends a message of the type iterator, to be handled by the onReceive handler in the
previous example, and processes the responses received from that target.

The sending application creates a message whose script (contained in the body string) iterates through all
files in a specific folder (represented by an Adobe Bridge Thumbnail object), using the iterator variable 1.
For each file in the folder, it returns file size data. For each contained folder, it returns -1. The last executed
line in the script is the final result value for the message.

The onResult method of the message object receives each intermediate result, stores it into an array,
resArr, and processes it immediately using a script-defined function processInterResult.

// Code for send message and handling response

// in the sending application (any message-enabled application)
var idx = 0;
var resArr = new Array;

bt = new BridgeTalk;
bt.target = "bridge";

bt.type = "iterator";

bt.body ="
var fld = new Thumbnail (Folder ('C/Junk')) ;
if (1 == (fld.children.length - 1))

done = true; //no more files, end loop
tn = fld.children[i];
if (tn.spec.constructor.name == 'File')
md = tn.core.immediate.size;
elsemd = -1;

n.
7

// store intermediate results

bt.onResult = function(rObj) ({
resArr [idx] = rObj.body;
processInterResult (resArr[idx]) ;
idx++;};

bt.onError = function (eObj) {
bt.error = eObj.body };

bt .send() ;

The BridgeTalk.onReceive static callback function can return values of any type. The messaging
framework, however, packages the response into a response message, and passes any returned values in
the message body;, first converting the result to a UTF-8-encoded string.
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When your message object’s onResult callback receives a response, it must interpret the string it finds in
the body of the response message to obtain a result of the correct type. Results of various types can be
identified and processed as follows:

Number JavaScript allows you to access a string that contains a number directly as a number,
without doing any type conversion. However, be careful when using the plus operator
(+), which works with either strings or numbers. If one of the operands is a string, both
operands are converted to strings and concatenated.

String No conversion is required.

Boolean The result string is either “true” or “false.” You can convert it to a true boolean by
evaluating it with the eval method.

Date The result string contains the date in the form:

"dow nmm dd yyyy hh: nmss GMI- nnnn".
For example “Wed Jun 23 2004 00:00:00 GMT-0700".

Array The result string contains a comma delimited list of the elements of the array. For
example, If the resultarrayis [12, "test", 432],the messaging framework flattens
this into the string "12, test, 432"

As an alternative to simply returning the array, the message target can use the t oSour ce
method to return the code used to create the array. In this case, the sender must
reconstitute the array by using the eval method on the result string in the response
body. See discussion below.

When returning complex types (arrays and objects), the script that you send must construct a result string,
using the t oSour ce method to serialize the array or object. In this case, the sender must reconstitute the
array or object by using the eval method on the result string in the response body.

» Passing an array with toSource and eval

For example, the following code sends a script that returns an array in this way. The onResult callback
that receives the response uses eval to reconstruct the array.

var bt = new BridgeTalk;
bt.target = "bridge-2.0";
// the script passed to the target application
// needs to return the array using "toSource"
bt.body = "var arr = [10, "this string", 324];
arr.toSource () ;"
bt.onResult = function (resObj)
// use eval to reconstruct the array
arr = eval (resObj.body) ;
// now you can access the returned array
for (i=0; i< arr.length(); i++)
doSomething (arr[i]) ;
}
// send the message
bt.send() ;
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» Passing an object with toSource and eval

This technique is the only way to pass objects between applications. For example, this code sends a script
that returns an object containing some of the metadata for a specific file, and defines an onResul t callback
that receives the object.

var bt = new BridgeTalk;
bt.target = "bridge-2.0";

//the script passed to the target application
// returns the object using "toSource"
bt.body = "var tn = new Thumbnail (File ('C:\\Myphotos\\photol.jpg')) ;
var md = {fname:tn.core.immediate.name,
fsize:tn.core.immediate.size};
md. toSource () ;"
//For the result, use eval to reconstruct the object
bt.onResult = function (resObj)
md = bt.result = eval(resObj.body) ;
// now you can access fname and fsize properties
doSomething (md.fname, md.fsize) ;
}
// send the message
bt .send() ;

» Passing a DOM object

You can send a script that returns a DOM object, but the resulting object contains only those properties
that were accessed within the script. For example, the following script requests the return of the Adobe
Bridge DOM Thumbnail object. Only the properties path and uri are accessed by the script, and only
those properties are returned:

var bt = new BridgeTalk;
bt.target = "bridge";
//set up the script passed to the target application
// to return the array using "toSource"
bt.body = "var tn = new Thumbnail (File ('C:\\Myphotos\\photol.jpg')) ;
var p = tn.path; var u = tn.uri;
tn.toSource () ;"
//For the result, use eval to reconstruct the object
bt.onResult = function (resObj)
// use eval to reconstruct the object
tn = eval (resObj.body) ;
// now the script can access tn.path and tn.uri,
// but no other properties of the Adobe Bridge DOM Thumbnail object
doSomething (tn.path, tn.uri);
}
// send the message
bt .send() ;
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This application programming interface (API) defines a communication protocol between
message-enabled applications. These objects are available to all ExtendScript scripts when any of the
applications is loaded.

The messaging protocol is extensible. Although it is primarily designed to send scripts, you can use it to
send other kinds of data.

The messaging API defines the BridgeTalk class. Static properties and methods of the class provide
access to environmental information relevant for communication between applications. Instantiate the
class to create a BridgeTalk message object, which encapsulates the message itself. For discussion and
examples, see “Communicating Through Messages” on page 143, and the example code provided with
the Adobe Bridge SDK.

» Example code

The sample code distributed with the Adobe Bridge SDK includes these code examples that specifically
demonstrate the use of interapplication messaging:

Interapplication messaging

SnpSendMessage. j Sx Shows how to send message from Adobe Bridge to Photoshop and
receive a response.

SnpSendArray. j sx Sends message from Adobe Bridge to Photoshop that creates an array in
the target and passes it back to the sender.

SnpSendQust onhj ect . j sx  Sends message from Adobe Bridge to Photoshop that creates a JavaScript
object in the target and passes it back to the sender.

SnpSendDOMMj ect . j sx Sends message from Adobe Bridge to Photoshop that creates a
Photoshop object in the target and passes values from it back to the
sender.

Static properties and methods of this class provide a way for your script to determine basic messaging
system information before you create any specific message objects. Static methods allow you to check if
an application is installed and is already running, and to launch the application. A callback defined on the
class determines how the application processes incoming messages.

You can access static properties and methods in the BridgeTalk class, which is available in the global
namespace. For example:

var thisApp = BridgeTalk.appName;
Note: You must instantiate the BridgeTalk class to create the BridgeTalk message object, which is

used to send message packets between applications. Dynamic properties and methods can be
accessed only in instances.
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The BridgeTalk class provides these static properties, which are available in the global namespace:

appl nst ance

appLocal e

apphane

appSpeci fi er

appSt at us

app\Ver si on

onRecei ve

String

String

String

String

String

String

Function

The instance identifier of an application launched by the messaging
framework, the instance portion of an application specifier; see
“Application specifiers” on page 162. Read only.

Used only for those applications, such as InDesign, that support
launching and running multiple instances.

The locale of this application, the locale portion of an application
specifier; see “Application specifiers” on page 162. When a message is
sent, this is the locale of the sending application. Read only.

The name of this application, the appname portion of an application
specifier; see “Application specifiers” on page 162. When a message is
sent, this is the name of the sending application. Read only.

A lower-case string containing the complete specifier for this application;
see “Application specifiers” on page 162. Read/write.

The current processing status of this application. Read only. One of:

busy: The application is currently busy, but not processing messages.
This is the case, for example, when a modal dialog is shown.

i dl e: The application is currently idle, but processes messages
regularly.

not installed: The application is not installed.

The version number of this application, the version portion of an
application specifier; see “Application specifiers” on page 162. When a
message is sent, this is the version of the sending application. Read only.

A callback function that this application applies to unsolicited incoming
messages. The default function evaluates the body of the received
message and returns the result of evaluation. To change the default
behavior, set this to a function definition in the following form:

Bri dgeTal k. onRecei ve = function( bridgeTal kGbj ect ) {
/] act on received nessage
¥

The body property of the received message object contains the received
data. The function can return any type. See “Handling unsolicited
messages” on page 145.

Note: This function is not applied to a message that is received in
response to a message sent from this application. Response
messages are processed by the onResul t, onRecei ved, or onEr r or
callbacks associated with the sent message.
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The BridgeTalk class provides these static methods, which are available in the global namespace:

bri ngToFr ont ()
Bri dgeTal k. bri ngToFront ( app)

app A specifier for the target application; see “Application specifiers” on page 162.

Brings all windows of the specified application to the front of the screen.

In Mac OS, an application can be running but have no windows open. In this case, calling this
function might or might not open a new window, depending on the application. For Adobe Bridge,
it opens a new browser window.

get AppPat h()
Bri dgeTal k. get AppPat h (. app)

app A specifier for the target application; see “Application specifiers” on page 162.

Retrieves the full path of the executable file for a specified application.

Returns a string.

get D spl ayNarre()
Bri dgeTal k. get Speci fier (app)

app A specifier for the target application; see “Application specifiers” on page 162.

Returns a localized display name for an application, or NULL if the application is not installed. For
example:

Bri dgeTal k. get O spl ayNanme( " phot oshop- 10. 0") ;
=> Adobe Phot oshop CS3

get Speci fier()
Bri dgeTal k. get Speci fi er (apphare, [ version],[]ocal €)

appNane The base name of the application to search for.

version Optional. The specific version number to search for. If 0 or not supplied, returns the
most recent version. If negative, returns the highest version up to and including the
absolute value.

If a major version is specified, returns the highest minor-version variation. For
example, if Photoshop CS versions 9, 9.1, and 10 are installed:

Bri dgeTal k. Speci fi er( " phot oshop", "9" )
=> ["phot oshop-9. 1"]

local e Optional. The specific locale to search for.

If not supplied and multiple language versions are installed, prefers the version for
the current locale.

Retrieves a complete application specifier.

Returns a complete specifier (see “Application specifiers” on page 162) for a messaging-enabled
application version installed on this computer, or nul | if the requested version of the application is
not installed.
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For example, assuming installed applications include Photoshop CS3 10.0 en_us, Photoshop CS2 8.5
de_de, Photoshop CS2 9.0 de_de, and Photoshop CS2 9.5 de_de, and that the current locale is en_US:

Bri dgeTal k. get Speci fi er ("photoshop");
=> [ " phot oshop- 10. 0- en_us"]

Bri dgeTal k. get Speci fi er ("photoshop", 0, "en_us");
=> [ "phot oshop- 10. 0- en_us"]

Bri dgeTal k. get Speci fi er ("photoshop", 0, "de_de");
=> [ " phot oshop- 9. 5-de_de"]

Bri dgeTal k. get Speci fi er ("photoshop", -9.2, "de_de");
=> [ " phot oshop- 9. 0-de_de"]

Bri dgeTal k. get Speci fi er ("photoshop", 8);
=> [ " phot oshop- 8. 5- de_de"]

get St at us()
Bri dgeTal k. get Stat us (target Spec)

target Spec  QOptional, a specifier for the target application; see “Application specifiers” on
page 162.
If not supplied, returns the processing status of the current application.

Retrieves the processing status of an application. Returns a string, one of:

BUSY: The application is currently busy, but not processing messages. This is the case, for
example, when a modal dialog is shown.

I DLE The application is currently idle, but processes messages regularly.

PUWPI NG The application is currently processing messages.

I SNOTRUNNI NG The application is installed but not running.

| SNOTI NSTALLED: The application is not installed.

UNDEFI NED: The application is running but not responding to ping requests. This can be true of a
CS2 application that uses an earlier version of the messaging framework.

get Tar get s()
Bri dgeTal k. get Targets ([ version],[/ocal e])

version Optional. The specific version number to search for, or nul I to return the most
appropriate version (matching, most recent, or running), with version information.

e Specify only a major version number to return the highest minor-version
variation. For example, if Photoshop CS versions 9, 9.5, and 10 are installed:

Bri dgeTal k. get Targets( "9" )
=> [ phot oshop- 9. 5]

e Specify a negative value to return all versions up to the absolute value of the
version number. For example:

Bri dgeTal k. get Targets( "-9.9" )
=> [ phot oshop- 9. 0, phot oshop- 9. 5]

I ocal e Optional. The specific locale to search for, or nul | to return applications for all
locales, with locale information.

If not supplied when ver si onis supplied, returns specifiers with version information
only.
Retrieves a list of messaging-enabled applications installed on this computer.

Returns an array of “Application specifiers” on page 162.

e Ifversionis supplied, specifiers include the base name plus the version information.

e Iflocal eis supplied, specifiers include the full name, with both version and locale information.
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e If neither versi on norl ocal e is supplied, returns base specifiers with neither version nor locale
information, but tries to find the most appropriate version and locale; see “Application specifiers”

on page 162.

For example, assuming installed applications include Photoshop CS2 9.0 en_Us, Photoshop CS3 10.0
en_us, and lllustrator CS3 13.0 de_de:

Bri dgeTal k. get Tar get s() ;
=> [ phot oshop, il | ustrator]
Bri dgeTal k. get Targets( "9.0" );
=> [ phot oshop- 9. 0]
Bri dgeTal k. get Targets( null );
=> [ phot oshop-10.0, illustrator-13.0]
Bri dgeTal k. get Targets( null, "en_US' );
=> [ phot oshop- 9. 0-en_US, phot oshop- 10. 0- en_US]
Bri dgeTal k. get Targets( null, null );
=> [ phot oshop-9. 0-en_US, phot oshop-10. 0-en_us, illustrator-13.0-de_de]

i sSRunni ng()
Bri dgeTal k. i sRunni ng (speci fier)

speci fier A specifier for the target application; see “Application specifiers” on page 162.

Returns true if the given application is running and active on the local computer.

| aunch()
BridgeTal k. |l aunch (specifier [, where])

specifier A specifier for the target application; see “Application specifiers” on page 162.

wher e Optional. If the value " backgr ound" is specified, the application’s main window is
not brought to the front of the screen.

Launches the given application on the local computer. It is not necessary to launch an application
explicitly in order to send it a message; sending a message to an application that is not running
automatically launches it.

Returns true if the application has already been launched, false if it was launched by this call.

| oadAppScri pt ()
Bri dgeTal k. | oadAppScri pt (speci fier)

specifier A specifier for the target application; see “Application specifiers” on page 162.

Loads the startup script for an application from the common Start upScri pt s folders. Use to
implement late loading of startup scripts.

Returns true if the script was successfully loaded.

pi ng()
Bri dgeTal k. pi ng (specifier, pingRequest)

specifier A specifier for the target application; see “Application specifiers” on page 162.

pi ngRequest  An identifying key string for a specific type of return value. One of:

STATUS: Returns the processing status; see get St at us() .
DI AGNCBTI CS: Returns a diagnostic report that includes a list of valid ping keys.
ECHO _REQUEST: Returns ECHO RESPONSE for a simple ping request.

Sends a message to another application to determine whether it can be contacted. Returns a string
whose meaning is defined by the ping-request key.
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punp()
Bri dgeTal k. punp ()

Checks all active messaging interfaces for outgoing and incoming messages, and processes them if
there are any.

Returns true if any messages have been processed, false otherwise.

(Most applications have a message processing loop that continually checks the message queues, so
use of this method is rarely required.)

The message object defines the basic communication packet that is sent between applications. Its
properties allow you to specify the receiving application (the t ar get ), the data to send to the target (the
body), and the t ype of data that is sent. The messaging protocol is extensible; it allows you to define new
types of data for the type property, and to send and receive arbitrary additional information with the
header s property.

Create a new message object using a simple constructor:

var bt = new BridgeTalk;

Before you send a message to another application, you must set the t ar get property to the receiving
application, and the body property to the data message (typically a script) you want to send.

body String The data payload of the message. Read/write.

e If thisis an unsolicited message to another application, typically contains a
script packaged as a string. The target application’s full document object
model (DOM) is available within the script.

e |If this message is a result returned from the static Bri dgeTal k onReceive
method of a target application, directed to an onResult callback in this
object, contains the return result from that method flattened into a string.
See “Passing values between applications” on page 149.

e If this message contains an error notification for the onError callback,
contains the error message.

headers  Object A JavaScript object containing script-defined headers. Read/write.

Use this property to define custom header data to send supplementary
information between applications. You can add any number of new headers.
The headers are name/value pairs, and can be accessed with the JavaScript
dot notation (msgQhj . header s. pr opNane), or bracket notation

(msgQj . header s[ pr ophane]). If the header name conforms to JavaScript
symbol syntax, use the dot notation. If not, use the bracket notation.
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sender

t ar get

ti meout

type

String

String

Number

String

The predefined header ["Error- Code"] is used to return error messages to a
sender; see “Messaging Error Codes” on page 161.

Examples of setting headers:

bt. headers.info = "Additional |nformation";
bt.headers ["Error-Code"] = 8;

Examples of getting header values:

var info = bt. headers.info;
var error = bt.headers ["Error-Code"];

The application specifier for the sending application (see “Application
specifiers” on page 162). Read/write.

The application specifier for the target, or receiving, application (see
“Application specifiers” on page 162). Read/write.

The number of seconds before the message times out. Read/write.

If a message has not been removed from the input queue for processing
before this time elapses, the message is discarded. If the sender has defined
an onTimeout callback for the message, the target application sends a
timeout message back to the sender.

The message type, which indicates what type of data the body contains.
Read/write. Default is Ext endScri pt .

You can define a type for script-defined data. If you do so, the target
application must have a static Bri dgeTal k onReceive method that checks for
and processes that type.

Note: The message callbacks are optional, and are not implemented by all message-enabled applications.

onError

Function

A callback function that the target application invokes to return an error
response to the sender. It can send JavaScript run-time errors or exceptions,
or C++ exceptions.

To define error-response behavior, set this to a function definition in the
following form:

bridgeTal kQpj . onError = function( errorMgQject ) {

Il error handler defined here
b
The body property of the received message object contains the error
message, and the header s property contains the error code in its
Er r or - Code property. See “Messaging Error Codes” on page 161.

The function returns undef i ned.
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onRecei ved  Function A callback function that the target application invokes to confirm that the
message was received. (Note that this is different from the static onReceive
method of the BridgeTalk class that handles unsolicited messages.)

To define a response to receipt notification, set this to a function definition
in the following form:

bridgeTal kQbj . onRecei ved = function( ori gMgQyject ) {

/'l handl er defined here
b
The target passes back the original message object, with the body property
set to the empty string.

The function returns undef i ned.

onResul t Function | A callback function that the target application invokes to return a response
to the sender. This can be an intermediate response or the final result of
processing the message.

To handle the response, set this to a function definition in the following
form:

bridgeTal kQpj . onResult = function( responseMsgQbj ect ) {
/'l handl er defined here

b

The target passes a new message object, with the body property set to the

result string. This is the result of the target application’s static Bri dgeTal k

onReceive method, packaged as a UTF-8-encoded string. See “Passing
values between applications” on page 149.

onTi neout Function | A callback function that the target application invokes with a timeout
message if timeout occurred before the target finished processing another
message previously sent by this application. To enable this callback, the
message must specify a value for the timeout property.

To define a response to the timeout event, set this to a function definition in
the following form:

bridgeTal kQyj . onTi neout = function( tineout MgQyject ) {
/'l handl er defined here

b

send()
bridgeTal kQbj.send ([tinoutlnSecs[, |aunchParaneters]])

timout | nSecs Optional. A maximum number of seconds to wait for a result before returning
from this function. The message is sent synchronously, and the function does
not return until the target has processed the message or this number of
seconds have passed.

If not supplied or 0, the message is sent asynchronously, and the function
returns immediately without waiting for a result.
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I aunchPar anet er s Optional. A string of parameters to append to the name of the target
application when launching it, if the application is not already running.

If the target application is already running, this value is ignored.

Sends this message to the t ar get application.

Returns true if the message could be sentimmediately, false if it could not be sent or was queued for
sending later.

If the target application is not running and the message contains a body, the messaging system
automatically launches the target application, passing in any supplied launch parameters. In this
case, the message is queued rather than sent immediately, and this method returns false. The
message is processed once the application is running.

Sending the message does not guarantee that the target actually receives it. You can request
notification of receipt by defining an onReceived callback for this message object. (Note that this is
different from the static onReceive method of the BridgeTalk class that handles unsolicited
messages.)

sendResul t ()
bridgeTal kQbj . sendResult (result)

result You can send data of any type as the result value. The messaging framework
creates a BridgeTalk Message Object, and flattens this value into a string which
it stores in the body of that message. See “Passing values between applications”

on page 149.

When processing an unsolicited message, the static Bri dgeTal k onReceive method can return an
intermediate result to the sender by calling this method in the received message object. It invokes
the onResult callback of the original message, passing a new message object containing the
specified resul t value.

This allows you to send multiple responses to messages.

Returns true if the received message has an onResult callback defined and the response message
can be sent, false otherwise.
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The interapplication messaging protocol defines the following error codes, which are compatible with

ExtendScript error codes. Negative values indicate unrecoverable errors that cause ExtendScript to
terminate a running script.

1
8

44
47
48
49
50
51
52
53
54
56
57
58
59

General error
Syntax error

Bad argument list
Stack overrun

Out of memory
Uncaught exception

Bad URI

Cannot perform requested action

Internal error

Not yet implemented
Range error

Cannot convert

Type mismatch

File or folder does not exist
File of folder already exists
I/O device is not open
Read past EOF

I/O error

Permission denied
JavaScript execution
Cannot connect

Cannot resolve reference
I/O timeout

No response
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All forms of interapplication communication use Application specifiers to identify Adobe applications.

e Inall ExtendScript scripts, the #target directive can use an specifier to identify the application that
should run that script. See “Preprocessor directives” on page 216.

e Ininterapplication messages, the specifier is used as the value of the target property of the message
object, to identify the target application for the message.

e Adobe Bridge (which is integrated with many Adobe applications) uses an application specifier as the
value of the document . owner property, to identify another application that created or opened an
Adobe Bridge browser window. For details, see the Adobe Bridge JavaScript Reference.

When a script for one application invokes cross-DOM or exported functions, it identifies the exporting
application using Namespace specifiers.

Application specifiers are strings that encode the application name, a version number and a language
code. They take the following form:

appname [ instancel[[-version[-localel]l

appnarne An Adobe application name. For example:

aftereffects
bri dge
estool ki t
illustrator

i ncopy

i ndesi gn

i ndesi gnser ver
phot oshop

i nst ance Optional. An additional string appended with an underscore, that distinguishes the
instance for those applications (such as InDesign Server) that support the launching
and running of multiple instances.

For example, for a server launched with SOAP port 12345, the specifier would be
i ndesi gnser ver _confi guration_12345

version Optional. A number indicating at least a major version. The number should include a
minor version separated from the major version number by a dot; for example, 1. 5.

If not supplied, assumes the same suite version as the sending application, if
possible; otherwise, the highest available version number.

For example, these are some of the latest version numbers for the Creative Suite 3
release:

aftereffects-8.0
bridge-2.0

estool kit-2.0
illustrator-13.0

i ncopy-5.0

i ndesign-5.0

i ndesi gnserver-5.0
phot oshop- 10. 0
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local e Optional. An Adobe locale code, consisting of a 2-letter ISO-639 language code and
an optional 2-letter ISO 3166 country code separated by an underscore. Case is
significant. For example, en_us, en_uk, j a_j p, de_de, fr_fr.

If not supplied, ExtendScript uses the current platform locale.

Do not specify a locale for a multilingual application, such as Bridge, that has all
locale versions included in a single installation.

The following are examples of legal specifiers:

photoshop

bridge-2.0

indesign 1-5.0
illustrator-13.0
illustrator-13.0-de de

If a specifier does not supply specific version and locale information, the framework tries to find the most
appropriate available installation. It tries to match to available applications in this order:

1. Peer applications (from the same suite)

2. Applications with the highest available version number
3. Applications that are currently running

4. Applications that match the current locale

5. Applications for any locale

When calling cross-DOM and exported functions from other applications, a namespace specifier qualifies
the function call, directing it to the appropriate application.

Namespace specifiers consist of an application name, as used in an application specifier, with an optional
major version number. Use it as a prefix to an exported function name, with the JavaScript dot notation.

appname [majorVersion] . functionName (args)

For example:

e To call the cross-DOM function quit in Photoshop, use photoshop.quit (), and to call it in Adobe
Illustrator®, use illustrator.quit ().

e To call the exported function place, defined for lllustrator CS3 version 13, call
illustratorl3.place (myFiles).

For information about the cross-DOM and exported functions, see “Remote function calls” on page 139.




External Communication Tools

ExtendScript offers tools for communicating with other computers or the Internet using standard
protocols. These objects support external communication:

e The Web Access library defines the FtpConnection Object, which supports FTP and SFTP
communication protocols, and the HttpConnection Object, which supports HTTP and HTTPS
communication protocols.

Your script must load the platform-compiled Web Access library as an ExternalObject in order to
use these objects. For details, see “Loading the Web Access Library” on page 164. This library is
available in:

e Adobe Bridge CS3.
e The Socket Object supports low-level TCP connections. It is available in the following applications:
e Adobe Bridge CS3
e Adobe InDesign CS3
e Adobe After Effects® CS3
e Adobe Photoshop CS3

To use the FtpConnection Object or HttpConnection Object, you must dynamically load the Web Access
library into Adobe Bridge as an ExternalObject. This library is compiled as a shared library; a DLL in
Windows, a bundle or framework in Mac OS.

For example, use the following JavaScript code:

if ( !ExternalObject.webaccesslib ) {
ExternalObject.webaccesslib = new ExternalObject ('lib:webaccesslib') ;

}
The location of the compiled library files is determined by the operating system.
e In Windows, the DLLs reside in the executable directory.

e InMac OS, bundles and frameworks are loaded from the @executable/ . . /Frameworks directory.
Use the layout of bundles and Frameworks from the shellframework sample application as a
template.

For more information on loading compiled libraries into JavaScript, see Chapter 7, “Integrating External
Libraries.”

Supports the FTP and SFTP protocols for file transfer. The object allows you to send data to or receive data
from an FTP server, synchronously or asynchronously.

To use the FtpConnection object, you must load the Web Access library (webaccesslib)into
JavaScript as an ExternalObject. See “Loading the Web Access Library” on page 164.

164
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Typically, you create a File Object for use with your FtpConnect ion object. The get() and put()
operations automatically open the file for read and write, respectively, if you have not done so explicitly.
The default transfer mode is binary.

e To transfer binary files to the server, use code such as the following:

var file = new File('/c/Photo.jpg') ;

var ftp = new FtpConnection('ftp://server') ;
ftp.put (file, 'Photo.jpg') ;

ftp.close() ;

file.close () ;

e Similarly, to transfer binary files from the server:

var file = new File('/c/Photo.jpg') ;

var ftp = new FtpConnection('ftp://server')
ftp.get ('Photo.jpg',file) ;

ftp.close() ;

file.close () ;

7

The operations do not automatically close the file. This allows you, for example, to use get() to copy many
files to a single file on your local file system. For example:

var file = new File("/c/archive.bin")
ftp.get("a.txt",file) ;

ftp.get ("c.txt",file) ;

file.close () ;

7

Open files are eventually closed by the JavaScript garbage collector when there are no remaining
JavaScript references.

ExtendScript supports many file filters; see “File and Folder Supported Encoding Names” on page 42.

Two properties of the FtpConnection, sync and async, control whether get() and put() operations are
performed synchronously or asynchronously. The property values are tied together, and are mutually
exclusive. You can set either one, and the other is automatically toggled to the opposite value.

When the property syncis set to true (the default), the connection operation blocks the main thread. All
operations must be completed before your script continues.

» Example: synchronous operation (blocking)

var ftp = new FtpConnection("ftp://localhost™")
var file = new File("here.text")

// synchronous mode is the default

ftp.get ("remote.txt",file) ;

// the operation simply returns when complete
file.close () ;

ftp.close() ;

1

When the property syncis set to false (or async set to true), the connection operation occurs in a
background thread while your script continues to do other work. The background thread sets the property
isComplete to true when the current operation has finished. If the operation times out, isComplete is set to
true and error is set to FtpConnection.errorTimeout


ftp://server
ftp://server
ftp://localhost

6: External Communication Tools FtpConnection Object 166

Only a single connection to the FTP server is allowed; you cannot start two operations on the server at the
same time. If you do attempt to do so, error is set to FtpConnection.errorCommandActive to
indicate that the connection is waiting to complete a previous operation.

You can define a callback function in the onCallback property, that checks the completion status of an
asynchronous call, and closes the file and connection when it is done. Use the pump() function to call that
function periodically from the main thread. Typically, a callback function displays and updates a dialog
that shows the progress, and allows the user to cancel an asynchronous operation before its completion;
your callback can accomplish this using cancel().

» Example: asynchronous operation (non-blocking)

var file = new File("here.text")
ftp.sync = false ; // set asynchronous mode
// define callback to check status and close when complete
ftp.onCallback = function(reason,p log,total) ({
if ( this.isComplete ) (
file.close() ;
}

}

// the operation spawns a new thread and returns
ftp.get ("remote.txt",file) ;

// at some time and occasionally

// update progress by calling ftp.onCallback ()
ftp.pump () ;

This section provides details of the FtpConnection object’s properties and functions.

[new] FtpConnection ( [url] );

url Optional. The URL to which to connect. The URL specifies the protocol; for example:

ftp://1ocal host
sftp://1 ocal host

If not provided, you must set the object’s url property.

active Boolean  When true, the connection is active, not passive. Sets passi ve to false. See
the FTP standard (RFC 959) for details. Read-write.

asci i Boolean  When true, the encoding used to transmit data is ASCII. Default is false.
When set to true, sets bi nary to false. Read-write.

async Boolean = When true, the connection is asynchronous. Operations spawn a thread and
return immediately to the main thread. The background thread sets
i sConpl et e to true when the current operation has finished. If the operation
times out, i sConpl et e is set to true and error is set to error Ti neout .

Default is false. When set to true, sets sync to false. Read-write.
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bi nary

cd

dat es

error

errorString

files

Boolean

String

Array of
Date

Number

String

Array of
String

When true, the encoding used to transmit data is binary. Default is true.
When set to true, sets asci i to false. Read-write.

Sets the current directory when the connection is open. Default is
undef i ned. Read-write.

Setting to a directory that does not exist causes a JavaScript error, and sets
the error and error Stri ng properties of the object.

The dates of the files in the current directory. Set by the Is() call. An array
corresponding to the files array, where each member is a JavaScript Dat e
object (as returned by date() for an individual file). Default is undef i ned.

Read only.

The most recent error encountered in the course of connecting or

executing the operation. All functions set this value before returning. A

constant value, one of:

Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnecti on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnecti on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnect i on.
Ft pConnecti on.
Ft pConnecti on.
Ft pConnect i on.
Ft pConnecti on.
Ft pConnecti on.
Ft pConnect i on.
Ft pConnecti on.
Ft pConnecti on.
Ft pConnect i on.

error NoEr r or

er ror CommandAct i ve
err or UnknownExcept i on
er r or Unknown
error Qut Cf Menory
error Cancel | ed

er r or UnknownHost

error Connect Fai | ed
error Ti medQut
errorLogi nFai | ed
errorProtocol Error

er r or UnknownPr ot ocol
er r or Channel (pen
error Channel A osed
error Qper at i onPendi ng
error BadPar anet er s
error Resour ceExi sts
err or Resour ceDoesnt Exi st
error Resour cel nUse
error AccessDeni ed
error Qut & Di sk
errorLocal | oError
error Renot el oError
error Not Enpty
errorNotDirectory
errorNotFile

er r or BadPat hnane
error Not | npl enent ed
error Not Locked
errorLocked

error Met hodNot Al | owed
error Resour ceRedi rect ed

Default is err or NoEr r or. Read only.

A description of the most recent error encountered in the course of
connecting or executing the operation. Default is “OK." Read only.

The files in the current directory. Set by the Is() call. Default is undef i ned.

Read only.
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fl ags Array of  The access permissions and types for the files in the current directory. Set
Number by the Is() call. An array corresponding to the files array, where each
member is a logical OR of these constant values:

Ft pConnect i on. f | agQ her Execut e
Ft pConnection. flagQ herWite
Ft pConnecti on. f | agQ her Read

Ft pConnecti on. f| agG oupExecut e
Ft pConnecti on. fl ag& oupWite
Ft pConnect i on. f | ag@ oupRead

Ft pGConnect i on. f | agOmner Execut e
Ft pConnecti on. fl agOamnerWite
Ft pConnect i on. f | agOaner Read

Ft pGConnection. fl agh rectory

Ft pConnecti on. f 1 agSynii nk

Default is undef i ned. Read only.

isConplete  Boolean  When true, the operation is completed. See “Synchronous and
asynchronous operation” on page 165. Default is true. Read only.

i sCpen Boolean = When true, the connection to the FTP server is open. Default is false. Read
only.

onCal | back Function  Optional. A callback function to the connection thread for asynchronous
mode.

The object stores progress messages from operation thread; to check on
the progress, call pump() on the main thread. The punp() method invokes
this function on each stored message, passing the operation status at that
point. Within the call, you can use t hi s. cancel() to halt the asynchronous
operation. Read-write.

The function must return undef i ned, and take these arguments:
function(reason,p log, total) { }
e reason: The type of progress message. One of:
Ft pConnect i on. r easonSt ar t : The transfer started.
Ft pConnect i on. r easonConpl et e: The transfer is complete.
Ft pConnect i on. r easonFai | ed: The transfer failed.

Ft pConnect i on. r easonPr ogr ess: The transfer is in progress.
Ft pConnect i on. r easonLog: The operation generated a log message.

e p_log: Depends on the reason for the message:

— For a log message, the message string.
— For a progress message, the current number of bytes transferred.
— Otherwise, undef i ned.

e total: Depends on the reason for the message:

— For a progress message, the total number of bytes to be transferred.
— Otherwise undef i ned.

passi ve Boolean = When true, the connection is passive, not active. See the FTP standard (RFC
959) for details. When set to true, sets act i ve to false. Default is false.
Read-write.

password String The connection password for the FTP server. Set this to override the

password given in the URL. Default is undef i ned. Read-write.
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pr oxy String

renanestyl e String

si zes Array of
Number
sync Boolean
ti meout Number
url String
user nane String

Not used.

The rename() function takes a source and destination path and file name, so
that it can both move and rename the source object. You can normally
specify the source and destination without a path or with a relative path
(suchas../nyfile. htm. The function interprets the path as relative to the
current working directory. This typical case is handled by the default value
for this property, "styl el".

If you connect to an FTP server that cannot parse the ". . " notation, change
this value to " st yl e2", and specify both source and destination with
absolute paths.

The sizes of the files in the current directory. Set by the Is() call. An array
corresponding to the files array, where each member is a number of bytes.
Default is undef i ned. Read only.

When true, the connection is synchronous. Operations block the main
thread and return when complete. Default is true. When set to true, sets
async to false. Read-write.

An integer, the number of seconds to continue attempting the operation
before completing with the error message error Ti neout . Default is 5.
Read-write.

The URL of the FTP server, and optionally the port, to which to connect. This
includes the protocol (FTP or SFTP), and can include a login user name and
password in this format:

[s]ftp://[[ usernane:] passvord@ server[: port]
This string must use escape sequences for special characters, such as %20
for space and %40 for @.

Default is undef i ned. Read-write.
The connection user name for the FTP server. Set this to override the user

name given in the URL. Default is undef i ned, for anonymous FTP.
Read-write.

All functions set the error property to indicate the status of the operation when completed
(errorNoError on success).

cancel ()
ftpQy . cancel ();

Cancels the current operation, if it is being performed asynchronously. See “Synchronous and
asynchronous operation” on page 165.

Returns true on success.
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cl ose()
ftpQyj.close ();

Terminates the open connection. Deleting the object also closes the connection, but not until
JavaScript garbage-collects the object. The connection might stay open longer than you wish if you
do not close it explicitly. There are a limited number of open connections available; failing to close
connections can make you unable to open a new one.

Returns true if the connection was closed, false on I/O errors.

chnod()
ftpQyj.chnod (renote[, flags]);

renot e String. The name of the remote file-system object.
flags Optional. The new permissions. A logical OR of the flags constants.

Changes the permissions and/or type of a file-system object on the FTP server.

Returns true on success.

cwd()
ftpQyj.cwd (renote);

renote String. The name of the remote directory.

Changes the current directory on the FTP server.

Returns true on success.

dat e()
ftpQyj.date (renote);

remnot e String. The name of the remote file.

Retrieves the date information for a file-system object on the FTP server.

Returns an array of three JavaScript Dat e objects, for the creation, modification, and most recent
access dates of the given file. If a date is unavailable, the corresponding array member is undef i ned.
See also dates.

Returns false if all dates are unavailable; as when the file-system object does not exist, is a directory,
or is a link that cannot be resolved.

del ()
ftpQhj.del (renote);

renote String. The name of the remote file-system object.

Deletes a file-system object on the FTP server.

Returns true on success.

exi sts()
ftpQyj.exists (renvte);

renot e String. The name of the remote file-system object.

Reports whether a file-system object exists on the FTP server.

Returns true if the object exists on the server, false if it does not exist or is a link that cannot be
resolved.
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get ()
ftpQj.get (renote, file);
remnot e String. The name of the remote file containing data to transfer.
file A File Object, the local file in which to receive the data.

Transfers date from a file on the FTP server to a local file.

Returns true on success.

isDr()
ftpQyj.isDr (renote);

renot e String. The name of the remote file-system object.

Reports whether a file-system object on the FTP server is a directory.

Returns true if the file is a directory on the server, false otherwise.

| s()
ftpQj.1s ();

Retrieves information about the current directory, and returns it in the files, dates, sizes, and flags
properties of this object.

Returns true on success, false on I/0O errors.

nkdi r ()
ftpQyj.nkdir (renote);

renote String. The name of the new remote directory.

Creates a directory on the FTP server.

Returns true on success.

open()
ftpQyj . open ();

Opens the FTP connection explicitly. This in not typically needed; calling a function to perform an
operation opens the connection if necessary.

Returns true if the connection was successfully opened, false on I/0 errors.

punp()
ftpQj . punp ();

Executes the callback procedure defined in onCallback on all progress messages that have been
received since the last call to this function.

Use this function in the main thread to invoke the callback, in order to check on the progress of an
asynchronous operation. It is not required, however; the asynchronous operation continues to
progress on the spawned thread, whether or not you make this call.

Returns true on success, false on I/O errors.
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put ()
ftpQj.get (file, renotel, putMde]);
file A File Object, the local file containing data to transfer.
renote String. The name of the remote file in which to receive the data.
put Mbde Optional. The style of transfer, one of these constants:

Ft pConnect i on. put ModeTr uncat eQr O eat e (default): Allows creation of the
target file, and truncates an existing file to the size of data written. Does not
lock the target file.

Ft pConnect i on. put ModeExcl usi ve: Locks the target file during the write
operation.

Transfers data from a local file to a file on the FTP server. Overwrites the target file, if it already exists.

Returns true on success.

r enarme()
ftpQj.rename (from to);

from String. The path and file name of the source object in the remote file system.
to String. The path and file name of the destination object in the remote file system.

Moves and changes the name of a file-system object on the FTP server. The path can be absolute, or
(in most cases) relative to the current working directory; see renamestyle.

Returns true on success.

rndir()
ftp@j.rmdir (renote);

remnot e String. The name of the remote directory.

Deletes a directory on the FTP server.

Returns true on success.

si ze()
ftpQyj.size (renvte);

renote String. The name of the remote file-system object.

Retrieves the size of a file-system object on the FTP server.

Returns the number of bytes in the file, or -1 if there is no such file, or if the object is a directory or a
link that cannot be resolved.
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Supports the HTTP and HTTPS protocols for Internet communication. The object allows your script to open
a connection to a remote computer that acts as an HTTP server, send an HTTP request, and receive the
response.

To use the Ht tpConnect ion object, you must load the Web Access library (webaccesslib) into
JavaScript as an ExternalObject. See “Loading the Web Access Library” on page 164.

The Ht tpConnect ion object can open only one connection to the internet. If you call execute() before
the current operation is complete (status is Ht tpConnection. statusCompleted), the current
operation is terminated.

The method property of the Ht t pConnect ion object determines the type of operation: GET, PUT, POST,
HEAD, or DELETE. The GET operation is the default.

The request and response properties can contain File Objects or strings.

e Request and response files

The default encoding for both request and response files is BINARY; you can specify another encoding
in the File Object; see File and Folder Supported Encoding Names. (The Ht t pConnection properties
requestencoding and responseencoding affect only string values, not files.)

If the file is not open, it will be opened for reading (for a request) or for writing (for a response). Request
and response files are not closed automatically; when there are no remaining JavaScript references to a
file, it is eventually closed by the garbage collector.

e Request and response strings

When the request is a string, it is converted to binary as specified by the requestencoding value. The
default encoding is UTF-8.

When the server response is anything other than afile, it is converted to a string using the
responseencoding value; the default is ASCII.

» Getting a file

var http = new HttpConnection ("http://www.clanmills.com/robin.shtml")
http.response = new File("/c/temp/robin.shtml")

// Get is the default method

http.execute() ;

http.response.close() ;

» Posting a string

var http = new HttpConnection ("http://localhost/perlasp/wform.asp" )
http.request = "Yourname=Fred Smith" ;

http.method = "POST"

http.execute() ;

» Adding request headers and printing response headers

var http = new HttpConnection ("http://localhost/perlasp/httpvar.asp") ;
http.requestheaders = ["MyHeader" , "MyValue"] ;
http.execute () ;


http://www.clanmills.com/robin.shtml
http://localhost/perlasp/wform.asp
http://localhost/perlasp/httpvar.asp
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http.response = new File("/c/temp/dumpvars.txt")

var a = http.responseheaders ;

for (i =0 ; i < a.length/2 ; i++ ) {
alert(ali*2] + " => " + a[i*2+1])

7

I

The Ht tpConnect ion object can operate asynchronously; when you set async to true (or sync to false)
the operation is performed in the background, while your script continues to do other work. However, the
asynchronous behavior is not automatic. You must execute the pump() method periodically to increment
the progress of the operation, and periodically test the status and lastread properties. After the status is
HttpConnection.statusCompleted, you must continue to call pump() to transfer all bytes from the
server to your object, until lastread is negative.

» Blocking (synchronous use)

var http = new HttpConnection ("http://someserver/index.html")
http.response = new File("/c/index.html")
http.execute() ;

» Not blocking (asynchronous call)

var http = new HttpConnection ("http://some.website/file.html")
http.async = true ; // or http.sync = false ;
http.onCallback = function() {
with ( this ) {
if ( status == HttpConnection.statusComplete && http.lastread < 0 ) {
alert ("done") ;
this.close () ;

}
}

return HttpConnection.actionContinue ;

}

http.execute() ; // returns immediately

//

// . . . Somewhere and occasionally

if ( http.status <= HttpConnection.statusComplete && http.lastread >= 0 )
http.pump () ;

You can specify a user login name and password in the URL using the standard syntax:

http:// [username:] [passworde] server|:port] /path?querystring
Use an escape sequence for special characters, such as $20 for space and %40 for @.

You can override the user name and password specified in the URL by setting the username and password
on the HttpConnection object.

If the connection is challenged by the server and authentication is required, the operation invokes your
onAuthentication callback function. You can use this set the username and password properties; you
cannot use it to change the URL.



http://someserver/index.html
http://some.website/file.html
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» Authentication callback

var http = new HttpConnection ("http://www.website.com")

http.onAuthentication= function (host,realm,isProxy,retries,
currentUser, currentPassword) {

alert ("onHttpAuthentication CALLED" + \n +

"host = " + host + \n +

"realm = " + realm + \n +

"igProxy = " + isProxy + \n +

"retries = " + retrie + \n +

"currentUser = " + currentUser + \n +

"currentPassword = " + currentPassword ) ;
this.username = "therealusername"
this.password = "thepassword"

return HttpConnection.actionContinue ;

}

http.execute() ;

This section provides details of the Ht t pConnect ion object’s properties and functions.

[new] HttpConnection (

[url] );

url Optional. The URL to which to connect. The URL specifies the protocol; for example:

http://1 ocal host
https://I1 ocal host

If not provided, you must set the object’s url property.

async Boolean
chunked Boolean
byt esRecei ved Number
byt esSent Number

When true, the connection is asynchronous. Operations spawn a
thread and return immediately to the main thread. The background
thread sets i sConpl et e to true when the current operation has
finished. If the operation times out, i sConpl et e is set to true and err or
is setto error Ti neout .

Default is false. When set to true, sets sync to false. Read-write.

When true, send the response using chunked encoding. Default is
true. Read-write.

The number of bytes received from the HTTP server. -1 when there is
no connection.

The number of bytes transmitted to the HTTP server. -1 when there is
no connection.


http://www.website.com
http://localhost
https://localhost
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faul t

i sCpen

| astread

et hod

m ne

net wor k

Number

Boolean

Number

String

String

Number

The error status of the connection. Read only. A constant value, one

of:

H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnecti on.

faul t None

faul t User Cancel | ed

f aul t NoConnect i on

f aul t Host Not Found

f aul t Net Ti meout

faul tdient Ti neout
faul t Mal f or medUr |
faul tlnval i dResponse
f aul t Uhaut hori zed
faul t Rel ocat ed

When true, the connection to the FTP server is open. Default is false.

Read only.

The number of bytes read from the HTTP server during the last call to
pump(). Negative when execution is completely finished. Default is 0.

Read only.

The HTTP method. Read-write. One of:

CET (default)
PUT

HEAD
PCST
DELETE

The MIME type of the request. Default is t ext / ht ni . Read-write.

The network status of the connection. Read only. A constant value,

one of:

H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnect i on.
H t pConnecti on.
H t pConnecti on.

net wor kil dl e

net wor kConnect i ng

net wor kSendi ngRequest Header s
net wor kSendi ngRequest Body

net wor kAwai t i ngResponse

net wor kRecei vei ngResponseHeader s
net wor kRecei vei ngResponseBody
net wor kResponseConpl et e

net wor kPr oxyl dl e

net wor kKPr oxyConnect i ng

net wor kPr oxyCGonnect ed

onAut henti cation Function Optional. A callback function invoked by the server if authentication
fails using the username and password passed with the original URL.
Use this method to override the username and password by setting

thi s. username and t hi s. password.

The callback function takes these arguments:

host: the server name string.

realm: a string provided by the server.
isProxy: true if the server is a proxy.
retries: always 1
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onAut henti cati on
(cont’d)

onCal | back

password

pr oxy

redirect

response

r esponseencodi ng

r esponseheader s

responseSt at us

r equest

r equest encodi ng

request header s

Function

String

String

Number

String or
File

String
Array of
String
Number
String or
File
String

Array of
String

currentUser: the user name string already presented to the server.
currentPassword: the password string already presented to the
server.

The function should return H t pConnect i on. acti onCont i nue.

Optional. A callback function for the operation being executed. It is
automatically invoked periodically during synchronous operations.
For an asynchronous operation, each call to pump() invokes this
function. Read-write.

You can use this function to monitor the progress and check the
completion status in this object (the value of t hi s in the function), in
order to provide progress feedback in the user interface and allow
cancellation of long operations. Use t hi s. close() in this function to
halt the operation.

The function takes no arguments. It should return
H t pConnecti on. acti onCont i nue or H t pConnect i on. act i onCancel .

The connection password for the HTTP server. Set this to override the
password given in the URL. Default is undef i ned, for an unsecured or
anonymous connection. Read-write.

The HTTP proxy server. A string containing an IP address and port, or
the empty string to use the operating-system default, or undef i ned
(the default) for no proxy server. Read-write.

The maximum number of redirection tries for the request.

If the server redirects the request to another server (returning a
response status of 301 or 302), this connection resends the request to
that server. If it redirects this number of times without success, it
returns an error.

Default is 5. Read-write.

The response to the request, received from the HTTP server. Read
only.

The encoding to use in converting the request to a string. Default is
asci i . Read-write.

The response headers, an array of key-value pairs. Read only.

The response status, an HTTP Response code (such as 200 for OK, or
404 for “file not found”) or -1 if no status has been received. Read only.

The request to execute on the HTTP server. Read-write.

The encoding to use in converting the request string to binary.
Default is ut f 8. Read-write.

The request headers, an array of key-value pairs. Read-write.
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snooze

status

sync

t i meout

url

user nane

Number

Number

Boolean

Number

String

String

A number of milliseconds to wait before checking the completion
status of synchronous operations. Default is 10. Read-write.

The execution status of the request. Read only. A constant value, one
of:

H t pConnecti on. statusl dl e

H t pConnect i on. st at usRunni ng

H t pConnect i on. st at usConpl et ed

H t pConnect i on. st at usSuspended
H t pConnecti on. st at usFai | ed

When true, the connection is synchronous. Operations block the main
thread and return when complete. Default is true. When set to true,
sets async to false. Read-write.

An integer, the number of seconds to continue attempting to make
the connection before completing with the message
faul t Net Ti meout . Default is 5. Read-write.

The URL of the HTTP server, and optionally the port, to which to
connect. This includes the protocol (HTTP or HTTPS), and caninclude a
login user name and password in this format:

http[s]://[[ usernamne:] password@ server|[: port]
Default is undef i ned. Read-write.

The connection user name for the HTTP server. Set this to override the
user name given in the URL. Default is undef i ned, for an anonymous
connection. Read-write.

cl ose()

httpQj.close ();

Terminates the open connection. Deleting the object also closes the connection, but not until
JavaScript garbage-collects the object. The connection might stay open longer than you wish if you
do not close it explicitly. There are a limited number of open connections available; failing to close
connections can make you unable to open a new one.

Returns true if the connection was closed, false on |/O errors.

execut e()

htt pQyj . execute ();

Opens a connection if necessary, executes the request on the HTTP server, and receives the

response.

Returns true on success, false on errors. Check fault for the error c ode.
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punp()
ht t pQoj . punp ();

Increments the progress of an asynchronous connection. You must call this function periodically to
advance the progress of an asynchronous operation.

Executes the callback procedure defined in onCallback, passing no arguments.

Returns true on success, false on I/0 errors.
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TCP connections are the basic transport layer of the Internet. Every time your Web browser connects to a
server and requests a new page, it opens a TCP connection to handle the request as well as the server’s
reply. The JavaScript Socket object lets you connect to any server on the Internet and to exchange data
with this server.

The Socket object provides basic functionality to connect to a remote computer over a TCP/IP network or
the Internet. It provides calls like open () and close () to establish or to terminate a connection, and
read () orwrite () to transfer data. The 1isten () method establishes a simple Internet server; the
server uses the method pol1 () to check for incoming connections.

Many of these connections are based on simple data exchange of ASCIl data, while other protocols, like
the FTP protocol, are more complex and involve binary data. One of the simplest protocols is the HTTP
protocol. The following sample TCP/IP client connects to a WWW server (which listens on port 80); it then
sends a very simple HTTP GET request to obtain the home page of the WWW server, and then it reads the
reply, which is the home page together with a HTTP response header.

reply = "";
conn = new Socket;
// access Adobe's home page
if (conn.open ("www.adobe.com:80")) {
// send a HTTP GET request
conn.write ("GET /index.html HTTP/1.0\n\n") ;
// and read the server's reply
reply = conn.read(999999) ;
conn.close () ;

}

After executing this code, the variable reply contains the contents of the Adobe home page together
with an HTTP response header.

Establishing an Internet server is a bit more complicated. A typical server program sits and waits for
incoming connections, which it then processes. Usually, you would not want your application to run in an
endless loop, waiting for any incoming connection request. Therefore, you can ask a Socket object for an
incoming connection by calling the pol11 () method of a Socket object. This call would just check the
incoming connections and then return immediately. If there is a connection request, the call to pol11 ()
would return another Socket object containing the brand new connection. Use this connection object to
talk to the calling client; when finished, close the connection and discard the connection object.

Before a Socket object is able to check for an incoming connection, it must be told to listen on a specific
port, like port 80 for HTTP requests. Do this by calling the 1isten () method instead of the open ()
method.

The following example is a very simple Web server. It listens on port 80, waiting until it detects an
incoming request. The HTTP header is discarded, and a dummy HTML page is transmitted to the caller.

conn = new Socket;

// listen on port 80

if (conn.listen (80)) {
// wait forever for a connection
var incoming;
do incoming = conn.poll () ;
while (incoming == null);
// discard the request
conn.read() ;


http://www.adobe.com:80
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// Reply with a HTTP header

incoming.writeln ("HTTP/1.0 200 OK");

incoming.writeln ("Content-Type: text/html");

incoming.writeln() ;

// Transmit a dummy homepage

incoming.writeln ("<htmls><body><hl>Homepage</hl></body></html>") ;
// done!

incoming.close() ;

delete incoming;

}

Often, the remote endpoint terminates the connection after transmitting data. Therefore, there is a
connected property that contains true as long as the connection still exists. If the connected property
returns false, the connection is closed automatically.

On errors, the error property of the Socket object contains a short message describing the type of the
error.

The socket object lets you easily implement software that talks to each other via the Internet. You could,
for example, let two Adobe applications exchange documents and data simply by writing and executing
JavaScript programs.

The following sample code implements a very simple chat server. A chat client may connect to the chat
server, who is listening on port number 1234. The server responds with a welcome message and waits for
one line of input from the client. The client types some text and transmits it to the server who displays the
text and lets the user at the server computer type a line of text, which the client computer again displays.
This goes back and forth until either the server or the client computer types the word “bye".

// A simple Chat server on port 1234

function chatServer () {
var tcp = new Socket;
// listen on port 1234
writeln ("Chat server listening on port 1234");
if (tcp.listen (1234)) {
for (;;) {
// poll for a new connection
var connection = tcp.poll();
if (connection != null) ({
writeln ("Connection from " + connection.host) ;
// we have a new connection, so welcome and chat
// until client terminates the session
connection.writeln ("Welcome to a little chat!");
chat (connection) ;
connection.writeln ( "*** Goodbye ***"),;
connection.close() ;
delete connection;
writeln ("Connection closed") ;
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function chatClient () {

var connection = new Socket;

// connect to sample server

if (connection.open ("remote-pc.corp.adobe.com:1234")) {
// then chat with server
chat (connection) ;
connection.close() ;
delete connection;

}

function chat (c) {
// select a long timeout
c.timeout=1000;
while (true) {
// get one line and echo it
writeln (c.read());
// stop if the connection is broken
if (!c.connected)
break;
// read a line of text
write ("chat: ");
var text = readln() ;

if (text == "bye")
// stop conversation if the user entered "bye"
break;

else

// otherwise transmit to server
c.writeln (text);

This section provides details of the object’s properties and methods.

[new] Socket () ;

Creates and returns a new Socket object.

connected Boolean  When true, the connection is active. Read only.

encodi ng  String Sets or retrieves the name of the encoding used to transmit data. Typical
values are “ASCII," “BINARY,” or “UTF-8"

eof Boolean  When true, the receive buffer is empty. Read only.

error String A message describing the most recent error. Setting this value clears any error
message.
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host String The name of the remote computer when a connection is established. If the
connection is shut down or does not exist, the property contains the empty
string. Read only.

ti meout Number  The timeout in seconds to be applied to read or write operations. Default is 10.

cl ose()
socket @oj . cl ose ();

Terminates the open connection. Deleting the object also closes the connection, but not until
JavaScript garbage-collects the object. The connection might stay open longer than you wish if you
do not close it explicitly.

Returns true if the connection was closed, false on I/O errors.

| i sten()
socket @pj . listen (port [, encoding]);

port Number. The TCP/IP port number to listen on. Valid port numbers are 1 to 65535.
Typical values are 80 for a Web server, 23 for a Telnet server and so on.

encoding  Optional. String. The encoding to be used for the connection. Typical values are
“ASCII," “binary,” or “UTF-8." Default is “ASCII"

Instructs the object to start listening for an incoming connection.

The call to open() and the call toli sten() are mutually exclusive. Call one function or the other, not
both.

Returns true on success.

open()
socket Cbj . open (host [, encoding]);

host String. The name or IP address of the remote computer, followed by a colon and the
port number to connect to. The port number is required. Valid computer names are,
for example, “www.adobe.com:80” or “192.150.14.12:80"

encoding  Optional. String. The encoding to be used for the connection. Typical values are
“ASCII," “binary,” or “UTF-8." Default is “ASCII"

Opens the connection for subsequent read/write operations.

The call to open() and the call toli sten() are mutually exclusive. Call one function or the other, not
both.

Returns true on success.

pol | ()
socket Qj . pol |l ();

Checks a listening object for a new incoming connection. If a connection request was detected, the
method returns a new Socket object that wraps the new connection. Use this connection object to
communicate with the remote computer. After use, close the connection and delete the JavaScript
object. If no new connection request was detected, the method returns nul I .

Returns a Socket object ornul | .


http://www.adobe.com:80%E2%80%9D
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read()
socket @oj .read ([count]);

count Optional. Number. The number of characters to read; default is 0. If negative, the call is
equivalent toreadl n()

Reads up to the specified number of characters from the connection, waiting if necessary. Ignores CR
characters unless encoding is set to Bl NARY.

Returns a string that contains up to the number of characters that were supposed to be read, or the
number of characters read before the connection closed or timed out.

readl n()
socket pj .readl n ();

Reads one line of text up to the next line feed. Line feeds are recognized as LF or CRLF pairs. CR
characters are ignored.

Returns a string.

wite()
socket bj .wite (text[, text...]);

text String. Any number of string values. All arguments are concatenated to form the string
to be written.

Concatenates all arguments into a single string and writes that string to the connection. CRLF
sequences are converted to LFs unless encoding is set to Bl NARY.

Returns true on success.

writeln()
sockethj .wite (text[, text...]);

text String. Any number of string values. All arguments are concatenated to form the string
to be written.

Concatenates all arguments into a single string, appends a Line Feed character, and writes that
string to the connection.

Returns true on success.
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Integrating External Libraries

You can extend the JavaScript DOM for an application by writing a C or C++ shared library, compiling it for
the platform you are using, and loading it into JavaScript as an ExternalObject Object. A shared library is
implemented by a DLL in Windows, a bundle or framework in Mac OS, or a SharedObject in UNIX.

You can access the library functions directly through the ExternalObject instance, or you can define an
interface that allows your C/C++ code to create and access JavaScript classes and objects.

All Creative Suite 3 applications support this feature.

Example code

The sample code distributed with the Adobe Bridge and JavaScript SDK includes an example that
demonstrates how write a C/C++ shared library to be integrated with JavaScript. It is in the directory:

sdkInstall/sdksamples/cpp/

The sample shows how to write a plug-in for Adobe Bridge in C/C++, using the ExternalObject
mechanism, which enables the C/C++ code to be called from the JavaScript context. Project files for
Microsoft Visual Studio 2005 and XCode 2.4 are included in subfolders of
sdkInstall/sdksamples/cpp/build

To load an external shared library into JavaScript, create a new ExternalObject Object. The instance acts as
a container and manager for the JavaScript interface to the library. It provides a logging facility that prints
status information to the JavaScript Console in the ExtendScript Toolkit, to help you debug your external
library usage.

Once the library has been loaded, its exported symbols become available to JavaScript. In your JavaScript
code, you can call the functions defined in the library directly in the ExternalObject instance, or
indirectly through library-defined object types.

e Direct access to library calls through the ExternalObject instance

Use the direct access style for C-language libraries. For each function defined in the C library, there is a
corresponding method in the ExternalObject object. You can pass data to these methods and
receive the return value directly. For example:

mylib = new ExternalObject ("lib:" + samplelib); // load the library
alert (mylib.version) ;

// access functions directly from ExternalObject instance

var a = mylib.method abc(1,2.0,true, "this is data")

alert (a) ;

mylib.unload() ;

7

For details of how to define functions for direct access through the ExternalObject object, see “Defining
Entry Points for Direct Access” on page 187.

185
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Indirect access to library calls through JavaScript classes

Use the indirect style to access classes defined in a C++ library. For each C++ class defined in the library,
a corresponding JavaScript class is automatically defined, and you can access the properties and
methods through an instance of that class. For example:

anotherlib= new ExternalObject ("lib:" + filespec); // load the library
alert (anotherlib.version) ;

// instantiate library-defined class

var myObject = new MyNewClass () ;

// access functions from instance

var a = myObject.method abc(1,2.0,true,"this is data")

alert (a) ;

anotherlib.unload() ;

For details of how to define functions for direct access through the ExternalObject object, see “Defining
Entry Points for Indirect Access” on page 190.

You specify the name of the library in the constructor. The constructor searches for the named library
using the paths defined in the static property ExternalObject .searchFolders.

If you are having difficulty loading your library as an ExternalObject, set the property
ExternalObject.logto true, then call ExternalObject.search('lib:myLibrary'). This
function performs the search, and the log reports the paths that have been searched to the ExtendScript
Toolkit Console.

Before loading the library, the current folder is temporarily switched to the location of the found
executable file.

In Mac OS, the current directory is set to the bundle or framework folder for the library.

In Windows and UNIX, the current directory is set to the folder that contains the library.

obj = new ExternalObject ("lib:" + filespec, argl, ...argn);

filespec The specifier"l'i b: " is case sensitive, and serves as the marker for dynamic libraries.

Concatenate this to the base name of the shared library, with or without an
extension. ExtendScript appends a file extension if necessary, according to the
operating system:

e .dl1linWindows
e .bundleor .framework in Mac OS (only Mach-O bundles are supported)
e .soin UNIX (except for HP/UX, where the extensionis .s1 )

The name of the library is case sensitive in UNIX.

argl...argn | Optional. Any number of arguments to pass to the library’s initialization routine.

For example:

var mylib = new ExternalObject( "lib:myLibrary" );



7: Integrating External Libraries Defining Entry Points for Direct Access 187

The ExternalObject class provides these static properties:

| og Boolean  Set to true to write status information to standard output (the
JavaScript Console in the ExtendScript Toolkit). Set to false to turn
logging off. Default is false.

sear chFol ders String A set of alternate paths in which to search for the shared library files, a
single string with multiple path specifications delimited by semicolons
(; ). Paths can be absolute or relative to the Folder . startup location.

Default value is:
e InWindows,"P ugins; Plug-1ns;."

e InMacOS,"Pl ugins; Pl ug- I ns; Franeworks;.;../../../Pl ugins;
Aol /Pug-ins;../../../Frameworks;../../..;

e InUNIX, "Pl ugi ns; Pl ug- I ns; pl ugi ns; . "

version Number  The version of the library, as returned by ESGetVersion().

The ExternalObject class provides this static function to help debug problems with loading libraries as
external objects:

sear ch()
Ext er nal bj ect . sear ch ( spec)
spec String. The file specification for the compiled library, with or without path
information.

Reports whether a compiled C/C++ library can be found, but does not load it. If logging is on, the
paths searched are reported to the JavaScript Console in the ExtendScript Toolkit.

Returns true if the library is found, false otherwise.

A library to be loaded and accessed directly through an ExternalObject instance must publish the
following entry points:

ESInitialize()
char* ESInitialize (TaggedData* argv, long argc);

argv, argc The pointer to and number of arguments passed to the constructor, in the
form of TaggedData.

Called when your library is loaded into memory.

Returns a string of function signatures; see “Library initialization” on page 189.
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ESGet Ver si on()
ong ESGet Version (void );

Takes no arguments, and returns a version number for the library as a long integer. The result is
available in JavaScript as ExternalObject . version.

ESFr eeMent()
voi d ESFreeMem (voi d* p);

p A pointer to the string.

Called to free memory allocated for a nul | -terminated string passed to or from library functions.
Returns nothing.

ESTer m nat e()
voi d ESTerminate (void );

Called when your library is being unloaded. See “Library termination” on page 189.

Takes no arguments, and returns nothing.

The shared library can contain any number of additional functions. Each function corresponds to a
JavaScript method in the ExternalObject instance. If a function is undefined, ExtendScript throws a
run-time error.

Each function must accept the following arguments:

e An array of TaggedData.
e Anargument count.

e A variant data structure that takes the return value.

The variant data does not support JavaScript objects. The following data types are allowed:

Undef i ned

Bool ean

Doubl e

String Must be UTF-8 encoded.

The library must define an entry point ESFreeMem(), which ExtendScript calls to
release a returned string pointer. If this entry point is missing, ExtendScript does not
attempt to release any returned string data.

Scri pt A string to be evaluated by ExtendScript. Use to return small JavaScript scripts that
define arbitrarily complex data.

If, when a function is invoked, a supplied parameter is undefined, ExtendScript sets the data type to
undef i ned and does not attempt to convert the data to the requested type.

Note: The data type of a return value cannot be predefined; JavaScript functions can return any data type.
The called function is free to return any of the listed data types.
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ExtendScript calls ESInitialize() to initialize the library.

e The function receives an argument vector containing the additional arguments passed in to the
ExternalObject constructor.

e The function can return an array of function name-signature strings, which are used to support the
ExtendScript Reflection Interface, and to cast function arguments to specific types. You do not need to
define a signature for a function in order to make it callable in JavaScript.

If you choose to return a set of function name-signature strings, each string associates a function name
with that function’s parameter types, if any. For example:

["functionNamel argtypes", "functionName2 argtypes', "functionName3"]
For each function, the string begins with the function name, followed by an underscore character and a
list of argument data types, represented as a single character for each argument. If the function does not

have arguments, you can omit the trailing underscore character (unless there is an underscore in the
function name).

The characters that indicate data types are:

a Any type. The argument is not converted. This is the default, if no
type is supplied or if a type code is unrecognized.

b Boolean

d signed 32 bit integer

U unsigned 32 bit integer
f 64 bit floating point

s String

For example, suppose your library defines these two entry points:

One (Integer a, String b);
Two () ;

The signature strings for these two functions would be "one ds", "Two™.

Note: You cannot define function overloading by returning multiple different signatures for one function.
Attempting to do so produces undefined results.

Define the entry point ESTerminate() to free any memory you have allocated when your library is
unloaded.

Whenever a JavaScript function makes a call to a library function, it increments a reference count for that
library. When the reference count for a library reaches 0, the library is automatically unloaded; your
termination function is called, and the ExternalObject instance is deleted. Note that deleting the
ExternalObject instance does not unload the library if there are remaining references.
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The C-client object interface for external libraries allows your C or C++ shared-library code to define,
create, use, and manage JavaScript objects.

The following entry points are required if you wish to use the object interface:

ESA i ent I nterface()
nt ESAientinterface (SoCdient_e kReason, SoServerlnterface* pServer, SoHServer hServer)

kReason The reason for this call, one of these constants:

kSoQd i ent _i ni t: The function is being called for initialization upon load.
kSoQd i ent _t er m: The function is being called for termination upon
unload.

pServer A pointer to an SoServerInterface containing function pointers for the entry
points, which enable the shared-library code to call into JavaScript to create
and access JavaScript classes and objects.

The shared-library code is responsible for storing this structure between the
initialization and termination call, and retrieving it to access the functions.

hSer ver An SoHServer reference for this shared library. The server is an object factory
that creates and manages SoHObject objects.

The shared-library code is responsible for storing this structure between the
initialization and termination calls. You must pass it to taggedDatalnit() and
taggedDataFree().

Your library must define this global function in order to use the object interface to JavaScript. The
function is called twice in each session, immediately upon loading the library, and again when
unloading it.

Returns an error code, KESEr r K on success.

ESVal | ocMend()
voi d * ESMal | ocMem ( si ze_t nbytes)

nbyt es The number of bytes to allocate.

Provides a memory allocation routine to be used by JavaScript for managing memory associated
with the library’s objects.

Returns a pointer to the allocated block of memory.

Your shared-library C/C++ code defines its interface to JavaScript in two sets of functions, collected in
SoServerinterface and SoObjectinterface function-pointer structures.

Return values from most functions are integer constants. The error code kESErrOK == 0 indicates
success.
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SoServerInterface is a structure of function pointers which enable the shared-library code to call

JavaScript objects. It is passed to the global ESClientInterface() function for initialization when the library is
loaded, and again for cleanup when the library is unloaded. Between these calls, your shared-library code
must store the structure and use it to access the communication functions.

You can store information for every object and class in your C code. The recommended method is to create
a data structure during the initialize() and free it during finalize(). You can then access that data with

setClientData() and getClientData().

The SoServerInterface structure contains these function pointers:

SoServerInterface {
SoServerDumpServer f
SoServerDumpObject f

SoServerAddClass f
SoServerAddMethod f
SoServerAddMethods f
SoServerAddProperty f

SoServerAddProperties f

SoServerGetClass f
SoServerGetServer f

SoServerSetClientData f
SoServerGetClientData f

SoServerEval f

dumpServer; //debugging, show server in console
dumpObject; //debugging, show object in console

addClass; //define a JS class
addMethod; // define a method
addMethods; // define a set of methods
addProperty; // define a property

addProperties; // define a set of properties

getClass; // get class for an instance
getServer; // get server for an instance

setClientData; //set data in instance
getClientData; //get data from instance

eval; // call JavaScript interpreter

SoServerTaggedDatalInit f taggedDataInit; // init tagged data
SoServerTaggedDataFree f taggedDataFree; // free tagged data

}

These functions allow your C/C++ shared library code to create, modify, and access JavaScript classes and
objects. The functions must conform to the following type definitions.

dunpSer ver ()

ESerror_t dunpServer (SoHServer hServer);

hSer ver The SoHServer reference for this shared library, as passed to your global
ESClientInterface() function on initialization.

Prints the contents of this server to the JavaScript Console in the ExtendScript Toolkit, for

debugging.

Returns an error code, KESEr r K on success.
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dunpChj ect ()
ESerror_t dunpChj ect (SoHOhj ect hQbj ect);
h@j ect The SoHODbject reference for an instance of this class.
Prints the contents of this object to the JavaScript Console in the ExtendScript Toolkit, for
debugging.
Returns an error code, KESEr r K on success.
addd ass()
ESerror_t addd ass (SoHServer hServer, char* name, SoQhjectlnterface_p pQyectlnterface);
hSer ver The SoHServer reference for this shared library, as passed to your global
ESClientInterface() function on initialization.
nane String. The unique name of the new class. The name must begin with an
uppercase alphabetic character.
pQojectinterface A pointerto an SoObjectinterface. A structure containing pointers to the
object interface methods for instances of this class.
Creates a new JavaScript class.
Returns an error code, KESEr r CK on success.
addMet hod()
ESerror_t addMet hod (SoHbj ect hQbj ect, const char* nane, int id, char* desc);
hQvj ect The SoHODbject reference for an instance of this class.
naire String. The unique name of the new method.
id Number. The unique identifier for the new method.
desc String. A descriptive string for the new method.
Adds new method to an instance.
Returns an error code, KESEr r K on success.
addMet hods()
ESerror_t addMet hods (SoHChj ect h(hj ect, SoCd i ent Nane_p pNanes);
hQyj ect The SoHODbject reference for an instance of this class.
phares| | SoCClientName. A structure containing the names and identifiers of methods
to be added.

Adds a set of new methods to an instance.

Returns an error code, KESEr r CK on success.
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addPr operty()
ESerror_t addProperty (SoHDj ect hQbject, const char* nane, int id, char* desc);
hQj ect The SoHObject reference for an instance of this class.
namne String. The unique name of the new property.
id Number. The unique identifier for the new property.
desc

String. Optional. A descriptive string for the new property, or nul I .
Adds new property to an instance.

Returns an error code, KESEr r K on success.

addPr operties()
ESerror_t addProperties (SoHDbj ect hQyject, SoQdientNane_p pNanes);

h@yj ect The SoHObject reference for an instance of this class.

phares| | SoCClientName. A structure containing the names and identifiers of
properties to be added.

Adds a set of new properties to an instance.

Returns an error code, KESEr r K on success.

get A ass()

ESerror_t getd ass (SoHbj ect hhj ect, char* nane, int nane_l);
h@j ect The SoHODbject reference for an instance of the class.
namne String. A buffer in which to return the unique name of the class.
name_| Number. The size of the name buffer.

Retrieves this object’s parent class name.

Returns an error code, KESEr r K on success.

get Server ()

ESerror_t getServer (SoHDbject h@bject, SoHServer* phServer,
SoServer | nterface_p* ppServerlnterface);

hayj ect The SoHObject reference for an instance of the class.

phSer ver A buffer in which to return theSoHServer reference for this object.

ppServerlnterface A bufferin which to return the SoServerinterface reference for this object.

Retrieves the interface methods for this object, and the server object that manages it.
Returns an error code, kESEr r K on success.
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set d i ent Dat a()
ESerror_t setdientData (SoHMj ect hQyj ect, void* pData);

hayj ect The SoHODbject reference for an instance of the class.
phat a A pointer to the library-defined data.

Sets your own data to be stored with an object.

Returns an error code, KESEr r CK on success.

get A i ent Dat a()
ESerror_t setdientData (SoHbj ect hQyject, void** pLata);

hQj ect The SoHObject reference for an instance of the class.
pDat a A buffer in which to return a pointer to the library-defined data.

Retrieves data that was stored with setClientData().

Returns an error code, KESEr r K on success.

eval ()
ESerror_t eval (SohServer hServer, char* string, TaggedData* pTaggedData);

hSer ver The SoHServer reference for this shared library, as passed to your global
ESClientInterface() function on initialization.

string A string containing the JavaScript expression to evaluate.
pTaggedlat a A pointer to a TaggedData object in which to return the result of evaluation.

Calls the JavaScript interpreter to evaluate a JavaScript expression.

Returns an error code, KESEr r CK on success.

t aggedDat al ni t ()
ESerror_t taggedDatal nit (SoHSever hServer, TaggedData* pTaggedData);

hSer ver The SoHServer reference for this shared library, as passed to your global
ESClientInterface() function on initialization.

pTaggedDat a A pointer to the TaggedData.
Initializes a TaggedData structure.

Returns an error code, KESEr r K on success.

t aggedDat aFr ee()
ESerror_t setdientData (SoHServer hServer, TaggedData* pTaggedDat a);

hSer ver The SoHServer reference for this shared library, as passed to your global
ESClientInterface() function on initialization.

pTaggedDat a A pointer to the TaggedData.
Frees memory being used by a TaggedData structure.

Returns an error code, KESEr r K on success.
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When you add a JavaScript class with SoServerInterface.addClass (), you must provide this
interface. JavaScript calls the provided functions in order to interact with objects of the new class.
The soObjectInterface is an array of function pointers defined as follows:

SoObjectInterface {
SoObjectInitialize f initialize;

SoObjectPut £ put;
SoObjectGet £ get;
SoObjectCall f call;
SoObjectValueOf £ valueOf;

SoObjectToString £ toString;
SoObjectFinalize £ finalize;

}

All SoObjectInterface members must be valid function pointers, or NULL. You must implement
initialize () and finalize (). The functions must conform to the following type definitions.

initialize()
ESerror_t initialize (SoHChj ect hQyject, int argc, TaggedData* argv);

hQvj ect The SoHODbject reference for this instance.
arge, argv The number of and pointer to arguments passed to the constructor, in the

form of TaggedData.

Required. Called when JavaScript code instantiates this class with the newoperator:

var xx = New MyQ ass(argl, ...)
The initialization function typically adds properties and methods to the object. Objects of the same
class can offer different properties and methods, which you can add with the addMethod() and
addProperty() functions in the stored SoServerinterface.

Returns an error code, KESEr r CK on success.

put ()
ESerror_t put (SoHMDject h@ject, SoCdient Nare* name, TaggedData* pVal ue);

hQj ect The SoHObject reference for this instance.
naire The name of the property, a pointer to an SoCClientName.
pVval ue The new value, a pointer to a TaggedData.

Called when JavaScript code sets a property of this class:

XX. nyproperty = "abc" ;
If you provide NULL for this function, the JavaScript object is read-only.

Returns an error code, KESEr r CK on success.
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et
i Esfei ror_t get (SoH®Dject h@ject, SoCdient Name* nane, TaggedData* pVal ue);
h@j ect The SoHODbject reference for this instance.
nane The name of the property, a pointer to an SoCClientName.
pVal ue A buffer in which to return the property value, a TaggedData.

Called when JavaScript code accesses a property of this class:

al ert (xx. nyproperty);
Returns an error code, KESEr r K on success.

cal | ()

ESerror_t call (SoHbject hhject, SoCQdient Nanme* nane, int argc, TaggedData* argv,
TaggedDat a* pResul't);

hQyj ect The SoHODbject reference for this instance.
nane The name of the method, an SoCClientName.
arge, argv The number and pointer to arguments passed to the call, in the form of

TaggedDatas.
pResul t A buffer in which to return the result of the call, in the form of TaggedDatas.

Called when JavaScript code calls a method of this class:

XX. nymet hod()
Required in order for JavaScript to call any methods of this class.

Returns an error code, KESEr r CK on success.

val ueCr ()
ESerror_t valued (SoHMDject hQyj ect, TaggedData* pResult);
hQyj ect The SoHObject reference for this instance.
pResul t A buffer in which to return the result of the value, in the form of TaggedDatas.

Creates and returns the value of the object, with no type conversion.

Returns an error code, KESEr r K on success.

toString()
ESerror_t toString (SoHbject hQyj ect, TaggedDat a* pResult);
hQyj ect The SoHObject reference for this instance.
pResul t A buffer in which to return the result of the string, in the form of TaggedDatas.

Creates and returns a string representing the value of this object.

Returns an error code, KESEr r CK on success.
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finalize()
ESerror_t finalize (SoHDject hQyject);

hayj ect The SoHObject reference for this instance.

Required. Called when JavaScript deletes an instance of this class. Use this function to free any
memory you have allocated.

Returns an error code, KESEr r K on success.

These support structures are passed to functions that you define for your JavaScript interface:

SoHMj ect An opaque pointer (I ong *) to the C/C++ representation of a JavaScript object.

SoHSer ver An opaque pointer (I ong *) to the server object, which acts as an object factory for the
shared library.

SoCClientName A structure that uniquely identifies methods and properties.

TaggedData A structure that encapsulates data values with type information, to be passed between
C/C++ and JavaScript.

The soCClientName data structure stores identifying information for methods and properties of
JavaScript objects created by shared-library C/C++ code. It is defined as follows:

SoCClientName {
char* name sig ;
uint32_t id ;
char* desc ;

}

nane_si g The name of the property or method, unique within the class.
Optionally contains a signature following an underscore, which identifies the types of
arguments to methods; see Function signatures. When names are passed back to your
SoObjectinterface functions, the signature portion is omitted.

id A unique identifying number for the property or method, or 0 to assign a generated
uID.
If you assign the UID, your C/C++ code can use it to avoid string comparisons when
identifying JavaScript properties and methods. It is recommended that you either
assign all UIDs explicitly, or allow them all to be generated.

desc A descriptive string or NULL.

The TaggedData structure is used to communicate data values between JavaScript and shared-library
C/C++ code. Types are automatically converted as appropriate.

typedef struct {
union
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long intval;

double fltval;
char* string;
SoHObject* hObject;

} data;

long type;

long filler;
} TaggedData;

i nt val
fltval

string

hQyj ect

type

filler

Integer and boolean data values. Type is kTypel nt eger, kTypeU nt eger, or kTypeBool .
Floating-point numeric data values. Type is kTypeDoubl e.

String data values. All strings are UTF-8 encoded and nul | -terminated. Type is
kTypeStri ng or kTypeScri pt .

e The library must define an entry point ESFreeMem(), which ExtendScript calls to
release a returned string pointer. If this entry point is missing, ExtendScript does
not attempt to release any returned string data.

e When a function returns a string of type kTypeScri pt, ExtendScript evaluates the
script and returns the result of evaluation as the result of the function call.

A C/C++ representation of a JavaScript object data value. Type is kTypeLi veQhj ect or
kTypeLi ve(bj ect Rel ease.

e When afunction returns an object of type kTypeLi veQj ect , ExtendScript does not
release the object.

e When a function returns an object of type kTypeLi ve(hj ect Rel ease, ExtendScript
releases the object.

The data type tag. One of:

kTypeUndef i ned: a null value, equivalent of JavaScript undef i ned. The return value
for a function is always set to this by default.

kTypeBool : a boolean value, 0 for false, 1 for true.

kTypeDoubl e: a 64-bit floating-point number.

kTypeSt ri ng: a character string.

kTypeLi ve(oj ect : a pointer to an internal representation of an object (SoHObject).

kTypeLi ve(bj ect Rel ease: a pointer to an internal representation of an object
(SoHObject).

kTypel nt eger : a 32-bit signed integer value.

kTypeU nt eger : a 32-bit unsigned integer value.

kTypeScri pt : a string containing an executable JavaScript script.

A 4-byte filler for 8-byte alignment.




8 ExtendScript Tools and Features

In addition to the specific functional modules and development tools, ExtendScript provides these tools
and features:

Global objects that support debugging and object inspection; these include the Dollar ($) Object
and the ExtendScript Reflection Interface.

A localization utility for providing user-interface string values in different languages. See Localizing
ExtendScript Strings.

Global functions for displaying short messages in dialog boxes. See User Notification Dialogs.

An object type for specifying measurement values together with their units. See Specifying
Measurement Values.

Modular Programming Support: Tools for combining scripts, which include Preprocessor directives
and Importing and exporting between scripts.

Support for extending or overriding math and logical operator behavior on a class-by-class basis.
See Operator Overloading.

ExtendScript also provides a common scripting environment for all Adobe JavaScript-enabled
applications, and allows interapplication communication through scripts. For information on these
features, see Chapter 5, “Interapplication Communication with Scripts.”

This global ExtendScript object provides a number of debugging facilities and informational methods. The
properties of the $ object allow you to get global information such as the most recent run-time error, and
set flags that control debugging and localization behavior. The methods allow you to output text to the
JavaScript Console during script execution, control execution and other ExtendScript behavior
programmatically, and gather statistics on object use.

build Number The ExtendScript build number. Read only.

bui | dDat e Date The date the current JavaScript engine was built. Read only.

engi neNare String The name of the current JavaScript engine, if set. Read only.

error Error The most recent run-time error information, contained in a
String JavaScript Error object.

Assigning error text to this property generates a run-time error;
however, the preferred way to generate a run-time error is to throw
an Error object.

fil eNane String The file name of the current script. Read only.

199
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flags Number Gets or sets low-level debug output flags. A logical AND of the
following bit flag values:

0x0002 (2): Displays each line with its line number as it is
executed.

0x0040 (64): Enables excessive garbage collection. Usually,
garbage collection starts when the number of objects has
increased by a certain amount since the last garbage
collection. This flag causes ExtendScript to garbage collect
after almost every statement. This impairs performance
severely, but is useful when you suspect that an object gets
released too soon.

0x0080 (128): Displays all calls with their arguments and the
return value.

0x0100 (256): Enables extended error handling (see strict).

0x0200 (512): Enables the localization feature of thet oSt ri ng
method. Equivalent to the localize property.

gl obal Global Provides access to the @ obal object, which contains the JavaScript
global namespace.

i ncl udePat h String The path for include files for the current script. Read only.

| evel Number The current debugging level, which enables or disables the
JavaScript debugger. Read only. One of:

0: No debugging
1: Break on runtime errors
2: Full debug mode

| ocal e String Gets or sets the current locale. The string contains five characters in
the form LL_RR where LLis an ISO 639 language specifier, and RRis
an I1SO 3166 region specifier.

Initially, this is the value that the application or the platform returns
for the current user. You can set it to temporarily change the locale
for testing. To return to the application or platform setting, set to
undef i ned, nul I, or the empty string.

| ocal i ze Boolean Enable or disable the extended localization features of the built-in
t oSt ri ng method. See Localizing ExtendScript Strings.

nenCache Number Gets or sets the ExtendScript memory cache size in bytes.
0s String The current operating system version information. Read only.
screens Array An array of objects containing information about the display screens

attached to your computer.

e Eachobject has the properties| eft,top,ri ght,and bot t om which
contain the four corners of each screen in global coordinates.

e A property prinary is true if that object describes the primary
display.

st ack String The current stack trace.
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strict Boolean When true, any attempt to write to a read-only property causes a
runtime error. Some objects do not permit the creation of new
properties when true.

version String The version number of the JavaScript engine as a three-part number
and description; for example: “3.6.5 (debug)” Read only.

Function Return type
about () String
$. about ()

Displays the About box for the ExtendScript component, and returns the text
of the About box as a string.

bp() undef i ned
$.bp ([condition])
Executes a breakpoint at the current position.

condi ti on: Optional. A string containing a JavaScript statement to be
used as a condition. If the statement evaluates to true or nonzero
when this point is reached, execution stops.

If no condition is needed, it is recommended that you use the JavaScript
debugger statement in the script, rather than this method.

col or Pi cker () Number
$. col or Pi cker (nane)

Invokes the platform-specific color selection dialog, and returns the selected
color as a hexadecimal RGB value: 0x RRGEBB

nane: The color to be preselected in the dialog, as a hexadecimal RGB
value (0xRR@BB), or -1 for the platform default.

eval Fil e() Any
$.evalFile (path[, tinmeout])

Loads a JavaScript script file from disk, evaluates it, and returns the result of
evaluation.

pat h: The name and location of the file.

ti meout : Optional. A number of milliseconds to wait before returning
undef i ned, if the script cannot be evaluated. Default is 10000
milliseconds.

gc() undef i ned
$.gc ()
Initiates garbage collection in the JavaScript engine.

getenv() String
$. getenv (envnane)

Retrieves the value of the specified environment variable, or nul | if no such
variable is defined.

envnarne: The name of the environment variable.
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Function Return type
setenv() undef i ned
$. setenv (envnane, val ue)
Sets the value of the specified environment variable, if no such variable is
defined.
envnane: The name of the environment variable.
val ue: The new value, a string.
sl eep() undef i ned
$.sl eep (nilliseconds)
Suspends the calling thread for the given number of milliseconds.
milliseconds: The number of milliseconds to wait.
During a sleep period, checks at 100 millisecond intervals to see whether the
sleep should be terminated. This can happen if there is a break request, or if
the script timeout has expired.
wite() undef i ned
$.wite (text[, text...]...)
Writes the specified text to the JavaScript Console.
text: One or more strings to write, which are concatenated to form a
single string.
witeln() undef i ned

$.witeln (text[, text...]...)
Writes the specified text to the JavaScript Console and appends a linefeed
sequence.

text: One or more strings to write, which are concatenated to form a
single string.
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ExtendScript provides a reflection interface that allows you to find out everything about an object,
including its name, a description, the expected data type for properties, the arguments and return value
for methods, and any default values or limitations to the input values.

Every object has a reflect property that returns a reflection object that reports the contents of the
object. You can, for example, show the values of all the properties of an object with code like this:

var £ = new File ("myfile");
var props = f.reflect.properties;
for (var i = 0; i < props.length; i++) {
S.writeln('this property ' + props[i] .name + ' is ' + f[props[i] .name]l) ;
}

All properties are read only.

description  String Short text describing the reflected object, or undef i ned if no
description is available.

hel p String Longer text describing the reflected object more completely, or
undef i ned if no description is available.

met hods Array of An Array of ReflectionInfo objects containing all methods of the
Reflectioninfo  reflected object, defined in the class or in the specific instance.

nare String The class name of the reflected object.

properties Array of An Array of Reflectionlnfo objects containing all properties of the
Reflectioninfo  reflected object, defined in the class or in the specific instance. For
objects with dynamic properties (defined at runtime) the list contains
only those dynamic properties that have already been accessed by
the script. For example, in an object wrapping an HTML tag, the
names of the HTML attributes are determined at run time.

find()
reflectionj.find (nane)

nane The property for which to retrieve information.

Returns the ReflectionInfo object for the named property of the reflected object, or nul | if no such
property exists.

Use this method to get information about dynamic properties that have not yet been accessed, but
that are known to exist.
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» Examples
This code determines the class name of an object:
obj = new String ("hi");
obj.reflect.name; // => String
This code gets a list of all methods:
obj = new String ("hi");
obj.reflect.methods; //=> indexOf,slice, ...
obj.reflect.find ("indexOf"); // => the method info
This code gets a list of properties:

Math.reflect.properties; //=> PI,LOG10, ...

This code gets the data type of a property:
Math.reflect.find ("PI") .type; // => number

This object contains information about a property, a method, or a method argument.

e You can access ReflectionInfo objects in a Reflection object’s properties and methods arrays,
by name or index:

obj = new String ("hi");
obj.reflect.methods [0];
obj.reflect.methods ["index0Of"] ;

e You can access the ReflectionInfo objects for the arguments of a method in the arguments array
of the ReflectionInfo object for the method, by index:

obj.reflect.methods ["indexOf"] .arguments [0] ;

ar gunent s Array of For a reflected method, an array of ReflectionInfo objects
Reflectioninfo  describing each method argument.

dat aType String The data type of the reflected element. One of:

bool ean

nunber

string

d assnane: The class name of an object.

Note: Class names start with a capital letter. Thus, the value
st ri ng stands for a JavaScript string, while Stringisa
JavaScript St ri ng wrapper object.

*: Any type. This is the default.

nul |

undef i ned: Return data type for a function that does not
return any value.

unknown
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def aul t Val ue any The default value for a reflected property or method argument,
or undef i ned if there is no default value, if the property is
undefined, or if the element is a method.

description String Short text describing the reflected object, or undef i ned if no
description is available.

hel p String Longer text describing the reflected object more completely, or
undef i ned if no description is available.

i sCol | ecti on Boolean When true, the reflected property or method returns a collection;
otherwise, false.

nmax Number The maximum numeric value for the reflected element, or
undef i ned if there is no maximum or if the element is a method.

mn Number The minimum numeric value for the reflected element, or
undef i ned if there is no minimum or if the element is a method.

nane String The name of the reflected element. A string, or a number for an
Number array index.
type String The type of the reflected element. One of:

readonl y: A Read only property.

readw it e: A read-write property.

creat eonl y: A property that is valid only during creation of an
object.

met hod: A method.
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Localization is the process of translating and otherwise manipulating an interface so that it looks as if it
had been originally designed for a particular language. ExtendScript gives you the ability to localize the
strings in your script’s user interface. The language is chosen by the application at startup, according to
the current locale provided by the operating system.

For portions of your user interface that are displayed on the screen, you may want to localize the displayed
text. You can localize any string explicitly using the Global localize function, which takes as its argument a
localization object containing the localized versions of a string.

A localization object is a JavaScript object literal whose property names are locale names, and whose
property values are the localized text strings. The locale name is a standard language code with an
optional region identifier. For details of the syntax, see Locale names.

In this example, a msg object contains localized text strings for two locales. This object supplies the text for
an alert dialog.

msg = { en: "Hello, world", de: "Hallo Welt" };
alert (msg);

ExtendScript matches the current locale and platform to one of the object’s properties and uses the
associated string. On a German system, for example, the property de: "Hallo Welt" is converted to
the string "Hallo Welt™".

Some localization strings need to contain additional data whose position and order may change
according to the language used.

You can include variables in the string values of the localization object, in the form %n. The variables are
replaced in the returned string with the results of JavaScript expressions, supplied as additional
arguments to the 1ocalize function. The variable $1 corresponds to the first additional argument, %2 to
the second, and so on.

Because the replacement occurs after the localized string is chosen, the variable values are inserted in the
correct position. For example:

today = {
en: "Today is %1/%2.",
de: "Heute ist der %2.%1."
}i
d = new Date() ;
alert (localize (today, d.getMonth()+1l, d.getDate()));

ExtendScript offers an automatic localization feature. When it is enabled, you can specify a localization
object directly as the value of any property that takes a localizable string, without using the 1ocalize
function. For example:

msg = { en: "Yes", de: "Ja", fr: "Oui" };
alert (msg);
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To use automatic translation of localization objects, you must enable localization in your script with this
statement:

S.localize = true;

The localize function always performs its translation, regardless of the setting of the $.1localize
variable. For example:

msg = { en: "Yes", de: "Ja", fr: "Oui" };
//0nly works if the $.localize=true

alert (msg) ;

//Always works, regardless of $.localize value
alert ( localize (msg)) ;

If you need to include variables in the localized strings, use the 1ocalize function.

A locale name is an identifier string in that contains an ISO 639 language specifier, and optionally an ISO
3166 region specifier, separated from the language specifier by an underscore.

e TheISO 639 standard defines a set of two-letter language abbreviations, such as en for English and de
for German.

e TheISO 3166 standard defines a region code, another two-letter identifier, which you can optionally
append to the language identifier with an underscore. For example, en_US identifies U.S. English,
while en_GB identifies British English.

This object defines one message for British English, another for all other flavors of English, and another for
all flavors of German:
message = {
en GB: "Please select a colour."

en: "Please select a colour."
de: "Bitte wdhlen Sie eine Farbe."

}i

If you need to specify different messages for different platforms, you can append another underline
character and the name of the platform, one of Win, Mac, or Unix. For example, this objects defines one
message in British English to be displayed on Mac OS, one for all other flavors of English on Mac OS, and
one for all other flavors of English on all other platforms:

pressMsg = {
en GB Mac: "Press Cmd-S to select a colour.",
en_Mac: "Press Cmd-S to select a color.",
en: "Press Ctrl-S to select a color."

}i

All of these identifiers are case sensitive. For example, EN_US is not valid.

» How locale names are resolved
1. ExtendScript gets the hosting application’s locale; for example, en US.
2. It appends the platform identifier; for example, en_US_ Win.

3. Itlooks for a matching property, and if found, returns the value string.

4. If not found, it removes the platform identifier (for example, en US) and retries .
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5. If not found, it removes the region identifier (for example, en) and retries .

6. If not found, it tries the identifier en (that is, the default language is English).

7. If not found, it returns the entire localizer object.

ExtendScript stores the current locale in the variable $ . 1ocale. This variable is updated whenever the
locale of the hosting application changes.

To test your localized strings, you can temporarily reset the locale. To restore the original behavior, set the
variable to nul I, false, 0, or the empty string. An example:

$.locale = "ru"; // try your Russian messages

$S.locale

null; // restore to the locale of the app

The globally available 1ocalize function can be used to provide localized strings anywhere a displayed
text value is specified. The function takes a specially formatted set of localized versions of a display string,
and returns the version appropriate to the current locale.

| ocal i ze()

| ocal i ze (ZString)

localize (/ocalization obj[, args])

| ocal i zat i on_obj

args

ZString

A JavaScript object literal whose property names are locale names, and whose
property values are the localized text strings. The locale name is an identifier
as specified in the ISO 3166 standard, a set of two-letter language
abbreviations, such as "en” for English and "de” for German.

For example:
btnText = { en: "Yes", de: "Ja", fr: "Qui" };
bl = wadd ("button", undefined, |ocalize (btnText));
The string value of each property can contain variables in the form %, %, and

so on, corresponding to additional arguments. The variable is replaced with
the result of evaluating the corresponding argument in the returned string.

Optional. Additional JavaScript expressions matching variables in the string
values supplied in the localization object. The first argument corresponds to
the variable 94, the second to %2, and so on.

Each expression is evaluated and the result inserted in the variable’s position
in the returned string.

Internal use only. A ZString is an internal Adobe format for localized strings,
which you might see in Adobe scripts. It is a string that begins with $$$ and
contains a path to the localized string in an installed ZString dictionary. For
example:

w = new Wndow ("dial og", localize ("$3$/U/titlel=Sanple"));
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For example:

today = {
en: "Today is %1/%2",
de: "Heute ist der %2.%1."

Vi
d = new Date() ;
alert (localize (today, d.getMonth()+1l, d.getDate()));

ExtendScript provides a set of globally available functions that allow you to display short messages to the
user in platform-standard dialog boxes. There are three types of message dialogs:

e Alert: Displays a dialog containing a short message and an OK button.

e Confirm: Displays a dialog containing a short message and two buttons, Yes and No, allowing the user
to accept or reject an action.

e Prompt: Displays a dialog containing a short message, a text entry field, and OK and Cancel buttons,
allowing the user to supply a value to the script.

These dialogs are customizable to a small degree. The appearance is platform specific.

Displays a platform-standard dialog containing a short message and an OK button.

al ert ()
alert (nessage[, title, errorlcon]);

nmessage The string for the displayed message.

title Optional. A string to appear as the title of the dialog, if the platform supports a
title. Mac OS does not support titles for alert dialogs. The default title string is
"Script Alert.”

errorlcon Optional. When true, the platform-standard alert icon is replaced by the

platform-standard error icon in the dialog. Default is false.

Returns undef i ned

» Examples

This figure shows simple alert dialogs in Windows and in Mac OS.

Script Alert [ Title

i Header i Header Header
Message Message
; Message
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This figure shows alert dialogs with error icons.

[ Titte

Header
Header Meteans
Message 9

Displays a platform-standard dialog containing a short message and two buttons labeled Yes and No.

conf i rn()
confirm (nmessage[, noAsD¥It ,title]);
nessage The string for the displayed message.
noAsD¥ | t Optional. When true, the No button is the default choice, selected when the

user types ENTER. Default is false, meaning that Yes is the default choice.

titlhe Optional. A string to appear as the title of the dialog, if the platform supports a
title. Mac OS does not support titles for confirmation dialogs. The default title
string is “Script Alert”

Returns true if the user clicked Yes, false if the user clicked No.

» Examples

This figure shows simple confirmation dialogs on Windows and Mac OS.

| script Alert
Header
2 Header
e Message ; I Message
o '
[ No 3 (—Vaﬂ—)

This figure shows confirmation dialogs with No as the default button.

script Alert

<@ Header Ll

) Message ; Message

i T G ) G
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Displays a platform-standard dialog containing a short message, a text edit field, and two buttons labeled

OK and Cancel.
pr onpt ()
pronpt (nessage, preset[, title]);
nmessage The string for the displayed message.
preset The initial value to be displayed in the text edit field.
title

Optional. A string to appear as the title of the dialog. On Windows, this
appears in the window’s frame, while on Mac OS it appears above the
message. The default title string is “Script Prompt.”

Returns the value of the text edit field if the user clicked OK, nul | if the user clicked Cancel.

» Examples

This figure shows simple prompt dialogs on Windows and Mac OS.

_Script Prompt E
e Header _OK Script Prompt
ﬁ\: Message Header
B Cancel & Message
J 12345
12345

(:Canceljjf OK )

This figure shows confirmation dialogs with a t it 1e value specified.
Titte &
- Header oK Title
&
\,ﬁ.{ Header
Cancel & Message

I 12345] ——

(Cancel)f 0K )
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ExtendScript provides the UnitValue object to represent measurement values. The properties and

methods of the Unitvalue object make it easy to change the value, the unit, or both, or to perform
conversions from one unit to another.

Represents measurement values that contain both the numeric magnitude and the unit of measurement.

The Unitvalue constructor creates a new UnitValue object. The keyword new is optional:

myVal
myVal
myVal

The value is a number, and the unit is specified with a string in abbreviated, singular, or plural form, as

new UnitValue
new UnitValue
new UnitValue

shown in the following table.

(value,
("value unit") ;
(value,

unit) ;

"Ul’lit") ;

Abbreviation | Singular Plural Comments

in inch inches 2.54cm

ft foot feet 30.48 cm

yd yard yards 91.44 cm

mi mile miles 1609.344 m

mm millimeter millimeters

cm centimeter centimeters

m meter meters

km kilometer kilometers

pt point points inches /72

pc pica picas points * 12

tpt traditional point | traditional points | inches/72.27

tpc traditional pica traditional picas 12 tpt

Ci cicero ciceros 12.7872 pt

px pixel pixels baseless (see below)
% percent percent baseless (see below)

If an unknown unit type is supplied, the type is set to " ? ", and the UnitValue object prints as "UnitValue

0.00000".
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For example, all of the following formats are equivalent:

myVal = new UnitValue (12, "cm");
myVal = new UnitValue ("12 cm") ;
myVal = UnitValue ("12 centimeters");

baselni t UnitValue | A UnitValue object that defines the size of one pixel, or a total size to use as a
base for percentage values. This is used as the base conversion unit for pixels
and percentages; see Converting pixel and percentage values.

Default is 0.013889 inches (1/72 in), which is the base conversion unit for
pixels at 72 dpi. Set to nul | to restore the default.

type String The unit type in abbreviated form; for example, “cm” or “in”.
val ue Number The numeric measurement value.
as()

uni t Val ueCbj . as (unit)

uni t The unit type in abbreviated form; for example, “cm” or “in”".

Returns the numeric value of this object in the given unit. If the unit is unknown or cannot be
computed, generates a run-time error.

convert ()
uni t vVal ueQyj . convert (unit)

uni t The unit type in abbreviated form; for example, “cm” or “in”.

Converts this object to the given unit, resetting the t ype and val ue accordingly.

Returns true if the conversion is successful. If the unit is unknown or the object cannot be converted,
generates a run-time error and returns false.

Converting measurements among different units requires a common base unit. For example, for length,
the meter is the base unit. All length units can be converted into meters, which makes it possible to
convert any length unit into any other length unit.

Pixels and percentages do not have a standard common base unit. Pixel measurements are relative to
display resolution, and percentages are relative to an absolute total size.

e To convert pixels into length units, you must know the size of a single pixel. The size of a pixel depends
on the display resolution. A common resolution measurement is 72 dpi, which means that there are 72
pixels to the inch. The conversion base for pixels at 72 dpi is 0.013889 inches (1/72 inch).

e Percentage values are relative to a total measurement. For example, 10% of 100 inches is 10 inches,
while 10% of 1 meter is 0.1 meters. The conversion base of a percentage is the unit value
corresponding to 100%.
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The default baseUnit of a unitValue objectis 0.013889 inches, the base for pixels at 72 dpi. If the
unitValue is for pixels at any other dpi, or for a percentage value, you must set the baseUnit value
accordingly. The baseUnit value is itself a unitvalue object, containing both a magnitude and a unit.

For a system using a different dpi, you can change the baseUnit value in the UnitValue class, thus
changing the default for all new unitvalue objects. For example, to double the resolution of pixels:

UnitValue.baseUnit = UnitValue (1/144, "in"); //144 dpi

To restore the default, assign null to the class property:

UnitValue.baseUnit = null; //restore default

You can override the default value for any particular unitvalue object by setting the property in that
object. For example, to create a unitValue object for pixels with 96 dpi:

pixels = UnitValue (10, "px");
myPixBase = UnitValue (1/96, "in");
pixels.baseUnit = myPixBase;

For percentage measurements, set the baseUnit property to the measurement value for 100%. For
example, to create a unitValue object for 40 % of 10 feet:

myPctVal = UnitValue (40, "%");
myBase = UnitValue (10, "ft")
myPctVal .baseUnit = myBase;

Use the as() method to get to a percentage value as a unit value:
myFootVal = myPctVal.as ("ft"); // => 4
myInchVal = myPctVal.as ("in"); // => 36
You can convert a unitvalue from an absolute measurement to pixels or percents in the same way:

myMeterVal = UnitValue (10, "m"); // 10 meters

myBase = UnitValue (1, "km");

myMeterVal .baseUnit = myBase; //as a percentage of 1 kilometer
pctOfKm = myMeterVal.as ('$'); // => 1

myVal = UnitValue ("1 in"); // Define measurement in inches
// convert to pixels using default base
myVal.convert ("px"); // => value=72 type=px

UnitValue objects can be used in computational JavaScript expressions. The way the value is used
depends on the type of operator.

e Unary operators (~, !, +, -)

~uni t Val ue The numeric value is converted to a 32-bit integer with inverted bits.
I uni t val ue Result is true if the numeric value is nonzero, false if it is not.
+uni t Val ue Result is the numeric value.

- uni t val ue Result is the negated numeric value.
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e Binary operators (+, -, *, /, %)

If one operand is unitVvalue object and the other is a number, the operation is applied to the number
and the numeric value of the object. The expression returns a new unitvalue object with the result
as its value. For example:

val = new UnitValue ("10 cm") ;
res = val * 20;
// res is a UnitValue (200, "cm") ;

If both operands are unitValue objects, JavaScript converts the right operand to the same unit as the
left operand and applies the operation to the resulting values. The expression returns a new uni t Val ue
object with the unit of the left operand, and the result val ue. For example:

a = new UnitValue ("1 m");

b = new UnitValue ("10 cm") ;

a + b;

// res is a UnitvValue (1.1, "m");
b + a;

// res is a UnitValue (110, "cm");

e Comparisons (=, ==, <, >, <=, >=)

If one operand is a unitValue object and the other is a number, JavaScript compares the number
with the unitvalue's numeric value.

If both operands are unitVvalue objects, JavaScript converts both objects to the same unit, and
compares the converted numeric values.

For example:

new UnitValue ("98 cm") ;
new UnitValue ("1 m");
b; // => true

1; // => false

== 98; // => true

RV O o S
AN
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ExtendScript provides support for a modular approach to scripting by allowing you to include one scriptin
another as a resource, and allowing a script to export definitions that can be imported and used in another

script.

ExtendScript provides preprocessor directives for including external scripts, naming scripts, specifying a
JavaScript engine, and setting certain flags. Specify these with a C-style statement starting with the #

character:

#include "file.jsxinc"

When a directive takes one or more arguments, and an argument contains any nonalphanumeric
characters, the argument must be enclosed in single or double quotes. This is generally the case with
paths and file names, for example, which contain dots and slashes.

#include file

#i ncl udepat h pat h

Includes a JavaScript source file from another location. Inserts the
contents of the named file into this file at the location of this
statement. The fi / eargument is an Adobe portable file specification.
See Specifying paths.

As a convention, use the file extension . j sxi nc for JavaScript include
files. For example:

#include "../include/lib.jsxinc"
To set one or more paths for the #i ncl ude statement to scan, use the

#i ncl udepat h preprocessor directive.

If the file to be included cannot be found, ExtendScript throws a
run-time error.

Included source code is not shown in the debugger, so you cannot
set breakpoints in it.

One or more paths that the #i ncl ude statement should use to locate
the files to be included. The semicolon (; ) separates path names.

If a #i ncl ude file name starts with a slash (/), it is an absolute path
name, and the include paths are ignored. Otherwise, ExtendScript
attempts to find the file by prefixing the file with each path set by the
#i ncl udepat h statement.

For example:

#i ncl udepat h "incl ude; . ./incl ude"
#include "file.jsxinc"

Multiple #i ncl udepat h statements are allowed; the list of paths
changes each time an #i ncl udepat h statement is executed.

As a fallback, ExtendScript also uses the contents of the environment
variable JSI NCLUDE as a list of include paths.
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#script nane

#strict on

#t arget nane

#t ar get engi ne engi nenarne

Some engines can have a predefined set of include paths. If so, the
path provided by #i ncl udepat his tried before the predefined paths.
If, for example, the engine has a predefined path set to

pr edef ; predef /i ncl ude, the preceding example causes the following
lookup sequence:

file.jsxinc:literal lookup

i nclude/ fil e.jsxinc:first #i ncl udepat h path
..linclude/file.jsxinc: second #i ncl udepat h path
predef/file.jsxinc:first predefined engine path

predef/incl ude/ fil e.|sxinc: second predefined engine path

Names a script. Enclosing quotes are optional, but required for
names that include spaces or special characters. For example:

#script SetupPal ette
#script "Load inage file"

The nane value is displayed in the Toolkit Editor tab. An unnamed
script is assigned a unique name generated from a number.

Turns on strict error checking. See the Dollar ($) Object’s strict
property.

Defines the target application for this JSX file. The nane value is an
application specifier; see Application and Namespace Specifiers.
Enclosing quotes are optional.

If the Toolkit is registered as the handler for files with the . j sx
extension (as it is by default), opening the file opens the target
application to run the script. If this directive is not present, the Toolkit
loads and displays the script. A user can open a file by
double-clicking it in a file browser, and a script can open a file using a
Fi | e object’s execut e method.

Defines the target JavaScript engine for this JSX file, within the
designated target application.

Supported by Adobe Illustrator CS3 and Adobe InDesign CS3; other
applications ignore the directive.

e For Adobe lllustrator CS3 and Adobe InDesign CS3, if the named
engine does not exist, and if the script originates within the
application (rather than being executed in the ExtendScript
Toolkit or received in an interapplication message), the
application creates a new JavaScript engine with this name,
which persists for the lifetime of the application session.

e If the script originates outside the application, and the named
engine does not exist, the directive is ignored.

ExtendScript has been extended to support function calls and variable access across various source code
modules and JavaScript engines. A script can use the export statement to make its definitions available
to other scripts, which use the import statement to access those definitions.
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To use this feature, the exporting script must name its JavaScript engine using the #engine preprocessor
statement. The name must follow JavaScript naming syntax; it cannot be an expression.

For example, the following script could serve as a library or resource file. It defines and exports a constant
and a function:

#engine library
export random, libVersion;
const libVersion = "Library 1.0";
function random (max)
return Math.floor (Math.random() * max) ;
}

A script running in a different engine can import the exported elements. The import statement identifies
the resource script that exported the variables using the engine name:

import library.random, library.libVersion;

print (random (100)) ;
You can use the asterisk wildcard (*) to import all symbols exported by a library:

import library.*
Objects cannot be transferred between engines. You cannot retrieve or store objects, and you cannot call
functions with objects as arguments. However, you can use the JavaScript toSource function to serialize
objects into strings before passing them. You can then use the JavaScript eval function to reconstruct the
object from the string.
For example, this function takes as its argument a serialized string and constructs an object from it:

function myFn (serialized) {
var obj = eval (serialized);
// continue working..

}

In calling the function, you deconstruct the object you want to pass into a serialized string:

myFn (myObject.toSource()); // pass a serialized object
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ExtendScript allows you to extend or override the behavior of a math or a Boolean operator for a specific
class by defining a method in that class with same name as the operator. For example, this code defines
the addition (+) operator for the class MyClass. In this case, the addition operator simply adds the
operand to the property value:

// define the constructor method

function MyClass (initialvalue) {
this.value = initialValue;

}

// define the addition operator

MyClass.prototype ["+"] = function (operand) {
return this.value + operand;

}

This allows you to perform the "+" operation with any object of this class:

var obj = new MyClass (5);
Result: [object Object]
obj + 10;

Result: 15

You can override the following operators:

Unary + -

Binary + -

<<, S>> >>>

&, |‘ ===

e The operators > and >= are implemented by executing NOT operator <= and NOT operator <.

e Combined assignment operators such as *= are not supported.

All operator overload implementations must return the result of the operation. To perform the default
operation, return undefined.

Unary operator functions work on the this object, while binary operators work on the this object and
the first argument. The + and - operators have both unary and binary implementations. If the first
argument is undefined, the operator is unary; if it is supplied, the operator is binary.

For binary operators, a second argument indicates the order of operands. For noncommutative operators,
either implement both order variants in your function or return unde f ined for combinations that you do
not support. For example:

this ["/"] = function (operand, rev) ({
if (rev) {
// do not resolve operand / this
return;
} else {
// resolve this / operand
return this.value / operand;



O  Integrating XML into JavaScript

ExtendScript defines the XML object, which allows you to process XML with your JavaScript scripts. This
feature offers a subset of the functionality specified by the ECMA-357 specification (E4X). For more
information on this standard, see:

http://www.ecma-international.org/publications/files/ECMA-ST/Ecma-357.pdf

The XML object represents an XML element node in an XML tree. The topmost XML object for an XML file
represents the root node. It acts as a list, which contains additional XML objects for each element. These in
turn contain XML objects for their own member elements, and so on.

The child elements of an element tree are available as properties of the XML object for the parent. The
name of the property corresponds to the name of the element. Each property contains an array of XML
objects, each of which represents one element of the named type.

For example, suppose you have the following, minimal XML code:

<rootElement>
<elementA>
<elementB></elementB>
</elementA>
<elementA>
<elementB></elementB>
</elementA>
</rootElement>

In a JavaScript script, the XML object that you create from this XML code represents the root element:

var myRoot = new XML ("<rootElement> <elementA> <elementB></elementB>
</elementA> <elementA> <elementB></elementB> </elementA>
</rootElement>") ;

The object myRoot contains a property named elementa, which contains two XML objects for the two
instances of that element. Each of these, in turn, contains an elementB property, which contains one
empty XML object:

var elemBl = myRoot.elementA[0] .elementB[0] ;

If an element is empty in the XML, the corresponding property exists and contains an empty XML object; it
isnevernull orundefined.

This sample XML code is used for examples throughout this chapter:

<bookstore>
<book category="COOKING">
<title lang="en">The Boston Cooking-School Cookbook</titles
<authors>Fannie Merrit Farmer</author>
<year>1896</year>
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<price>49.99</price>

</book>

<book category="CHILDREN">
<title lang="en">The Wonderful Wizard of Oz</title>
<authors>L. Frank Baum</authors>
<year>1900</years>
<price>39.95</price>

</book>

<book category="CHILDREN">
<title lang="en">Alice’s Adventures in Wonderland</title>
<author>Charles "Lewis Carroll" Dodgeson</authors>
<author>Charles Dodgeson</author>
<authorsLewis Carroll</authors>
<year>1865</year>
<price>29.99</price>

</book>

<book category="MUSIC">
<title lang="en">Gilbert and Sullivan Opera; A History and a Comment</title>
<author>H. M. Walbrook</authors>
<year>1922</year>
<price>30.00</price>

</book>

</bookstore>

To encapsulate this code in an XML object, serialize it into a string and pass that string to the constructor:
var bookXmlStr = "...";

var bookstoreObj = new XML (bookXmlStr) ;

Using this example, the root element <bookstores, is represented by the XML object returned from the
constructor. Each of the <book> elements is available as a member of the book property of the XML
object.

e The Javascript statement bookstoreObj .book ; returns the entire list of books.
e The statement bookstoreObj .book [0] ; returns the XML object for the first book.

e The statement bookstoreObj .book [0] .author; returns all authors of the first book.

Attribute are properties of their parent elements. In ExtendScript, access an attribute using the name
preceded with an at-sign '@'. An attribute property is a one-element list, which contains an XML object for
the value of the attribute. For example:

xml.book [0] .@category;
This returns the category attribute of the first book, whose value is the string “COOKING”.

To access all category attributes of all books, use this statement:

xml .book.@category


mailto:0].@category

9: Integrating XML into JavaScript The XML Object 222

The XML object, like all ExtendScript objects, has a toString() method that serializes the contents into a
string. This method is called when you evaluate the object in the JavaScript Console of the ExtendScript
Toolkit.

In this case, the method recreates the XML text that the object encapsulates. Thus, if you evaluate the
object xml .book [1] in the Console, you see the XML text for the encapsulated tree, formatted with line
feeds and spaces:

> xml.book [1];
<book category="CHILDREN">
<title lang="en">The Wonderful Wizard of Oz</title>
<authorsL. Frank Baum</author>
<year>1900</year>
<price>39.95</price>
</book>

If you evaluate an object with a text value, you see the text value. For example:

> xml .book [1] .@category;
CHILDREN

If you access multiple values, you see each on a separate line:

> xml.book.@category
COOKING
CHILDREN
CHILDREN
MUSIC

You can change an element by assigning a value to the corresponding property.

If the value assigned is an XML element, the element is simply replaced. If there are multiple elements
of the same type, the first element is replaced, and all other elements are deleted.

If the value assigned is not XML, it is converted to a string, and the content of the element is replaced
with that string.

If no element of this type is present, a new element is appended to the XML.

You can change the values of attributes using the same technique.

» Modification examples

In the sample XML, the third book has several <authors elements. This statement replaces all of them
with a single element, containing a new string:

bookstoreObj.book [2] .author = "Charles 'Lewis Carroll’ Dodgeson";
The result is this XML:

<book category="CHILDREN">
<title lang="en">Alice'’s Adventures in Wonderland</title>
<author>Charles ’'Lewis Carroll’ Dodgeson</authors>
<year>1865</year>
<price>29.99</price>

</book>
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e To replace just the first author, leaving all the other authors in place, use this statement:
bookstoreObj.book [2] .author [0] = "Charles Dodgeson, aka Lewis Carroll";

e This statement changes the content of the <year> element in the second book. ExtendScript
automatically converts the numeric value to a string:

bookstoreObj.book [1] .year = 1901;
e This following statement adds a new <ratings> element to the second book:
bookstoreObj.book [1] .rating = "**x*xxxmn .,
The result is this XML:

<book category="CHILDREN">
<title lang="en">The Wonderful Wizard of Oz</title>
<authorsL. Frank Baum</author>
<year>1900</year>
<price>39.95</price>
<ratings>*****</ratings>
</book>

e This statement changes the value of the category attribute of the second book:
bookstoreObj.book [1] .@category = "LITERATURE, FANTASY"
The result is this XML:

<book category="LITERATURE, FANTASY">
<title lang="en">The Wonderful Wizard of Oz</title>

To delete an element or attribute in the XML, use the JavaScript delete operator to delete the
corresponding element or attribute property. If there are multiple instances of an element, you can delete
all, or refer to a single one by its index.

» Deletion examples
e This statement deletes all authors from the third book:
delete bookstoreObj.book[2] .author;
e This statement deletes only the second author from the third book:
delete bookstoreObj.book[2] .author[1];
e This statement deletes the category attribute from the third book:

delete bookstoreObj.book[2] .@category;

Several methods in the XML object retrieve the contents, in various ways:

e XML . children() gets the direct child elements, including text elements.

e XML .elements() gets the direct child elements that are XML tags, but does not get text.

e XML .descendants() allows you to match a specific tag, and gets all matching elements at any level of
nesting.

For example, consider this XML code loaded into a top-level XML object named x:
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<top>
<ones>one text</one>
<two>
two text
<inside>inside text</inside>
</two>
top text
</top>

Here are the results of the different calls.

e The result of XML . children() contains 3 elements, the direct child tags <one> and <two>, and the
directly contained text of the <top> tag:

> x.children()
<ones>one text</one>
<two>
two text
<inside>inside text</inside>
</two>
top text
> x.children() .length()
3

e The result of XML . elements() contains 2 elements, the direct child tags <one> and <two>:

> x.elements ()
<one>one text</ones
<two>
two text
<insides>inside text</inside>
</two>
> x.elements () .length()
2

e The result of XML . descendants() contains 7 elements, the direct child tags <one> and <two>, the
<inside> tag one level down, and the text contents of all the tags:

> x.descendants ()
<onesone text</one>
one text
<two>
two text
<insides>inside text</inside>
</two>
two text
<insides>inside text</inside>
ingide text
top text
> x.descendants () .length()
7

e Use the plus operator, +, to combine XML elements into a list.

e Use the == operator to make an in-depth comparison of two XML trees.
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This section provides reference details for the properties and methods of the XML object itself, and for the
related utility objects and global functions that you use to work with namespaces:

e “XML object” on page 225

e “Namespace object” on page 234

e “QName object” on page 233

e "“Global functions” on page 233

The XML object provides both static properties and functions, available through the XML class, and
dynamic properties and functions available through each instance.

The constructor returns the XML object representing the root node of an XML tree, which contains
additional XML objects for all contained elements.

[new] XML (xmlCode) ;

xni Code String A string containing valid XML code, or an existing XM. object.

or XML If a valid string is supplied, returns a new XM object encapsulating the XML

code. If the XML code cannot be parsed, throws a JavaScript error.

e If an existing object is supplied and the new operator is used, returns a
copy of the object; otherwise, returns the object itself.

These static properties are available through the XML class. They control how XML is parsed and
generated:

i gnor eConment s Boolean When true, comments are stripped from the XML
during parsing. Default is false.

i gnor eProcessi ngl nstructions Boolean When true, processing instructions (<?xxx?> elements)
are stripped from the XML during parsing. Default is
false.

i gnor eWi t espace Boolean When true, white-space characters are stripped from
the XML during parsing. Default is true.

prettyl ndent Number The number of spaces to use for indenting when
pretty-printing. Default is 2.

prettyPrinting Boolean When true,t oXM.Stri ng() uses indenting and line
feeds to create the XML string. Default is true.




9: Integrating XML into JavaScript XML Object Reference 226

These static functions are available through the XML class, and provide information about the global
settings of the XML parser.

def aul t Set ti ngs()
XM.. defaul t Settings ();

Retrieves the default global option settings that control how XML is parsed and generated.

Returns a JavaScript object containing five properties, which correspond to the five XML class
properties.

settings()
XM.. settings ();

Retrieves the current global option settings that control how XML is parsed and generated.

Returns a JavaScript object containing five properties, which correspond to the five XML class
properties.

set Settings()
XM.. set Settings (object);

obj ect A JavaScript object containing five properties, which correspond to the five XML
class properties.

Sets the global option settings that control how XML is parsed and generated. You can use this to
restore settings retrieved with settings() or defaultSettings().

Returns undef i ned.

The properties of the XML object are named for and contain the values of the child elements and attributes
of the element that the object represents.

chi | dBl ement Name XML object  Child-element properties are named with the child element name.

@t tri but eNane XML object  Attribute properties are named with the attribute name prefixed
with the at-sign, e.

addNarrespace()
xm Qbj . addNanespace (ns);

ns A Namespace object.

Adds a namespace declaration to this node.

Returns this XML object.
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appendChi | d()
xm Qbj . appendChi ld (child);

child An XML object or any value that can be converted to a String with t oSt ri ng().

Appends a child element to this node, after any existing children. If the argument is not XML, creates
a new XML element that contains the string as its text value, using the same element name as the
last element currently contained in this object’s node.

Returns this XML object.

attri but es()
xm Qbj . attributes (nane);

namne A String, the attribute name.

Retrieves a list of the named attribute elements contained in this node.

Returns an XML object containing all values of the named attribute.

chi | d()
xm Qj . chi | d (which);

whi ch A String, the element name, or a Number, a 0-based index into this node’s child array.

Retrieves a list of all child elements of this node of a given type.

Returns an XML object containing all child elements of the given type.

chi | dl ndex()
xm Qyj . chi | dl ndex ();

Retrieves the 0-based position index of this node within its parent node.

Returns a Number.

chi | dren()
xm Qj . chi l dren();

Retrieves all of the immediate child elements of this node, including text elements.

Returns an XML object containing the child elements.

comment s()
xm Qoj . coment s() ;

Retrieves all XML comment elements from this node.

Returns an XML object containing the comments.

cont ai ns()
xnt Qpj . contains (el enent);

el enment An XML object.

Reports whether an element is contained in this node at any level of nesting.

Returns true if the element is contained in this XML tree.
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copy()
xnt Qj . copy() ;

Creates a copy of this node.

Returns the new XML object.

descendant s()
xnmt Qvj . descendants ([ nane]);

nane Optional. A String, the element name to match. If not provided, matches all elements.

Retrieves all descendent elements of this node of a given element type, or all XML-valued
descendants, at any level of nesting. Includes text elements.

Returns an XML object containing properties for each descendant element.

el enent s()
xm Qbj . el ements (nane) ;

nanme Optional. A String, the element name to match. If not provided, matches all elements.

Retrieves all of the immediate child elements of this node of the given type, or of all types. Does not
include text elements.

Returns an XML object containing properties for each child element.

hasConpl exCont ent ()
xm Qvj . hasConpl exContent ();

Reports whether this node has complex content; that is, whether it contains child elements.
Disregards contents of other kinds, including attributes, comments, processing instructions and text
nodes.

Returns true if this node contains child elements.

hasSi npl eCont ent ()
xm Qbj . hasSi npl eContent ();

Reports whether this node has simple content; that is, whether it represents a text node, an attribute
node, or an element without child elements (regardless of whether it also contains attributes,
comments, processing instructions or text).

Object representing comments and processing instructions do not have simple content.

Returns true if this node contains no child elements.

i nScopeNaespaces()
xni Qbj . i nScopeNanespaces () ;

Retrieves the current list of valid namespaces in this element.

Returns an Array of Namespace objects, in which the last member is the default namespace.
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i nsert Chi | dAfter()
xm Qoj .insertChildAfter (childl, child2);

childi An XML object, the existing child element after which to place the new child, or nul |
to insert the new child at the beginning.

chil d2 An XML object, the new child element, or any value that can be converted to a String
withtoString().

Inserts a new child element or text node into this node, after another existing child element. If the
relative element is not currently in this node, does not insert the new child.

Returns this XML object.

i nsert Chi | dBef ore()
xm Qoj .insert Chil dBefore (childl, child2);

childi An XML object, the existing child element before which to place the new child, or
nul I to insert the new child at the end.

chil d2 An XML object, the new child element, or any value that can be converted to a String
withtoString().

Inserts a new child element or text node into this node, before another existing child element. If the
relative element is not currently in this node, does not insert the new child.

Returns this XML object.

| engt h()
xm Q. length ();

Reports the number of child elements contained in this node. The minimum number is 1, the
element that this object represents.

Returns a Number.

| ocal Nane()
xm Qo . | ocal Nane ();

Retrieves the local name of this element; that is, the element name, without any namespace prefix.

Returns a String.

nane()
xm Qoj . name ();

Retrieves the full name of this element, with the namespace information.

Returns a QName object containing the element name and namespace URI.

nanmespace()
xnmt Qoj . namespace ();

Retrieves the namespace URI of this element.

Returns a String.
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nodekKi nd()
xm Qbj . nodeKi nd ();

Reports the type of this node.
Returns a String, one of:

el enent

attribute

coment

processi ng-instruction
t ext

namespaceDecl ar at i ons()
xm Qbj . nanespaceDecl arations ();

Retrieves all of the namespace declarations contained in this node.

Returns an Array of Namespace objects.

nor mal i ze()
xm Qo .nornalize ();

Puts all text nodes in this and all descendant XML objects into a normal form by merging adjacent
text nodes and eliminating empty text nodes.

Returns this XML object.

par ent ()
xm Qoj . parent ();

Retrieves the parent node of this node.

Returns an XML object, or nul | for the root element.

prependChi | d()
xm Qoj . prependChi | d (child);

child An XML object or string.

Prepends a child element to this node, before any existing children. If you prepend a string to a text
element, the result is two text elements; call normalize() to concatenate them into a single text
string.

Returns this XML object.

pr ocessi ngl nstructi ons()
xm Qbj . processi ngl nstructions ([ nane]);

narre A String, the name of a processing instruction, or nul | to get all processing
instructions.

Retrieves processing instructions contained in this node.

Returns an XML object containing the children of this object that are processing instructions,
matching the name if supplied.




9: Integrating XML into JavaScript XML Object Reference 231

repl ace()
xm Qbj . repl ace (nane, val ue);

harre An element or attribute name, with or without the 0-based position index of a
specific element, or the wildcard string “*".

e If no position index is supplied, replaces the value of all matching elements.

e Ifthe wildcard is supplied, replaces the value of all contained elements. When an
element contain subelements, those are removed, and only the replacement
value remains.

val ue An XML object or any value that can be converted to a String with t oSt ri ng().
Replaces one or more property values in this node.
If the named element does not exist, appends the given value as a text element.

Returns this XML object.

set Chi | dren()
xm Qoj . set Chil dren (val ue);

val ue An XML object or any value that can be converted to a String with t oSt ri ng().

Replaces all of the XML-valued properties in this object with a new value, which can be a simple text
element, or can contain another set of XML properties.

Returns this XML object.

set Local Nane()
xm Qbj . set Local Nane( nane) ;

name A String, the new name.
Replaces the local name of this object; that is, the element name without any namespace prefix.

Returns this XML object.

set Nane()
xm Qbj . set Nane( nane) ;

nane A String, the new name.
Replaces the full name of this object; that is, the element name and its namespace prefix.

Returns this XML object.

set Namespace()
xni Qb . set Namespace( ns) ;

ns A Namespace object for a namespace that has been declared in the tree above this
element.

Sets the namespace for this XML element. If the namespace has not been declared in the tree above
this element, add a namespace declaration instead.

Returns this XML object.
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t ext ()
xm Qoj . text();

Retrieves text nodes from this element.

Returns an XML object containing all properties of this object that represent XML text nodes.

toString()
xm Q. toString();

Creates a string representation of this object.
e Fortext and attribute nodes, this is the textual value of the node.
e For other elements, it is the result of toXMLString().

o If this XML object is a list, concatenates the result of calling the function on each contained
element.

Returns a String.

t oXM.String()
xm Q. toXMString();

Creates an XML-encoded string representation of this XML object. This result includes the start tag,
attributes and end tag of the XML object, regardless of its content. Formats the string as specified by
the global settings XM.. prettyPrinting and XM.. prettylndent.

Returns a String.

xpat h()
xm Qbj . xpath (expression[, variables]);

expression A String containing an XPath expression.

Note: In this context, include the actual top level element. For example, an
expression for the example XML must start with “/bookstore”. This is unlike
JavaScript property access, where the top level element is implied.

variables  Optional. A JavaScript object containing variable definitions. The properties are used
to look up XPath variables contained in the expression. For example, if the expression
contains the variable $abc, the value is in the object’s abc property.

Evaluates an XPath expression in accordance with the W3C XPath recommendation, using this XML
object as the context node. The context position and size are set to 1, and all variables are initially
unbound. If this XML object is a list, evaluates all contained XML element nodes (not comments or
other node types) and return the results in a list in the order of execution.

If the XPath expression does not evaluate to a node list, throws a JavaScript exception.

Returns an XML object, the result of evaluation.
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These functions are available in the JavaScript global namespace.

i sSXM_Nane()
i sXMLNarre (String nane)

nane A string.

Reports whether a string contains a name that conforms to valid XML syntax.

Note: This implementation uses the same rules as for a JavaScript name, except for the '$' character,
which is disallowed, and the '-' character, which as added. It does not follow the W3C
definition of an XML name, which adds more Unicode characters to the valid set of characters.

Returns true if the name is a valid XML name, false otherwise.

set Def aul t XM_.Nanespace()
set Def aul t XM_Nanespace (Nanespace ns)

ns A Namespace object. Any prefix is ignored.

Sets the default namespace for XML objects.

Returns undef i ned.

This object encapsulates a fully qualified XML name, the combination of a local XML name and its
namespace URI.

The constructor takes several forms:

new QName

()
new QName (name)
new QName (ns)
new QName (uri, name)

When no arguments are supplies, creates a QName object with an empty local name and no URI.

namne String Creates a QName object with the given local name and the URI of the default
namespace. Can be the wildcard character, “*”.

nane QName Creates a copy of an existing QName object.
ns Namespace Creates a QName object with an empty local name and the URI of the

Namespace object.

uri, narme String Create a QName object with the given namespace URI and local name.

If the local name is supplied as the wildcard character, “*”, the uri argument
is ignored, and the URI value is that of the default namespace.
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nane  String The local element name portion of the XML element’s fully qualified XML name.

uri String The namespace prefix of the XML element’s fully qualified XML name.

This object encapsulates the definition of an XML namespace. A namespace associates an XML-name
prefix with a complete URI. The prefix is a string that precedes the local name of an XML element or
attribute and identifies the namespace, while the URI points to the actual location where the definition of
the namespace is found.

For example, this XML definition contains a namespace declaration:

<?xml xmlns:adobe=http://www.adobe.com/test?>

In the corresponding namespace, the prefix is adobe, and the URlis http: //www.adobe . com/test.

The Namespace constructor takes several forms:

new Namespace ()

new Namespace (String uri)

new Namespace (QName prefix)

new Namespace (Namespace ns)

new Namespace (String prefix, String uri)

When no argument is supplied, creates a namespace with an empty prefix and URI.

uri String Creates a Namespace object with an empty prefix and the given URI.

prefix QName Creates a namespace with an empty prefix and the URI set to the URI of
the QName object (if the Q\ane object contains a URI).

ns Namespace Creates a copy of the given Namespace object.

If the Namespace() function is called without the new operator, and the
only argument is a Namespace object, the function simply returns that
object, rather than creating a copy.

prefix, uri  String Creates a Namespace object with the given prefix and the given URI.

prefix String The element-name prefix associated with the namespace URI.

The prefix value can be undefi ned, as when a specified prefix is not a valid XML
name. Namespaces with an undefined prefix are completely ignored; they are not
added to an XML namespace declaration.

uri String The location of the namespace definition, a URI.
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Scripting Access to XMP Metadata

XMPScript, the XMP ExtendScript API, offers JavaScript access to the Adobe XMP Core and XMP Files
libraries. This chapter provides reference information for the JavaScript objects related to XMP, with their
properties and methods.

This chapter is not intended to provide complete details of the XMP metadata technology. For more
information about XMP metadata, see the XMP Specification at Adobe Developer Center,
http://www.adobe.com/devnet/.

Adobe Bridge CS3 makes the XMP library available in its libraries folder. Scripts must load the library at run
time to use the API; it is not automatically loaded when Adobe Bridge launches. The XMPScript APl is
separate from the Adobe Bridge DOM. You can use it independently, to get and set metadata in supported
formats; or you can use it with the Adobe Bridge APl to modify the metadata that you access from files
using the Adobe Bridge DOM’s Thumbnail object.

Note: Adobe Bridge provides a means of embedding metadata values in a script (to describe the script file
itself) using XML delimited by special tags within a comment block. This is not related to metadata
access for files and thumbnails. For details, see the Adobe Bridge JavaScript Guide.

In order to use the XMP objects, you must load the XMP library as an ExtendScript ExternalObject.To
avoid loading multiple instances of the library, use code such as the following:

// load the library

if (ExternalObject.AdobeXMPScript == undefined) ({
ExternalObject.AdobeXMPScript = new
ExternalObject ('lib:AdobeXMPScript') ;

}

After the library has been loaded, these primary XMP classes are available in the global JavaScript
namespace:

XMPMeta object Provides the core services of the XMP Toolkit. Allows you to create and delete
metadata properties, and to retrieve and modify property values.

XMPFile object Provides convenient I/O access to the main, or document level, XMP for a file.
Allows you to retrieve existing metadata from a file, update file metadata, and
add new metadata to afile.

Additional top-level objects include array-handling utilities, a date-time object, and constant definitions
that include namespace constants. The top-level objects provide access to additional support classes that
encapsulate individual metadata properties, file information, and XMP packet information, and a utility
that allows iteration through properties.

See ‘XMPScript Object Reference’ on page 239 for details of the classes, their properties, and their
methods.
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The XMPMeta object is the primary means of access to the namespaces and properties of an XMP
metadata packet. Through this object, you can create and delete namespaces and properties, and
examine and modify property values.

You can obtain or create an XMPMeta object in several ways:

e You can use an XMPFile object to retrieve existing metadata directly from a file. The
XMPFile.getXMP() method creates an XMPMeta object, which you can use to examine or modify the
properties and their values. You can then use XMPFile . putXMP() to write the modified metadata back
to the file.

e You can create an XMPMeta object with the constructor, initializing it with an XMP packet created or
obtained elsewhere.

e You can create a new, empty XMPMeta object with the constructor, and use its methods to create
entirely new namespaces and properties. You can then use XMPFile . putXMP() to inject the new
metadata into a file.

In Adobe Bridge, you can pass XMP metadata between the built-in Metadata object and the XMPScript
XMPMeta object using serialized XMP.

e You can use XMPScript to examine thumbnail metadata by creating the XMPMeta object from the
metadata stored with a Thumbnail object, using the object constructor. To ensure that the metadata
is up-to-date, use synchronous mode (which is off by default):

var thumb = new Thumbnail (new File ("myImage.jpg")) ;
app . synchronousMode = true;
xmp = new XMPMeta (thumb.metadata.serialize()) ;

or
xmp = new XMPMeta (thumb.synchronousMetadata.serialize()) ;

e You can modify the metadata in an Adobe Bridge thumbnail by creating a new Metadata object with
serialized XMP. Continuing the previous example:

// create a compact XMP packet

newPacket = xmp.serialize (XMPConst.SERIALIZE OMIT PACKET WRAPPER |
XMPConst .SERIALIZE USE COMPACT FORMAT)) ;

thumb.metadata = new Metadata (newPacket) ;

e To write metadata back to the file for a thumbnail, you can access the thumbnail’s file and create an
XMPFile object object to access the embedded metadata directly.

xmp = new XMPFile (thumb.spec.fsName, XMPConst .UNKNOWN,
XMPConst.OPEN_FOR_UPDATE);

Note: The XMPFile object does not support all of the file formats that Adobe Bridge supports.

» Creating new metadata

This code creates an empty XMPMeta object, uses it to set a metadata property, and serializes it to a string,
which you could pass to an authoring tool, for example, or store in a file.

xmp = new XMPMeta () ;

xmp . setProperty (XMPConst .NS_XMP, "CreatorTool", "My Script");
xmpStr = xmp.serialize(); // serialize the XMP packet to XML
// retrieve property

prop = xmp.getProperty (XMPConst .NS_XMP, "CreatorTool") ;
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$.writeln ("namespace: " + prop.namespace + \n + "property path + name: " +
prop.path + \n + "value: " + prop); // same as prop.value
» Modifying existing metadata

This code accesses an existing XMP packet, assuming the location has been assigned to a string variable. It
sets the modification-date property to the current date and time, and stores the updated XMP packet back
to the string, making it as small as possible.

xmp = new XMPMeta (xmpStr); // object initialized with xmp packet as string

dateTime = new XMPDateTime (new Date()); // now
S.writeln("old modification date: " +
xmp .getProperty (XMPConst .NS_XMP, "ModifyDate", "xmpdate")) ;

xmp . setProperty (XMPConst .NS_XMP, "ModifyDate", dateTime, "xmpdate") ;
// serialize to XML, in compact style
xmpStr = xmp.serialize (XMPConst.SERIALIZE USE COMPACT_ FORMAT) ;

» Using XMPFile for batch processing

This example iterates through a folder of image files and processes the metadata. The script processes
each picture as follows:

e Reads and parses the metadata. If an image file does not contain XMP metadata, the legacy metadata is
automatically converted to XMP.

e Deletes the list of existing creators, and adds a new creator value.
e Writes the modified metadata back to the file.

S.writeln ("XMPFiles batch processing example") ;
// define folder containing images (make sure that you use copies)

var picFolder = "/c/temp/photos";
// load the XMPScript library
if (ExternalObject.AdobeXMPScript == undefined)

ExternalObject.AdobeXMPScript =
new ExternalObject ('lib:AdobeXMPScript') ;
// iterate through the photos in the folder
var pics = Folder (picFolder) .getFiles() ;
for (f in pics) ({
var file = pics[f];
$.writeln("process file: " + file.fsName) ;
// applies only to files, not to folders
if (file instanceof File) {
var xmpFile = new XMPFile (file.fsName, XMPConst .UNKNOWN,
XMPCOnSt.OPEN_FOR_UPDATE);
var xmp = xmpFile.getXMP () ;
// delete existing authors and add a new one
// existing metadata stays untouched
xmp .deleteProperty (XMPConst .NS_DC, "creator");
xmp . appendArrayItem (XMPConst .NS_DC, '"creator", "Judy", O,
XMPCOnSt.ARRAY_IS_ORDERED);
// write updated metadata into the file
if (xmpFile.canPutXMP (xmp))
xmpFile.putXMP (xmp) ;
}

xmpFile.closeFile (XMPConst .CLOSE UPDATE_SAFELY) ;

}
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» Integrating XMPScript with Adobe Bridge

This script adds a command to the context menu for Thumbnails that shows some of the XMP properties.
It demonstrates how to retrieve the XMP metadata that is stored with the Thumbnail object, and use it to
create an XMPMeta object, then use that object to retrieve different types of property values.

To use this script, place it in the "Startup Scripts” folder for Adobe Bridge (see ‘Startup scripts’ on page 12).
When you start Adobe Bridge, select a thumbnail for a document that contains XMP metadata, right click,
and choose "Show XMP Properties" from the menu.

S.writeln ("XMPScript Adobe Bridge Integration Example") ;

// load the XMPScript library

if (ExternalObject.AdobeXMPScript == undefined) {
ExternalObject.AdobeXMPScript = new
ExternalObject ('lib:AdobeXMPScript') ;

}

// add a context menu item to Thumbnails
var xmpCommand = new MenuElement ("command", "Show XMP Properties",
"at the end of Thumbnail", "showProperties") ;

// define command behavior
xmpCommand.onSelect = function(m)
// get the first selected thumbnail
thumb = app.document.selections[0];
// if there is one, and it has metadata
if (thumb && thumb.metadata)
// retrieve metadata from the thumbnail into an XMPMeta object
// (if app.synchronousMode is set, use thumb.metadata)
xmp = new XMPMeta (thumb.synchronousMetadata.serialize()) ;

// retrieve some of the XMP property values

// a simple property with a localized string value
var msg = "Title: " + xmp.getLocalizedText (XMPConst.NS DC,
"title", null, "en") + "\n";

// an array property
msg += "Authors of the document:\n";
num = xmp.countArrayItems (XMPConst.NS DC, "creator");

for (i = 1; i <= num; i++)
msg += "* " 4+ xmp.getArrayItem(XMPConst.NS DC,
"creator", i) + "\n";

// a simple property with a date value
msg += "Creation Date: " + xmp.getProperty (XMPConst.NS XMP,
"CreateDate")

// display the values
Window.alert (msg) ;
}
else
Window.alert ("No thumbnail selected or no XMP contained") ;

}i
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The classes defined for the XMP JavaScript API, with their properties and methods, are listed here in
alphabetical order.

After the library has been loaded, these XMP classes are available in the global JavaScript namespace:

XMPMeta object Provides the core services of the XMP Toolkit.
XMPFile object Provides convenient I/0 access to the main, or document level, XMP for a file.
XMPUtils object Provides additional utility functions for array handling.

XMPDateTime object Represents date-time values.

XMPConst object Contains numeric and string constant values for use with the JavaScript API.

e These top-level objects provide access to additional support classes:

XMPlterator object Allows iteration through properties in an XMPMeta object.
XMPProperty object Describes a metadata property.

XMPAliasInfo object Describes a metadata alias.

XMPFilelnfo object Describes afile.

XMPPacketInfo object Describes a raw XMP packet in a file.

This object is returned by XMPMet a . resolveAlias(). The read-only properties describe an XMP metadata
alias.

arrayForm Number A constant that describes the property type of the resolved alias, 0 for a
simple property. Constants are:

XMPConst . ALI AS TO SI MPLE_PRCP: A direct mapping. It can be
simple-to-simple, array-to-array, or structure-to-structure.

XMPConst . ALI AS_TO ARRAY: The actual property is an unordered array;
the alias is to the first element.

XMPConst . ALI AS TO CRDERED ARRAY: The actual property is an ordered
array; the alias is to the first element.

XMPConst . ALI AS TO ALT_ARRAY: The actual property is an alternate
array; the alias is to the first element.

XMPConst . ALI AS TO ALT_TEXT: The actual property is an alternate text
array; the alias is to the x- def aul t element.

nane String The name of the property to which the alias resolves.

nanespace String The namespace of the property to which the alias resolves. See ‘Schema
namespace string constants’ on page 240.
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This object contains the read-only constant definitions for use with the JavaScript XMP API. Some of these
are listed in the context in which they are used. Longer lists are provided here.

Constant values for the namespace URI strings used in all get and set property operations. See XMPMeta

object.

NS_DC The XML namespace for the Dublin Core schema,
http://purl.org/dc/elements/ 1.1

NS | PTC OCRE The XML namespace for the IPTC Core schema.

NS_RDF The XML namespace for RDF.

NS_XM The XML namespace for XML.

NS_XwP The XML namespace for the XMP basic schema.

NS_XMP_R GHTS The XML namespace for the XMP copyright schema.

NS_XMP_MM The XML namespace for the XMP digital asset management schema.

NS_XMP_BJ The XML namespace for the job management schema.

NS_XMP_NOTE The XML namespace for the XMP note schema. An Adobe private namespace;
do not create new properties.

NS_PDF The XML namespace for the PDF schema.

NS_PDFX The XML namespace for the PDFX schema. An Adobe private namespace; do
not create new properties.

NS_PHOTCBHCP The XML namespace for the Adobe Photoshop custom schema.

NS_PS_ALBUM The XML namespace for the Adobe Photoshop Album custom schema.

NS _EX F The XML namespace for Adobe's EXIF schema.

NS_EXI F_AUX The XML namespace for Adobe's EXIF auxiliary schema.

NS_TI FF The XML namespace for Adobe's TIFF schema.

NS_PNG The XML namespace for the PNG schema.

NS JPEG The XML namespace for the JPEG schema.

NS_SW The XML namespace for the Flash small web format schema.

NS_JPK The XML namespace for the JPK schema.

NS_CAMERA RAW The XML namespace for the Camera Raw schema.

NS_DM The XML namespace for the DM schema.

NS_ADCBE_STOXK_PHOTO | The XML namespace for the Adobe Stock Photos schema.

NS_ASF The XML namespace for the Microsoft advanced streaming format schema.
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Constant values for the field-type namespace URI strings used in all structured property operations. See
XMPMeta object.

TYPE_| DENTI FI ER QUAL
TYPE_DI MENSI ONS
TYPE_TEXT
TYPE_PAGEDFI LE

TYPE_GRAPH CS

TYPE | MAGE

TYPE_FONT

TYPE_RESOURCE_EVENT
TYPE_RESOURCE_REF
TYPE ST VERSI ON
TYPE ST JOB

TYPE_MAN FEST | TEM

TYPE_PDFA FI ELD
TYPE_PDFA | D
TYPE_PDFA_EXTENSI ON

The XML namespace for qualifiers of the xnp: 1 denti fi er property.
The XML namespace for fields of the Dimensions type.

The XML namespace for the XMP text document schema.

The XML namespace for the XMP paged document schema.

The XML namespace for a structure containing the characteristics of a colorant
(swatch) used in a document.

The XML namespace for fields of a graphical image. Used for the Thumbnail
type.

The XML namespace for a structure containing the characteristics of a font
used in a document.

The XML namespace for fields of the ResourceEvent type.
The XML namespace for fields of the ResourceRef type.
The XML namespace for fields of the Version type.

The XML namespace for fields of the JobRef type.

The XML namespace for the elements of a manifest array.

The XML namespaces for PDF subtypes

Constant values for supported file types, used in I/0 operations. See XMPFile object.

FI LE_UNKNO
FI LE_PDF

FI LE_POSTSCR PT
FI LE_EPS

FI LE JPEG

FI LE_JPEGK
FILE TI FF
FILEGF

FI LE_PNG

Unknown file-format.

PDF

PS, general PostScript following DSC conventions
EPS, encapsulated PostScript

JPEG

JPX, JPEG 2000 file

TIFF

GIF

PNG
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FI LE SW

FILE FLA

FI LE FLV

FI LE MOV

FILE_ AVl

FILEQN

FI LE WAV

FI LE MP3

FI LE_SES

FILE CEL

FI LE MPEG

FI LE MPEQ2

FI LE_ MPEGA

FI LE WAV

FILE Al FF

FI LE_HTM.

FI LE XM

FI LE TEXT

FI LE_PHOTOSHOP

FI LE | LLUSTRATCR

FI LE_| NDESI QN

FI LE AE_PRQJECT

FI LE AE_PROJECT TEMPLATE
FI LE_AE_FI LTER PRESET
FI LE_ENCORE_PRQJECT

FI LE_PREM ERE_PRQJECT

FI LE_PREM ERE_TI TLE

SWEF, Flash file

FLA, Flash authoring file

FLV, Flash video file

MOV, Quicktime

AVI

CIN, Cineon

WAV

MP3

SES, Audition session

CEL, Audition loop

MPEG

MP2

MP4

WMAV, Windows Media Audio and Video
AIFF

HTML

XML

TEXT

PSD, Photoshop

Al, Illustrator

INDD, Indesign

AE, After Effects

AET, After Effects Project Template
FFX, After Effects Filter Preset file
NCOR, Encore DVD project file
PRPJ, Premiere Project file

PRTL, Premiere Title file
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This class represents a date and time. Times include a time zone, and can have up to nanosecond

resolution.
new XMPDateTime ( ); // creates an object containing a 0 date
new XMPDateTime ( date ); // initializes the object with a JavaScript date
new XMPDateTime ( iso8601Date ); // initializes the object with an ISO date
dat e A JavaScript Dat e object.

The time zone is set to the local operation-system time-zone value.

Times in the XMP Toolkit can have up to nanosecond resolution; however, when
converting to or from a JavaScript Date value, time resolution is reduced to
milliseconds.

i s08601D0at e | A string containing a date-time in ISO 8601 format; for example:
"2007-04-10T17:54:50+01:00"

All properties are read-write, and allow you to modify the date-time value. If values are set outside the
allowed range, they are automatically set to the minimum or maximum allowed value.

year
nont h

day

hour

m nut e
second
nanosecond

tzSi gn

t zHour

tzM nut e

Number
Number
Number
Number
Number
Number
Number

Number

Number

Number

The year, in the range [0000..9999].

The month, in the range [1..12].

The day, in the range [1..31].

The hour, in the range [1..23].

The minute, in the range [1..59].

The second, in the range [1..59.

The nanosecond, in the range [0..1e+9 -1].

The time zone direction of offset.

0: UTC
-1: west
1: east

The time zone hour offset from the prime meridian, in the range [1..23].

The time zone minute offset from the prime meridian, in the range [1..59].
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conpar eTo()
XMPDat eTi meChj . conpar eTo( xnpDat eTi ne)

xnpDat aTi me Another XMPDateTime object.

Reports the time order of two date-time values.

Returns 0 if the two values are the same, 1 if this date-time is later than the comparison value, -1 if
this date-time is earlier than the comparison value.

convert ToLocal Ti ne()
XMPDat eTi meChj . convert ToLocal Ti ne()

Sets the time zone in this object to the local operating-system time zone, adjusting the time values
from the previous time zone, if necessary.

Returns undef i ned.

conver t TOUTCTi ne()
XMPDat eTi meChj . conver t TOUTCTi me()

Sets the time zone in this object to UTC (coordinated universal time), adjusting the time values from
the previous time zone, if necessary.

Returns undef i ned.

get Dat e()
XMPDat eTi meChj . get Dat e()

Converts this date-time value to a JavaScript Dat e. The time zone is normalized (time zones are not
supported in the JavaScript format), and the accuracy is reduced to milliseconds.

Returns a JavaScript Dat e object.

set Local Ti meZone()
XMPDat eTi meChj . set Local Ti meZone()

Sets the time zone in this object to the current operation-system value, replacing any existing value.
Does not affect other fields.

Returns undef i ned.

This class corresponds to the Adobe XMP Toolkit's File Handler component, which provides convenient
I/0 access to the main, or document level, XMP for a file.

The File Handler supports those file formats in which you can embed XMP metadata, as defined in the XMP
Specification. It allows you to add XMP where none currently exists, expand existing XMP without regard
to existing padding, and reconcile XMP with other metadata formats.

The XMP Toolkit also supplies the Packet Scanner as a fallback solution for unsupported file formats. It
provides more limited accesses to all file formats by performing a dump file scan. It can update a file, but
cannot extend the packet or reconcile other metadata formats.

The XMPScript API does not currently support retrieving thumbnails.
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Note: You can also use the Adobe Bridge Metadata object to access embedded metadata in files. It
supports thumbnails and previews, and additional file formats such as PDF and Camera Raw. For
details, see the Adobe Bridge JavaScript Guide and Adobe Bridge JavaScript Reference.

new XMPFile( filePath, format, openFlags)

filePath A string containing the file path of a document.

for nat The file format constant. See ‘File format numeric constants’ on page 241.

openFl ags | The open options for the file. One of these constants:

XMPConst . OPEN_FCR_READOpen for read-only access.

XMPConst . OPEN_FCR_UPDATE Open for reading and writing.

XMPConst . OPEN_ONLY_XMP Only the XMP is wanted, allows space/time optimizations.

XMPConst . OPEN_STR! CTLY Be strict about locating XMP and reconciling with other
forms.

XMPConst . CPEN_USE_SVART_HANDLERRequire the use of a smart handler. No packet
scanning is performed.

XMPConst . OPEN_USE_PACKET_SCANN NGForce packet scanning, do not use a smart
handler.

XMPConst . OPEN_LI M TED_SCANN NGOnly packet-scan files known to need scanning.

This property is available as a static property of the XMPFi1le class. It is not necessary to create an instance
to access it.

version String  The descriptive string for this version of the XMP Toolkit.

This function is available as a static method of the XMPFile class. It is not necessary to create an instance
to call it.

get For mat | nf o()
XMPFi | e. get For mat | nf o( f or nat)

for nat The file format constant. See ‘File format numeric constants’ on page 241.

Reports the supported features for the given file format.
Returns a logical OR of bit-flag constants, or 0 if the format is not handled. Constants are:

XMPConst . HANDLER CAN | NJECT_XMP Can inject first-time XMP into an existing file.

XMPConst . HANDLER CAN EXPAND Can expand XMP or other metadata in an existing file.
XMPConst . HANDLER CAN_REWR TE Can copy one file to another, writing new metadata.
XMPConst . HANDLER PPEFERS | N PLACE Can expand, but prefers in-place update.

XMPConst . HANDLER CAN REQONO LE Supports reconciliation between XMP and other forms.
XMPConst . HANDLER ALLOMS CNLY_XMP Allows access to just the XMP, ignoring other forms.
XMPConst . HANDLER RETURNS RAW PACKETS File handler returns raw XMP packet information.
XMPConst . HANDLER RETURNS TNAI L File handler returns native thumbnail.

XMPConst . HANDLER OMS_FI LE The file handler does the file open and close.
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XMPConst . HANDLER ALLONS_SAFE_UPDATE The file handler allows crash-safe file updates.
XMPConst . HANDLER NEEDS READONLY_PACKET The file format needs the XMP packet to be read-only.
XMPConst . HANDLER USES_SI DECAR XMWP The file handler uses a sidecar file for the XMP.

canPut XMP()

XMPFI | eQoj . canPut XMP( xnpQj )
XMPFi | eQhj . canPut XMP( xnpPacket )
XMPFi | eQhj . canPut XMP( xnpBuf f er)

xnpQbj The XMP metadata as an XMPMeta object.

xnpPacket The XMP metadata as a string containing an XMP packet.

xnpBuf f er The XMP metadata as an Array of Number containing raw XMP packet data.
Reports whether XMP metadata of a given size can be updated for this file. This is particularly
important if the packet size is increased.

Considers only the length of the serialized packet; does not keep the provided XMP. Use putXMP() to
actually update the XMP in the open file.

Returns true if the given XMP can be put into this file.

cl oseFil e()
XMPFi | eQj . cl oseFi | e( ¢l oseFl ags)

closeflags A close-option constant, or 0. Close options are:

XMPConst . CLOBE_UPDATE_SAFELY Write into a temporary file then swap for crash
safety.

Closes this open file, after writing to it as necessary; that is, if the file was opened for update, and if
the XMP metadata was updated or injected. The options provided when the file was opened
determine whether this function reconciles the XMP with other forms of metadata; that is, whether
any legacy metadata is also updated to be consistent with the XMP metadata.

Returns undef i ned.

get XMX()
XMPFi | eQhj . get XMP()

Retrieves and parses the existing XMP metadata from this file. If the file format contains legacy
metadata in a format that is recognized by the File Handler, the function creates an XMP packet
containing the metadata.

Returns an XMPMeta object, or nul | if the files does not contain XMP or convertible legacy
metadata.

get Packet | nf o()
XMPFi | eQj . get Packet | nf o()

Retrieves the raw XMP packet from this file, along with information about the packet. The options
with which the file was opened determine whether this function reconciles other forms of metadata

with the XMP.

Returns an XMPPacketInfo object, or nul | if the files does not contain XMP metadata.
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get Fi | el nfo()
XMPFi | eQhj . get Fi l el nfo()

Retrieves basic information about this file.

Returns an XMPFilelnfo object.

put XMP()
XMPFI | eQj . put XMP( xnpQj )
XMPFi | eQhj . put XMP( xnpPacket)
XMPFi | eQhj . put XMP( xnpQBuf fer)

xnpQbj The XMP metadata as an XMPMeta object.

xnpPacket The XMP metadata as a String containing an XMP packet.
xnpBuf f er The XMP metadata as an Array of Number containing raw XMP packet data.

Supplies new XMP metadata for this file. The file is not actually written until closeFile() is called. The
options provided when the file was opened determine whether that function reconciles the XMP
with other forms of metadata; that is, whether any legacy metadata is also updated to be consistent
with the XMP metadata.

Returns undef i ned.

This object is returned by XMPFile . getFileInfo(). The read-only properties describe the file represented
by the XMPFile object.

Note: This object is not related to the XMP File Info dialog that Creative Suite 3 applications use to display

metadata.
filePath String The absolute path of the file, in JavaScript notation.
f or mat Number @ One of the file-format constants. See ‘File format numeric constants’ on

page 241.

handl erFl ags | Number | The features that are supported for this format. A logical OR of these
bit-flag constants:

XMPConst . HANDLER CAN | NDECT_XMP Can inject first-time XMP into an
existing file.

XMPConst . HANDLER CAN EXPAND Can expand XMP or other metadata in
an existing file.

XWPConst . HANDLER CAN_REWR TE Can copy one file to another, writing
new metadata.

XMPConst . HANDLER PPEFERS | N PLACE Can expand, but prefers
in-place update.

XMPConst . HANDLER CAN REQONO LE Supports reconciliation between
XMP and other forms.

XMPConst . HANDLER ALLOMAS_ONLY_XMP Allows access to just the XMP,
ignoring other forms.
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openFl ags

XMPConst . HANDLER RETURNS RAW PACKETS File handler returns raw XMP
packet information.

XMPConst . HANDLER RETURNS TNAI L File handler returns native
thumbnail.

XMPConst . HANDLER OMS _FI LE The file handler does the file open and
close.

XMPConst . HANDLER ALLOANS SAFE_UPDATE The file handler allows
crash-safe file updates.

The options with which this file was opened. One of these constants:

XMPConst . CPEN_FCR_READ Open for read-only access.

XMPConst . CPEN_FCR_UPDATE Open for reading and writing.

XMPConst . CPEN_ONLY_XMWP Only the XMP is wanted, allows space/time
optimizations.

XMPConst . OPEN_STRI CTLY Be strict about locating XMP and reconciling
with other forms.

XMPConst . CPEN_USE SVART HANDLERRequire the use of a smart handler.
No packet scanning is performed.

XMPConst . CPEN_USE_PACKET_SCANN NGForce packet scanning, do not
use a smart handler.

XMPConst . CPEN_LI M TED_SCANN NGOnly packet-scan files known to
need scanning.

Created by a call to xMPMeta . iterator(). Walks recursively through the properties and qualifiers of an
XMPMeta object, and returns them as XMPProperty objects.

The object has no JavaScript properties.

next ()

XMPl terator@yj.next ()

Retrieves the next item in the metadata.

Returns an XMPProperty object, or nul | if there are no more items.

ski pSi bl i ngs()

XMPl terator@j.skipSiblings ()

Skips the subtree below and the siblings of the current node on the subsequent call to next().

Returns undef i ned.

ski pSubt ree()

XMPI t erat or Qyj . ski pSubtree ()

Skips the subtree below the current node on the subsequent call to next().

Returns undef i ned.
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This class provides the core services of the XMP Toolkit. The functions provide the ability to create and
query metadata properties from an XMP namespace. The class also provides static functions that allow
you to create and query namespaces and aliases.

There is one static property on the class that provides XMP version information; there are no JavaScript
properties in the instance. The object encapsulates a set of metadata properties, which you access
through the object functions.

The generic functions getProperty(), setProperty(), and deleteProperty() allow you to manipulate all types
of properties, when used with appropriately composed path expressions. For convenience, the object also
provides more specific functions for use with specific types of properties, such as arrays.

To create an XMPMeta object, use the new operator. The constructor accepts an RDF/XML serialized
metadata packet as a string, or as an array of numbers that contain only byte values. It returns the new
object. If no argument is supplied, the new object is empty; you can use the object’s functions to add
namespaces and properties.

The first call to any of these constructors initializes the library by registering the standard namespaces and
aliases.

new XMPMeta ( ); // creates an empty object
new XMPMeta ( packet ) ;
new XMPMeta ( buffer );

packet A String containing an XML file or an XMP packet.

buf fer An Array of Number. The UTF-8 or UTF-16 encoded bytes of an XML file or an XMP packet.
This array is the result of XMPMet a. serializeToArray().

The XMPMeta class provides this static property. It is not necessary to create an instance to access it.

version String | The descriptive string for this version of the XMP Toolkit.
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The XMPMeta class provides these static functions. It is not necessary to create an instance to call them.

del et eAl i as()
XMPMet a. del eteAlias (aliasNS aliasProp)

al i asNs The namespace URI string. See ‘Schema namespace string constants’ on
page 240.
aliasProp The alias property string.

Deletes the specified alias; does not delete the aliased property. If the alias does not exist, does
nothing.

Note: Not yet implemented in the XMP Toolkit.

Returns undef i ned.

del et eNanespace()
XMPMet a. del et eNanespace ( nanespaceUR)

namespacelRl The namespace URI string. See ‘Schema namespace string constants’ on
page 240.

Deletes a registered prefix - namespace URI pair.
Note: Not yet implemented in the XMP Toolkit.

Returns undef i ned.

dunpAl i ases()
XWPMet a. dunpAl i ases ()

Creates and returns a human-readable string containing the list of registered aliases and their
targets.

Returns a String.

dunpNarrespaces()
X\MPMet a. dunpNaneSpaces ()

Creates and returns a human-readable string containing the list of registered namespace URIs and
their associated prefixes.

Returns a String.

get NanespacePr ef i x()
X\MVPMet a. get NamespacePr ef i x (namespaceUR)

namespacelUR! The namespace URI string. See ‘Schema namespace string constants’ on
page 240.

Retrieves the prefix associated with a registered namespace URI.

Returns the prefix string followed by a colon.
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get NarmespaceUR ()
X\WPMet a. get NamespaceUR  ( namespacePr ef i x)

namespacePrefix The namespace prefix string.

Retrieves the registered namespace URI associated with a namespace prefix.

Returns the URI String.

regi sterAias()
XMWPMet a. regi sterAlias (aliasNS, aliasProp, actual NS, actual Prop, arrayForn)

al i asNs The alias namespace string. See ‘Schema namespace string constants’ on
page 240.

aliasProp The alias property, a simple name string.

actual NS The namespace string of the aliased property. See ‘'Schema namespace string

constants’ on page 240.

act ual Prop The aliased property, a simple name string.

arrayForm Number. The array form for a simple alias to an array item, which controls how
the array is created if it is set for the first time through the alias. One of these
constants:

XMPConst . ALl AS TO Sl MPLE_PRCP (default): A direct mapping. It can be
simple-to-simple, array-to-array, or structure-to-structure.

XMPConst . ALI AS_TO ARRAY: The actual is an unordered array, the alias is to
the first element of the array.

XMPConst . ALI AS_ TO CRDERED ARRAY: The actual is an ordered array, the alias
is to the first element of the array.

XMPConst . ALI AS TO ALT_ARRAY: The actual is an alternate array, the alias is to
the first element of the array.

XMPConst . ALI AS TO ALT_TEXT: The actual is an alternate-text array (a
localized property), the alias is to the x- def aul t element of the array.

Defines an alias mapping from one namespace and property to another. An alias can be a direct
mapping where the alias and actual property have the same data type, or it can map a simple alias to
an item in an array, either the first item, or the x- def aul t item in an alternate-text array.

Multiple alias names can map to the same actual property, as long as the forms match. If the same
alias and form exists, the call does nothing.

Returns undef i ned.

r egi st er Nanespace()
XMPMet a. r egi st er Nanespaces ( nhanespaceUR, suggest edPrefi x)

schemaNs The namespace URI string. See ‘Schema namespace string constants’ on
page 240.

suggest edPrefi x The suggested namespace prefix string.

Registers a namespace with a prefix. If the suggested prefix is already in use, generates, registers, and
returns a different prefix.

Returns a String containing the actual registered prefix. This is the suggestedPrefix, unless that one is
already assigned to another namespace.
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resol veAl i as()
XWPMet a. resol veAl i as (aliasNS, al i asProp)

schemaNs The alias namespace URI string. See ‘Schema namespace string constants’ on
page 240.
aliasProp The alias property string.

Retrieves information about the actual property to which an alias is mapped.

Returns an XMPAliasInfo object.

appendArraylt en()
XMPMVet aChj . appendArrayl t en{ schenaNsS, arrayName, itenmval ue[, iten(ptions, arrayQptions))

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arr ayNane The array-type property name string. Can be a general path expression.
i temval ue The new item value string. Pass nul | for array items that do not have values.

itemptions Optional. A flag that describes the new item, if it is being created. One of:

0: The default. A simple item, or the type implied by the arrayOptions value.
XMPConst . PRCP_I S_ARRAY: The item is an array (of type al t, bag, or seq).
XMPConst . PRCP_I S_STRUCT: The item is a structure with nested fields.

arraytions Optional. A flag that describes the array form. Must be provided if the array is being
created; ignored if the array already exists. One of:

XMPConst . ARRAY_| S CRDERED: Item order is significant. Implies
XMPConst . PRCP_| S _ARRAY.

XMPConst . ARRAY_| S_ALTERNATI VE Items are mutually exclusive alternates.
Implies XMPConst . PROP_I S_ARRAY and XMPConst . ARRAY_| S CRDERED

Appends an item to an existing array, or creates a new array-type property if the named array does
not exist.

Returns undef i ned.

count Arrayl t ems()
XMPMet aChj . count Arrayl t ens( schenalNs, arr ayNane)

schenaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arrayNane The array-type property name string. Can be a general path expression.

Reports the number of items in an array-type metadata property.

Returns the number of items.
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del et eArraylten()
XMPMet aChj . del et eArrayl t en{ schenalNs, arrayNane, i t eni ndex)

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arrayName  The array-type property name string. Can be a general path expression.

i t em ndex Number. The 1-based position index of the item. Use XMPConst . ARRAY_LAST | TEMto
reference the last existing item in the array.

Deletes the metadata tree that has the given array item as its root.

Returns undef i ned.

del et eProperty()
XMPMVet aCbj . del et eProperty( schenalNs, propNane)

schemaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

prop The property name string. Can be a general path expression.

Deletes the metadata tree that has the given property as its root. If the property does not exist, does
nothing.

Returns undef i ned.

del et eStruct Fi el d()
XMPMet aChj . del et eStruct Fi el d( schenaNs, struct Nane, fiel dNS, fiel d\Nane)

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

struct Nane  The structure name string. Can be a general path expression.

fiel dNS The field type namespace string. See ‘Type namespace string constants’ on
page 241.

fi el d\ane The field name string. Must be a simple XML name.

Deletes the metadata tree that has the given structure field as its root.

Returns undef i ned.

del eteQual i fier()
XMPMet aChj . del et eQual i fi er (schenalNs, structName, qual NS, qual Nane)

schenaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

struct Nane  The structure name string. Can be a general path expression.
qual NS The URI string of the qualifier namespace.
qual Nane The qualifier name string. Must be a simple XML name.

Deletes the metadata tree that has the given qualifier as its root. If the qualifier does not exist, does
nothing.

Returns undef i ned.
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doesArrayl t enexi st ()
XMPMet aChj . doesArrayl t enExi st (schenaNS, arrayNane, itenindex)

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

ar r ayNane The array name string. Can be a general path expression.
i t em ndex Number. The 1-based position index of the item.

Reports whether an array item with a given index currently exists in an existing array in the
metadata.

Returns t r ue if the array and item exist.

doesPr opert yExi st ()
XMPMVet aChj . doesPr oper t yExi st ( schenalNs, pr opNane)

schemaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

pr opNane The property name string. Can be a general path expression.

Reports whether a property with a given name currently exists in the metadata.

Returns t r ue if the property exists.

doesSt ruct Fi el dExi st ()
XMPMet aChj . del et eStruct Fi el d( schenalNs, struct Nane, fiel dNS, fiel d\Nane)

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

struct Nane  The structure name string. Can be a general path expression.

fiel dNS The field type namespace string. See ‘Type namespace string constants’ on
page 241.

fiel d\ame The field name string. Must be a simple XML name.

Reports whether a structure field with a given name currently exists in the metadata.

Returns t r ue if the structure and field exist.

doesQual i fi er Exi st ()
XMPMet aChj . del et eQual i fier(schenalNs, structName, qual NS, qual Nane)

schenaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

struct Nane  The structure name string. Can be a general path expression.
qual NS The qualifier namespace URI string.
qual Nane The qualifier name string. Must be a simple XML name.

Reports whether a qualifier with a given name currently exists for a given property.

Returns t r ue if the property and qualifier exist.

dunpQoj ect ()
XMPVet aChj . dunpChj ect ()

Creates and returns a string containing the metadata content of this object as RDF.

Returns a String.
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get Arrayl temn()
XMPMet aChj . get Arrayl t en{ schenaNS, arrayNane, iteni ndex)

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

ar r ayNane The array name string. Can be a general path expression.

i t em ndex Number. The 1-based position index of the item. Use XMPConst . ARRAY_LAST | TEMto
reference the last existing item in the array.

Retrieves an item from an array-type metadata property.

Returns an XMPProperty object, or undef i ned if the property is not found.

get Local i zedText ()
XMPMVet aChj . get Local | zedText (schenalNsS, al t Text Nane, generi cLang, speci ficLang)

schemaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

al t Text N\ane  The alternate-text array name string. Can be a general path expression.

genericLang The name of the generic language as an RFC 3066 primary subtag. Can be nul | or
the empty string.

speci fi cLang The name of the specific language as an RFC 3066 primary subtag; for example,
en- US. Must be specified.

Retrieves the text value for a specific language from an alternate-text array. First tries to match the
specific language. If not found, tries to match the generic language, if specified. If not found, gets the
x-def aul t item, if any. Otherwise, gets the first item.

Returns a String, or undef i ned if no matching value is not found.

get Property()
XMPVet aChj . get Property(schenaNs, propNane[, val ueType])

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

pr opNane The property name string. Can be a general path expression.

val ueType Optional, String. The property data type, one of:

XMPConst . STRI NG
XMPConst . | NTEGER
XMPConst . NUMBER
XMPConst . BOOLEAN
XMPConst . XMPDATE

Retrieves the value and options of a metadata property. Use for top-level, simple properties, or after
using the path-composition functions in the XMPUtils object.

Returns an XMPProperty object, or undef i ned if the property is not found.
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get Struct Fi el d()
XMPMet aChj . get Struct Fi el d(schenalNS, struct Nane, fiel dNS fiel d\ane)

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

struct Nane  The structure name string. Can be a general path expression.

fiel dNS The field type namespace string. See ‘Type namespace string constants’ on
page 241.

fiel d\ane The field name string. Must be a simple XML name.

Retrieves a field value from within a nested structure in metadata.

Returns an XMPProperty object, or undef i ned if the property is not found.

get Qual i fier()
XMPMet aChj . get Qual i fier(schenalNs, struct Nane, qual NS, qual Nane)

schenaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

struct Nane  String. The structure name. Can be a general path expression.
qual NS String. The URI of the qualifier namespace.
qual Nane String. The qualifier name. Must be a simple XML name.

Retrieves a qualifier attached to a metadata property.

Returns an XMPProperty object, or undef i ned if the property is not found.

i nsert Arraylten)
XMPMVet aQhj . i nsert Arrayl ten( schenaNsS, arrayName, itenindex, itenVvalue[, iten(ptions])

schemaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arr ayNare String. The name of an existing array. Can be a general path expression.

i t et ndex Number. The 1-based position index at which to insert the new item. Use
XMPConst . ARRAY_LAST_| TEMto reference the last existing item in the array.

i temval ue String. The new item value. Pass nul | for array items that do not have values.

itemptions Optional. A flag that describes the new item, if it is being created. One of:

0: A simple item, the default.
XMPConst . PRCP_|I S_ARRAY: The item is an array (of type al t, bag, or seq).
XMPConst . PROP_I S_STRUCT: The item is a structure with nested fields.

Inserts an item into an array, before an existing item. The index positions of all later items are
incremented. The array must exist.

Returns undef i ned.
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iterator()

XMPMVet aChj . i terator(options, schenaNs, prophane)

opt i ons The set of options that control how the iteration is performed, and how values are
returned. A logical OR of these bit-flag constants:

XMPConst . | TERATCR JUST_CH LDREN Limit iteration to immediate children of the
root property. By default, iterates into subtrees.

XMPConst . | TERATOR JUST_LEAFNCDES: Limit iteration to leaf nodes. By default,
iterates into all nodes of a subtree.

XMPConst . | TERATCR JUST_LEAFNAMES: Return only the leaf part of the path. By
default, returns a full path.

XMPConst . | TERATCR | NCLUDE_ALI ASES: Include aliases. By default, considers only
actual properties.

XMPConst . | TERATCR OM T_QUALI FI ERS: Omit qualifiers from iteration.

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.
propNarre The name string of a property within which to iterate. Can be a general path
expression.

Creates an iteration object that can iterate over the properties, arrays, and qualifiers within this
metadata. Specify options, a namespace, and a property to limit the range and granularity of the

resulting items.

Returns an XMPlterator object for this metadata object.

serialize()

XMPMVet aChj . seri al i ze([ options, padding, indent, new ine, baselndent])

opt i ons Optional. The set of options that control how the serialization is performed. The
options must be logically consistent; if they conflict, the function throws an
exception. A logical OR of these bit-flag constants:

XMPConst . SERI ALI ZE_ QM T_PACKET_WRAPPER Do not include an XML packet
wrapper.

XMPConst . SER ALl ZE_READ ONLY_PACKET: Create a read-only XML packet
wrapper.

XMPConst . SER ALI ZE_USE_COMPACT_FCRMAT: Use a highly compact RDF syntax and
layout.

XMPConst . SER ALI ZE_USE_PLAI N_XMP: Serialize a plain XMP (not currently
supported).

XMPConst . SERI ALI ZE_| NCLUDE_THUMBNAI L_PAD: Include typical space for a JPEG
thumbnail in the padding if no xnp: Thunbnai | property is present.

XMPConst . SER ALI ZE_EXACT_PACKET_LENGTH Compute padding to meet the
overall packet length provided by the padding parameter. Throws an
exception if the unpadded packet exceeds this length.

XMPConst . SERI ALI ZE WR TE_ALI AS COMMENTS: Include XML comments for aliases.

paddi ng Optional, Number.

If the options value is SER ALI ZE_EXACT_PACKET_LENGTH, this the exact length of
the packet, including padding characters that are added to meet this length.

If the options value is not SERI ALl ZE_EXACT_PACKET_LENGTH this is a number of
padding characters to add.

Default is 0, meaning to use the appropriate amount of padding.
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new i ne

i ndent

basel ndent

Optional, String. The newline character to use. Default is U+000A
Optional, String. The string to use as an indent. Default is two spaces.

Optional, Number. The level of indentation of the outermost XML element. Default
is 0.

Serializes this XMP metadata into a string as RDF.

Returns a String.

serializeToArray()
XMPMet aChj . serial i zeToArray([ options, padding, indent, newine, baselndent])

options

paddi ng

new i ne
i ndent

basel ndent

Optional. The set of options that control how the serialization is performed. The
options must be logically consistent; if they conflict, the function throws an
exception. A logical OR of these bit-flag constants:

XMPConst . SER ALI ZE OM T_PACKET_WRAPPER Do not include an XML packet
wrapper.

XMPConst . SER ALI ZE READ ONLY_PACKET: Create a read-only XML packet
wrapper.

XMPConst . SER ALI ZE_USE_COWPACT_FCRVAT: Use a highly compact RDF syntax and
layout.

XMPConst . SERI ALI ZE_USE_PLAI N_XMP: Serialize plain XMP (not currently
supported).

XMPConst . SERI ALI ZE_| NCLUDE_THUMBNAI L_PAD: Include typical space for a JPEG
thumbnail in the padding if no xnp: Thunbnai | property is present.

XMPConst . SER ALI ZE_EXACT_PACKET_LENGTH Compute padding to meet the
overall packet length provided by the padding parameter. Throws an
exception if the unpadded packet exceeds this length.

XMPConst . SER ALI ZE WR TE_ALI AS COWENTS: Include XML comments for aliases.

Optional, Number.

e Ifthe options value is SER ALl ZE EXACT_PACKET_LENGTH this the exact length of
the packet, including padding characters that are added to meet this length.

e If the options value is not SER ALI ZE_EXACT_PACKET_LENGTH this is a number of
padding characters to add.

Default is 0, meaning to use the appropriate amount of padding.
Optional, String. The newline character to use. Default is UrO00A
Optional, String. The string to use as an indent. Default is two spaces.

Optional, Number. The level of indentation of the outermost XML element. Default
is 0.

Serializes this XMP metadata into a string as RDF, then converts that to an array of one-byte numeric
values, the UTF-8 or UTF-16 encoded characters.

Returns an Array of Numbers.
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set Arrayl temn()
XMPMVet aChj . set Arrayl ten{ schenaNs, arrayNane, itenindex, itenVvalue[, iten(ptions])

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arr ayNane The name string of an existing array. Can be a general path expression.

i t em ndex Number. The 1-based position index of the item. Use XMPConst . ARRAY_LAST | TEMto
replace the last existing item in the array.

it emval ue The new item value string. Pass nul | for array items that do not have values.

itemptions Optional, aflag that describes the new item, if it is being created. One of:

0: A simple item, the default.
XMPConst . PRCP_|I S_ARRAY: The item is an array (of type al t, bag, or seq).
XMPConst . PROP_I S_STRUCT: The item is a structure with nested fields.

Replaces an item within an array, or appends an item. The array must exist. To create an item,
appendArrayltem() and insertArrayltem() are preferred.

Returns undef i ned.

set Local i zedText ()

XMPMVet aChj . set Local | zedText ( schenalNs, al t Text Nane, generi cLang, specificlang, itenval ue,
set ot i ons)

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

al t Text N\ame  The name string of the alternate-text array. Can be a general path expression.

genericLang The name of the generic language as an RFC 3066 primary subtag. Can be nul | or
the empty string.

speci ficLang The name of the specific language as an RFC 3066 primary subtag; for example,
de- CH Must be specified.

it emval ue The new string value.
settions  Not used.

Sets the text value for a specific language in an alternate-text array. Handles special cases for the
x-def aul t item.

Returns undef i ned.
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set Struct Fi el d()
XMPMVet aChj . set Struct Fi el d( schenalNs, struct Nane, fiel dNS, fiel d\ane, fiel dval ue[, options])

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

struct Nane  The name string of an existing structure. Can be a general path expression.

fiel dNS The field type namespace string. See ‘Type namespace string constants’ on
page 241.

fiel d\ane The field name string. Must be a simple XML name.

fieldvalue  The new field value string. Pass nul | for fields that do not have values.

options Optional, option flags that describe a new structure. Used only if the structure is
being created. One of:

0: A simple item, the default.
XMPConst . PRCP_I S_ARRAY: The item is an array (of type al t, bag, or seq).
XMPConst . PRCP_I S_STRUCT: The item is a structure with nested fields.

Sets the value of a field within a structure-type property, or creates a new field if the named field
does not exist in the structure, or creates a new structure containing the named field if the named
structure does not exist.

Returns undef i ned.

set Qual i fier()
XMPMet aChj . set Qual i fier(schenaNS, prophane, qual NS, qual Nane, qual Val ue[, options])

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

structNane  The name string of an existing property. Can be a general path expression.

qual NS The URI of the qualifier namespace. Has the same URI and prefix usage as a schema
namespace.
qual Nane String. The name of the qualifier. Must be a simple XML name. Has the same prefix

usage as a property name.
qual Val ue The new qualifier value string. Pass nul | for qualifiers that do not have values.

options Optional, option flags that describe the qualifier. Used only if the qualifier is being
created. One of:

0: A simple item, the default.
XMPConst . PRCP_I S_ARRAY: The item is an array (of type al t, bag, or seq).
XMPConst . PRCP_I S_STRUCT: The item is a structure with nested fields.

Attaches a new qualifier to a metadata property. A qualifier can be added to a simple property, an
array item, a struct field, or another qualifier.

Returns undef i ned.
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set Property()

XMPMVet aChj . set Property(schenaNSs, propName, propVal ue[, set(tions, val ueType])

schenaNS
pr opNane

propVal ue

set (vt i ons

val ueType

The namespace URI string. See ‘'Schema namespace string constants’ on page 240.

The property name string. Can be a general path expression.

The new property value string. Pass nul | to create an array or non-leaf level
structure property.

Optional. The type of property to create, if the named property does not exist.
Default is 0, a simple-valued property. Other constant values are:

XMPConst . PRCP_I S_ARRAY: The property is an array (of type al t, bag, or seq).
XMPConst . PRCP_|I S_STRUCT: The property is a structure with nested fields.

Optional. The property data type. If supplied, the value is converted to this type.

One of:

XMPConst . STRI NG
XMPConst . | NTEGER
XMPConst . NUMBER
XMPConst . BOOLEAN
XMPConst . XMPDATE

Sets the value of a simple metadata property, creating the property if necessary, or creates a new
array or structure property. For creating array and structure properties, setArrayltem() and
setStructField() are preferred. Use this call to create or set top-level, simple properties, or after using
the path-composition functions in the XMPUtils object.

Returns undef i ned.

This object is returned by XxMPFile . getPacketinfo(). The read-only properties describe the XMP packet
for the file represented by the XMPFile object.

char For m

I engt h
of f set
packet
padS ze

witeabl e

Number

Number
Number
String

Number

Boolean

The character encoding in the packet, one of:

0: UTF8

2: UTF-16, MSB-first (big-endian)
3: UTF-16, LSB-first (little-endian)
4: UTF 32, MSB-first (big-endian)
5: UTF 32, LSB-first (little-endian)

The length of the packet in bytes.

The byte-offset from the start of the file where the packet begins.
The raw packet data.

The packet’s padding size in bytes, 0 if unknown.

If true, the packet is writeable.
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This object is returned by various property accessor functions of the XMPMeta object, such as
getProperty(). The read-only properties describe a metadata property.

| ocal e

nanespace

options

pat h

val ue

String

String

Number

String

Variant

The language of the property value. This value is set by calls to
getLocalizedText(), which assigns the language of the selected alternative text
item, if an appropriate item is found.

The namespace of the property; see ‘Schema namespace string constants’ on
page 240. Typically used when browsing metadata with an XMPIterator object.

A constant that describes the property type, 0 for a simple property. Constants
are:

XMPConst . PRCP_I S_ARRAY: The property is an array (of type al t, bag, or seq).
XMPConst . PRCP_I S_STRUCT: The property is a structure with nested fields.

The property path, including the property name. For a simple property, the
entire path is the property name.

The value of the property, if any. Arrays and non-leaf levels of structures do not
have values.

This class provides additional utility functions for the XMP Toolkit, layered upon the functionality of the
XMPMeta object. It has only static functions, you cannot create an instance.

e Path-composition functions such as composeArrayltemPath(), provide support for composing path
expressions to deeply nested properties, which you can then pass to the accessor functions in
XMPMeta object, such as getProperty().

e Higher-level functions such as duplicateSubtree() allow you to manipulate the metadata tree in an
XMPMeta object.

appendPr operti es()
XMPU i | s. appendProperti es(source, dest, options)

source
dest

options

The source XMPMeta object.

The destination XMPMeta object.

Option flags that control the copying operation. A logical OR of these bit-flag
constants:

XMPConst . APPEND ALL_PRCPERTI ES: Include both internal and external
properties. By default, copies only external properties. This applies only to
top-level properties.

XMPConst . APPEND REPLACE QLD VALLES: Replace the values of existing properties
with the value from the source object. By default, existing values are
retained. This applies to properties at all levels of hierarchy.
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XMPConst . APPEND DELETE_EMPTY_VALUES: Delete properties if the new value is
empty.

Default is 0.

Copies properties from a source XMPMeta object and appends them to a destination XMPMeta
object.

Returns undef i ned.

cat enat eArrayl t ens()
XMPU i | s. cat enat eArrayl tens( xnpQhj, schenmalNs, arrayName, separator, quotes, options)

xnpQbj The XMPMeta object containing the array.

schemaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arr ayNane The array property name string. Can be a general path expression. Each item in the
array must be a simple string value.

separ at or The string used to separate the items in the result string. Defaultis'; ', an ASCII
semicolon and space (U+003B,U+0020).

quot es The character used to quote items that contain a separator. Defaultis' "', an ASCII
double quote (U+0022).
options Option flag that controls the concatenation. This constant value:

XMPConst . SEPARATE_ALLON COMVAS: Allow commas in item values (such as
"LastName, FirstName"). This option must be set the same way in this
function and in separateArrayltems() to reconstruct the items correctly.

Default is 0.

Concatenates a set of array item values into a single string. The resulting string can be separated
back out into array items using separateArrayltems().

Returns the concatenated String.

conposeAr rayl t enfPat h()
XMPU i | s. conposeArrayl t enPat h( schenaNsS, arrayNane, itenindex)

schenaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arr ayNane The array property name string. Can be a general path expression.

i t ent ndex Number. The 1-based position index of the item. Use XMPConst . ARRAY_LAST_| TEMto
reference the last existing item in the array. In this case, the resulting path is
ns: arrayName[ | ast ()] .

Creates and returns a string containing the path expression for an item in an array, using the
registered prefix for the namespace, in the form:

schenals. ar r ayNane[ i t eni ndex]
Returns a String.

conmposeFi el dSel ector ()
XMPU i | s. conposeFi el dSel ect or (schenalNs, arrayName, fiel dNS, fiel d\ame, fiel dval ue)

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arrayNane  The array property name string. Can be a general path expression.
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fiel d\NS The field namespace URI string.
fiel d\ane The field name. Must be a simple XML name.
fiel dvalue  The desired field value.

Creates and returns a string containing the path expression to select an alternate item by a field’s
value, using the registered prefixes for the namespaces, in the form:

schenmaNs. arrayNane[ fi el dNS fi el d\Name=" fi el dval ue' ]
Returns a String.

conposelLanguageSel ect or ()
XMPU i | s. conposelLanguageSel ect or ( schenaNs, arrayNane, | ocal €)

schenmalNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arrayNane The array property name string. Can be a general path expression.
local e The RFC3066 locale code string for the desired language.

Creates and returns a string containing the path expression to select an alternateiteminanal t text
array by language, using the registered prefix for the namespace, in the form:

schenals. arrayNane[ @n : | ang=" | anghane’ |
Returns a String.
Note: Do not use this in place of getLocalizedText() or setLocalizedText(). Those functions provide
extra logic to choose the appropriate language and maintain consistency with the x- def aul t

value. This function provides a path expression for an explicit language, and only for that
language.

conmposeSt r uct Fi el dPat h()
XMPU i |'s. conposeSt ruct Fi el dPat h( schenaNs, struct Nane, fiel dNS, fiel d\ane)

schenaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

struct Nane  The structure property name string. Can be a general path expression.
fiel d\NS The field namespace URI string.
fi el d\ane The field name. Must be a simple XML name.

Creates and returns a string containing the path expression for a field in a structure, using the
registered prefixes for the namespaces, in the form:

schenalS. st ruct Nanel fi el dNS. fi el d\ane
Returns a String.

conmposeQual i fi er Pat h()
XMPUi | s. conposeQual i fi er Pat h( schenaNS, propNane, qual NS, qual Nane)

schemaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

pr opNane The property name string. Can be a general path expression.

qual NS The qualifier namespace URI string.
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qual Nane The qualifier name. Must be a simple XML name.
Creates and returns a string containing the path expression for a qualifier attached to a property,
using the registered prefix for the namespace, in the form:

schenaNs. pr opNanel ?qual NS qual Nane
Returns a String.

dupl i cat eSubt ree()
XMPU i |'s. dupl i cat eSubtree(source, dest, sourceNS, sourceRoot, dest NS, destRoot, options)

source The source XMPMeta object.

dest The destination XMPMeta object.

sour ceNS The source namespace URI string. See ‘Schema namespace string constants’ on
page 240.

sourceRoot  The property name string for the root location of the source subtree. Can be a
general path expression.

dest NS The destination namespace URI string. See ‘Schema namespace string constants’ on
page 240.
dest Root Optional. The property name string for the root location of the destination subtree.

Can be a general path expression. Default is the source root location.

opt i ons Option flags that control the copying operation. A logical OR of these bit-flag
constants:

XMPConst . APPEND ALL_PRCPERTI ES: Include both internal and external
properties. By default, copies only external properties. This applies only to
top-level properties.

XMPConst . APPEND REPLACE QLD VALLES: Replace the values of existing properties
with the value from the source object. By default, existing values are
retained. This applies to properties at all levels of hierarchy.

XMPConst . APPEND DELETE_EMPTY_VALUES: Delete properties if the new value is
empty.

Default is 0.

Copies properties in the specified subtree from a source XMPMeta object and adds them into a
destination XMPMeta object.

Returns undef i ned.

renovePr operti es()
XMPU i |'s. renoveProperti es(xnpQbj, schenalNS, propNane, options)

xnpQbj The XMPMeta object.

schermalNs Optional. The namespace URI string. See ‘Schema namespace string constants’ on
page 240. Must be supplied if a property name is supplied.

prophane Optional. The property name string. Can be a general path expression.
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options Option flags that control the deletion operation. A logical OR of these bit-flag
constants:

XMPConst . REMOVE_ALL_PRCPERTI ES: Remove internal and external properties. By
default, removes only external properties. Applies only to top-level
properties.

XMPConst . REMOVE | NCLUDE_ALI ASES: Remove aliases defined in the namespace. If
the property name is supplied, removes it regardless of this option.

Default is 0.

Removes multiple properties from an XMPMeta object.

e If both the namespace and property name are supplied, removes the property if it is external,
even if it is an alias. If it is internal, removes it if the option XMPConst . REMOVE_ALL_PRCPERTI ESis
specified.

e If the namespace is supplied and the property name is not, removes all external properties in the
namespace, and optionally all internal properties. Removes aliases only if the option
XMPConst . REMOVE_| NCLUDE_ALI ASES is specified.

e If neither the namespace nor the property name are supplied, removes all external properties,
and optionally all internal properties. Aliases are handled implicitly, because the associated
actual is removed.

Returns undef i ned.

separ at eArrayl tens()
XMPUi | s. separat eArrayl tens(xnpQbj, schenaNS, arrayNanme, array(ptions, concat String)

xnpQbj The XMPMeta object containing the array.

schenaNs The namespace URI string. See ‘Schema namespace string constants’ on page 240.

arrayNane The array property name string. Can be a general path expression. Each item in the
array must be a simple string value.

array@tions Option flags that control how the array property is updated from the separated
string. A logical OR of these bit-flag constants:

XMPConst . APPEND ALL_PRCPERTI ES: Include both internal and external
properties. By default, copies only external properties. This applies only to
top-level properties.

XMPConst . APPEND REPLACE (LD VALUES: Replace the values of existing properties
with the value from the source object. By default, existing values are
retained. This applies to properties at all levels of hierarchy.

XMPConst . APPEND DELETE_EMPTY_VALUES: Delete properties if the new value is
empty.

XMPConst . SEPARATE_ALLON COMVAS: Allow commas in item values. If not
specified, an item containing a comma (such as "LastName, FirstName") is
separated into two array items.

Default is 0.
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concat String The string containing the concatenated array values, as returned by
catenateArrayltems().

Updates individual array item strings in the XMPMeta object from a concatenated string returned by
catenateArrayltems(). Recognizes a large set of separator characters, including semicolons, commas,

tab, return, linefeed, and multiple spaces.

Returns undef i ned.
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Porting Guide

This chapter briefly describes changes between this release and the previous release of ExtendScript, to
aid you in porting applications to current versions.

This release of ExtendScript includes a new look and many new features in the ExtendScript Toolkit; see
“Configuring the Toolkit Window"” on page 13. New features include:

e Multiple document windows in which you can edit and run multiple scripts simultaneously, with
per-document target selection.

e A powerful search-and-replace facility, with the ability to search for text in multiple files.

e A Scripts palette that provides easy access to frequently used scripts, configurable with user-defined
Favorites folders.

e Configurable keyboard shortcuts for menu commands.

The Toolkit includes an expanded Script Editor with many new features to support a structured view of
JavaScript code; see “The Script Editor” on page 18. New features include:

e A collapsible tree view for JavaScript code files that allows you to collapse and expand structural units
e Find matching brace and select to matching brace

e Line wrapping

e Blockindentation

e Comment and uncomment commands

e JavaScript syntax checking

e Configurable syntax highlighting for JavaScript and many other languages

The Toolkit offers expanded debugging features; see “Debugging in the Toolkit” on page 24. New features
include:

e A multi-line JavaScript listener and output console

e The ability to create and navigate to bookmarks in files

The Toolkit now offers an Object Model Viewer, which allows you to inspect the JavaScript object model of
an application. See “Inspecting Object Models” on page 34

This release includes:

e Support for loading and playing Flash movies (SWF files) in ScriptUI, through the FlashPlayer control
type.
o New TreeView control type, a hierarchical list with collapsible items.

268
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e New ScriptUIGraphics object for low-level control of element appearance.

e New ScriptUI Class for access to global settings. The Window Class provides access to the built-in
notification dialogs.

e Enhancements to resizing behavior and other features of automatic layout.
e Addition of JPEG image format for IconButton and Image elements.

e Checkmarks for items in list boxes.

This release includes:
e Timeouts for message receipt and acknowledgement.

e Increased security; see “Changes in messaging” on page 270.

e Internal improvements for performance and reliability.

This release supports a utility for communicating over sockets, and higher-level support for FTP and HTTP
communication protocols.

This release provides for the integration of C/C++ shared libraries, and allows you to represent and
manipulate XML code directly in JavaScript.

e The static properties Window. frameworkName and Window.version are deprecated in favor of
ScriptUI. frameworkName and ScriptUI.version.

e The icon property in control objects is deprecated in favor of the new image property.

e The ability to specify script directives within comments using the @ character has been deprecated. Do
not continue to use the following syntax:

// @include "file.jsxinc"
Use the # syntax instead:
#include "file.jsxinc"

e New debugger properties: $.evalFile ()



11: Porting Guide

Feature Support in Applications 270

This release of the messaging framework includes these changes that are incompatible with the previous

release:

e Message authentication added

By default, Creative Suite 3 applications reject messages built with the Creative Suite 2 framework. To
accept such messages, set BridgeTalk .messageAuthentication = false inthe Creative Suite
3 application.

Changed launch aliases for applications

The Creative Suite 2 release used XPEP launch aliases for applications. In this release, Creative Suite 3

applications are registered in the Adobe Product Code Database (PCD).

To use the previous version of messaging with Creative Suite 3 applications, you must either launch
them outside the framework, or add XPEP launch aliases for them.

This table show the extent to which individual applications in Adobe® Creative Suite 3 support features

and modules of ExtendScript.

Adobe After
Feature or Module Bridge Photoshop Illustrator InDesign Effects
ExtendScript Toolkit X X X X X
Compiled JavaScript X X X X X
(execution)
ScriptUl X X X X X
External library integration X X X X X
Sockets X X X
Web access (HTTP and FTP) X
XMLScript X X X X X
XMPScript X limited support
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creating 112
Listbox objects 67
listeners
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using 75
Listitem objects 67
creating 112
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about 207
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resolving 207
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about 206
enabling automatic 92, 206
ExtendScript utilities 206
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ScriptUl windows 92
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Mac OS
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list of object types 71

objects 70

preferred 85

setting preferences 85
slashes in paths 37
Slider objects 66

creating 114
SoCClientName data structure 197
Socket object

about 180

availability 164

constructor 182

functions 183

properties 182

reference 182
SoObjectInterface structure 195-197
SoServerinterface structure 191-194
spacing between child elements 85
special characters in paths 37
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